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Preface 
 
This document contains information about data collection with Wavewin. The document also describes 
the Wavewin Dispatch application. A number of examples are provided including communicating with 
devices from Hathaway, Mehta, Schweitzer, ABB, GE, etc. 

Documentation Format 

The documentation is structured to the following format: 
 

• Chapter 1: Installation and Requirements. 
 

• Chapter 2: Device Manager Quick Start. 
 

• Chapter 3: Dispatch Table Quick Start. 
 
• Chapter 4: File Manager Quick Start. 

 
• Chapter 5: Analysis Quick Start. 

 
• Chapter 6: Fields and features in the system. 

 
• Appendix A defines the script language used in the Drivers.ini file. 

 
• Appendix B lists the available function keys, navigational keys, and menu buttons. 

 
This document is intended for use by individuals working in protection, engineering, and system 
operations.
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C H A P T E R  1  

System Requirements & Installation 
 
This chapter lists the system requirements needed for installing and running the Wavewin software.  It 
also describes the installation procedures and provides technical support information. 

System Requirements 

The system requirements are listed below. 
 
� An IBM or compatible PC with an 80486 microprocessor or higher. 
� 500 Megabytes of memory. 
� 2 gigabytes of available hard disk space. 
� A VGA, 8514/A, or compatible graphics adapter. 
� Microsoft Windows version 98 or higher. 

Installation 

The system files are distributed in a compressed format.  To install the software follow the instruction for 
the type of storage media distributed with this manual. 
 
Web: To install the software from the Web access the www.wavewin.net web site. Under the “Wavewin 
Upgrades” link click on the Wavewin application to download. Enter your username and password. The 
username and password are case sensitive. Click on the software link to download the latest system’s 
executable files. Open the zip file and run the install.  
 
CD: To install the software using a CD place the CD into the CD drive.  The installation program will run 
automatically. If the installation program is not displayed, navigate to the CD’s root drive and double click 
on the install.exe application. 
 
Follow the instructions to fully install the software. 
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Figure 1.1  Destination Folder 
 
Define the destination folder for the system files then click Next to start the installation.  
 
The destination folder is the location where all files are to be copied. Use the browse button to select an 
existing folder.
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Figure 1.2  Finish Install 
 
The install is now complete click Finish to end the installation. 
 

Starting the Software 
 
After you have installed the software on your computer, you are ready to begin.  How you begin depends 
on your own style.  If you like to dive right in and learn by doing the system provides on-line help to assist 
you.  If you prefer a structured learning approach, read the quick start chapters to get familiar with the 
software. 
 
To run the software, click on the installed desktop icon or open the Start menu, navigate to the installed 
Program folder and click on the Wavewin32 shortcut. 

 

Technical Support 

Although this system is easy to use and understand, at some point you may encounter a technical 
question, feel that the system has improperly operated, or have suggestions for future improvements. In 
either case, contact Softstuf using one of the following methods: 
 
Phone:  215-922-6880, hours are from 9:00 a.m. to 8:00 p.m. Mon- Fri, (EST). 
Fax:  215-625-2497, response time is 24 hours.  
E-mail:  support@softstuf.com, response time 24 hours. 
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C H A P T E R  2  

Device Manager Quick Start 
 
This chapter shows an example of a typical utility’s digital devices and how they are configured in the 
Wavewin Device Manager. The example uses the different network and device topologies available in the 
device manager.  

Configuration Example 

The digital devices are outlined below:  
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 2.1  Example Digital Devices 

DEVICE MANAGER TABLE 
The device manager table lists all the devices configured in the software. Refer to Figure 2.2. The 
following sections describe how each device defined in the example is configured. 
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Figure 2.2  Example Device Manager Table 

POLLING TIMERS 
The first device defined in the table starts the polling sequence. The polling sequence is always 
performed in a sequential manner according to the device numbers.  The start polling entry can either 
poll the device periodically, or upon demand or at a given time during the day. 
 
The following sections explain how to configure the devices defined in the example device configuration 
displayed in Figure 2.2. DFRs and Relays can be polled directly or through a communication processor, 
phone switch, Statmux or port switch.  
 
A Communication Processor requires 2 main device entries in the table, one to dial and logon and one 
to logoff and hang up after polling is complete. Also, there must be an entry for each device connected. 
The dial and logon entry is the first entry defined, then a device entry for each device connected to the 
communication processor and the last device entry is the hang up, refer to Figure 2.2.  The device 
numbers for each entry must be defined in a sequential manner. The hang up driver’s device number 
can be X times greater than the last device defined so future expansion is allowed. 

INITIALIZE MODEMS 
The second device defined in the table resets the modem used to call the devices configured for 
modem communications. The MODEM INIT driver sends a number of initialization commands to the 
modem. In this example only one modem is used. If multiple modems are configured then there must 
be an initialize modem entry for each modem. 

RS232 DEVICES (POLL DRIVERS) 
The RS232 example is a star topology with each device directly connected to the Wavewin computer. 
In a star topology all devices are polled simultaneously. Device numbers 10, 11, 12 and 13 are the 
configurations for the RS232 devices. Each device’s configuration is defined in the following sections. 

 
DEVICE 10 (SEL 351) 
The SEL 351 relay is directly connected to the computers COM1 serial port. Below is the 
configuration dialog along with a description for each field.  
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Figure 2.3  SEL 351 Relay 
 

 
Field Description 

  
Device Settings  
Device Number The SEL 351 relay is device number 10.  
Address Since the relay is directly connected to the computer the address field 

does not apply, it is defaulted to xxx. 
Group ID The relay is in group 10. 
Data Type The 351 relay communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is Line A (351). All devices that are polled for event 

files and/or meter values must have the device type included in the title 
surrounded by ().   

Device Driver The POLL, SEL-351/311 driver is selected. The POLL drivers are used 
for direct communications with a device. This driver issues the following 
commands: 

� Send a logon command to the relay. The password is defined in 
the second parameter in the EscSeq field. 

� Poll for new events. 
� Send a meter command to the relay. 

Group Name The relay is in the South Arkey group. 
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Field Description 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  0 OTTER 0 0 1 L  
 
There is no phone number associated with the relay, the password is set 
to OTTER, a second level password is not required, also a back out 
command does not apply, the header is set to ON and the raw 16 
samples/cycle files are downloaded. 

  
Port Settings  
Port Number Communications with the relay is through the computers COM1 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 11 (MDAR) 
The MDAR relay is directly connected to the computers COM2 serial port. Wavewin uses the ABB 
Incom protocol to communicate with the MDAR relays. Below is the configuration dialog along with a 
description for each field.  
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Figure 2.4  MDAR Relay 

 
 

Field Description 
  
Device Settings  
Device Number The MDAR relay is device number 11.  
Address Since the relay is directly connected to the computer the address field 

does not apply, it is defaulted to xxx. 
Group ID The relay is in group 10. 
Data Type The MDAR relay communicates using a Binary protocol. 
Print OFF. 
Title The title of the relay is Line B (MDAR). All devices that are polled for 

event files and/or meter values must have the device type included in 
the title surrounded by (). 

Device Driver The POLL, REL-30X driver is selected. The POLL drivers are used for 
direct communications with a device. This driver issues the following 
commands: 

� Request fault status.   
� Request and save the latest targets 0 - 7. 
� Request and save the latest targets 8 - 15. 
� Save the latest target summary files. 
� Save the target history file. 
� Request and save the latest oscillography events 0 – 7. 
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Field Description 
� Request and save the latest oscillography events 8 – 15. 

Group Name The relay is in the South Arkey group. 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  0 000 0 0 1  
 
There is no phone number associated with the relay, the password is set 
to 000, a second level password is not required, also a back out 
command does not apply, the header is set to ON and the event type 
only applies to SEL relays. 
 
The MDAR password is part of the INCOM communication protocol. 

  
Port Settings  
Port Number Communications with the relay is through the computers COM2 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 12 ( SEL 311) 
The SEL 311 relay is directly connected to the computers COM3 serial port. Below is the 
configuration dialog along with a description for each field.  
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Figure 2.5  SEL 311Relay 

 
 

Field Description 
  
Device Settings  
Device Number The SEL 311 relay is device number 12.  
Address Since the relay is directly connected to the computer the address field 

does not apply, it is defaulted to xxx. 
Group ID The relay is in group 10. 
Data Type The SEL 311 relay communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is Line C (311). All devices that are polled for event 

files and/or meter values must have the device type included in the title 
surrounded by (). 

Device Driver The POLL, SEL-351/311 driver is selected. The POLL drivers are used 
for direct communications with a device. This driver issues the following 
commands: 

� Send a logon command to the relay. The password is defined in 
the second parameter in the EscSeq field. 

� Poll for new events. 
� Send a meter command to the relay. 

Group Name The relay is in the South Arkey group. 
Time Code The Time Code is -5 for eastern US.  



Chapter 2 –Device Manager Quick Start 
 

12 

Field Description 
EscSeq Command The 6 parameters are: 

  0 OTTER 0 0 1 L  
 
There is no phone number associated with the relay, the password is set 
to OTTER, a second level password is not required, also a back out 
command does not apply, the header is set to ON and the raw 16 
samples/cycle files are downloaded. 

  
Port Settings  
Port Number Communications with the relay is through the computers COM3 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 13 (ALPS) 
The ALPS relay is directly connected to the computers COM4 serial port. Below is the configuration 
dialog along with a description for each field.  
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Figure 2.6  ALPSRelay 

 
 

Field Description 
  
Device Settings  
Device Number The ALPS relay is device number 13.  
Address Since the relay is directly connected to the computer the address field 

does not apply, it is defaulted to xxx. 
Group ID The relay is in group 10. 
Data Type The ALPS relay communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is Line D (ALPS).  
Device Driver The POLL ALPS driver is selected. The POLL drivers are used for direct 

communications with a device. This driver issues the following 
commands: 

� Send a logon command to the relay. The password is defined in 
the second parameter in the EscSeq field. 

� Poll for new events. 
� Send a meter command to the relay. 

Group Name The relay is in the South Arkey group. 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  0 OTTER 0 0 1   
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Field Description 
 
There is no phone number associated with the relay, the password is set 
to OTTER, a second level password is not required, also a back out 
command does not apply, the header is set to ON and the event type 
only applies to SEL relays. 

  
Port Settings  
Port Number Communications with the relay is through the computers COM4 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

DIALUP DEVICES (DIAL DRIVERS) 
The Modem example is a multi-drop topology with each device connected a phone switch and some 
also connected to a communication processor.  In a multi-drop topology all devices are polled one at a 
time. The devices are polled in sequence according to the device numbers. The modem devices are 
device numbers 20 thru 49. Each devices configuration is defined in the following sections. 

 
DEVICE 20 (TRANSCAN) 
The Transcan DFR is connected to a phone switch. The Wavewin computer first calls the phone 
switch then switches to the port where the DFR is connected. Below is the configuration dialog along 
with a description for each field.  
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Figure 2.7  Transcan DFR 

 
 

Field Description 
  
Device Settings  
Device Number The Mehta Transcan DFR is device number 20.  
Address The address field defines what master number to use when polling the 

DFR. In this example master 1 is being used. 
Group ID The DFR is in group 20. 
Data Type The Transcan DFR communicates using a Binary protocol. 
Print OFF. 
Title The title of the DFR is DFR-A (Transcan). All devices that are polled for 

event files must have the device type included in the title surrounded by 
(). 

Device Driver The DIAL, MEHTA-DFR driver is selected. The DIAL drivers are used to 
communicate with a device that is connected to a modem. This driver 
issues the following commands: 

� Dial the DFR and wait for a Connect signal from the modem. 
� Logon as defined Master. The Master number is defined in the 

Address field.   
� Request the Mehta DIR. 
� Retrieve the latest event files. 

Group Name The DFR is in the Break Street group. 
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Field Description 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  9,1-899-765-2452,,,11 0 0 0 1  
 
The first parameter is the phone number followed by 3 commas and the 
port switch number, the DFR does not require a password, a second 
level password is not required, also a back out command does not 
apply, the header is set to ON. 

  
Port Settings  
Port Number Communications with the DFR is through the computers COM7 serial 

port. 
Baud Rate The baud rate is 38400. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 21 (DLP) 
The DLP relay is connected to a phone switch. The Wavewin computer first calls the phone switch 
then switches to the port where the DLP relay is connected. Below is the configuration dialog along 
with a description for each field.  
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Figure 2.8  DLP Relay 

 
 

Field Description 
  
Device Settings  
Device Number The DLP relay is device number 21.  
Address The address field defines the DLP’s communication relay number. The 

relay number is included in the commands sent to the relay. 
Group ID The relay is in group 20. 
Data Type The DLP relay communicates using a Binary protocol. 
Print OFF. 
Title The title of the relay is Line-F (DLP). All devices that are polled for event 

files and/or meter values must have the device type included in the title 
surrounded by (). 

Device Driver The DIAL, GE-DLP driver is selected. The DIAL drivers are used to 
communicate with a device that is connected to a modem. This driver 
issues the following commands: 

� Dial the relay and wait for a Connect signal from the modem. 
� Send a login command to the relay. 
� Request the fault list. 
� Request latest fault files, save fault files and produce summary 

files.  
� Request meter values. 
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Field Description 
Group Name The relay is in the Break Street group. 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  9,1-899-765-2452,,,22 ^[%VIEW:16] 0 0 1  
 
The first parameter is the phone number followed by 3 commas and the 
port switch number, the DLP password is set to VIEW, the DLP relays 
requires 16 character for the password the “:16” pads blanks at the end 
of the password, a second level password is not required, also a back 
out command does not apply, the header is set to ON. 

  
Port Settings  
Port Number Communications with the relay is through the computers COM7 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 22 (SEL 387) 
The SEL 387 relay is connected to a phone switch. The Wavewin computer first calls the phone 
switch then switches to the port where the relay is connected. Below is the configuration dialog along 
with a description for each field.  
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Figure 2.9  SEL 387 Relay 

 
 

Field Description 
  
Device Settings  
Device Number The SEL 387 relay is device number 22.  
Address The address field does not apply for direct communications through a 

modem. The address field is defaulted to xxx. 
Group ID The relay is in group 20. 
Data Type The SEL 387 relay communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is Line-G (387). All devices that are polled for event 

files and/or meter values must have the device type included in the title 
surrounded by (). 

Device Driver The DIAL, SEL-387 driver is selected. The DIAL drivers are used to 
communicate with a device that is connected to a modem. This driver 
issues the following commands: 

� Dial the relay and wait for a Connect signal from the modem. 
� Send a logon command to the relay. The password is defined in 

the second parameter in the EscSeq field. 
� Poll for new events. 
� Send a meter command to the relay. 

Group Name The relay is in the Break Street group. 
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Field Description 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  9,1-899-765-2452,,,33 OTTER 0 0 1  
 
The first parameter is the phone number followed by 3 commas and the 
port switch number, the password is set to OTTER, a second level 
password is not required, also a back out command does not apply, the 
header is set to ON. 

  
Port Settings  
Port Number Communications with the relay is through the computers COM7 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 23 (SEL 587) 
The SEL 587 relay is connected to a phone switch. The Wavewin computer first calls the phone 
switch then switches to the port where the relay is connected. Below is the configuration dialog along 
with a description for each field.  
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Figure 2.10  SEL 587 Relay 

 
 

Field Description 
  
Device Settings  
Device Number The SEL 387 relay is device number 23.  
Address The address field does not apply for direct communications through a 

modem. The address field is defaulted to xxx. 
Group ID The relay is in group 20. 
Data Type The SEL 387 relay communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is Line-G (387). All devices that are polled for event 

files and/or meter values must have the device type included in the title 
surrounded by (). 

Device Driver The DIAL, SEL-387 driver is selected. The DIAL drivers are used to 
communicate with a device that is connected to a modem. This driver 
issues the following commands: 

� Dial the relay and wait for a Connect signal from the modem. 
� Send a logon command to the relay. The password is defined in 

the second parameter in the EscSeq field. 
� Poll for new events. 
� Send a meter command to the relay. 

Group Name The relay is in the Break Street group. 
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Field Description 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  9,1-899-765-2452,,,44 OTTER 0 0 1  
 
The first parameter is the phone number followed by 3 commas and the 
port switch number, the password is set to OTTER, a second level 
password is not required, also a back out command does not apply, the 
header is set to ON. 

  
Port Settings  
Port Number Communications with the relay is through the computers COM7 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 23 (SEL 2030) 
The SEL 2030 communication processor is connected to a phone switch. The Wavewin computer first 
calls the phone switch then switches to the port where the 2030 is connected. Below is the 
configuration dialog along with a description for each field.  
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Figure 2.11  SEL 2030 Communication Processor 

 
 

Field Description 
  
Device Settings  
Device Number The SEL 2030 communication processor is device number 24.  
Address The address field does not apply. It is defaulted to xxx. 
Group ID The 2030 is in group 30. 
Data Type The SEL 2030 communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is SEL 2030-X Logon.  
Device Driver The DIAL, SEL-SW LOGON driver is selected. The DIAL drivers are 

used to communicate with a device that is connected to a modem. This 
driver issues the following commands: 

� Dial the 2030 and wait for a Connect signal from the modem. 
� Send the SEL ACC command to the 2030 along with the 

password defined in the EscSeq Command field. 
Group Name The 2030 is in the Break Street group. 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  9,1-899-765-2452,,,55 BRKY 0 0 1  
 
The first parameter is the phone number followed by 3 commas and the 
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Field Description 
port switch number, the password is set to BRKY, a second level 
password is not required, also a back out command does not apply, the 
header is set to ON. 

  
Port Settings  
Port Number Communications with the 2030 is through the computers COM7 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 25 (PRTU) 
The SEL PRTU is connected to the 2030 communication processor through a modem. The Wavewin 
computer first calls the phone switch then switches to the port where the 2030 is connected then 
switches to the PRTU. Below is the configuration dialog along with a description for each field.  
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Figure 2.12  SEL Protective Relay Terminal Unit (PRTU) 

 
 

Field Description 
  
Device Settings  
Device Number The SEL PRTU is device number 25.  
Address The address field is 1. The PRTU is connected to the 2030’s port 1. 
Group ID The PRTU is in group 30. 
Data Type The SEL PRTU communicates using an ASCII protocol. 
Print OFF. 
Title The title of the PRTU is SEL PRTU Logon.  
Device Driver The SW-SEL, SEL-SW LOGON driver is selected. The SW drivers are 

used to communicate with a device that is connected to a 
communication processor. This driver issues the following commands: 

� Send a Clear command to the PRTU. 
� Switch to the port number listed in the address field. 
� Send the ACC command and the password defined in the 

EscSeq Command field. 
Group Name The PRTU is in the Break Street group. 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  0 BSWER 0 0 1  
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Field Description 
A phone number is not required, the password is set to BSWER, a 
second level password is not required, also a back out command does 
not apply, the header is set to ON. 

  
Port Settings  
Port Number Communications with the PRTU is through the computers COM7 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 26 (SEL 501) 
The SEL 501 Relay is connected to a PRTU which is connected to a 2030 communication processor 
through a modem. The Wavewin computer first calls the phone switch then switches to the port where 
the 2030 is connected then switches to the PRTU then switches to the 501 Relay. Below is the 
configuration dialog along with a description for each field.  
 



Chapter 2 –Device Manager Quick Start 
 

27 

 
Figure 2.13  SEL 501 Relay 

 
 

Field Description 
  
Device Settings  
Device Number The SEL 501 is device number 26.  
Address The address field is 6. The 501 relay is connected to the PRTU’s port 

number 6. 
Group ID The relay is in group 30. 
Data Type The SEL 501 relay communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is Line I (501). All devices that are polled for event 

files and/or meter values must have the device type included in the title 
surrounded by ().  

Device Driver The SW-SEL, SEL-501 driver is selected. The SW drivers are used to 
communicate with a device that is connected to a communication 
processor. This driver issues the following commands: 

� Switch to the port number listed in the address field. 
� Send the SEL ACC command to along with the password 

defined in the EscSeq Command field. 
� Download all new events. 
� Send a Meter command. 

Group Name The 501 relay is in the Break Street group. 
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Field Description 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  0 OTTER 0 0 1  
 
A phone number is not required, the password is set to OTTER, a 
second level password is not required, also a back out command does 
not apply, the header is set to ON. 

  
Port Settings  
Port Number Communications with the relay is through the computers COM7 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 27 (SEL 287) 
The SEL 287 Relay is connected to a PRTU which is connected to a 2030 communication processor 
through a modem. The Wavewin computer first calls the phone switch then switches to the port where 
the 2030 is connected then switches to the PRTU then switches to the 287 Relay. Below is the 
configuration dialog along with a description for each field.  
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Figure 2.14  SEL 287 Relay 

 
 

Field Description 
  
Device Settings  
Device Number The SEL 287 Relay is device number 27.  
Address The address field is 7. The 287 relay is connected to the PRTU’s port 

number 7. 
Group ID The relay is in group 30. 
Data Type The SEL 287 relay communicates using an ASCII protocol. 
Print OFF. 
Title The title of the 287 relay is Line J (287). All devices that are polled for 

event files and/or meter values must have the device type included in 
the title surrounded by (). 

Device Driver The SW-SEL, SEL-187/287/352 driver is selected. The SW drivers are 
used to communicate with a device that is connected to a 
communication processor. This driver issues the following commands: 

� Switch to the port number listed in the address field. 
� Send the SEL ACC command to along with the password 

defined in the EscSeq Command field. 
� Download all new events. 
� Send a Meter command. 

Group Name The relay is in the Break Street group. 
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Field Description 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  0 OTTER 0 0 1  
 
A phone number is not required, the password is set to OTTER, a 
second level password is not required, also a back out command does 
not apply, the header is set to ON. 

  
Port Settings  
Port Number Communications with the relay is through the computers COM7 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 28 (D60) 
The GE D60 Relay is connected to a PRTU which is connected to a 2030 communication processor 
through a modem. The Wavewin computer first calls the phone switch then switches to the port where 
the 2030 is connected then switches to the PRTU then switches to the D60 Relay. Below is the 
configuration dialog along with a description for each field.  
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Figure 2.15  GE D60 Relay 

 
 

Field Description 
  
Device Settings  
Device Number The GE D60 Relay is device number 28.  
Address The address field is 8. The D60 relay is connected to the PRTU’s port 

number 8. 
Group ID The relay is in group 30. 
Data Type The GE D60 relay communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is T-3 (D60). All devices that are polled for event 

files and/or meter values must have the device type included in the title 
surrounded by (). 

Device Driver The SW-SEL, GE-D60 driver is selected. The SW drivers are used to 
communicate with a device that is connected to a communication 
processor. This driver issues the following commands: 

� Switch to the port number listed in the address field. 
� Logon using the password defined in the EscSeq field if there is 

a password set on the machine.  
� Request and save all new html fault report files. 
� Request and save all new event files. 
� Request and save all new oscillography Comtrade files. 
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Field Description 
� Request and save all new data logger Comtrade files.  
� Log off. 

Group Name The relay is in the Break Street group. 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  0 LPF123 0 0 1  
 
A phone number is not required, the password is set to LPF123, a 
second level password is not required, also a back out command does 
not apply, the header is set to ON. 

  
Port Settings  
Port Number Communications with the relay is through the computers COM7 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 34 (PRTU QUIT) 
The SEL PRTU QUIT will back out of the last connected port on the PRTU then issue a QUIT 
command to the PRTU. Below is the configuration dialog along with a description for each field.  
 



Chapter 2 –Device Manager Quick Start 
 

33 

 
Figure 2.16  SEL PRTU Quit 

 
 

Field Description 
  
Device Settings  
Device Number The PRTU Quit is at device number 34. Five device numbers where 

skipped between the D60 relay and the PRTU Quit. This is done to 
handle new devices that may be added to the SEL PRTU in the future. 
Always leave a difference of at least 5 device numbers between the last 
device on a communication processor and the PRTU quit.  

Address The address field is not needed, it is defaulted to xxx. 
Group ID The PRTU Quit is in group 30. 
Data Type The PRTU communicates using an ASCII protocol. 
Print OFF. 
Title The title of the PRTU Quit is SEL PRTU QUIT.  
Device Driver The SW-SEL, SEL-SW QUIT driver is selected. The SW drivers are 

used to communicate with a communication processor. This driver 
issues the following commands: 

� Switch back out to the PRTU. 
� Send a QUIT command to the PRTU. 

Group Name The PRTU quit is in the Break Street group. 
Time Code The Time Code is -5 for eastern US.  
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Field Description 
EscSeq Command The 6 parameters are: 

  0 0 0 0 0  
 
A phone number is not required, a password does not apply, a second 
level password is not required, also a back out command does not 
apply, the header is set to ON. 

  
Port Settings  
Port Number Communications with the PRTU is through the computers COM7 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 35 (SEL 551) 
The SEL 551 Relay is connected to the 2030 communication processor through a modem. The 
Wavewin computer first calls the phone switch then switches to the port where the 2030 is connected 
then switches to the SEL 551 Relay. Below is the configuration dialog along with a description for 
each field.  
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Figure 2.17  SEL 551 Relay 

 
 

Field Description 
  
Device Settings  
Device Number The SEL 551 Relay is device number 35.  
Address The address field is 2. The 551 relay is connected to the 2030’s port 

number 2. 
Group ID The relay is in group 30. 
Data Type The 551 relay communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is Line M (551). All devices that are polled for event 

files and/or meter values must have the device type included in the title 
surrounded by (). 

Device Driver The SW-SEL, SEL-551/311/587Z driver is selected. The SW drivers are 
used to communicate with a device connected to a communication 
processor. This driver issues the following commands: 

� Switch to the port number listed in the address field. 
� Send the SEL ACC command along with the password defined 

in the EscSeq Command field. 
� Download all new events. 
� Send a Meter command. 

Group Name The relay is in the Break Street group. 
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Field Description 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  0 OTTER 0 0 0  
 
A phone number is not required, the password is set to OTTER, a 
second level password is not required, also a back out command does 
not apply, the header is set to ON. 

  
Port Settings  
Port Number Communications with the relay is through the computers COM7 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 36 (OPTIMHO) 
The Optimho Relay is connected to the 2030 communication processor through a modem. The 
Wavewin computer first calls the phone switch then switches to the port where the 2030 is connected 
then switches to the Optimho Relay. Below is the configuration dialog along with a description for 
each field.  
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Figure 2.18  Optimho Relay 

 
 

Field Description 
  
Device Settings  
Device Number The Optimho relay is device number 36.  
Address The address field is 3. The Optimho relay is connected to the 2030’s 

port number 3. 
Group ID The relay is in group 30. 
Data Type The Optimho communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is Line S1 (LFZP). All devices that are polled for 

event files and/or meter values must have the device type included in 
the title surrounded by (). 

Device Driver The SW-SEL, OPTIMHO LFZP111 driver is selected. The SW drivers 
are used to communicate with a communication processor. This driver 
issues the following commands: 

� Switch to the port number listed in the address field. 
� Logon to the relay using the password defined in the EscSeq 

Command field. 
� Download all new events. 
� Logoff the relay. 

Group Name The relay is in the Break Street group. 
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Field Description 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  1 S-643^[32]SYSTEM^[32]1 0 0 1  
 
A phone number is not required, a password is set to S-
643^[32]SYSTEM^[32]1, a second level password is not required, also a 
back out command does not apply, the header is set to ON. 

  
Port Settings  
Port Number Communications with the relay is through the computers COM7 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 37 (SEL 352) 
The SEL 352 Relay is connected to the 2030 communication processor through a modem. The 
Wavewin computer first calls the phone switch then switches to the port where the 2030 is connected 
then switches to the SEL 352 Relay. Below is the configuration dialog along with a description for 
each field.  
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Figure 2.19  SEL 352 Relay 

 
 

Field Description 
  
Device Settings  
Device Number The SEL 352 Relay is device number 37.  
Address The address field is 4. The 352 relay is connected to the 2030’s port 

number 4. 
Group ID The relay is in group 30. 
Data Type The 352 relay communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is Line P (352). All devices that are polled for event 

files and/or meter values must have the device type included in the title 
surrounded by (). 

Device Driver The SW-SEL, SEL-187/287/352 driver is selected. The SW drivers are 
used to communicate with a device connected to a communication 
processor. This driver issues the following commands: 

� Switch to the port number listed in the address field. 
� Send the SEL ACC command along with the password defined 

in the EscSeq Command field. 
� Download all new events. 
� Send a Meter command. 

Group Name The relay is in the Break Street group. 
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Field Description 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  0 OTTER 0 0 0  
 
A phone number is not required, the password is set to OTTER, a 
second level password is not required, also a back out command does 
not apply, the header is set to ON. 

  
Port Settings  
Port Number Communications with the relay is through the computers COM7 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 49 (SEL 2030) 
The SEL 2030-X QUIT will back out of the last connected port on the 2030 then issue a QUIT 
command to the 2030 then hang up the modem. Below is the configuration dialog along with a 
description for each field.  
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Figure 2.20  SEL 2030-X Quit 

 
 

Field Description 
  
Device Settings  
Device Number The 2030-X Quit is at device number 49. Twelve device numbers where 

skipped between the SEL 352 relay and the 2030-X Quit. This is done to 
handle new devices that may be added to the SEL 2030 in the future. 
Always leave a difference of at least 5 device numbers between the last 
device on a communication processor and the PRTU quit.  

Address The address field is not needed, it is defaulted to xxx. 
Group ID The 2030-X Quit is in group 30. 
Data Type The 2030 communicates using an ASCII protocol. 
Print OFF. 
Title The title of the 2030-X Quit is SEL 2030-X QUIT.  
Device Driver The DIAL, SEL-SW HANGUP driver is selected. The DIAL drivers are 

used to communicate with a device connected to a modem. This driver 
issues the following commands: 

� Switch back out to the 2030. 
� Send a QUIT command to the 2030. 
� Hang up the modem. 

Group Name The 2030 quit is in the Break Street group. 
Time Code The Time Code is -5 for eastern US.  
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Field Description 
EscSeq Command The 6 parameters are: 

  0 0 0 0 0  
 
A phone number is not required, a password does not apply, a second 
level password is not required, also a back out command does not 
apply, the header is set to ON. 

  
Port Settings  
Port Number Communications with the 2030 is through the computers COM7 serial 

port. 
Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

ETHERNET STAR (NETWORK DRIVERS) 
The Ethernet example is a star topology with each device having an IP address and port number.  In a 
star topology all devices are polled simultaneously. The Ethernet devices are device numbers 50 thru 
69. Each device’s configuration is defined in the following sections. 

 
DEVICE 50 (TESLA) 
The Tesla DFR is connected to the computer using an Ethernet connection. Below is the 
configuration dialog along with a description for each field.  
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Figure 2.21  Tesla DFR 

 
 

Field Description 
  
Device Settings  
Device Number The Tesla DFR is at device number 50.  
Address The address field is not needed, it is defaulted to xxx. 
Group ID The DFR is in group 40. 
Data Type The Tesla communicates using an ASCII protocol. 
Print OFF. 
Title The title of the DFR is DFR B (Tesla). All devices that are polled for 

event files and/or meter values must have the device type included in 
the title surrounded by (). 

Device Driver The LAN, FTP-EVENTS driver is selected. The LAN drivers are used to 
communicate with a device connected using Ethernet. This driver issues 
the following commands: 

� Connect to the FTP server. 
� Request a directory listing on the FTP server’s remote path. 
� Download all new event files. 
� Disconnect the from the FTP server. 

Group Name The Tesla is in the Linpoint group. 
Time Code The Time Code is -5 for eastern US.  
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Field Description 
EscSeq Command The 6 parameters are: 

  0 0 0 0 0  
FTP=192.168.200.211;21;ftp;aptftp;/usr/apt/tesla/record;;2;C:\SDCS
AVE;1;1  
 
A phone number is not required, a password does not apply, a second 
level password is not required, also a back out command does not 
apply, the header is set to OFF and the FTP information is defined, 
Refer to Figure 2.22. 

  
Port Settings  
Port Number The COM port number is set to COM50. Communications with the Tesla 

DFR is through an Ethernet connection. All Ethernet connections require 
a unique COM port number. The COM port number for Ethernet 
connections cannot be a physical COM port on the computer. Start all 
Ethernet COM port numbers at COM50.  

Baud Rate The baud rate field does not apply to Ethernet connections. 
Parity The parity field does not apply to Ethernet connections. 
Data Bits The data bits field does not apply to Ethernet connections. 
Stop Bits The stop bits field does not apply to Ethernet connections. 
Flow Control The flow control field does not apply to Ethernet connections.. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 
 
The Tesla DFR uses FTP to download the events from the DFR. FTP communications requires a 
number of parameters to successfully connect to the DFR. To enter the FTP required fields click on 

the Ethernet button  displayed next to the “EscSeq Command” field, Refer to Figure 2.22. Enter 
the DFR information for all the fields displayed in the FTP dialog. The enter fields are listed in the 
EscSeq Command field labeled FTP= and separated by a semicolon “;”. 
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Figure 2.22  FTP Dialog 
 
DEVICE 51 (SEL 421) 
The SEL 421 Relay is connected to the computer using an Ethernet connection. Below is the 
configuration dialog along with a description for each field.  
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Figure 2.23  SEL 421 

 
 

Field Description 
  
Device Settings  
Device Number The SEL 421 is at device number 51.  
Address The address field is not needed, it is defaulted to xxx. 
Group ID The relay is in group 50. 
Data Type The SEL 421 communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is Line Q (421). All devices that are polled for event 

files and/or meter values must have the device type included in the title 
surrounded by (). 

Device Driver The LAN, SEL-321/421 driver is selected. The LAN drivers are used to 
communicate with a device connected using Ethernet. This driver issues 
the following commands: 

� Connect to the IP server. 
� Switch to the port number listed in the address field. 
� Send the SEL ACC command along with the password defined 

in the EscSeq Command field. 
� Download all new events. 
� Send a Meter command. 
� Disconnect the from the IP server. 
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Field Description 
Group Name The relay is in the Somers Harbor group. 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  0 OTTER 0 0 0 IP=192.168.200.198:8003 
 
A phone number is not required, the password is set to OTTER, a 
second level password is not required, also a back out command does 
not apply, the header is set to OFF and the IP information is defined, 
Refer to Figure 2.24. 

  
Port Settings  
Port Number The COM port number is set to COM51. Communications with the relay 

is through an Ethernet connection. All Ethernet connections require a 
unique COM port number. The COM port number for Ethernet 
connections cannot be a physical COM port on the computer.  

Baud Rate The baud rate field does not apply to Ethernet connections. 
Parity The parity field does not apply to Ethernet connections. 
Data Bits The data bits field does not apply to Ethernet connections. 
Stop Bits The stop bits field does not apply to Ethernet connections. 
Flow Control The flow control field does not apply to Ethernet connections.. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 
 
The 421 relay uses IP to download the events from the relay. IP communications requires a port 
number and IP address to successfully connect to the relay. To enter the IP required fields click on 

the Ethernet button  displayed next to the “EscSeq Command” field, Refer to Figure 2.24. Enter 
the relay’s port number and IP address. The enter fields are listed in the EscSeq Command field 
labeled IP= and separated by a colon “:”. 
 

 
Figure 2.24  SEL 421 IP Dialog 
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DEVICE 52 (ORION 5) 
The Orion5 communication processor is connected to the computer using an Ethernet connection. 
Below is the configuration dialog along with a description for each field.  
 

 
Figure 2.25  Orion5 

 
 

Field Description 
  
Device Settings  
Device Number The Orion5 is at device number 52.  
Address The address field is not needed, it is defaulted to xxx. 
Group ID The Orion5 is in group 60. 
Data Type The Orion5 communicates using an ASCII protocol. 
Print OFF. 
Title The title of the Orion is Orion-5 LOGON. 
Device Driver The LAN, OR5-SW LOGON driver is selected. The LAN drivers are 

used to communicate with a device connected using Ethernet. This 
driver issues the following commands: 

� Connect to the IP server. 
� Logon with the password defined in the EscSeq Command field. 

Group Name The Orion is in the Northville group. 
Time Code The Time Code is -5 for eastern US.  
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Field Description 
EscSeq Command The 6 parameters are: 

  0 SDQ-1 0 0 1 IP=192.168.200.110:2001 
 
A phone number is not required, the password is set to SDQ-1, a 
second level password is not required, also a back out command does 
not apply, the header is set to ON and the IP information is defined, 
Refer to Figure 2.26. 

  
Port Settings  
Port Number The COM port number is set to COM53. Communications with the relay 

is through an Ethernet connection. All Ethernet connections require a 
unique COM port number. The COM port number for Ethernet 
connections cannot be a physical COM port on the computer.  

Baud Rate The baud rate field does not apply to Ethernet connections. 
Parity The parity field does not apply to Ethernet connections. 
Data Bits The data bits field does not apply to Ethernet connections. 
Stop Bits The stop bits field does not apply to Ethernet connections. 
Flow Control The flow control field does not apply to Ethernet connections.. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 
 
The Orion5 uses IP to communicate. IP communications requires a port number and IP address to 

successfully connect. To enter the IP required fields click on the Ethernet button  displayed next 
to the “EscSeq Command” field, Refer to Figure 2.26. Enter the Orion’s port number and IP address. 
The enter fields are listed in the EscSeq Command field labeled IP= and separated by a colon “:”. 
 

 
Figure 2.26  Orion IP Dialog 
 
DEVICE 53 (SEL 321) 



Chapter 2 –Device Manager Quick Start 
 

50 

The SEL 321 Relay is connected to the Orion5 communication processor. The Wavewin computer 
first connects to the Orion5 using Ethernet then switches to the SEL 321 Relay. Below is the 
configuration dialog along with a description for each field.  
 

 
Figure 2.27  SEL 321 Relay 

 
 

Field Description 
  
Device Settings  
Device Number The SEL 321 Relay is device number 53.  
Address The address field is 1. The 321 relay is connected to the Orion’s port 

number 1. 
Group ID The relay is in group 60. 
Data Type The 321 relay communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is Line R (321). All devices that are polled for event 

files and/or meter values must have the device type included in the title 
surrounded by (). 

Device Driver The SW-OR5, SEL-321/421 driver is selected. The SW drivers are used 
to communicate with a device connected to a communication processor. 
This driver issues the following commands: 

� Switch to the port number listed in the address field using the 
Orion pass thru command. 
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Field Description 
� Send the SEL ACC command along with the password defined 

in the EscSeq Command field. 
� Download all new events. 
� Send a Meter command. 

Group Name The relay is in the Northville group. 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  0 OTTER 0 0 1  
 
A phone number is not required, the password is set to OTTER, a 
second level password is not required, also a back out command does 
not apply, the header is set to ON. 

  
Port Settings  
Port Number The COM port number is set to COM53. Communications with the relay 

is through the Orion5. All devices connected to a communication 
processor must have the same COM port number as the communication 
processor. 

Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 54 (SEL 187) 
The SEL 187 Relay is connected to the Orion5 communication processor. The Wavewin computer 
first connects to the Orion5 using Ethernet then switches to the SEL 187 Relay. Below is the 
configuration dialog along with a description for each field.  
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Figure 2.28  SEL 187 Relay 

 
 

Field Description 
  
Device Settings  
Device Number The SEL 187 Relay is device number 54.  
Address The address field is 2. The 187 relay is connected to the Orion’s port 

number 2. 
Group ID The relay is in group 60. 
Data Type The 187 relay communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is M3 Bank (187). All devices that are polled for 

event files and/or meter values must have the device type included in 
the title surrounded by (). 

Device Driver The SW-OR5, SEL-187/287/352 driver is selected. The SW drivers are 
used to communicate with a device connected to a communication 
processor. This driver issues the following commands: 

� Switch to the port number listed in the address field using the 
Orion pass thru command. 

� Send the SEL ACC command along with the password defined 
in the EscSeq Command field. 

� Download all new events. 
� Send a Meter command. 
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Field Description 
Group Name The relay is in the Northville group. 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  0 OTTER 0 0 1  
 
A phone number is not required, the password is set to OTTER, a 
second level password is not required, also a back out command does 
not apply, the header is set to ON. 

  
Port Settings  
Port Number The COM port number is set to COM53. Communications with the relay 

is through the Orion5. All devices connected to a communication 
processor must have the same COM port number as the communication 
processor. 

Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 55 (HATHAWAY) 
The Hathaway DFR is connected to the Orion5 communication processor. The Wavewin computer 
first connects to the Orion5 using Ethernet then switches to the Hathaway DFR. Below is the 
configuration dialog along with a description for each field.  
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Figure 2.29  Hathaway DFR 

 
 

Field Description 
  
Device Settings  
Device Number The Hathaway DFR is device number 55.  
Address The address field is 3. The DFR is connected to the Orion’s port number 

2. 
Group ID The relay is in group 60. 
Data Type The Hathaway DFR communicates using a Binary protocol. 
Print OFF. 
Title The title of the DFR is DFR-C (Hathaway). All devices that are polled for 

event files and/or meter values must have the device type included in 
the title surrounded by (). 

Device Driver The SW-OR5, HATH driver is selected. The SW drivers are used to 
communicate with a device connected to a communication processor. 
This driver issues the following commands: 

� Switch to the port number listed in the address field using the 
Orion pass thru command. 

� Request the latest event file. 
� If event is a new file download the event. 

Group Name The DFR is in the Northville group. 
Time Code The Time Code is -5 for eastern US.  
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Field Description 
EscSeq Command The 6 parameters are: 

  0 0 0 0 0  
 
A phone number is not required, the password is not applicable, a 
second level password is not required, also a back out command does 
not apply and the header is set to OFF. 

  
Port Settings  
Port Number The COM port number is set to COM53. Communications with the DFR 

is through the Orion5. All devices connected to a communication 
processor must have the same COM port number as the communication 
processor. 

Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 56 (DPU2000R) 
The DPU2000R Relay is connected to the Orion5 communication processor. The Wavewin computer 
first connects to the Orion5 using Ethernet then switches to the DPU2000R relay. Below is the 
configuration dialog along with a description for each field.  
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Figure 2.30  DPU2000R Relay 

 
 

Field Description 
  
Device Settings  
Device Number The DPU2000R relay is device number 56.  
Address The address field is 4. The relay is connected to the Orion’s port number 

4. 
Group ID The relay is in group 60. 
Data Type The DPU2000R relay communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is LINE T (DPU2000R). All devices that are polled 

for event files and/or meter values must have the device type included in 
the title surrounded by (). 

Device Driver The SW-OR5, ABB-DPU2000R driver is selected. The SW drivers are 
used to communicate with a device connected to a communication 
processor. This driver issues the following commands: 

� Switch to the port number listed in the address field using the 
Orion pass thru command. 

� Request total number of records.   
� Request 1st new records configuration. 
� Request Quarter Cycle data until done. 
� Save Configuration & Data to a long filename with a “.DPU” 
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Field Description 
extension. 

Group Name The relay is in the Northville group. 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

  0 0 0 0 0  
 
A phone number is not required, the password is not applicable, a 
second level password is not required, also a back out command does 
not apply and the header is set to OFF. 

  
Port Settings  
Port Number The COM port number is set to COM53. Communications with the relay 

is through the Orion5. All devices connected to a communication 
processor must have the same COM port number as the communication 
processor. 

Baud Rate The baud rate is 19200. 
Parity No parity. 
Data Bits The Data Bits = 8. 
Stop Bits The Stop Bits = 1. 
Flow Control The Flow Control = None. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 66 (ORION5) 
The Orion-5 QUIT will back out of the last connected port on the Orion then issue a QUIT command 
to the Orion then hang up the modem. Below is the configuration dialog along with a description for 
each field.  
 



Chapter 2 –Device Manager Quick Start 
 

58 

 
Figure 2.31  Orion-5 Quit 

 
 

Field Description 
  
Device Settings  
Device Number The Orion-5 Quit is at device number 66. Nine device numbers where 

skipped between the DPU2000R relay and the Orion-5 Quit. This is 
done to handle new devices that may be added to the Orion in the 
future. Always leave a difference of at least 5 device numbers between 
the last device on a communication processor and the quit.  

Address The address field is not needed, it is defaulted to xxx. 
Group ID The Orion Quit is in group 60. 
Data Type The Orion communicates using an ASCII protocol. 
Print OFF. 
Title The title of the Orion Quit is Orion-5 QUIT.  
Device Driver The LAN, OR5-SW QUIT driver is selected. The LAN drivers are used to 

communicate with a device connected via Ethernet. This driver issues 
the following commands: 

� Switch back out to the Orion. 
� Send a QUIT command to the Orion. 
� Disconnect the from the IP server. 

Group Name The Orion quit is in the Northville group. 
Time Code The Time Code is -5 for eastern US.  



Chapter 2 –Device Manager Quick Start 
 

59 

Field Description 
EscSeq Command The 6 parameters are: 

  0 0 0 0 0  
 
A phone number is not required, a password does not apply, a second 
level password is not required, also a back out command does not 
apply, the header is set to ON. 

  
Port Settings  
Port Number The COM port number is set to COM53. The quit command for a 

communications processor must have the same COM port number as 
the communication processors LOGON. 

Baud Rate The baud rate field does not apply to Ethernet connections. 
Parity The parity field does not apply to Ethernet connections. 
Data Bits The data bits field does not apply to Ethernet connections. 
Stop Bits The stop bits field does not apply to Ethernet connections. 
Flow Control The flow control field does not apply to Ethernet connections. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 

 
DEVICE 67 (BPRO) 
The BPRO relay is connected to the computer using an Ethernet connection. Below is the 
configuration dialog along with a description for each field. 
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Figure 2.32  BPRO Relay 

 
 

Field Description 
  
Device Settings  
Device Number The BPRO relay is device number 67.  
Address Since the relay is directly connected to the computer through an 

Ethernet connection the address field does not apply, it is defaulted to 
xxx. 

Group ID The relay is in group 70. 
Data Type The BPRO relay communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is LINE S2 (BPRO). All devices that are polled for 

event files and/or meter values must have the device type included in 
the title surrounded by (). 

Device Driver The LAN, FTP-EVENTS driver is selected. The LAN drivers are used to 
communicate with a device connected using Ethernet. This driver issues 
the following commands: 

� Connect to the FTP server. 
� Request a directory listing on the FTP server’s remote path. 
� Download all new event files. 
� Disconnect the from the FTP server. 

Group Name The relay is in the Hamilton group. 
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Field Description 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

 0 0 0 0 0 
FTP=192.168.200.250;21;ftp;aptftp;/usr/apt/bpro/record;;2;C:\SDCS
AVE;1;1  
 
A phone number is not required, a password does not apply, a second 
level password is not required, also a back out command does not 
apply, the header is set to OFF and the FTP information is defined, 
Refer to Figure 2.33. 

  
Port Settings  
Port Number The COM port number is set to COM60. Communications with the relay 

is through an Ethernet connection. All Ethernet connections require a 
unique COM port number. The COM port number for Ethernet 
connections cannot be a physical COM port on the computer. Start all 
Ethernet COM port numbers at COM50. 

Baud Rate The baud rate field does not apply to Ethernet connections. 
Parity The parity field does not apply to Ethernet connections. 
Data Bits The data bits field does not apply to Ethernet connections. 
Stop Bits The stop bits field does not apply to Ethernet connections. 
Flow Control The flow control field does not apply to Ethernet connections. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 
 
The BPRO relay uses FTP to download the events from the relay. FTP communications requires a 
number of parameters to successfully connect to the relay. To enter the FTP required fields click on 

the Ethernet button  displayed next to the “EscSeq Command” field, Refer to Figure 2.33. Enter 
the relay information for all the fields displayed in the FTP dialog. The enter fields are listed in the 
EscSeq Command field labeled FTP= and separated by a semicolon “;”. 
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Figure 2.33  BPRO FTP Dialog 
 
DEVICE 68 (TPRO) 
The TPRO relay is connected to the computer using an Ethernet connection. Below is the 
configuration dialog along with a description for each field. 
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Figure 2.34  TPRO Relay 

 
 

Field Description 
  
Device Settings  
Device Number The TPRO relay is device number 68.  
Address Since the relay is directly connected to the computer through an 

Ethernet connection the address field does not apply, it is defaulted to 
xxx. 

Group ID The relay is in group 80. 
Data Type The TPRO relay communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is LINE R1 (TPRO). All devices that are polled for 

event files and/or meter values must have the device type included in 
the title surrounded by (). 

Device Driver The LAN, FTP-EVENTS driver is selected. The LAN drivers are used to 
communicate with a device connected using Ethernet. This driver issues 
the following commands: 

� Connect to the FTP server. 
� Request a directory listing on the FTP server’s remote path. 
� Download all new event files. 
� Disconnect the from the FTP server. 

Group Name The relay is in the Hamilton group. 
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Field Description 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

 0 0 0 0 0 
FTP=192.168.200.251;21;ftp;aptftp;/usr/apt/tpro/record;;2;C:\SDCSA
VE;1;1  
 
A phone number is not required, a password does not apply, a second 
level password is not required, also a back out command does not 
apply, the header is set to OFF and the FTP information is defined, 
Refer to Figure 2.35. 

  
Port Settings  
Port Number The COM port number is set to COM61. Communications with the relay 

is through an Ethernet connection. All Ethernet connections require a 
unique COM port number. The COM port number for Ethernet 
connections cannot be a physical COM port on the computer. Start all 
Ethernet COM port numbers at COM50. 

Baud Rate The baud rate field does not apply to Ethernet connections. 
Parity The parity field does not apply to Ethernet connections. 
Data Bits The data bits field does not apply to Ethernet connections. 
Stop Bits The stop bits field does not apply to Ethernet connections. 
Flow Control The flow control field does not apply to Ethernet connections. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 
 
The TPRO relay uses FTP to download the events from the relay. FTP communications requires a 
number of parameters to successfully connect to the relay. To enter the FTP required fields click on 

the Ethernet button  displayed next to the “EscSeq Command” field, Refer to Figure 2.35. Enter 
the relay information for all the fields displayed in the FTP dialog. The enter fields are listed in the 
EscSeq Command field labeled FTP= and separated by a semicolon “;”. 
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Figure 2.35  TPRO FTP Dialog 
 
DEVICE 69 (LPRO) 
The LPRO relay is connected to the computer using an Ethernet connection. Below is the 
configuration dialog along with a description for each field. 
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Figure 2.36  LPRO Relay 

 
 

Field Description 
  
Device Settings  
Device Number The LPRO relay is device number 69.  
Address Since the relay is directly connected to the computer through an 

Ethernet connection the address field does not apply, it is defaulted to 
xxx. 

Group ID The relay is in group 90. 
Data Type The LPRO relay communicates using an ASCII protocol. 
Print OFF. 
Title The title of the relay is LINE X1 (LPRO). All devices that are polled for 

event files and/or meter values must have the device type included in 
the title surrounded by (). 

Device Driver The LAN, FTP-EVENTS driver is selected. The LAN drivers are used to 
communicate with a device connected using Ethernet. This driver issues 
the following commands: 

� Connect to the FTP server. 
� Request a directory listing on the FTP server’s remote path. 
� Download all new event files. 
� Disconnect the from the FTP server. 

Group Name The relay is in the Hamilton group. 
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Field Description 
Time Code The Time Code is -5 for eastern US.  
EscSeq Command The 6 parameters are: 

 0 0 0 0 0 
FTP=192.168.200.251;21;ftp;aptftp;/usr/apt/lpro/record;;2;C:\SDCSA
VE;1;1  
 
A phone number is not required, a password does not apply, a second 
level password is not required, also a back out command does not 
apply, the header is set to OFF and the FTP information is defined, 
Refer to Figure 2.37. 

  
Port Settings  
Port Number The COM port number is set to COM62. Communications with the relay 

is through an Ethernet connection. All Ethernet connections require a 
unique COM port number. The COM port number for Ethernet 
connections cannot be a physical COM port on the computer. Start all 
Ethernet COM port numbers at COM50. 

Baud Rate The baud rate field does not apply to Ethernet connections. 
Parity The parity field does not apply to Ethernet connections. 
Data Bits The data bits field does not apply to Ethernet connections. 
Stop Bits The stop bits field does not apply to Ethernet connections. 
Flow Control The flow control field does not apply to Ethernet connections. 
 
 
Terminal Settings 

 

CR/LF Carriage Return and Line Feed are not needed. 
Local Echo Local Echo = OFF. 
Inter Char Delay No Inter Char Delay is needed. 
 
The LPRO relay uses FTP to download the events from the relay. FTP communications requires a 
number of parameters to successfully connect to the relay. To enter the FTP required fields click on 

the Ethernet button  displayed next to the “EscSeq Command” field, Refer to Figure 2.37. Enter 
the relay information for all the fields displayed in the FTP dialog. The enter fields are listed in the 
EscSeq Command field labeled FTP= and separated by a semicolon “;”. 
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Figure 2.37  LPRO FTP Dialog 

STOP MODEMS 
The second to last device defined in the table resets the modem used to call the devices configured for 
modem communications. The MODEM INIT driver sends a number of initialization commands to the 
modem. In this example only one modem is used. If multiple modems are configured then there must 
be reset modem entry in the table for each modem. 

SYSTEM SERVICES 
The last device defined in the table performs any system service needed. The system services can 
include monitoring the message folder for poll requests, archiving files and so on. 

Device Manager Features 

DEVICE CONFIGURATION FIELDS 
The device manager table lists the configuration fields for each device. To configure a new device 
select the “New” menu option under the “Device” menu or click the “New”  menu button in the 
Device Manager’s menu toolbar. To edit an existing device select the ‘Edit” menu option under the 
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“Device” menu or click the “Edit”  menu button in the Device Manager’s menu toolbar or right click 
on the device.   
 
The configuration fields are described in the following table. Not all fields may be applicable for all 
devices. Use the fields that are associated with the device being configured. 
 

 
Field Description Range 

   
Device Settings   
Device Number Each device must have a unique device number.  1..999 
Address The address field can define the port number the 

device is connected to off a communication 
processor or the relay’s communication number 
for DLP relays or the master number for Mehta 
Transcan DFRs. 

4 Characters 

Group ID The group ID defines what group the relay is 
associated with. 

4 Byte Number 
1..214748364 

Data Type The data type field defines the type of 
communication protocol. 

ASCII / Binary 

Print The print field defines to print all data from the 
device (ON/OFF). 

ON / OFF 

Title The Title field is the device name followed by the 
type of device surrounded by (). This field is used 
when composing the IEEE long file name for 
event, history and summary files. Microsoft does 
not allow a number of characters in a file name. 
Do not use the comma and the list of illegal 
characters displayed in the IEEE long file name 
section.  

24 Characters 

Device Driver The device driver is selected from a drop down 
list. There are 3 types of drivers: 
 

• POLL: The Poll drivers are used for direct 
communications with a device. 

• SW: The SW drivers are used for devices 
connected to a communication processor. 

• LAN: The LAN drivers are used for 
devices connected on a LAN network. 

Selectable 

Group Name The Group Name field is the name of the group 
the device is associated with. This field is used 
when composing the IEEE long file name for the 
event, history and summary files. Microsoft does 
not allow a number of characters in a file name. 
Do not use the comma and the list of illegal 
characters displayed in the IEEE long file name 
section. 

24 Characters 

Time Code The Time Code defines the time offset from GMT 
time.  

4 Characters 

EscSeq Command This field has 6 parameters. Each parameter is 
separated by a space. Do not use spaces in the 
individual parameters. If the parameter does not 
apply to the device default the parameter to 0. 
 
The first parameter (CMND) is the phone 

255 Characters 
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Field Description Range 
number for the device. If a phone number does 
not apply default this parameter to 0. 
 
The second parameter (CMND1) is the device’s 
first level password. If a password is not needed 
default this parameter to 0. 
 
The third parameter (CMND2) is the device’s 
second level password. If a second level 
password is not needed then default this 
parameter to 0. 
 
The fourth parameter (CMND3) is the back out 
command from a nested communication 
processor. If not applicable then default this 
parameter to 0. 
 
The fifth parameter (CMND4) is Header ON or 
OFF for the DXF Display (Header ON = 1, OFF = 
0). 
 
The sixth parameter (CMND5) defines the type 
of SEL events to download. The L parameter will 
download the raw 16 samples/cycle files and a 
blank will download the short 4 samples/cycle 
files. 

   
Port Settings   
Port Number The Port Number field defines the physical or 

virtual COM port used for connecting to the 
device. For a physical connection select the COM 
port number from the drop down list. For a virtual 
connection type the COM port number. 

Selectable 

Baud Rate Select the Baud Rate. The baud rate must be an 
exact match of the baud rate set on the device. 

Selectable 

Parity Select the Parity. The parity must be an exact 
match of the parity set on the device. Default = 
None. 

None, Odd, Even 

Data Bits Select the Data Bits. The data bits must be an 
exact match of the data bits set on the device. 
Default = 8. 

7, 8 

Stop Bits Select the Stop Bits. The stop bits must be an 
exact match of the stop bits set on the device. 
Default = 1. 

1, 2 

Flow Control Select the Flow Control. The flow control must be 
an exact match of the flow control set on the 
device. Default = None. 

None, Software, 
Hardware 

 
 
Terminal Settings 

  

CR/LF Select when a Carriage Return and Line Feed are 
needed when information is sent and/or received 
from the device in terminal mode. Default = None. 

None, Both, RX, 
TX 

Local Echo Select ON if you would like the commands sent to On / Off 
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Field Description Range 
the device echoed back in terminal mode. Default 
= OFF. 

Inter Char Delay Enter the duration in milliseconds to wait between 
sending characters to the device. 0 indicates no 
Inter Char Delay needed for the device. Default = 
0. 

2 Byte Number 
0..65535 

LONG FILE NAMING FORMAT 
All the data downloaded from the connected devices are saved to a file using the IEEE long file naming 
format. The IEEE long file naming format is a PSRC format used to name time sequenced data files. 
The file name contains the following ten fields stored in a comma-delimited fashion: 
 
Example:  000112,123433234,-5S,South Arkey,DLP1,Sun Power,T,123.22,+34,60,AG T.OCS 
 
Field Definitions: 
 
Field Example Displayed Definition 
Date 040112 01/12/2004 The Date field defines the start date of the file.  

The date fields are stored as: year (2 
characters), month and day.  

Time 123433234 12:34:33.234 The time field defines the start time of the file.  
The Time fields are defined as: hour, minutes, 
seconds and milliseconds.  

Tcode -5S -5S The Time Code defines the time offset from 
GMT time.  -5s would be specified for US 
Eastern Standard Time. If the start time is 
expressed in UT, this field is coded 0z.  
Note: GMT is the international abbreviation for 
Greenwich Mean Time.  

Substation South Arkey South Arkey The substation name or code where the 
originating device is located. 

Device DLP1 DLP1 The device name or code that generated the 
file.  

Company Sun Power Sun Power The company of the specifed substation.  
File Tag T T The fault type or contents type of the file.  
Line Length 123.22 123.22 The line length extracted from the event file. 

This field applies to certain relays.  
Fault 
Location 

+34.60 +34.60 The fault location extracted from the event file. 
This field applies to certain relays.  

Fault Type AG T AG T The fault type extracted from the event file. 
This field applies to certain relays.  

OPENING DEVICE TABLE 
To open the Device Manager table select “Device Manager” from the File Table’s Options menu or click 
on the Devices menu button .  When the Device Manager is activated all the devices defined 
in the table are automatically opened. A message dialog reports on the state of each connection. Refer 
to Figure 2.38. If an error occurs while initializing a port all device I/O is disabled. The device manager 
consists of a table and a query bar. Refer to Figure 2.1.  
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Figure 2.38  Initialize Device Ports 

CREATING/EDITING DEVICE RECORDS 
To create a new device, press F4 or click the New  menu button. To edit an existing device, select 
the device and press F2 or click the Edit  menu button or right click on the device. Use the tab key 
to navigate between fields. Fields that are followed by a down arrow button are selectable fields. Use 
the up and down arrow keys to view the selectable options or click the down arrow button.  
 
Each field is described below:  
 

Field Description 
  
Device Settings  
Device Number The unique device number for the configured device.  Range = 1..999. 
Address The address number for the device.  Range = 4 ASCII characters. The 

device number can be the port address of the device off a multidrop or 
communication processor or the device number registered in the device for 
communications. 

Group ID The ID number for the station where the device is installed. 
Data Type Device communication format, ASCII or Binary. 
Print Sends all the data received at the port to the printer every 60 seconds.  

Select ON or OFF. 
Title Device title. Enter up to 24 characters or digits. The following characters are 

not permitted: :  ?  “  /  \  <  >  *  |  @  #. 
Device Driver Driver used to periodically poll information from the device.  See Appendix 

A for script command definitions. 
Group Name The name of the station where the device is installed.  Enter up to 24 

characters or digits.  The following characters are not permitted: :  ?  “  /  \  <  
>  *  |  @  # 

Time Code The time code where the device is installed (Grenwich Time). 
EscSeq Command Six fields allocated for general driver information such as: phone numbers, 

passwords, back out commands and so on…  The fields must be separated 
by a blank.  For Ethernet connections enter “IP=IP address:port number” in 
one of the available 6 fields. If an IP adress is used the “Port Number” field 
must be unique. It is advisable to start the ethernet ports at COM50.   

  
Port Settings  
Port Number Port number.  Enter Com1 to Com999.  Up to 999 external ports can be 

defined.  For Ethernet connections the port number must be unique.  It is 
advisable to start the Ethernet ports at the COM50. 

Baud Rate Data transfer rate.  Selectable range is 300 to 256,000bps. 
Parity Parity bit.  Select Odd, Even, or None. 
Data Bits Number of bits per data packet.  Select 7 or 8. 
Stop Bits Number of stop bits used to frame each data packet.  Select 1 or 2. 
Flow Control Flow control method used by the device.  Select Software Xon/Xoff, 
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Field Description 
Hardware RTS/CTS, or None. 

  
Terminal 
Settings 

 

CR/LF Carriage Return and Line Feed setting for the terminal display. Select RX 
(for received data), TX (for transmitted data), both, or none. 

Local Echo Local Echo setting for the terminal display.  Select ON or OFF. When local 
echo is on the characters/digits entered from the keyboard are duplicated 
on the terminal screen. 

 
TX Delay 

 

Inter Char Delay Millisecond delay inserted between the transmitted characters. Maximum 
delay is 99 milliseconds. Enter 0 to turn this feature off. 

 
Click Save to save the record or Cancel to close the dialog without saving. If an error occurs when 
opening a COM port a message is displayed and all device I/O is aborted. If an error occurs connecting 
to an Ethernet port then the last device that reported an error is displayed in the device table’s status 
bar. All communication is left open when an Ethernet connection reports an error. The polling drivers 
will try to reopen the Ethernet connection on each poll. To edit an existing record select the device in 
the table and press F2 or click the Edit menu button. 
 
The title and station fields are used to compose the IEEE long file name.  Refer to “IEEE Long File 
Naming Format” section above for more information.  Below are the characters not permitted in the 
filename. 
 
 :  ?  “  /  \  <  >  *  |  @  # 
 
An error message will be displayed if these characters are entered into the title or station fields. 

DUPLICATING DEVICES RECORDS  
To duplicate an existing device record, place the cursor on the desired device and select “Duplicate” 
from the “Device” menu or press Alt+D,U. When duplicating an existing device the device number must 
be changed. If the device number is duplicated or out of range all device I/O is aborted until the error is 
corrected. Up to 999 devices can be defined. 

SAVE & ARCHIVE DIALOG 
To setup the system and file properties open the “Save & Archive” dialog under the “Options” menu.  
This dialog is used to set up the basic system parameters such as: Station ID, Station name, Company 
name and system password and to define the system files settings. Refer to Figure 2.39. 
 
The file settings maintain the device DTB files. The device DTB files can be periodically renamed to the 
IEEE PSRC long naming format (Refer to the “IEEE Long File Naming Format” section) and/or deleted 
when the device file size exceeds the defined buffer size.   
 
Refer to the table below for information on each field. 
 

Field Description 
  
System Settings  
Station ID The Station number where the system is running. 
Station Name The Station name where the system is running. 
Company Name The company name. 
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Field Description 
Password The password to gain access to this platform from another station. 

 
  
File Settings  
Save Path Path where the event, summary and history files are saved.  Enter up to 80 

characters/digits. 
Message Path Path where the data DTB files, message files and meter values files are 

saved.  Enter up to 80 characters/digits. 
Save Rx Data Save all data received from the polled devices to a separate DTB file. 

Select “Yes” to keep a record of all data received from the devices or “No” 
to discard all received data. This feature is used to troubleshooting 
commincations with devices. 

Duration (min) The duration when to rename or delete the received data stored in the 
database files (DTB).  Enter up to 99999 minutes or 0 to turn this feature 
off.  

End With Action to take when the duration field is exceeded. Select rename to 
rename the DTB file to the IEEE long file naming format or delete to delete 
the files.  

 
Use the tab key to navigate between fields, the Save button to save the data, and the Cancel button to 
terminate the command. 
 

 
Figure 2.39  Save & Archive Dialog 
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EXPORT 
The export feature exports device records from the active configuration table to a comma delimited 
ASCII file. The “Export” menu option is under the “Device” menu. All devices or only the marked 
devices can be exported, Refer to Figure 2.40.  
 
This feature is useful for changing common information for all devices quickly. For example if a COM 
port number has changed for a number of devices then those devices can be exported. The export file 
can be opened in “Excel” and all of the Com port fields can be changed easily. To import the changes 
back into the device configuration table use the “Import” menu option under the “Device” menu.  
 

 
Figure 2.40  Export Dialog 

IMPORT 
The import feature imports all device information from the exported comma delimited ASCII file. It is 
advisable to always keep a backup of the existing Device Configuration files before using the import 
feature. This allows for a quick recovery if any of the changes made to the export file were incorrect. 
The 3 files to backup are the CFG_DEVS.DTB, CFG_SHOT.DTB & DRIVERS.INI files located in the 
Wavewin directory. 
 
To import a previously exported file select the “Import” menu option under the “Device” menu. Enter the 
exported file’s folder and filename or use the “Browse” button to select the file. All device information 
contained in the imported file will be updated in the active device configuration table. 
 

 
Figure 2.41  Import Dialog 

NAVIGATING 
To navigate the device records in the table use the up, down, page up, page down, ctrl+home, and 
ctrl+end keys, or the vertical scroll bar. To navigate the columns use the right, left, home, and end keys 
or the horizontal scroll bar. Use the tab key to move the cursor from the device table to the query fields 
and the up arrow to return to the table. 
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MARKING/UNMARKING DEVICES 
Devices are marked and unmarked through the “Mark” menu option, the spacebar, or the mouse 
button. Use the shift+mouse click button to mark a group of devices or the ctrl+mouse click button to 
randomly mark devices. Marked devices are displayed in red and can be deleted (Del), copied (Alt-
D,Y), grouped (Alt+M,G), sorted (Alt+S), printed (Alt+P,P) or polled in the multiport interrogation display 
(MID) window (F7) or the DXF display window (F8). 

DELETNG DEVICES 
Devices must be marked in order to delete them from the table. To delete a device, mark the device 
and press the delete key or select “Delete” from the Device menu. The software prompts for 
confirmation, click Yes to continue or No to Cancel. 

SORTING DEVICES 
The column headers displayed at the top of the table are used to sort the device records in ascending 
or descending order. Use the Sort menu options to sort all or marked devices with respect to the 
selected sort field. To set the sort field, place the cursor in the desired column and select “Set Sort 
Field” from the Sort menu. Clicking on the column header also sets the active sort field. The active sort 
field is displayed in the status bar at the bottom of the window. The active sort column header displays 

the sort order . 

CUSTOMIZING THE DEVICE TABLE 
The columns displayed in the table can be repositioned through the “Display” menu option under the 
“Options” menu. Refer to Figure 2.42. Use the Move Up and Move Down buttons to change the position 
of a column. The table columns can also be resized. Position the mouse over the column separator in 
the table and drag the mouse to the desired location or double click on a column separator to resize the 
column to the largest display.  
 
The size of the font displayed in the table can also be changed. Use the “Table Font Size” drop down 
list to select the desired font. 
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Figure 2.42  Device Display Dialog 

QUERYING DEVICES 
The query fields are used to search for specific information in the device table. Query fields are located 
below the table. Use the tab key to move the cursor from the device table to the query fields and up 
arrow to return to the table. Use the Ctrl-Left/Right arrow keys to move between the query fields. Each 
field contains a criteria and an operator. Refer to Figure 2.43. The criterion is directly entered from the 
keyboard, and may include the “*” and “?” wild cards. Operators are located above the criteria fields and 
can be changed by clicking the mouse button on the operator symbol or by pressing the F9 key.  The 
selectable options include equal to (=), less than (<), and greater than (<). 
 

 
Figure 2.43  Query Fields 

 
When a query is launched, the engine numerically compares the specified criteria with the information 
in the table. If numerical comparison is not possible then it symbolically compares. When multiple fields 
are defined, the engine searches for a match on the first field “AND” on the second field “AND” on the 
third field and so on. 
 
Three query options are available: Query All Devices, Query Marked Devices, or Query Unmarked 
Devices. Devices that meet the specified query requirements are marked, grouped, and displayed at 
the top of the table. Use the tab and Ctrl-Left/Right arrow keys to navigate through the query fields and 
the <enter> key to execute the query. 

CREATING FUNCTION KEYS 
Programmable function keys allow for a string of ASCII characters or hexadecimal values to be 
transmitted to the output device through a single keystroke. The function keys are active in ASCII and 
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Binary terminal emulators. Each device contains up to nine function keys. To create a function key, 

select the device and press F5 or click the TermKeys menu button . 
 
Each function key is composed of two fields: name and transmit (Tx). Refer to Figure 2.44. The name 
fields are used as key descriptors and the transmit fields are used to assign a string of ASCII 
characters, hexadecimal values, escape sequences, or other transmit strings. When the associated key 
is pressed in the terminal emulator the assigned transmit string is sent to the output device one 
character at a time. For example: 
 
ASCII   F1:name Request Meter Information 

Tx:  meter ^[13;10] 
 

Binary  F1:name Request RTU SOE Points 
Tx:  7E 01 01 03 A0 8A 20 C4 A6 

 
The term “meter” specifies an ASCII command and the instruction “^[” initiates an escape sequence that 
represents a series of decimal codes separated by semicolons and terminated by a closed bracket, “]” 
or a space. In the Binary case only hex characters (0..9,A..F) are allowed. A transmit string may also 
include other transmit strings. For example: 
 
F1:TX  acc^[13;10]password^[13;10] 
F2:TX  %F1%meter^[13;10] 
 
When F2 is pressed the transmit command defined in F1 is sent to the output device followed by the 
ASCII command “meter” and the escape sequence, defined in F2. Up to eight transmit strings can be 
included in a single string. To save the function keys click the Save button or click Cancel to terminate 
the command. The function keys names are displayed at the bottom of the terminal mode window. 
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Figure 2.44  Terminal Function Keys 

COMMUNICATING WITH AN ASCII DEVICE 
The ASCII emulator is used to transmit ASCII characters and/or escape sequences to the output 
device.  To communicate with an ASCII device place the cursor on the desired device and press 

<enter> or click the Terminal menu button . Refer to Figure 2.45.  Data is transmitted to the output 
device by pressing the predefined function keys or by manually pressing the numeric and/or letter keys. 
If the device does not respond, check the device’s communication parameters (F2) and/or the device 
connection. Use the up arrow, down arrow, right arrow, left arrow, page up, and page down keys to 
browse the data and the <esc> key to exit. 
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Figure 2.45  ASCII Terminal Mode 

COMMUNICATING WITH A BINARY DEVICE 
The Binary emulator is used to transmit hex characters to the output device. To communicate with a 
Binary device place the cursor on the desired device and press <enter> or click the Terminal menu 

button . Refer to Figure 2.46. The Binary display consists of a hex editor and an ASCII display.  
When a hex value is entered, the ASCII equivalent appears in the window to the right of the editor. Hex 
values range from 00 to FF. Transmit data to the output port by pressing the predefined function keys or 
by manually pressing the numeric keys. If the device does not respond, check the device’s 
communication parameters (F2), and/or the device connection. 
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Figure 2.46  Binary Terminal Mode 

VIEWING EVENT DATA 
All data received from a device is archived in a Dev_###.DTB file (### is the device number in the 
device table) in the “Message” folder defined in the “Save & Archive” dialog. To view or modify the data 
saved in the device DTB file, select the device and press F6 or select the “View Event File” menu option 

under the “Options” menu or click on the “Event File” menu button . Refer to Figure 2.47. If a 
message folder is not defined in the “Save and Archive” dialog, then the DTB files are saved in the 
Wavewin directory. Use the up arrow, down arrow, page up, page down, ctrl+page up, ctrl+page down, 
left arrow, right arrow, home, and end keys to browse the data. The Cut (shift+del), Copy (ctrl+ins), and 
Paste (shift+ins) menu options are used to edit the file and the Save As command to save the file 
under a new name. Press <esc> or click the Close menu button to exit the window. 
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Figure 2.47  View Device Event Data 

CAPTURING DATA 
The Device Manager offers both unsolicited and solicited data captures. When the device table is open, 
the system captures any unsolicited data received from the devices. The captured data is buffered, 
processed, and saved to the device’s database file in the Message folder specified in the “Save & 
Archive” dialog.  The database filename indicates the device number in which the data was received.  
For example, DEV_129.DTB represents device 129.  All data is saved in the original form it was 
received and can be viewed or modified in the ASCII or Binary editors. 
 
Devices that do not speak on their own can be periodically polled for analog, digital, summary and 
history information. A number of pre-canned drivers are supplied for report by exception commands, 
building load profile files, and for populating one-line diagrams. For devices not supported, the scripting 
language can be used to create script routines (device drivers) that periodically interrogate a device, 
parse values from the response, and display the values in the Multiport Interrogation Display (MID) 
device panels or in a one-line diagram (DXF). 

MULTIPORT INTERROGATION DISPLAY 
The Multiport Interrogation Display (MID) contains four device panels per page. A maximum of 999 
device panels can be opened at one time. MID executes the device’s assigned drivers and updates the 
parsed information into the device panel. To activate the MID window press F7. If no devices are 
marked all devices assigned a driver are displayed and polled and if there are marked devices then 
only the marked devices assigned a driver are displayed and polled. Use the up, down, page up, and 
page down keys to view the device panels. When F7 is pressed the device’s TXCOMMAND assigned in 
the DRIVERS.INI file is periodically sent to the output device. The response data is parsed by the 
RXSTRIP commands and updated on screen. Refer to Figure 2.48. Each panel displays the device title 
(Hdr), the assigned active device drive (Drv), the device number (Dev#), and the number of times the 
driver executed (Cycle). 
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Figure 2.48  Multiport Interrogation Display (MID) 

ANIMATED CAD-DXF 
Information parsed by the device drivers can also be used to populate a CAD-DXF drawing.  Refer to 
Figure 2.49.  In order to populate the drawing, control points must be added to offset the parsed data.  
The word “Device”, the associated device number, and the device title (optional) defines a control point.  
For example, if the CAD-DXF reader encounters the text “Device 12 SEL-321” in the DXF file, the 
information parsed by the assigned driver is offset at the upper left corner of the letter “D” in the word 
“Device”. 
 
DXF drawings can be created using an off the shelf program such as AutoCAD, Turbo CAD, Technical 
Visio, Drafix, or MEDUSA. The animated CAD-DXF reader also supports layered objects and multiple 

paging views. To activate the animated CAD-DXF display, click the DXF menu button  or press F8. 
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Figure 2.49  Animated CAD-DXF Display 
 

The status bar at the bottom of the DXF screen displays the X and Y coordinates of the mouse position, 
the maximum X and Y coordinates the active tab number and the total number of tabs in the window.  

To zoom in on the drawing press the “+” key, to zoom out press the “-“ key or use the ZoomIn  and 

ZoomOut  menu buttons.  Click the right mouse to resize the drawing to window size or to the 
windows original coordinates when the drawing was first opened. 
 

 
Figure 2.50  DXF Dawing Properties 
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EXPORTING DEVICES TO THE DISPATCH TABLE 
The Dispatch Table is created from the devices configured in the device manager, also from the event 
files stored in the save folder and from the message files saved to the message folder. The Dispatch 
table and the Device Manager communicate using message files saved in the message folder.  
 
The message folder is defined in the device manager’s “Save & Archive” dialog. The “Message Path” 
field in the Save & Archive dialog must point to the same folder as the Dispatch Table’s “Message 
Folder” in the Dispatch Table Properties dialog. This is also true for the “Save Path” in the Save & 
Archive dialog and the “Event Folder” in the Dispatch Table Properties dialog. 
 
To make the device manager information available to the dispatch table export all devices to a text file 
named “Master Station.txt” and save it in the message folder. Before exporting make sure the device 
manager table is sorted by device numbers in ascending order . To export, use the 
“Export” menu option under the “Device” menu. Refer to Figure 2.51. 
 

 
Figure 2.51  Export for Dispatch Table 

 
Set the “Path” field to the message folder defined in the “Save & Archive” dialog. Enter Master Station 
in the “Filename” field. The extension is automatically assigned to “.txt”. Click the “All Devices” radio 
button then click OK. 
 
The dispatch table displays columns for the District and Substation. To have both columns populated in 
the dispatch table, enter the District-Substation in each device’s group name field. 
 
Devices that have a driver assigned and have the device type between open brackets () defined in the 
title are imported into the dispatch table. 

PREPARING THE DEVICE MANAGER FOR DISPATCH REQUESTS 
The device manager must be in poll mood to respond to the poll requests issued from the dispatch 
table. To put the device manager in poll mode first make sure there are no marked devices in the 

device manager table. Next, click on the MID interface button  in the button menu or select the “Run 
MID Interface…” menu option under the “Options” menu. The MID window will be displayed and the 
start polling device along with the initialize modem devices will be executed. Leave the device manager 
in this state. The MID window will respond to the poll requests sent from the dispatch table.  
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C H A P T E R  3  

Dispatch Table Quick Start 
 
The Dispatch Table is used to request event files and meter information upon demand from one or more 
devices.  
 
The dispatch table communicates to the Wavewin device manager through message files saved in the 
message folder. The message folder is defined in both the dispatch table (Dispatch Properties dialog) and 
the device manager (Save & Archive dialog). These fields must point to the same folder. The device 
manager polls the device(s) specified by the message files and responses with either an “Unable to 
Connect” or “Poll Complete” status. Refer to Figure 3.1 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 3.1  Dispatch Table and Device Manager 

Dispatch Example 

The Dispatch Table columns are created from the fields exported from the device manager, the fields in 
the event filenames and from the message files stored in the message folder. Refer to Figure 3.2.  
 
The dispatch table will not open if the “Master Station.txt” does not exist in the message folder. Refer to 
“Exporting devices to the Dispatch Table” for more information on how to export the device manager 
fields. 
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Figure 3.2  Dispatch Table 
 
The columns in the table are described in the following table. Not all columns are applicable for all 
devices.  
 

Columns Description Source 
Device Number The device number assigned to the device in the 

device manager table. 
Device Manager 

District The district name listed in the device manager’s 
group name field. The district is separated from 
the station name with a dash (-). Example: 
RIVER-SOUTH ARKEY   

Device Manager 

Station The station name listed in the device manager’s 
group name field. The district is separated from 
the station name with a dash (-). Example: 
RIVER-SOUTH ARKEY   

Device Manager 

Dev-Name The device name assigned in the device manager 
title field. 

Device Manager 

Line Len. The length of the line associated with the device.  
The line length is added to the filename’s eighth 
field (if available in the file) when the file is saved 
in the device manager. Refer to the Long File 
Naming Format section for more information on 
the structure of the file names.   

Filename Fields 

Location The fault location of the event contained in the 
file. The fault location is added to the filename’s 
ninth field (if available in the file) when the file is 
saved in the device manager. Refer to the Long 
File Naming Format section for more information 
on the structure of the filenames.   

Filename Fields 

Type The type of fault for the event contained in the file. 
The fault type is added to the filename’s tenth 
field (if available in the file) when the file is saved 
in the device manager. Refer to the Long File 
Naming Format section for more information on 
the structure of the filenames.   

Filename Fields 

Date of Fault The date of the fault listed in the file. The date of 
the fault is added to the filename’s first field when 

Filename Fields 
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Columns Description Source 
the file is saved in the device manager. Refer to 
the Long File Naming Format section for more 
information on the structure of the filenames.   

Time of Fault The time of the fault listed in the file. The time of 
the fault is added to the filename’s second field 
when the file is saved in the device manager. 
Refer to the Long File Naming Format section for 
more information on the structure of the 
filenames.   

Filename Fields 

DB Recs The total number of events files for the device in 
the event folder. 

Event Folder 

Status The status of polling for the device. Refer to the 
Dispatch Polling section for more information on 
how devices are polled. 

Message Folder 

Poll Requested At The date and time the last poll was requested for 
the device. 

Message Folder 

Poll Completed At The date and time the last poll was completed for 
the device. 

Message Folder 

Poll Devices The device number sequence to poll to download 
the latest events and meter information from the 
device.  

Device Manager 

Event Files The path and filename of the latest event 
downloaded. 

Event Folder 

Open the Dispatch Table 

The dispatch table can be opened 3 ways, from the file manager, from the device manager and through a 
command line parameter. To open the Dispatch Table from the file manager, select the “Dispatcher 
Table…” menu option under the “Options” menu. To open the Dispatch Table from the device manager, 
select the “Dispatcher Table…” menu option under the “Options” menu. The command line option is 
described in the next section.  
 
The first time the dispatch table is opened the “Dispatch Properties” dialog is displayed. The “Message 
Folder” and the “Event Folder” must be specified prior to opening the dispatch table. These folders must 
be the same folders defined in the “Save & Archive” dialog in the device manager. Enter the folder where 
the polling messages are saved and enter the folder where the event files are saved. 
 
The dispatch table also has an automatic refresh option that will automatically refresh the event and 
status information. To turn the automatic refresh option on, click on the “Turn ON Automatic Refresh” 
checkbox.  Checked = ON. Also, enter the automatic refresh period. The period is specified in seconds. 
The default is 30 seconds. 
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Figure 3.3  Dispatch Properties Dialog 

COMMAND LINE PARAMETER 
The Dispatch Table can be automatically opened when Wavewin runs using the command line 
parameters. To add the “dispatcher” command line parameter opposite click on the Wavewin icon or 
shortcut. Add “dispatcher” after the Wavewin folder and filename in the target field.  Refer to Figure 3.4. 
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Figure 3.4  Dispatch Table – Command Line Parameter 

Dispatch Polling 

Polling of the devices is initiated from the Dispatch table. To request a poll first mark all the devices to 

poll. Marked devices are displayed in red. Next, click on the Poll Request button  in the button menu 
or select the “Request Poll” menu option under the “Options” menu. A message dialog is displayed listing 
the current status of each device requested. Refer to Figure 3.5. 
 



Chapter 3 –Dispatch Table Quick Start 
 

92 

 
Figure 3.5  Poll Status Message 
 

The devices that can be polled are listed under the “initiated” list and the devices that are already 
scheduled to be polled are listed under the “already in progress” list. The “Status”, “Poll Initiated At” and 
“Poll Complete At” columns display the status of the poll. The “Status” column has the following updates: 
 

• Poll Requested: When a poll is requested the dispatch table saves a POL message in the 
message folder for each device marked. The Status column is updated with “Poll Requested” and 
the Poll Requested At column is updated with the date and time the poll was requested. 
 

• Poll in Progress: The device manager monitors the message folder for POL files. Once it sees a 
POL file it starts the polling process and renames the POL file to a CAL file indicating the poll is in 
progress. The dispatch table also monitors the message folder. When it sees a CAL file it updates 
the Status column to “Poll in Progress”. 
 

• New Files: During the polling process the dispatch table checks if new event files were 
downloaded. At each automatic refresh period the dispatch table will count the number of event 
files in the events folder. It the number of event files counted is greater than the device’s DB Recs 
column then the Status column is updated with “New Files”. 
 

• Poll Complete: When a poll is successfully completed the device manager will rename the CAL 
file to a DON file. The dispatch table will update the Status column with “Poll Complete” and 
update the Poll Completed At column with the date and time the poll completed.  
  

• Unable to Connect: When the device manager encounters a problem connecting to the device 
the CAL file is renamed to an NCR file. The dispatch table will update the Status column with 
“Unable to Connect” and update the Poll Completed At column with the date and time the poll 
completed. 

Table Features 

The following sections describe the main features in the dispatch table.  
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REQUESTING A POLL 
To request a poll first mark the devices to poll. Next, either click the poll request button in the button 

menu  or select the “Request Poll” menu option under the “Option” menu.  
 
The status of the poll is displayed in the “Status”, “Poll Requested At” and “Poll Completed At” columns. 
The “Status” column updates when the poll is started and when it is completed. It also indicates if new 
event files have been downloaded. The “Poll Requested At” displays the date and time the last poll was 
requested. The “Poll Completed At” is updated once the poll has been completed. The time difference 
between the Poll Requested At and the Poll Completed At shows how long it took to complete the poll. 

DISPLAYING EVENT FILES 
All the events downloaded from the devices are saved to the events folder. To list the events for a 
specific device double click on the device in the dispatch table. All event, history and summary files for 
the selected device are marked and group at the top of the file manager table. Refer to Figure 3.6. 
 

 
Figure 3.6  Event List 
 
To view only the event files first select the device then click on the “View Events” button  in the button 
menu or select the “View Events…” menu option under the “Options” menu. To view only the history 
files click on the “View History” button  or select the “View History…” menu option under the 
“Options” menu. 
 
To return to the dispatch table press the ESC key in the file manager or click the “Back” button  
in the system toolbar. 

VIEWING METER INFORMATION 
Each time a device is polled the meter information is also downloaded (VA, VB, VC, & IA, IB IC). To 

view the meter values select the desired device then click on the “Meter Information” button  in the 
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button menu or select the “View Meter Values…” menu option under the “Options” menu. The meter 
information is displayed is an ASCII text editor. Refer to Figure 3.7. To return to the dispatch table press 
the ESC key in the ASCII editor or click the “Back” button  in the system toolbar. 
 

 
Figure 3.7  Meter Information 

REFRESH THE TABLE 
The Dispatch Table columns can be manually or automatically refreshed. To have the table 
automatically refreshed open the “Dispatch Properties” dialog from the “Options” menu. Refer to Figure 
3.8. 
 

 
Figure 3.8  Automatic Refresh 
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Click on the “Turn ON Automatic Refresh” checkbox. If the box is checked the automatic refresh is ON. 
Also, enter the refresh period. The period is measured in seconds. The default is 30 seconds. The 
automatic refresh will update the event and status columns only. 
 
To manually refresh the table click on the Refresh button  in the button menu. All of the columns in 
the table are updated. 

CUSTOMIZING THE DISPATCH TABLE 
The columns displayed in the table can be repositioned through the “Table Properties” menu option 
under the “Options” menu. Refer to Figure 3.9. Use the Move Up and Move Down buttons to change 
the position of a column. The table columns can also be resized. Position the mouse over the column 
separator in the table and drag the mouse to the desired location or double click on a column separator 
to resize the column to the largest display.  
 
The size of the font displayed in the table can also be changed. Use the “Table Font Size” drop down 
list to select the desired font. 
 

 
Figure 3.9  Device Display Dialog 

QUERYING DEVICES 
The query fields are used to search for specific information in the dispatch table. Query fields are 
located below the table. Use the tab key to move the cursor from the device table to the query fields 
and the up arrow to return to the table. Use the Ctrl-Left/Right arrow keys to move between the query 
fields. Each field contains a criteria and an operator. Refer to Figure 3.10.  
 
The criterion is directly entered from the keyboard, and may include the “*” and “?” wild cards. 
Operators are located above the criteria fields and can be changed by clicking the mouse button on the 
operator symbol or by pressing the F9 key. The selectable options include equal to (=), less than (<), 
and greater than (<). 
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Figure 3.10  Query Fields 
 
When a query is launched, the engine numerically compares the specified criteria with the information 
in the table. If numerical comparison is not possible then it symbolically compares. When multiple fields 
are defined, the engine searches for a match on the first field “AND” on the second field “AND” on the 
third field and so on. 
 
Three query options are available: Query All, Query Marked, or Query Unmarked. Devices that meet 
the specified query requirements are marked, grouped, and displayed at the top of the table. Use the 
tab and Ctrl-Left/Right arrow keys to navigate through the query fields and the <enter> key to execute 
the query. 

SORTING DEVICES 
The column headers displayed at the top of the table are used to sort the devices in ascending or 
descending order. Use the Sort menu options to sort all or marked devices with respect to the selected 
sort field. To set the sort field, place the cursor in the desired column and select “Set Sort Field” from 
the “Sort” menu. Clicking on the column header also sets the active sort field. The active sort field is 
displayed in the status bar at the bottom of the window. The active sort column header displays the sort 
order . 

MARKING/UNMARKING DEVICES 
Devices are marked and unmarked through the “Mark” menu option, the spacebar, or the mouse 
button. Use the shift+mouse click button to mark a group of devices or the ctrl+mouse click button to 
randomly mark devices. Marked devices are displayed in red and can be grouped (Alt+M,G), sorted 
(Alt+S), printed (Alt+P,P) or polled (Alt+O,R). 

DELETNG DEVICES 
Devices must be marked in order to delete them from the table. To delete a device, mark the device 
and press the delete key or select “Delete” from the “File” menu. The software prompts for confirmation, 
click Yes to continue or No to Cancel.  
 
Devices that are deleted from the Dispatch table will be restored the next time the Dispatch Table is 
opened or a manual refresh is selected. 

SAVING THE DISPATCH TABLE 
The device information listed in the Dispatch table can be saved to a .csv file. When the dispatch table 
is opened all the device information displayed in the columns is saved to the Dispatchers Table.csv file 
located in the Wavewin folder. To save the current state of the dispatch table to this file select the 
“Save” menu option under the “File” menu. 
 
To save the current state of the Dispatch table to a new file select the “Save As…” menu option under 
the “File” menu. The window’s “Save As” dialog is displayed. Select the destination folder and enter the 
filename using the .csv file extension. The dispatch files can be used for generating report files. 
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C H A P T E R  4  

File Manager Quick Start 
 
This chapter describes the main features of the File Manager. 

File Manager Features 

The File Manager is used to manage files on disk, search the contents of a drive or directory, and edit, 
plot, or draw the contents of a file.  This feature is similar to Windows Explorer with application specific 
functions tailored for the Power Utility Industry. The functions include automatic event file association, 
specialized copy/move engines, intelligent queries, specialized report files, COMTRADE conversion and 
compression routines, merge and append waveform and load files, event summaries, and calibration 
reports. 
 

 
Figure 4.1  File Manager 
 

When the software is activated, the File Manager displays the subdirectories and files of the last active 
drive and directory.  This window consists of a folder tree, file table and a query bar.  The query bar is 
located below the table.  Refer to Figure 4.1.  The main features are described in the following sections. 
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LONG FILE NAMING FORMAT 
The File Manager supports the IEEE long file naming format. The IEEE long file naming format is a 
PSRC format used to name time sequenced data files. The file table columns are used to display the 
contents of the long file name. The file name contains the first ten fields stored in a comma-delimited 
fashion. The remaining fields are optional. The file table lists four optional columns at the end of the 
table to support user defined fields. The ComNames properties dialog allows for user input for the first 
two optional fields. 
 
Example:  000112,123433234,-5S,South Arkey,DLP1,Sun Power,T,123.22,+34.6,AG T.OCS 
 
Field Definitions: 
 
Field Example Displayed Definition 
Date 000112 01/12/2000 The Date field defines the start date of the file. The 

date fields are defined as: the first two characters 
are the year, the next two are the month and the 
last two are the day. (required)  

Time 123433234 12:34:33.234 The time field defines the start time of the file. The 
Time fields are defined as: the first two characters 
are the hour, the next two are the minutes, the next 
two are the seconds and the last two or three are 
the milliseconds. (required)  

Tcode -5S -5S The TCode field is the time offset from GMT time.  
If the start time is expressed in UT, this field is 
coded 0z,  
Note: GMT is the international abbreviation 
Greenwich Mean Time. (required)  

Substation South Arkey South Arkey The substation name or code where the originating 
device is located. (required)  

Device DLP1 DLP1 The device name or code that generated the file. 
(required)  

Company Sun Power Sun Power The company of the specifed substation. (required)  
File Tag T T The fault type or contents type of the file. (optional)  
Line 
Length 

123.22 123.22 The line length extracted from the event file. This 
field applies to certain relays. (optional)  

Fault 
Location 

+34.60 +34.60 The fault location extracted from the event file. This 
field applies to certain relays. (optional)  

Fault Type AG T AG T The fault type extracted from the event file. This 
field applies to certain relays. (optional)  

COMNAME(S) RENAME 
To rename time sequenced data files using the IEEE long file naming format select the “ComName(s) 
Rename” menu option under the “File” menu. ComName(s) Rename will rename all the marked 
waveform files to the IEEE PSRC long file naming format. A message box will be prompted before 
renaming the file to insure the execution of the rename feature. This feature will permanently rename 
the files.  It is advisable to back up the files before renaming. Some proprietary applications may not be 
able to read the files once they are renamed. Refer to Figures 4.2 and 4.3.  For a full description of the 
format refer to the Long file Naming Format above. 
 
For specific display driver’s information from the file is placed in the long file names. 
 

• SEL Files: The Type field has the Event Type and Fault Location (example type field: ",CG T -
86.0,"). 
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• DLP Files: The Type field has the Fault Type, Distance and Trip Type in the type field (example 
type field: ",AG 001.8 PLT,"). 

• Transcan Files: The 1st User Field has the 4 character station ID (example user field: ",BEDG,"). 
• Rochester Files: The 1st User Field has the 5 character header name (example user field: 

",20626,"). 
• Hathaway Files: The #DAU ID data is added next to the device name (example device field: 

",DAU 8#8,") 
     
All files associated with the marked files will also be renamed.   

• Comtrade files: the ".CFG", ".INF", ".HDR", ".DAT" and "*.D##" files will be renamed. 
• Faxtrax files: the ".CTL", ".RCD", ".RCL", ".RCU" and ".RCS" files will be renamed. 
• Rochester files: the ".PRE" file and all files with the same name and a ".###" extension will be 

renamed. 
 

 
Figure 4.2  ComNames Rename: Select and Mark all the Waveform Files to Rename 
 

 
Figure 4.3  ComNames Rename: Result 

COMNAME PROPERTIES 
The fields defined in the IEEE long file naming format are not always available from the time sequenced 
files. The “ComName Properties” dialog allows for setting the most common fields not available in the 
time sequenced files. User fields allow for setting specific information into the file name. Refer to Figure 
4.4. 
 

• Company Name 
• Time Code 
• User Field 1 
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• User Field 2 
 
The fields entered are used for all files renamed. 
 

 
Figure 4.4  ComName Properties Dialog 

COMMAND LINE PARAMETERS 
Command line parameters are supported in the Wavewin software. The listed command line parameters 
are specific for the file manager and data plotting. Below is a list of all supported command line 
parameters and their descriptions: 

 
Command Line Description 

Path and Filename If a path and filename is passed as a command line parameter the 
path and filename must be surrounded by quotes, such as 
“c:\faultlibrary\event1.dat”. Wavewin will automatically open and 
display the file. 

/View The “/View” command line parameter is used along with a path and 
filename command line. It automatically opens and displays the file 
when Wavewin is executed. 

/Print The “/Print” command line parameter is used along with a path and 
filename command line. It automatically opens, displays and prints 
the file when Wavewin is executed. 

/Batch The “Batch” command line parameter is used along with a path and 
batch filename command line. It automatically opens the defined 
batch file and executes each command line parameter defined in the 
file. This feature is used mainly to print a number of files through one 
command line parameter. 

/Merge The /Merge command line parameter is used along with a path and 
filename command line. It will merge the file with all files that have a 
/merge command line parameter associated with them. The /merge 
command line parameter is defined in a Merged File.lst ASCII file. 
The Merged File.lst is passed to Wavewin through the command line 
parameters. All files listed in the Merged File.lst are automatically 
merged by time. If the files have different sampling frequencies the 
highest frequency is used. The merged file is saved as an ASCII 
1999 Comtrade file and placed in the same directory where the 
Merge File.lst is located. The Comtrade files are named Merged 
File.cfg and Merged File.dat. If an error occurs a Merged File.log file 
is created listing all errors encountered.  
Example contents of a Merged File.lst: 
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 C:\faultlibrary\event10.dat /merge /exit 
 C:\faultlibrary\event12.dat /merge /exit 
 C:\faultlibrary\event14.dat /merge /exit  

/X The “/X” command line parameter tells where to display Wavewin’s 
left corner when executed.  

/Y The “/Y” command line parameter tells where to display Wavewin’s 
upper corner when executed. 

/W The “/W” command line parameter tells the width of the Wavewin 
application when executed. 

/H The “/H” command line parameter tells the height of the Wavewin 
application when executed. 

/Exit The “/Exit” command line will automatically exit Wavewin after all 
other command line parameters are fully complete. 

Dispatcher The dispatcher command line will automatically open the Dispatch 
table at runtime. 

NAVIGATING 
 
Files: 
To browse the files in the active directory use the up, down, right, left, page up, page down, home, 
end, ctrl+home, and ctrl+end keys, or use the scroll bars.   
 
Drives/Directories: 
To view the contents of a folder, navigate through the folder tree or place the cursor on the folder 
name in the file table and press <enter> or double click on the desired folder.  Refer to Figure 4.5. 
The “.” and “..” displayed at the top of the file table provide shortcuts to the previous folder and the 
root directory. To return to the previous folder, place the cursor on the “..” shortcut and press <enter> 
or click the Up  menu button or press the backspace key. To return to the root folder, place the 
cursor on the “.” shortcut and press <enter>. 
 
To change the active drive letter, click the ChDir  menu button or press F7.  Enter the drive 
letter/path and click OK.  To return to the last active folder, enter only the drive letter. To display the 
contents of the root folder, enter the drive letter, a colon, and a backslash, for example type “C:\”.  
An error message is displayed if the software cannot find or open the specified folder. 
 
To navigate through the last active folders click the Back  menu button or click the right mouse 
button to display a list of the connected drives and the last 12 navigated folders.  Refer to Figure 4.6. 
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Figure 4.5  Folder Tree     Figure 4.6  Drive/Directory Navigation Menu 

UPDATING THE ACTIVE DIRECTORY 
Click the Refresh  menu button to update the contents of the folder tree and the file table or press 
F12.  To refresh only the folder tree right click on the folder tree and select the Refresh option. Refer to 

Figure 4.7.  To refresh only the file table right click on the file table and select the Refresh  
menu option.  
 

 
Figure 4.7  Folder Tree Popup Menu 
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MARKING FILES 
Files are marked and unmarked through the mark menu option, the space bar, or the mouse button.  
Use the shift+left mouse button to mark a group of files or the ctrl+left mouse button to randomly mark 
files. Marked files are displayed in red and can be copied (F8), moved (F9), deleted (Delete), grouped, 
sorted or plotted. 

SORTING FILES 
The column headers displayed at the top of the table are used to sort all the files in the table. Click the 

header buttons to toggle between ascending and descending order  or use the Sort menu 
option to sort all or marked files with respect to the selected sort field.  To change the sort field, place 
the cursor in the desired column and select “Set Sort Field” from the Sort menu.  The active sort field is 

displayed in the status bar at the bottom of the window .  

COPYING OR MOVING FILES 
 Files must be marked in order to copy or move them from the active folder.  To copy/move files using 

the Window’s Select Directory dialog click the Copy  / Move  menu buttons or press F8 for 
copy and F9 for move.  Select the folder from the Directories tree or enter a new directory in the 
Directory Name field then press <enter> or click the OK button. The system prompts the user prior to 
automatic creation of the directory. Refer to Figure 4.8. A message is displayed if an error occurs while 
copying or moving the files. The Cancel button or the <esc> key terminates the command. 
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Figure 4.8  Copy Dialog 

 
To copy or move files to the clipboard select the Copy/Cut menu options under the Edit menu or right 

click in the file table and select the Copy  or Cut  option from the popup menu.  
Navigate to the destination folder and select the Paste option under the edit menu or the Paste 

 option from the file table’s popup menu.  
 
Once the copy/move or paste command is executed and a file is successfully transferred to the 
destination directory, the system's task bar in the upper right hand corner of the screen is updated. All 
files that were unsuccessfully copied/moved using the Copy/Move menu buttons are marked and 
grouped at the top of the table. 
 
The specialized copy/move/paste engine copies the COMTRADE and DFR header and configuration 
information along with the selected DFR data file. For example, when a DFR data file is copied or 
moved the corresponding DFR header information (CFG, HDR, INF, DAU-DEF, SCF File, CTL File and 
*.PRE files…) are automatically copied from the source folder to the destination folder.   
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EMAIL FILES 
Files must be marked first (displayed in red) to email. Mark all of the files to email then click the Email 

menu button  or right click in the file table to display the popup menu and select the Email  
option. The users default email program is displayed with all marked files in the attachment section. 
Also, any support files needed to display the selected files will be automatically attached. Support files 
include Comtrade .CFG, .HDR and .INF files, Hathaway DAU files, Transcan .SCF and .TCF Files, 
Faxtrax or Director .CTL files and Rochester .PRE, Machine.DAT and Data files. Refer to Figure 4.9. 
 

 
Figure 4.9  Email Dialog 

ZIP FILES 
Files must be marked first (displayed in red) to zip them. Mark all of the files to zip than click the Zip 
Marked Files menu option under the File menu or right click in the file table to display the popup menu 

and select the Zip  option. The zip dialog is displayed. Enter the filename and folder. Click the 
Folder  button to browse and select a destination folder. If no destination folder is defined, the zip 
file is saved to the file table’s active folder. Also, any support files needed to display the selected files 
will be automatically included in the zip file. Support files include Comtrade .CFG, .HDR and .INF files. 
The zip files created are compatible with the WinZip and PKZip applications. Refer to Figure 4.10. 
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Figure 4.10  Zip Dialog 

CUSTOMIZING THE TABLE DISPLAY 
The columns displayed in the table can be repositioned through the “Display” feature in the “Options” 
menu.  Refer to Figure 4.11. Use the Move Up and Move Down buttons to change the position of a 
column. The table columns can also be resized. Position the mouse over the column separator and drag 
the mouse to the desired location or double click on the table separator to resize the column to the 
largest display. 
 
The size of the font displayed in the table can also be changed. Use the “Table Font Size” drop down 
list to select the desired font. 
 

 
Figure 4.11  Customize Table Columns 

PRINTING THE FILE TABLE 
The print feature provides two options: print all or marked files in the active directory. To print all the files 
press Alt+F,P,A or Alt+F,P,M to print the marked files. An error message is displayed if the software 
cannot access the printer port. 
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COMPRESSING COMTRADE ASCII FILES 
The File Manager contains a built in compression routine that converts COMTRADE ASCII files to 
COMTRADE Binary files. To compress COMTRADE ASCII files, mark the files and select “Compress 
COMTRADE Files” from the Options menu. The software prompts for confirmation, click Yes to 
continue, or No to cancel. 

SAVING AS COMTRADE 
Oscillography formats supported by the software can be converted to the COMTRADE ASCII or Binary 
format. Two Comtrade versions are supported: the older 1991 format and the newer 1999 format. The 
Comtrade format can be selected from the Data Plotting Window’s Properties dialog.  The default format 
is the newer 1999 format. Refer to Figure 4.12. To create a COMTRADE file place the cursor on the 
event file or mark the desired files and select “Save As COMTRADE” (ASCII or Binary) from the 
Options menu. Enter the destination path and filename (do not enter a filename extension) and click 
OK. The “.DAT” and “.CFG” files are automatically created. If a path is not defined, the COMTRADE 
files are saved in the active directory. 
 
If the sample values in the selected file(s) are RMS calibrated and the desired Comtrade file must have 
instantaneous values set the “Comtrade Settings” fields to automatically convert the RMS data to 
instantaneous values. To set the “Comtrade Settings” fields open the “Window Properties” dialog in the 
analysis display. Select the “Comtrade” tab then select “Yes” for the “Convert RMS Calibrated Data to 
Peak Data”. 
 

 
Figure 4.12  Comtrade Version 



Chapter 4 – File Manager Quick Start 
 

108 

 
To automatically convert the selected file(s) to Comtrade using the IEEE long file naming format check 
the “Use the ComNames Naming Convention to Name the Comtrade File(s)” field in the “Save As 
Comtrade” Dialog and leave the File Name field empty. Refer to Figure 4.13. All files marked in the table 
will be converted to the selected Comtrade format and will be named using the IEEE long file naming 
convention. 
 

 
Figure 4.13  Save As Comtrade 

RUNNING APPLICATIONS 
Files that contain the extension EXE, BAT, and COM can be activated from the file table. To run an 
application from the active folder place the cursor on the filename and press <enter> or double click the 
mouse button. To run an application from a non-active folder select “Run” from the File menu, enter the 
path and the filename in the “Open” field, and click OK.  Refer to Figure 4.14. 
 

 
Figure 4.14  Run Dialog 

DISPLAYING OSCILLOGRAPHY RECORDS 
A library of device drivers is used to display various types of oscillography formats (Universal Viewer). 
The formats currently supported by the system are:  
 
COMTRADE ASCII and Binary 
Hathaway DFR I, II, IIB, and 2000 
Emax Faxtrax & Director DFR 
Mehta Transcan DFR 
Rochester TR16**  DFR 
SEL Relays (all series including the compressed format) 
ABB Relays (REL 301/302, MDAR 300, GPU, TPU & DPU 2000R and below) 
ABB Load Profile (Wye-Connected VTs and Delta-Connected VTs) 
GE Relays (DLP1 & DLP3)  
Dranetz SER 
Satec PM295 
RFL 9300 
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SDC Log Files 
Fluke Scope Meter 
SEL Load Profile Data 
Ametek TR-100+, DL-8000, TR-2000 & P&QR128 
NxtPhase Tesla 
NxtPhase BPRO, TPRO, LPRO & FPRO 
Emax Long Term Records 
GE-SR745 & GE-SR489 
Hathaway Replay Plus (DFR, TSS & CSS files)  
TIS 
S&C IntelliRupter Waveform  
S&C PXI  
S&C Extended Waveform Capture 
Audio Wave File 
S&C Meter 
S&C Daily High Low File 
 
To plot the contents of a file, place the cursor on the filename and select the appropriate driver from the 
“Driver” menu. A maximum of ten display windows can be opened at one time. Refer to the “Analysis” 
section for more information. 

ASSOCIATING FILE TYPES 
The File Manager automatically associates file types according to the file naming structure. The 
associated driver is displayed in the driver column. When the <enter> key is pressed or the mouse 
button is double clicked the software inspects the filename at the cursor and executes the assigned 
driver. Files are associated according to the following parameters: 
 
Driver Association Parameter 
Directories  Directories are tagged according to the parameters read from the file allocation 

table. 
Applications  Files with the extension “.BAT”, “.COM”, or “.EXE” are tagged as application 

files. 
Hathaway DFR I,II, 
IIB & 2000 

Files that match the Hathaway Base32 file naming scheme or are long files 
with the .DFR extension are tagged as DFR I,II, IIB, & 2000 files. 

EMAX Faxtrax II / 
Director  

Filenames with the extensions “.RCD”, “.RCL”, “.RCU”, and there is a 
cooresponding “.CTL” file, are tagged as Faxtrax II / Director files. The Emax 
Faxtrax II / Director (12-bit/16bit) format is supported. 

Mehta Transcan  Files that have an extension starting with “X” and a corresponding “.SCF” file                    
exists are tagged as Mehta Transcan files. 

Rochester TR16**  Files that have the same name and an extension with a number and there is a 
corresponding .PRE file in the same directory are tagged as Rochester files. 

NxtPhase Tesla Files with the extension “.TLR” are tagged as NxtPhase Tesla files. 
COMTRADE  Files with the extension “.DAT” that have a cooresponding “.CFG” file are 

tagged as COMTRADE files. 
SEL   Files with the extensions “.SEL”, “.CEV” or “.EVE” are tagged as SEL files. 

 
SEL LPD Files with the extension “.BSV” are marked as SEL Load Profile Data files 
DLP  Files with the extension “.OSC” are tagged as DLP relays. GE DLP1 and DLP3 

formats are supported. 
REL300/301/302 Files with the extension “.REL” are tagged as ABB-MDAR files.   

 
TPU/DPU/GPU Files with the extension “.CAP” are tagged as ABB-TPU/DPU/GPU files. 
ABB Load Profile Files with the “.DLA” extension are tagged as ABB Load Profile-Wye files. 
GE SR745/489 File Files with the “.CSV” extension are tagged as GE SR745 Files. 
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Driver Association Parameter 
SDC Log File Files with the “.CSV” extension are tagged as SDC Log Files. 
TIS File Files with the “.TIS” extension are tagged as TIS (Trip Information System)  

Files. 
Ametek Files Files with the “.AMT” extension are tagged as Ametek TR-100+, DL-8000, TR-

2000 & P&QR128 Files. 
NxtPhase Tesla  Files with the “.TLR” extension are tagged as NxtPhase Tesla Files. 
NxtPhase Relays 
(BPRO, TPRO, 
LPRO & FPRO) 

Files with the “.BPR, .TPR, .LPR, FPR” extensions are tagged as NxtPhase 
Relay Files. 

Emax Long Term Files with the “.DAT” extension with an associated “.SET” file are tagged as 
Emax Long Term Files. 

Hathaway Replay 
Plus 

Files with the “.DAT” extension with no “.CFG” associated with it are tagged as 
Hathaway Replay Plus Files. 

S&C IntelliRupter Files with the extension “.WFC” are tagged as S&C IntelliRupter Waveform 
Files. 

S&C PXI Files with the extension “.TSV” are tagged as S&C PXI Waveform Files. 
S&C Extended 
Waveform Capture 

Files with the extension “.EWC” are tagged as S&C IntelliRupter Extended 
Waveform Files. 

Audio Wave Files with the extension “.WAV” are tagged as Microsoft’s Wave Files. 
S&C Meter Files with the extension “.PRO” are tagged as S&C IntelliRupter Meter Files. 
DXF Files with the extension “.DXF” are tagged as Drawing Exchange Format files. 
Application Files  Word Documents (“.Doc” & “.RTF”) , Execl Documents (“.XL”, ”.XLS”, “.XLT”, 

“.XLM”, “.XLA”, “.XLC” & “.XLW”) , Web pages (“.HTM”, “.HTML”, “MSPX” & 
“ASP”) , Access Files ('”MDB” & “.ADP”) , Power Point Presenation files 
(“.PPT” & “.PPS”) , Image files (“.GIF”, “.TIF”, “.JPG”, “.JPE”, “.BMP”, “.PSD” & 
“.PDD”) , Zip files (“.ZIP”) , and PDF files (“.PDF”)  are automatically associated 
with their source application. 

ASCII All other files are tagged as ASCII files. 
 
To change the driver type, place the cursor on the filename and select the driver from the Drivers menu.  
Once a driver is assigned the file contents appear in the corresponding display window.  If the driver 
encounters an error while reading a file an “Invalid Driver Message” is displayed indicating the line 
number in which the error was encountered. Use the ASCII or Hexadecimal editors to locate and correct 
the error. The ASCII and hexadecimal editors display the cursor’s line and character number in the 
lower left corner of the window. The following drivers are supported: 
 
ASCII (Text)  
Hexadecimal (Binary)  
Table (Comma Delimited, Double Quotes/Comma Delimited, Tab Delimited)  
DXF 
COMTRADE (ASCII and Binary)  
DRF I, II, IIB, and 2000 
Transcan 
Faxtrax II & Director (12/16 bit)  
Rochester TR16**  
Tesla  
SEL  
SEL-Meter  
SEL-Load Profile Data (LPD)  
DLPI and DLP3 
REL 300/301/302 
TPU/DPU/GPU 
GE SR745/489 
PM295 
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RFL 9300 
SDC Log files 
ABB Wye/Delta Connected VTs Load Profile  
TIS (Trip Information System)  
Fluke Scope Meter 
SEL Load Profile Data 
Ametek TR-100+, DL-8000, TR-2000 & P&QR128 
NxtPhase Tesla 
NxtPhase BPRO, TPRO, LPRO & FPRO 
Emax Long Term Records 
Hathaway Replay Plus (DFR, TSS & CSS files) 
S&C IntelliRupter Waveform (WFC files) 
S&C PXI  
S&C Extended Wavefore Capture  
Audio Wave  
S&C Meter  
S&C Daily High Low 
 
The “Auto Detect” feature inspects the file at the cursor position and tags it according to the filename.  

DEVICE CONFIGURATION 
The device configuration dialog allows for setting certain parameters for each type of device driver 
supported. To open, select the “Device Configuration” menu option under the “Options” menu. The 
right panel displays all the supported device drivers. Use the mouse or up and down arrow keys to 
select the device. Refer to Figure 4.15. The left panel displays the available settings for each device.  
Below is a list of the available settings: 
 

• Device’s Data Type: Options (Peak, RMS Calibrated or Log File). Select the type of data that is 
contained in the files for the selected device. 

• Device Header Directory: If the device requires support files to display the data then the 
support files can be placed in a centrialize directory so they do not have to be in the directories 
where the data files are located. Enter the directory or use the folder button  to browse for 
an existing directory. This field is for devices that maintain separate files for the Analog & Digital 
info. This field is available for Hathaway, Transcan, Rochester and Comtrade Files. 

• Default Display Frequency:  If the files are prefered to be displayed in a fixed sampling 
frequency when the files are open then set the default frequency in this field.   Example, if the 
files have 4 samples per cycle and it is prefered to view then with 40 samples per cycles enter 
2400. To maintain the original frequency leave this field blank or set to 0.00. 
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Figure 4.15  Device Configuration Dialog 

DAU-DEF EDITOR 
The DAU-DEF editor allows for changing the setting for all the available devices defined in the selected 
Hathaway DAU-DEF file and for adding new dau def configurations. To open, select the “Edit DAU-DEF 
File” menu option under the “Options” menu. Navigate to the desired directory and double click on the 
dau-def file. The right panel displays all the devices defined in the file. Use the mouse or up and down 
arrow keys to select the device. Refer to Figure 4.16. The left panel displays the available settings for 
each device. Below is a list of the available settings: 
 

• Telephone #: Enter the telephone numbe to connect to the device.  
• Analog Channels: The analog channels defined for the selected DAU-DEF record are 

displayed in a list box.  Use the up and down arrow keys or the mouse to select the analog 
channel to modified.  The following fields can be modifed for each analog channel. 

o Name: Modifiy the analog channel name.   
o Full Scale: Modify the analog channel’s full scale value.  
o Prefix: Modify the analog channel’s prefix.  
o Unit: Modify the analog channel’s unit.  

• Event Channels:  The event channels defined for the selected DAU-DEF record are displayed 
in a list box.  Use the up and down arrow keys or the mouse to select the event channel to 
modified.  The following fields can be modifed for each event channel. 

o Event #: Modifiy the event channel’s number.   
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o Name: Modify the event channel’s name.  
o NoNc: Modify the event channel’s normally open or normally closed value, option (1,0).  

• Sensor Channels: The sensor channels defined for the selected DAU-DEF record are 
displayed in a list box.  Use the up and down arrow keys or the mouse to select the sensor 
channel to modified.  The following fields can be modifed for each sensor channel. 

o Sensor #: Modifiy the sensor channel’s number.  
o Name: Modify the sensor channel’s name.  
o NoNc: Modify the sensor channel’s normally open or normally closed value, option 

(1,0). 
 
To add a new DAU-DEF configuration click on anyone of the “NOT USED” records and fill in the analog 
and digital information and click “Save”. The DAU-KEY and DAU-TYPE files are updated automatically. 
 

 
Figure 4.16  Hathaway DAU-DEF Editor 

TESLA FILES 
Tesla Files are displayed in the IEEE Comtrade Binary format. NxtPhase has developed an automatic 
conversion application called "AutoComtrade.exe" to convert the Tesla proprietary files to the Comtrade 
format for display. To view Tesla Files double click or press enter on the orginal Tesla files. To obtain a 
copy of the “AutoComtrade.exe” file please contact NxtPhase. 
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To edit the Tesla AutoComtade configuration open the “Device Configuration” dialog from the “Options” 
menu. Next select the NxtPhase-Tesla device under the device list box. Refer to Figure 4.17. Below is a 
list of the available settings: 
 

• Use Long Name Convention: The converted tesla files can automatically be named using the 
IEEE PSRC Long File Naming Convention. Select “Yes” to have them automatically renamed. If 
“No” is selected then the files are named using the original with the sampling frequency 
truncated to the name. Example: the “2002-07-23-15.49.01.000F1.tlr” Tesla file’s Comtrade files 
will be named: 2002-07-23-15.49.01.000F1-Converted_S96.dat. 

• Delete Original’s: To delete or send the original Tesla file to the recycle bin select “Yes”. All 
files that can be recycled will be sent to the Window’s recycle bin all other are permentally 
deleted from the active drive. To maintain the original files select “No”. 

 

 
Figure 4.17  Tesla Configuration 

LOAD ANALYSIS 
 The Load Analysis routines are a set of rules and methods used to measure 3 types of abnormal circuit 
conditions: imbalance, overload and inefficiency in a load “*.CSV“ file. When the load file is processed 4 
analog channels and 5 digital channels are created in the file: 
 
Analog Channels: 

• Max Rating – The max rating channels displays the defined maximum rating. 
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• I Average – The I Average channel displays the average value from the IA, IB and IC channels. 
• I Max – The I max channel displays the maximum value from the IA, IB and IC channels. 
• Derivative – The derivative of the power factor channel. 

 
Digital Channels:  

• Breaker Status – The breaker status channel is marked as triggered when a sample indicates 
an OPEN in the breaker status field (BRK).  

• Data Integrity – The data integrity channel is marked as triggered when the date and time for a 
sample is invalid and the difference between the current samples and the previous samples are 
greater than 5 times the defined rating. 

• Imbalance – The imbalance channel is marked as triggered when an imbalance condition is 
detected.  Refer to the Imbalance section below for more detail.  

• Overload – The overload channel is marked as triggered when an overload condition is 
detected.  Refer to the Overload section below for more detail. 

• Inefficiency – The inefficiency channel is marked as triggered when an imbalance condition is 
detected.  Refer to the Inefficiency section below for more detail. 

 
Before the load analysis routines can be performed on a file the ratings for the device must be defined.  
To define the ratings select a file in the file manager then select the “Load Rating” menu option from the 
“Reports” submenu option under the “Options” menu. Refer to Figure 4.18. Enter the “Summer Normal 
Rating” and the “Summer Emergency Rating”.  
 

 
Figure 4.18  Load Rating Dialog 

 
An adaptive learning scheme is used to tune the time varying coefficients (W1, W2 & W3) of an 
imbalance, overload and inefficiency summation equation.  The equation is used to classify circuit 
conditions (i.e., assign priority values). 
 
Figures 4.19 and 4.20 reveal the basic schematic of the expert and adaptive learning models used.  
Terms used in Expert System Model are defined as follows: 
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• IA  Phase-A current (Amps RMS) 
• IB  Phase-B current (Amps RMS) 
• IC  Phase-C current (Amps RMS) 
• AVG  Average of Phases A, B, and C 
• SNR  Summer Normal Rating for the circuit (Amps RMS) 
• PF  Power factor 
• X-I  Maximum imbalance value (max % change from average) 
• X-O  Maximum overload value (max % change from rating) 
• X-E  Maximum inefficiency value (max % change from unity) 
• IMB  Discrete imbalance signal (1=On, 0=Off) 
• OVR  Discrete overload signal (1=On, 0=Off) 
• INE  Discrete inefficiency signal (1=On, 0=Off) 
• T-I  Total imbalance duration (Days, Hours) 
• T-O  Total overload duration (Days, Hours) 
• T-E  Total inefficiency duration (Days, Hours) 

 

 
Figure 4.19  Expert System Model 

 
Terms used in Adaptive Learning Model are defined as follows:  
 

• X  Multiplication node 
• W-1  Time varying coefficient for imbalance condition 
• W-2  Time varying coefficient for overload condition 
• W-3  Time varying coefficient for inefficiency condition 
• ∑+  Summation node (good/bad circuit classification branch) 
• ∑-  Subtraction node (error signal generation branch) 
• Desired Input signal used to train the network 
• Err Function Cost function that governs the assignment of coefficient values 
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Figure 4.20  Adaptive Learning Model 

 
The “Load Trigger” Dialog allows for programming the level, weight, and duration triggers for the 
analysis procedures. Refer to Figure 4.21. The triggers are listed by circuit type. 
 

 
Figure 4.21  Load Analysis Triggers Dialog 
 
A description of the analysis procedures follows: 
 
Imbalance:  The system calculates the average value of the 3 phase currents and then measures the 
difference between each phase and the average.  If the maximum percentage change from average is 
greater than the “Over Trigger” value (say 10% of average) then an imbalanced condition is noted and 
the maximum percentage imbalance and total duration are tracked.  If the condition persists for a 
consecutive number of readings that is greater than the “Duration” value (say 6 hours) then an actual 
imbalance alarm is issued. 
 
Overload:  The system measures the maximum value of the 3 phase currents and then compares to 
the summer normal rating that is provided for that circuit.  If the maximum value is greater than the 
“Over Trigger” value (say 90% of rating) then an overload condition is noted and the maximum 
percentage overload and total duration are tracked.  If the condition persists for a consecutive number 
of readings that is greater than the “Duration” value (say 4 hours) then an actual overload alarm is 
issued. 
 
Inefficiency: The system looks at the power factor measurements and directly compares to the “Under 
Trigger” value (say 90% of unity).  If the value is less than “Under Trigger” then an inefficiency condition 
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is noted and the maximum percentage inefficiency and total duration are tracked.  If the condition 
persists for a consecutive number of readings that is greater than the “Duration” value (say 5 hours) 
then an actual inefficiency alarm is issued. 
 
Cumulative Values:  The system calculates a weighted sum of the tracked maximum percentages for 
imbalance, overload and inefficiency and uses that sum as a priority measure to rate the condition of 
each circuit.  The weights are specified in the “Weight” field as “multiplier, extreme duration”.  The actual 
weight is equal to the multiplier value but it doubles when the total duration exceeds the specified 
extreme duration. 
 
Data Filters:  Data measurements that are taken outside the interval “Start Time” to “End Time”, or that 
have values below “Ignore Under”, are not processed and the previous state of the system is retained.  
The system also detects “bad data” (due to spikes, network crashes, incorrect unit designations, modem 
communication failures and so on) and blocks it from propagating through the system. 
 
To perform the analysis on a directory containing *.CSV load files first mark the desired files then click 
on the Load Analysis menu button to display the Load Analysis Triggers dialog or select the desired 
load option from the load analysis drop down menu. Refer to Figure 4.22. 
 

 
Figure 4.22  Load Menu Button 

 
The first three menu options are also available from the Load Analysis Trigger dialog. Refer to Figure 
4.21. Below is a description for each option available. 
 

• Process & Update Database – The process & update database will process all the marked 
*.CSV files in the active directory and update the Max-Imbalance, Max-Overload, Max-
Inefficiency and the Priority columns with the new data.  

• Process & Create Summaries – The process & create summaries will process all the marked 
*.CSV files in the active directory and create device summary ASCII files for each file 
processed.  A folder destination dialog is displayed. Refer to Figure 4.23. Select the destination 
folder and define the names for the files.  The files are named using the IEEE PSRC Long file 
naming convention when the “Use ComName” option is checked.  

• Process & Save As Comtrade – The process & create summaries will process all the marked 
*.CSV files in the active directory and create Comtrade files for each file processed.  A folder 
destination dialog is displayed.  Select the destination folder and define the names for the files.  
The files are named using the IEEE PSRC Long file naming convention when the “Use 
ComName” option is checked.  
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Figure 4.23  Summary Destination Dialog 
 
Summary Files: 
 

• Device Summary – The device summary files list all the general information for the file, the 
maximum and minimum values for imbalance, overload & inefficiency, the maximum and 
minimum values for each analog channel and SOE for the digital channels. Refer to Figure 
4.24. 

• Station Summary – The station summary lists the imbalance, overload, inefficiency and priority 
for each device in the station. Refer to Figure 4.25. 

• System Summary – The system summary lists the imbalance, overload, inefficiency and 
priority for each device defined in the system along with the average for each station. Refer to 
Figure 4.26. 

 

 
Figure 4.24  Load Device Summary 
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Figure 4.25  Load Station Summary 
 

 
Figure 4.26  Load System Summary 

VIEWING/MODIFYING ASCII FILES 
The ASCII Editor allows for viewing and/or modifying the contents of a text file. To open an ASCII file 

place the cursor on the filename and press F2, or click the Edit menu button .  Use the up, down, 
right, left, ctrl+right, ctrl+left, page up, page down, home, end, ctrl+home, and ctrl+end keys, the scroll 
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bars or the search (F4) and search again (F3)  features to navigate through the file contents. The 
line and character number at the cursor position are displayed in the status bar (bottom left corner of the 

window). Refer to Figure 4.27. The Cut (ctrl+x) , Copy (ctrl+c) , and Paste (ctrl+v)  
commands are also provided.  New files can be created or existing files can be opened, saved and 
saved under a new name.  A maximum of ten editing windows can be opened at one time.  
 

 
Figure 4.27  ASCII Editor  

VIEWING/MODIFYING BINARY FILES 
The Hexadecimal Editor allows for viewing and/or modifying the contents of a binary file. To open a 
binary file, place the cursor on the file and press F3. The Hexadecimal window consists of a hex editor 
and an ASCII display. Refer to Figure 4.28. When a hex value is entered, the ASCII equivalent appears 
in the window to the right of the editor. To navigate through the file contents use the up, down, right, left, 
page up, page down, ctrl+home, and ctrl+end keys or the scroll bar. The byte number at the cursor 
position is displayed in the lower left corner of the window. To search the contents of a hex file use the 
search (F4) and search again (F3) functions. To search the ASCII window enter the ASCII information 
into the “Find Text” Field. To search for a hex value, enter “#”, then the hex number into the “Find Text” 
field.  Refer to Figure 4.29.  
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Figure 4.28  Hexadecimal Editor 

 

 
Figure 4.29  Hexadecimal Search 

VIEWING WAVEFORM SUMMARIES 
The File Manager and Analysis Display features generate analog and digital summaries for the 
supported oscillography formats. The summary engine extracts key information from the file and saves it 
to a small summary file. The header, analog, and digital information includes: 
 
Event Information 
Field  Description 
Station Name of the Station associated with the event file. 
Filename Name of the event file. 
File Size File size (displayed in kilobytes). 
Prefault-Time Date and time of the first prefault sample. 
Fault-Time Date and time of the first fault sample. 
Save-Time Date and time the file was saved to disk. 
Process-Time Date and time the file summary was processed. 
Start Date and 
Time 

Date and time of the first sample in the file. 

End Date and Date and time of the last sample in the file. 
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Field  Description 
Time 
File Duration Duration of the file measured in days, hours, seconds, milliseconds and/or 

microseconds, depending on the type of file. 
Sampling 
Frequency 

Sampling frequency and the time between each sample. 

Line Frequency Line Frequency defined in the file. 
 

Fault Information - Fault Information is displayed for files that include fault information in their format.   
Driver Fault Information 
SEL Event, Location, Frequency, Duration, Shot, Fault Currents, Targets and more. 
DLP Trip Date and Time, Trip Type, Fault Type, Distance and Operating Time. 
Transcan Triggered event information: Name, Time and Type. 
 

Maximum/Minimum Analog Summary   
Field  Description 
Max-Inst Instantaneous maximum values. 
Min-Inst Instantaneous minimum values. 
Max-RMS RMS maximum values. 
Min-RMS RMS minimum values. 
OneBit Channel's full-scale value divide by the channel's resolution. 
Inst-Diff The difference between the Max-Inst and Min-Inst values. 
RMS-Diff The difference between the Max-RMS and Min-RMs values. 
pU Channel prefix and unit. 
Description Channel title and number. 
 

Events/Sensors Activity Summary 
Field  Description 
Fst State at which the channel started, A=alarm and N=normal. 
Lst State at which the channel ended, A=alarm and N=normal. 
Fst-Change Date and time the channel first changed state. 
Lst-Change Date and time the channel last changed state. 
Changes Number of times the channel changed state. 
Description Channel title and number. 
 

Events/Sensors Activity Log 
Field  Description 
State State of the channel at the triggered time, A=alarm and N=normal. 
Trigger Time Time the channel-changed state. 
Description Channel title and number. 
 

The xx:xx:xx.xxx displayed in the “Fst-Change” and/or “Lst-Change” fields of the Events/Sensors Activity 
Summary indicates that the digital channel’s state did not change from the initial state (Fst).   

To generate a summary file, place the cursor on the filename and click the Summary  menu button or 
select “Waveform Summary” from the “Options” menu.  Refer to Figure 4.30. 
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Figure 4.30  Waveform Summary 

WAVEFORM FILE(S) OPTIONS 

OPEN SELECTED FILE 
The Open Selected File option opens the waveform file at the cursor position. Refer to the 
Displaying Oscillography Records section for a list of the supported waveform files. 

OPEN  ALL MARKED FILES 
The Open All Marked Files option opens all the marked waveform files, tiles the waveform files 
horizontally and minimize the file manage. To access the file manager click the “Files” menu button 

. 
 
A maximum of ten data windows can be opened at one time. 
 

The plot button icon  will plot all the marked files. If there are no marked files, the selected file 
is plotted. 

APPEND WAVEFORM FILES 
The Append Waveform Files option appends the marked files according to time. There are two 
options available under the Append Menu: 

• Discard Common Times: Any common times found in the marked files will be deleted from 
the older file. Refer to Figure 4.31. 

• Back to Back: The files are appended back to back. No samples are deleted. Refer to Figure 
4.32. 
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Figure 4.31  Append Waveform Files: Discard Common Times 

 

 
Figure 4.32  Append Waveform Files: Back to Back 
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MERGE WAVEFORM FILES 
The Merge Waveform Files option merges the marked waveform files. There are two options 
available under the Merge Menu: 

• By Time: Merge channel samples if they have a common time segment. The reference time 
is derived from the file with the latest start date and time. The file with the least amount of 
samples determines the length of the new merged file. Refer to Figure 4.35. 

• By Sample:  Merge regardless of time stamps. The reference time is derived from the first 
marked file. The file with the least number of samples determines the length of the file. Refer 
to Figure 4.36. 

 
When files with different sampling frequencies are merged a dialog will be displayed. The dialog 
contains a list of all the sampling frequencies in the marked files. Select the frequency for the 
merged file or enter a new frequency. Refer to Figure 4.33. 
 

 
Figure 4.33  Merge Waveform Files: Select Frequency 
 

If the merged files have different data types (RMS Calibrated or Peak Values) then the RMS values 
will be converted to Peak values by multiplying the RMS values by Root 2. 
 
To identify the merged channels the station name for each file is added to the beginning of the 

analog and digital channel names. To turn off this feature open the Properties dialog  in the 
analysis window. Click on the Append/Merge tab and uncheck the “Add the File’s Station Name to 
Beginning of the Analog/Digital Channels” field. Refer to Figure 4.34. 
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Figure 4.34  Append/Merge Properties 
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Figure 4.35  Merge Waveform Files By Time 

 

 
Figure 4.36  Merge Waveform Files By Sample 
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FILE REPORTS  

GENERATING CALIBRATION REPORTS 
The Calibration report list the Maximum and Minimum analog summary information for the marked 
files. 
 
Calibration reports should only be generated on files that contain no fault data such as snap shot 
files. To generate a report, mark the desired files and select “Calibration…” menu option from the 
“Report” submenu option under the “Options” menu. Refer to the “Summary” section for field 
descriptors. The report information is saved in the DVREPORT.DTB file located in the system 
directory. 

GENERATING SEQUENCE OF EVENTS (SOE) REPORTS 

To generate a table of sequence of events from multiple waveform files, mark all of the desired files 
then press F11 or Select the "SOE List" menu option from the "Reports" submenu under the 
"Options" menu. A table listing all of the events triggered in the selected files is displayed. Refer to 
Figure 4.37. The table is sorted according to date and time. The columns listed in the table include: 
 

State:  The state on the event/sensor at the displayed date and time (A=Abnormal, N=Normal). 
Trigger Date:  The date the event/sensor triggered or cleared. 
Trigger Time:  The time the event/sensor triggered or cleared. 
Chan:  The channel number of the event/sensors in the file from which it was read. 
Channel Title:  The channel title of the event/sensors. 
Device:  The device from which the event/sensors originated. 
Substation:  The substation from which the event/sensors originated. 
File:  The filename from which the event/sensors originated. 

 
The Query section at the bottom of the table allows for searching events from specific substations, 
devices, and channels. To plot the file containing the specific events press <enter> or double click 
on the event. 
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Figure 4.37  SOE List 

GENERATING SEQUENCE OF EVENTS (SOE) SUMMARIES 
To generate a summary of the sequence of events for multiple waveform files, mark all the desired 
files then Select the "SOE Summary" menu option from the "Reports" submenu under the "Options" 
menu. A table listing a summary of all the events triggered in the selected files is displayed. Refer to 
Figure 4.38. The table is sorted according to date and time. The columns listed in the table include: 
 

Substation:  The substation that triggered the event/sensor. 
Device:  The device that triggered the event/sensor. 
Fst-State:  State the channel started at, A=alarm and N=normal. 
Lst-State:  State the channel ended at, A=alarm and N=normal. 
Fst-Change Date:  Date the channel first changed state. 
Fst-Change Time:  Time the channel first changed state. 
Lst-Change Date:  Date the channel last changed state. 
Lst-Change Time:  Time the channel last changed state. 
Changes:  Number of times the channel changed state. 
Chan #:  Channel number in the file. 
Channel Title:  The channel title of the event/sensor. 
File:  The filename from which the event/sensors originated. 

 
The Query section at the bottom of the table allows for searching events from specific substations, 
devices, and channels. To plot the file containing the specific events press <enter> or double click 
on the event. 
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Figure 4.38  SOE Summary 

APPENDING LOG FILES 
The Appending Log features combine an unlimited number of CSV log files into one file. The files 
must be marked and of the same type (generated from the same device). The generated combined 
file can be displayed in a table or plotted in the log data viewer. This feature allows for analyzing 
load data over a long period. 

COMBINDING LOG FILES 
The Combine Log feature combines an unlimited number of CSV log files into one file. The files must 
be marked and can be from different file types (generated from different devices). The substation 
and device of each file is added in the file. The saved file is displayed in a table. This feature allows 
for analyzing load data over a long period for different devices. 

VIEWING CAD-DXF FILES 
The CAD-DXF Viewer reads and displays the contents of a Drawing Exchange Format (DXF) file. Refer 
to Figure 4.39. DXF files can be created using an off-the-shelf program such as AutoCAD, Turbo CAD, 
Technical Visio, Drafix, or MEDUSA. To view a DXF file double click the mouse button on the DXF 
filename. The viewer allows for opening and closing of DXF files, changing display resolution, setting 
zoom ratio, and selecting background color. It also provides zooming and printing capabilities. 
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Figure 4.39  DXF Viewer 
 
The status bar at the bottom of the screen displays the X and Y coordinates of the mouse position, the 
maximum X and Y coordinates of the drawing, the active tab number and the total number of tabs in the 

window. Refer to Figure 4.39. To zoom in or out use the Zoom In  and Zoom Out  menu buttons.  
To view the drawing in its original size click the Original Display  menu button, or click the Fit to 
Window  menu button to resize the drawing to fit in the window.  Use the Open File  menu 
button to add DXF files to the window. Click on the Close File  menu button to close an open DXF 
file.   
 

The Zoom Scalar selectable box  is used to increase or decrease the drawing’s 
display resolution. For example, when the Zoom In feature is activated the drawing's X and Y resolution 
values are multiplied by the Zoom IN/OUT Ratio to increase the resolution. When the Zoom Out feature 
is activated the drawing's X and Y resolution values are divided by the Zoom IN/OUT Ratio to decrease 
the resolution. 
 

The Const  menu button allows for changing the file, the drawing’s display resolution, and the 
background color. Refer to Figure 4.40. The dialog fields are described below: 
 
Field Description 
File Name The path and the DXF filename. Default: Empty. Use the Browse button to 

browse for a file.  
Background Color The background color for the displayed DXF file. Default: White. 
Max X Pixels The maximum number of X pixels used to display the DXF file.  Enter an 

integer value.   
Max Y Pixels The maximum number of Y pixels used to display the DXF file.  Enter an 

integer value.   
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Use the tab or shift+tab keys to navigate between fields and the up and down arrow keys to view the 
selectable options. Click Apply to view the changes, OK to accept the changes, or Cancel to terminate 
the changes. 
 

 
Figure 4.40  DXF Drawing Constants 

VIEWING ASCII FILES IN DATABASE FORMAT 
The database viewer provides an effective way to organize, sort, and search comma delimited, double 
quoted comma delimited, or tab delimited text files. Refer to Figure 4.41. The data is presented in 
tabular form, and an unlimited number of rows and columns can be displayed. The viewer allows for 
intelligent queries, column sorting, selecting and grouping data, row deletion, printing, saving and saving 
in a new file. 
 
Use the column headers to sort the data in ascending or descending order and the query fields to 
search the data. Refer to the “Querying Files” section for more information. To browse the data use the 
up, down, right, left, page-up, page-down, home, end, ctrl+home, and ctrl+end keys or use the scroll 
bars. Rows must be marked in order to delete them from the table. 
 
The database viewer is useful for processing COMTRADE data files, employing under triggers and over 
triggers, locating instantaneous maximum and minimum peak values and analyzing load information. 
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Figure 4.41  Database Viewer 

SHOW/HIDE CHANNEL TITLES 
The data plotting window automatically hides channels that contain certain characters in the channel 
title. Below is a list of the characters defined as invalid channels when a file is displayed.  
 

• UNUSE 
• UNDEF 
• NOT D 
• NOT U 
• NOT I 
• NOT A 
• { 
• N/A 
• ANALOG INPUT 
• UNTITLED 
• ANALOG CHANNEL 
• EXTERNAL INPUT 
• EVENT CHANNEL 
• CHANNEL: 
• DIGITAL TRACE # 
• SPARE 

 
If a channel title contains the above characters in the beginning of an analog or digital channel title the 
channel is automatically hidden. These characters can be modified to show a channel when a file is 
displayed. To show a title that contains the above characters select the “Show/Hide Channel Titles…” 
menu option under the “Options” menu. Refer to Figure 4.42. 
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Figure 4.42  Show/Hide Channel Titles Dialog 
 

To show a title, uncheck the checkbox next to the displayed invalid channel title. To remove a title from 
the list select the title in the list box then click the “Remove” button or press the delete key. To add a 
new title, first type the new title in the edit box then click the “Add” button. The new title is added to the 
end of the list with the checkbox automatically checked.  

QUERYING FILES 
The query fields are used to search for specific information in the table. Query fields are located below 
the table. Refer to Figure 4.43. Use the tab key to move the cursor from the table to the query fields and 
up arrow to return to the table. The Ctrl-left/right keys moves between the query fields. Each field 
contains a criteria and an operator. The criteria is directly entered from the keyboard, and may include 
the “*” and “?” wild cards. Operators are located above the criteria fields and can be changed by clicking 
the mouse button on the operator symbol or by pressing the F9 key. The selectable options include 
equal to (=), less than (<), and greater than (<).  
 

 
Figure 4.43  Query Fields 
 
When a query is launched, the engine numerically compares the criteria with the information in the 
table. If numerical comparison is not possible, symbolic comparison is performed. When multiple fields 
are defined, the engine searches for a match on the first field “AND” on the second field “AND” on the 
third field and so on. 
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Three query options are available: Query All Files, Query Marked Files, or Query Unmarked Files. Files 
that meet the specified query requirements are marked, grouped, and displayed at the top of the table. 
Use the tab and shift-tab keys to navigate through the query fields and the <enter> key to process the 
criteria at the cursor position. 

DSITURBANCE REPORT 
The disturbance report feature creates a comma delimited file that contains the following information for 
each file processed (if available in the file): 
 

• Utility Name,  
• Device Name (Fault),  
• File Start Date & Time,  
• Substation Name,  
• Report Date, 
• Faulted Phase,  
• Fault Location,  
• Line Length,  
• Fault Current,  
• Maximum Voltage,  
• Maximum Frequency, 
• Minimum Frequency,  
• Pass/Fail,  
• Passed Filters and the  
• Source file's folder and filename. 

 
The disturbance report dialog allows for setting the report's destination folder and filename. It also 
allows for setting the folder(s) where the event files are located. The filter section is for setting filter 
levels for the Faulted Phase, Fault Location, Current and Voltage thresholds and the deviation for the 
frequency. 
 
To open the disturbance report dialog, open the “Options” menu in the file manager’s table, select the 
“Report” submenu then click on the “Disturbance Report” menu option. Refer to Figure 4.44. 
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Figure 4.44  Disturbance Report Menu 
 
The disturbance report dialog is displayed when the “Disturbance Report” option is selected. Refer to 
Figure 4.45. 
 

 
Figure 4.45  Disturbance Report Dialog 
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The disturbance dialog has 3 sections: Destination Folder & File, Source Folder(s) and Filters. Each 
section is explained below along with the functions for each button. 
 
DESTINATION FOLDER & FILE: 
The Destination Folder & File section is used to set the disturbance report folder & filename. Type the 
drive, folder and filename into the "Destination File:" field or use the Browse button to locate an existing 
file or for creating a new file and/or folder. Refer to Figure 4.46. 
 

 
Figure 4.46  Disturbance Report: Destination Folder & File 
 
To save the disturbance information to a new file, click the "Create New File" radio button. This option 
will clear the file before processing the event files. To append the disturbance information to the end of 
an existing file, click the "Append Existing File" radio button. 
 
FOLDERS: 
The Folders section is used for defining where the event files are located. To process files located in the 
File Manager's active folder check the "Process Files in the Active Folder" check box. If files are marked 
in the active folder, then this feature will process only the marked event files. If there are no marked files 
then all the event files are processed. 
 
If the event files are located in different folders then use the "Add" button to add a folder to the Source 
Folder list. To remove a folder from the list, use the "Delete" button. Refer to Figure 4.47. 
 

 
Figure 4.47  Disturbance Report: Source Folder(s) 
 
FILTERS: 
The Filters section is used to define the faulted phases, the filter levels for the fault location, voltage 
class and fault current levels. It also, defines the deviation of the maximum and minimum frequency 
values from the Line Frequency. Refer to Figure 4.48. 
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Figure 4.48  Disturbance Report: Filters 
 
After the filters are applied to the data file the file will be tagged with a PASS or FAIL. A PASS means 
that the file’s fault type exists in the list AND the fault location is within the entered percentage of the line 
length AND the fault current is above the entered fault current value AND the voltage class is above the 
entered voltage class value OR the maximum or minimum frequency is above the entered deviation 
from the line frequency. The calculations used are listed below: 
 
For files with no Voltage Channels a PASS Equals: 

Faulted Phase is in the List of Filter Phase Settings 
AND 
Maximum Fault Current is > Entered Fault Current Filter 
OR 
|Maximum/Minimum Frequency Value - Line Frequency| is > Entered Filter Deviation Value 

 
For files with Voltage Channels a PASS Equals: 

Faulted Phase is in the List of Filter Phase Settings 
AND 
Fault Location is < Entered % of the Line Length 
AND 
Maximum Voltage Value is > Entered Voltage Class Filter 
AND 
Maximum Fault Current is > Entered Fault Current Filter 
OR 
|Maximum/Minimum Frequency Value - Line Frequency| is > Enter Filter Deviation Value 

 
Each file in the report also lists the filters that triggered. The 5 columns to the right of the PASS/FAIL 
column list the filters that triggered. Each column is labeled according to the filter: 

P = Faulted Phase Filter 
L = Fault Location Filter 
C = Current Filter 
V = Voltage Filter 
F = Frequency Filter 

 
 If a filter triggers then the filter letter is displayed in the columns otherwise it is left blank. Refer to Figure 
4.49. 
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Figure 4.49  Disturbance Report 
 
The “Process” button starts the disturbance report. Once started the Disturbance dialog is closed and 
each file is processed. The progress bar displayed in the button speed bar is updated according to the 
number of files to process and the current file being processed. 
 
When the processing is complete a comma delimited table is displayed. Refer to Figure 4.49. The 
comma delimited table allows for sorting each column by clicking on the column’s header. The query 
section located below the table allows for quickly searching for specific files. Also, the processed files 
can be displayed by double clicking on a row or moving the table cursor to the row and pressing enter. 
The file will be displayed in the analysis window. Refer to Figure 4.50. 
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Figure 4.50  Disturbance Display File 
 
BUTTONS: 
There are 5 buttons displayed at the bottom of the disturbance dialog. Each button is explained below: 
 
1. Process Button: The process button starts the disturbance report. The dialog is closed and each 

file is processed. The progress bar displayed in the button speed bar is updated according to the 
number of files to process and what file is currently being processed.  
 

2. Save Script: All the information displayed in the dialog is saved in a script file located in the folder 
where Wavewin is located. The file is called: Disturbance.ini. A message box is displayed 
confirming that the information has been saved. The dialog information is also saved to the 
Disturbance.ini file when the “Process” button is clicked. 
 

3. Edit Script: The edit script button closes the dialog and displays the Disturbance.ini file in the ASCII 
editor.  
 

4.  Show Help: The show help button displays the help information in a note pad below the buttons. 
The window size is increased to show the note pad. When the help window is displayed the “Show 
Help” button’s text changes to “Hide Help”. To hide the help window click on “Hide Help”. 
 

5. Close: Close the dialog without saving the entered information. 
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C H A P T E R  5  

Analysis Quick Start 
 
This chapter describes the main features of the Analysis Display. 

Analysis Features 

The Analysis Display offers a high-resolution graphical interface for displaying, analyzing, and 
manipulating analog and digital channels of an oscillography record or a periodic load file. Refer to Figure 
5.1. Displayed channels can be marked, merged, appended, moved, zoomed, removed, restored, 
superimposed, scaled, numerically processed, and summarized. A maximum of ten data windows can be 
opened at one time. 
 

 
Figure 5.1  Analysis Display 
 

The Analysis Display contains two sections: the analog view and the digital view. The analog view plots 
the oscillography or load data. Some of the values displayed are the channel’s highest peak, RMS, 
phase, reference, instantaneous, maximum, and minimum values. The cursor bars are used to view the 
data values. The digital view plots the events and sensors and displays the channel’s original state, the 
channel’s final state, time of the first change, time of the last change, and the number of times the 
channel changed state. 
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Up to 256 analog and 1024 digital channels can be displayed.  The main features are described below. 

PHASORS  
The phasor diagram shows a vector for each visible analog channel. The diagram is displayed to the 
right of the analog information window. Refer to Figure 5.1. To increase or decrease the size of the 
phasor window place the cursor over the vertical separator between the analog information window and 
the phasor window and drag the mouse to the left to increase or to the right to decrease. To close the 
phasor window click the close button located in the header. To navigate the phase angles use the left 
arrow, right arrow, home, end, page up and page down keys or the data scroll bar. To 
increase/decrease the length of a channel's vector, mark the channel and use the increase/decrease 
amplitude menu buttons or the Ctrl-Up and Ctrl-Down keys. To increase/decrease only the length of the 
vectors, use the up and down phasor buttons.  
 
To toggle between the phasor display and the circular chart display click the “P” button above the 
phasor display for phasors or the “C” button for a circular chart.  
 
There are two types of phasor displays: non-referenced and referenced. Refer to Figure 5.2. The non-
referenced display shows the phase angle for each sample in the display.  The reference display shows 
the phase angle for each sample with respect to the reference channel. The reference channel is the 
first marked channel in the window. All angles at a sample are subtracted from the reference angle. If 
there are no marked channels the non-referenced display is shown. 

 
Figure 5.2    (a) Non-Referenced Phasors       (b) Referenced Phasors 

HARMONICS 
The harmonics window displays as many harmonics as possible based on the file’s sampling frequency. 
A maximum of 200 harmonics can be displayed in the table. Refer to Figure 5.4. To display the 
harmonics window right click in the phasor diagram or in the analog information section and select the 
Harmonics menu option. The harmonics window displays the first marked analog channel or if no 
channels are marked, the first visible channel. Changing the marked channel in the data plotting window 
will update the harmonics window with the appropriate channel.   
 
The harmonic calculation is performed on one cycle of data, starting at the RMS bar and going forward 
to the data bar. There are three fields displayed at the bottom of the harmonics table and histogram; 
TrueRMS, CalculatedRMS and Total Harmonic Distortion (THD). The TrueRMS field displays the RMS 
value calculated by using the samples in the active cycle displayed in the waveform trace window. The 
CalculatedRMS field displays the square root of the summation of the squares of the DFT Magnitudes 
from harmonics 2 to the maximum harmonic divided by square root of 2. The THD field displays the 
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square root of the summation of the squares of the DFT Magnitudes from harmonics 2 to the maximum 
harmonic and that quantity divided by the DFT Magnitude of the Fundamental.   
 
The harmonics can be viewed in a table format or in a histogram. Click on the harmonics toggle button 

 to change the view. Refer to Figure 5.5. The histogram can show only one column from the table.  
To change the data displayed click the histogram drop down menu and select the column. Refer to 
Figure 5.3. The default view is the % of Fundamental.  
 

. 
Figure 5.3  Histogram Drop Down Menu 

 

The harmonic histogram bars can be resized using the resize up and down arrows  to display 
more or less harmonics in the window. The text displayed above the histogram bars can be shown or 

hidden be clicking on the Show/Hide text bar button . The harmonics window can be resized by 
dragging the edge of the window to show more or less harmonics per window. 
 
Also, a vector for each harmonic is displayed in the phasor diagram. To hide/show the harmonic vectors 
toggle the "Vector Harmonics" menu option under the "View" menu from checked=on to unchecked=off. 
 



Chapter 5 – Analysis Quick Start 

146 

 
Figure 5.4  Harmonics Table View 
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Figure 5.5  Harmonics Histogram View 

PERIODIC LOG FILES 
The periodic log viewer allows for viewing and analyzing large amounts of event data in a single display.  
Refer to Figure 5.6. The data is displayed in envelope form and may contain one day, one week, one 
month or one year of event data. This feature is useful for load flow analysis.   
 
A circular chart of the data displayed in the trace window is plotted to the right of the channel 
information window. The circular chart cursor is positioned on the sample at the waveform data bar.  
The duration of the data displayed also is shown below the circular chart along with the sample number 
at the cursor bar. 
 
The ABB Load Profile and SDC log drivers are specific drivers used to view periodic log data.  The 
COMTRADE format also displays log data. The ABB Load Profile format is an ASCII text file that 
contains time sequenced load information. The SDC Log format is an ASCII comma delimited CSV text 
file. The first line of the file is the header information. These files are generated from the Station Data 
Concentrator (SDC).  
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Figure 5.6  Periodic Log File 

CIRCULAR CHART 
The Circular Chart diagram shows a circular display for each visible channel. The diagram is displayed 
to the right of the analog information window. Refer to Figures 5.6 and 5.7. The amount of data 
displayed in the circular chart is equal to the amount of data displayed in the waveform 
trace window. The duration of the data displayed is shown at the bottom of the circular chart. To 
increase or decrease the size of the circular chart window place the cursor over the vertical separator 
between the analog information window and the circular chart window and drag the mouse to the left to 
increase or to the right to decrease. To close the circular chart window click the close button  located 
in the header. 
 
To navigate the circular chart use the left arrow, right arrow, home, end, page up and page down keys 
or the data scroll bar. The cursor bar on the circular chart displays where the data bar is in the chart. To 
increase/decrease the display area of a channel on the circular chart, mark the channel and use the 
increase/decrease amplitude menu buttons or the Ctrl-Up and Ctrl-Down keys or use the up and down 
arrow button  located in the circular chart header.   
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Figure 5.7  Circular Charts 

DISPLAY DRIVER’S DATA TYPE 
The data stored in the displayed file can be instantaneous values or RMS values. The default setting for 
all drivers is instantaneous values. If the display driver saves the sample values as RMS calibrated, set 
the display driver’s data type. If the display driver is not set properly the analog column data will be 

displayed incorrectly. To set the driver’s data type click the “Window Properties”  menu button from 
the speed bar or select the “Window Properties” option under the “File” menu.  Click the “Driver Data 
Type” tab and set the “Display Device’s Data Type” field to “RMS Calibrated” for RMS calibrated values 
and “Peak Type” for instantaneous values. Refer to Figure 5.8. 
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Figure 5.8 Analog Data Type Setting 

REOPEN WAVEFORM FILE 

To reopen a waveform file that was previously viewed click the reopen menu button  and select 
one of the files from the drop down list. Refer to Figure 5.9. 
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Figure 5.9 ReOpen Data File 

EMAIL ACTIVE FILE 

The active data file can be sent via email by clicking on the email  menu button or by selecting “Email 
Active File” from the “File” menu. The data file displayed and all the support files associated with the file 
are included as attachments. 

NAVIGATING 
Use the up and down arrow keys or the vertical scroll bar to browse the analog channels. The tab key 
toggles between the analog and digital views. 
 
The analog and digital values are displayed in a table to the right of the channel traces. Hold the mouse 
button down and drag the table separator bars to resize the viewing area. To view the analog sample 
values use the following navigation tools: 
 

• Left and right arrow keys to navigate sample by sample 
• Ctrl+left or ctrl+right keys to peak navigate 
• Shift+ctrl+left or shift+ctrl+right keys to cycle hop 
• Home and end keys to display the channel’s first and last samples 
• Triangle  at the bottom of the data bar to drag the data bar through the samples 
• Page up and page down keys to page through the samples 
• Left button  displayed to the left of the data scroll bar to move the sample at the data bar to 

the position of the first sample displayed 
• Left button  displayed to the right of the data scroll bar to move the trace and table separator 

to the position of the data bar 
 
Click the left/right arrow button  (located to the right of the analog table headers) or use the shift-
right/left arrows to scroll through the analog table columns. Refer to the “Viewing Analog Data” section 
for field descriptions.  
 
NOTE:  If no channels are marked then the peak navigate and cycle hop features navigate through the 
first channel’s data. 
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SETTING THE CURSOR BARS 
Four vertical cursor bars are displayed in the analog view. The blue dotted line represents the reference 
bar, the black solid line represents the data bar, the black dotted line represents the RMS bar and the 
red dotted line represents the fault position defined in the configuration file. There also are two 
horizontal bars displayed when the “Horizontal Bars” menu option under the “View” menu is checked.   

DATA BAR 
The data bar is displayed as a black solid line with a white triangle below the line. The data bar is 
automatically displayed at the end of the first cycle in the data file. To move the data bar use the left 
and right arrow keys to move one sample, use the Ctrl-left and Ctrl-right keys to peak hop, use the 
Shift-Ctrl-left and Shift-Ctrl-right keys to cycle hop, use the page up and page down keys to move 
one page up or down or left click the mouse to move to any position in the data or drag the triangle 
to scroll through the data. When the mouse is held over the triangle a hint message displays the 
sample number at the data bar and the delta time from the first sample. The time of the sample at 
the data bar is displayed in the second status bar field. The channel values at the data bar are 
displayed to the right of the traces in the analog channel information table.   

REFERENCE BAR 
The reference bar is displayed as a blue dotted line. The reference bar is defaulted to the fault time 
specified in the file. To move the reference bar to the position of the data bar use the "Move 
Reference Bar to Data Bar" option inside the “View” menu or press Ctrl-A or click the SetRef menu 
button .  Click the opposite mouse button to move the reference bar to any position in the data 
area. The status field Delta X in the status bar at the bottom of the screen shows the time difference 
(in milliseconds or seconds) between the reference bar and the data bar. It also shows how many 
cycles are between the two bars. 

RMS BAR 
The RMS bar is displayed as a black dotted line. The RMS bars default is always to be one cycle 
away from the data bar, except when the data bar is positioned at the beginning of the data. This bar 
is used for calculating the RMS value displayed in the analog table view. The RMS value in the 
analog table is calculated using all of the sample values displayed between the data bar and the 
RMS bar. To move the RMS bar to the position of the reference bar (blue dotted line) use the "Move 
RMS Bar to Reference Bar" option inside the “View” menu or press Ctrl-Z or click the SetRMS  
menu button.   

FAULT BAR 
The fault bar is displayed as a red dotted line. The fault bar is fixed and positioned at the fault time 
defined in the configuration file. The fault bar can be shown or hidden by selecting “Yes” or “No” 
options for the “Show Vertical Fault Bar” field in the properties dialog under the “Display Settings” 
tab. 

HORIZONTAL BARS 
When the “Horizontal Bars” menu option under the “View” menu is checked two horizontal bars will 
be displayed. The solid black line follows the data bar and the dotted blue line follows the reference 
bar. The bars will be positioned at the first marked analog channel (displayed in red), if no channels 
are marked, they are positioned at the first displayed channel. The Delta Y field in the status bar 
shows the difference between the two bars. 

 
To automatically resize the RMS sliding window click on the Resize Sliding Window menu button  
or open the “Resize Sliding Window” menu option under the “View” menu. Refer to Figures 5.10 to 5.12. 
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To manually resize the RMS sliding window click the opposite mouse button to set the reference 
position and the mouse button to set the data bar position then click the SetRMS  menu button. The 
RMS bar is moved to the reference position. The Delta X field displayed in the status bar at the bottom 
of the screen shows the time difference (in milliseconds or seconds) between the date bar and 
reference bar and the number of cycles between the two bars. Use the left, right, ctrl+left, and ctrl+right, 
shift+ctrl+left, and shift+ctrl+right keys or the horizontal scroll bar to move the sliding window. 
  

         
Figure 5.10 Resize Sliding Windows Drop Down Menus  

 

 
Figure 5.11 Resize Sliding Dialog for Waveforms  

 

 
Figure 5.12 Resize Sliding Windows Dialog for Log Files 

SAVE DISPLAYED VALUES 
The Save Displayed Values feature saves all displayed values in the analog table to a common 
delimited file (default format), to a user defined format file or to the Windows clipboard. To setup the 
waveform display for saving analog values follow the following steps:  

SELECT ANALOG COLUMNS 
All columns displayed in the table will be saved to the Selected Values file. Move the data bar along 
the waveform to change the sample values displayed in the table 
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To change the way the columns are displayed open the "Properties" dialog located in the "File" 
menu. Select the "Analog Table" tab. A list of all of the available analog columns is displayed. Use 
the "Move Up" and "Move Down" buttons to change the order of the columns and the check box next 
to each column header to hide or show the column (checked =show, unchecked=hide). 
 
Resizing the Analog table can also isolate the columns to save. Use the Shift-left and Shift-right keys 
to navigate through the columns. Navigate to the first column to be saved then resize the window by 
dragging the table/phasor separator bar to show only the columns needed. 

SELECT ANALOG CHANNELS 
The template file defines the channels to save in two ways: by the visible position of the channel or 
by specifying the actual channel number. If the template defines channels to save by position, the 
channels displayed need to be selected and arranged properly to match the template file. In both 
methods the channel values must be visible in the analog table. 
 
To isolate certain analog channels mark the desired channels. Marked channels are plotted in red. 
To mark a channel move the channel cursor to the channel and press the spacebar or click on the 
channels number or table values. After marking all of the desired channels press <enter>. Only the 
selected channels will be displayed. 

ARRANGE ANALOG CHANNELS 
To arrange the analog channels in a specific order mark the channels to be moved and press the "+" 
key to move them up or the "-" key to move them down. 

SETUP THE VALUES FILE 
Before saving values to the Values file the file must first be defined. To create or change the existing 
file, select the "New" option from the "Values File" submenu under the “Values” menu. Type in a new 
file name or select an existing file from the list. The new file automatically will be created. 

MARK & SAVE 
To save values to a file move the data bar to the desired sample and select the "Mark & Save" 
option under the "Values" menu. The sub menu allows for selecting the default format or a user 
defined format. The default format is the basic format defined in the "Values File" tab in the 
"Properties” dialog. Refer to the "User Templates" section below for more information on the user-
defined formats. All user defined template files must be saved in the Wavewin directory and have an 
extension ".TMP" to be listed in the template menu. 
 
Once the format is selected the sample at the data bar is marked and all of the values displayed in 
the table are saved to the selected values file. Marked samples have a red upside down T displayed 
at the top of the window. To clear the marked samples select the "Clear Marked Values" menu 
option under the "Values" menu. 

OPEN VALUES FILE 
To view the contents of the Values File select the "Open" option under the "Values File" submenu. A 
notepad window will be displayed. Refer to Figure 5.13. This window allows for editing the file, 
saving any changes, saving the file under a new name, and opening other Value files. 
 



Chapter 5 – Analysis Quick Start 

155 

 
Figure 5.13  Values File 

CLEAR VALUES FILE 
The "Clear" menu option under the "Values File" submenu or the “Clear” button inside the “View 
Values” window will clear the contents of the file. Use this feature if the Value File always remains 
the same. New value files are created using the "Save As" button in the "View Values" window. This 
feature also can be used if an error was made during saving and the file needs to be cleared to start 
over. 

DEFAULT FORMAT 
The "Values File" tab in the "Properties" dialog defines the default format for saving displayed values 
to the Values file. 
 
Below is a description of each field: 
 

• Save To - Select file to save the values to an ASCII text file, select clipboard to have the 
values go directly to the Windows clipboard or select both for both features. 

• Select Values File - Select an existing file or create a new file. If the file does not exist, a 
message that requests creation of the file upon exit of the dialog will be displayed. 

• Save Type - Select Rewrite to clear the file before every save, or select Append to add the 
values to the existing file. 
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• Save Format - Select Fixed ASCII to format the data as a table or select comma delimited to 
save the values separated by a comma. 

• Add Titles - Select “Yes” to add the titles of the column to the file or select “No” to define no 
titles (Used in the Default format only). 

USER FORMATS 
User formats are used to create custom templates in which to save the displayed values. The user 
formats are selected from the “Mark & Save” menu. User format files must be saved to the active 
Wavewin directory and have an extension ".TMP" to be listed in the “Mark & Save” menu. 
 
The format files can contain any ASCII text. Tags are used to define where the specified values are 
to be placed in the values file. When saving channel information the channel values must be visible 
in the analog table. 
 
Available Tags: 

• <Channel position #> - the position of the visible channel in the data plotting window. 
• <^Channel #> - the channel number displayed in the data plotting window. 
• <station> - the station displayed in the first status field. 
• <date>    - then date displayed in the D&T status field. 
• <time>    - then time displayed in the D&T status field. 

OPEN FORMAT FILE 
To view the contents of a format file select the "Open" option under the "Format Files" submenu. A 
notepad window will be displayed. This window allows for editing the file, saving any changes, 
saving the file under a new name, and opening other Format files. 

CREATE NEW FORMAT FILES 
To create a new Format File, select the "New" option under the "Format Files" submenu. A notepad 
window will be displayed. This window allows for adding text to the file, saving any changes, saving 
the file under a new name, and opening other Format files. 
 
User template files must be saved to the active Wavewin directory and have the extension “.TMP” to 
appear in the “Mark & Save” menu. 

MARKING, DELETING, AND RESTORING CHANNELS 
To mark or unmark a channel, click the mouse button on the channel ID or channel title, or use the 
space bar.  To mark a group of channels use the mouse button to mark the first channel and the shift 
mouse button to mark the last channel. Marked channels are displayed in red. 
 
To mark/unmark all analog and digital channels press the F8 key or select the “Mark/UnMark All” menu 
option under the “Channels” menu option. If no channels are marked, all of the analog and digital 
channels will be marked. If any channels are marked, all of the channels will be unmarked. To 
mark/unmark all the analog channels select the “Analog Mark/Unmark All” menu option under the 
“Channels” menu. To mark/unmark all of the digital channels select the “Digital Mark/Unmark All” menu 
option under the “Channels” menu. 
 
Channels must be marked to delete them from the display. The Delete key removes the marked 
channels and the Insert key restores all the deleted channels. 
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SCALING ANALOG CHANNELS 
When the analysis display is initially opened, all the analog channels are scaled to one value. To scale 

the channels according to the maximum space allocated for display, press F6 or click the AutoScale   
menu button. This option toggles among the three views: On, Off and ++. The active auto scale state is 
displayed in the “AS” status field. Each view is defined below: 
 

• ON – The On view plots the channel data scaled to the maximum value allocated along the zero 
reference line. 

• OFF – The Off view plots all of the channels that are scaled to the maximum value in the file.  
• ++ - The ++ view plots the signal using the number of maximum pixels allocated for the channel.  

The highest value is plotted at the maximum position and the smallest value is plotted at the 
lowest position. This feature was added to clearly show the profile of a frequency, Vdc and load 
data channels. 

 
The number of pixels allocated for each channel is displayed in the last column of the analog table. 
 
To increase or decrease a channel’s amplitude, along with the phasors and circular chart display mark 
the channels and click the AmpUp  or AmpDn  menus buttons or use the ctrl+up/down arrow keys. 
The auto scale multiplier (ASM) is used to amplify or attenuate the channel’s data values. For example, 
when the amplitude increases the ASM value is multiplied by the channel’s current “Pixsdisp” and when 
the amplitude decreases the ASM value is divided by the channel’s current “Pixsdisp”. To change the 
ASM value, select the “Properties” menu option under the “File” menu then click the “Display Settings” 
tab, enter a number and click OK. This value is initially defaulted to 2.00. To increase/decrease only the 
analog channels amplitude, click the up and down arrow buttons  located to the right of the data 
scroll bar. To increase/decrease only the phasor magnitude or circular chart click the up and down 
arrow buttons  located in the phasor/circular chart header.  
 

To increase or decrease the channel’s time scale, click the Condense  or Expand  menu buttons 
or press the ctrl+page up and ctrl+page down keys. 
 
NOTE:  If no channels are marked all the visible channels are scaled accordingly. 

ZOOMING CHANNELS 
To zoom in on analog or digital channels, mark the channels and press <enter> or click the ViewMrks 

 menu button. The unmarked channels are removed from the Analysis Display. To restore the hidden 
channels press the <esc> key, the <backspace> key, or click the ViewAll  menu button. 
 
When returning to the original view all channels in the previous view remain marked for quick selection 
of additional channels for a new view. 

SELECTING PREDEFINED VIEWS 
The DFR Transcan and Faxtrax records have predefined views encoded into their format. To select the 

predefined views click on the “Show All/ Select View” drop down menu button  or select the 
“Select Views” menu option under the “View” menu. A list of the available lines/graphs will be displayed.  
Refer to Figures 5.14 & 5.15. Click on the desired view. The analog channels defined in the select view 
will be displayed. To view all the analog channels in the file press the <esc> key, the <backspace>, or 
click the “Show All” menu button or click the ViewAll  menu button. To view user defined views refer 
to the “User Views” section. 
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Figure 5.14  Predefined Lines  Figure 5.15  Predefined Graphs 

REPOSITIONING CHANNELS 
Analog channels can be repositioned in the Analysis Display. To move a channel up one position mark 
the channel and press the “+” key or select “Shift Marks Up” from the “Channel” menu. To move a 
channel down one position mark the channel and press the “-” key or select “Shift Marks Down” from the 
“Channel” menu. 

PRINTING WAVEFORM FILES 
To print all of the data for the visible channels, select “Print/All” from the File menu. The page numbers 
are located on the top right corner of each printout. The date and time of the first sample on each page 
is printed at the bottom left corner. To print only the data currently displayed in the data window select 
“Print”/“Page” from the File menu. Use the zoom feature to print only the selected channels. If the 
software cannot access the printer port, an error message is displayed. 

SAVING AS COMTRADE 
The visible analog and digital channels can be saved in the COMTRADE ASCII or Binary format. The 
Comtrade versions supported are: the 1991 and 1999 format. The Comtrade format is selected in the 
“Properties” dialog under the “Comtrade” tab. The default format is the newer 1999 format.  Mark the 
analog and digital channels to save and press <enter> or click the ViewMrks menu button .  To 
create a COMTRADE file select the “Save as COMTRADE” (ASCII or Binary) option from the “File” 
menu. Enter the destination path and filename (do not define the filename extension) and click OK.  
Refer to Figure 5.16. The “.DAT” and “.CFG” files are automatically created. If a path is not defined, the 
COMTRADE files are saved in the active directory.  
 
To automatically name the Comtrade file using the IEEE long file naming format check the “Use the 
ComNames Naming Convention to Name the Comtrade File(s)” field in the “Save As Comtrade” dialog 
and leave the “File Name” field empty. The selected channels are converted to the specified Comtrade 
format and are named using the IEEE long file naming convention. 
 
If the sample values in the displayed file are RMS calibrated and the outcome Comtrade file must have 
instantaneous values, set the “Comtrade Settings” fields to automatically convert the RMS data to 
instantaneous values. To set the “Comtrade Settings” fields open the “Properties” dialog. Select the 
“Comtrade” tab then select “Yes” for the “Convert RMS Calibrated Data to Peak Data”. 
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Figure 5.16  Save As COMTRADE 

VIEWING ANALOG DATA 
The values displayed in the analog view can be presented in tabular form (analog table) or in a 
concentrated form (combination view). Press F4 to toggle between the two views or use the View  
button (located to the right of the analog table headers) or the shift-right/left arrow keys to toggle 
through the analog table columns. To close the analog table, click the Close button located in the 
header. Valid analog channels are displayed in the left portion of the window and the analog information 
in the right. An analog channel is marked as invalid if the title is empty, or it contains any of the following 
strings in the beginning of the title. To show an invalid channel use the “Show/Hide Channel Title” dialog 
in the file manager. Refer to the “Show/Hide Channel Title” section for usage. 
 

• UNUSE 
• UNDEF 
• NOT D 
• NOT U 
• NOT I 
• NAT A 
• UNDEF 
• { 
• N/A 
• ANALOG INPUT 
• ANALOG CHANNEL 
• EXTERNAL INPUT 
• EVENT CHANNEL 
• CHANNEL 
• DIGITAL TRACE # 
• SPARE 

 
A maximum of 256 analog channels can be displayed in one window. The values displayed in the 
analog table and combination view are described below. 
 
Analog Table View: 
The analog table view is the default view. Use the view button or the shift-right/left arrow keys to 
navigate through the columns of the table. The original sample values are plotted according to one of 
the following data types: 
 

• Peak to Peak data  
• RMS Calibrated data  
• Log files.  
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All of the display drivers in the system are defaulted to peak to peak except the predefined log drivers. 
To change the settings for a driver select the "Window Properties" option under the "File" menu. Click 
on the "Driver Data Type" tab and select the type from the "Displayed Device’s Data Types" drop down 
list. Periodic Log File’s data type cannot be changed. 
 
The following tables describe the analog data for the sinusoidal peak-to-peak, non-sinusoidal, and 
sinusoidal RMS data types:  
 
Peak to Peak 
Field Description 
Title The analog channel titles. 
RMS The TrueRMS value is calculated by taking the summation of the square of 

all the sample values that are between the RMS bar (black dotted line) and 
the data bar. The result is divided by the total number of samples between 
the two bars and takes the square root of that result. 

InstPeak The highest absolute value of all of the samples between the two zero 
reference crossings surrounding the data bar (black solid line). 

Phase The phase angle of each channel. 
InstVal The sample value at the data bar (black solid line). 
RefVal The sample value at the reference bar (blue dotted line). 
MaxPeak The maximum peak value of the channel. 
MinPeak The minimum peak value of the channel. 
Units The analog channels prefix and units. 
PixsDisp The number of pixels allocated for displaying the trace. 
DFT Peak The DFT Magnitude calculated between the RMS bar (black dotted line) 

and the data bar (solid data bar). 
Crest The DFTMag column divided by the RMS column. 

 
Sinusoidal RMS Calibrated 
Field Description 
Title The analog channel titles. 
RMS The RMSVal column calculates an RMS value for all of the samples 

between the RMS bar (black dotted line) and the data bar (black solid line). 
Since the data is RMS calibrated each sample value is multiplied by the 
square root of 2 before it is squared. 

InstPeak The square root of 2 multiplied by the peak value measured between the 
two reference crossings surrounding the data bar (black solid line). 

Phase The phase angle of each channel. 
InstVal The RMS sample value at the data bar (black solid line) multiplied by Root 

2. 
RefVal The RMS sample value at the reference bar (blue dotted line) multiplied by 

Root 2. 
MaxPeak The RMS maximum peak value of the channel multiplied by Root 2. 
MinPeak The RMS minimum peak value of the channel multiplied by Root 2. 
Units The analog channels prefix and units. 
PixsDisp The number of pixels allocated for displaying each trace. 
DFT Peak The DFT Magnitude calculated between the RMS bar (black dotted line) 

and the data bar (solid data bar). 
Crest The DFTMag column divided by the RMS column. 
        
Non-Sinusoidal (Load Files) 
Field Description 
Title The analog channel titles. 
MaxWin The absolute maximum value between the sliding window bar (black dotted 
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Field Description 
line) and the data bar (black solid line). 

InstVal The sample value at the data bar (black solid line). 
RefVal The sample value at the reference bar (blue dotted line). 
MaxVal The maximum value of the channel. 
MinVal The minimum value of the channel. 
Units The analog channels prefix and units. 
PixsDisp The number of pixels allocated for displaying the trace. 
AvgWin The average value of all of the samples between the sliding window bar 

(black dotted line) and the data bar (black solid line) 
   
Combination View: 
The combination view shows all of the channel information in a signal view. This view only is available if 
there is sufficient room between analog channels to display three lines of text. 
 
Default Display format: 
 
Peak to Peak: 

Channel Title    
RMS MaxPeak RefVal  
InstVal MinPeak Units ASV 

 
RMS Calibrated:  

Channel Title    
RMS MaxPeak RefVal  
InstVal MinPeak Units ASV 

      
Load Files: 

Channel Title    
MaxWin MaxVal RefVal  
InstVal MinVal Units ASV 

 
The peak sample values are displayed in red when the data bar is on the channel’s maximum value and 
they are displayed in blue when the data bar is on the channel’s minimum value. Use the Tab key to 
toggle between the analog and digital channels. To hide the channel information, select the "Channel 
Information" menu option from the "View" menu. 
 
The analog table and combination views can be resized by selecting the vertical separator bar and 
dragging it to the right or left. The cursor changes to the vertical resize cursor when the mouse is 
positioned over the separator bar.  
 
To change how the analog data is displayed in the analog table and combination view select the 
"Properties" menu option from the "File" menu. Some of the functions of the “Properties” dialog are 
reordering, hiding, and showing the analog table columns; changing the data positions in the 
combination view; changing the background colors and trace colors; and for changing the drivers data 
type and trace/phasor scale multipliers.   

VIEWING DIGITAL DATA 
The default digital view consists of only the triggered digital channels, which are displayed at the bottom 
of the screen. To view all of the digital channels including the unused channels press F9 or select “All 
Digital Channels” from the “View” menu.   
 
The digital trace is displayed as a thin black line when the sample value equals the original state defined 
in the displayed format and is displayed as a thick green line when the sample value differs from the 
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original state. The Cursor State column in the digital table displays an “A” for Alarm and “N” for Normal 
or the SEL defined state. These values are set by comparing the sample value at the data bar with 
original state, “A” = different than original state, “N” = same as original state.   
 
The digital information is displayed in tabular form. The data columns are described below: 
 
Column Number Description 
1 – Cursor State The digital state of the sample at the cursor position (A=Alarm, N=Normal).  
2 – Title The channel title, a maximum of 40 characters can be displayed.  
3 – Fst The digital state of the first sample (A=Alarm, N=Normal).  
4 – Lst The digital state of the last sample (A=Alarm, N=Normal).  
5 – Fst-Change The time the channel first changed state.  
6 – Lst-Change The time the channel last changed state.  
7 – Changes The number of times the channel-changed state.  

 
Use the scroll bar or the up and down arrow keys to navigate through the channels and use the tab key 
to toggle between the analog and digital views. 

CUSTOMIZING THE ANALYSIS DISPLAY 
The “Properties” option in the “File” menu allows for customizing the analysis display window. Below is a 
definition of each tab: 
 

• Analog Table – The Analog Table tab is used to reorder, hide and show the columns in the 
Analog Table.  

• Analog Combination – The Analog Combination tab is used to change the position of the data 
values in the Combination view.  

• Comtrade – The Comtrade tab is used to define the Comtrade format for saving, the date and 
time format for display and for setting automatic conversion from RMS data to Peak data when 
using the “Save As Comtrade” feature.  

• Colors – The Colors tab is used to define the background colors of each display section and to 
set the default analog channel colors.  

• Values File – The Values File tab is used to define the Values File and general information 
used when saving samples values to a file.  

• Display Settings – The Display Settings tab is used to define the ASM scale multiplier for the 
traces and phasor/circular chart scaling. It also can define general display information for the 
window such as: setting the display trace type (sample based or time based), showing the time 
reference bar between the analog channels and the digital channels, showing the separator bar 
between multiple events displayed in one window, showing or hiding the fault bar (red dotted 
vertical bar), and defining the option to reference angles across windows when Sync mode is 
active. When “Yes” is defined, all phase angles for the currently opened windows will be 
referenced from the first marked channel in the active window.  

• Append / Merge – The Append/Merge tab is used to define from which file the samples will be 
discarded when the append/discard common times option is used. It also is used to determine 
whether the station name should be added to the analog/digital titles when an append/merge 
option is executed.  

• Driver Data Type – The Driver Date type tab is used to define the type of data that is saved to 
the displayed device’s data file: RMS Calibrated or Peak Type.  

• Filters – The Filters tab is used to define if spikes detected in the data file should be ignored 
when the maximum and minimum values are calculated and at what level they should be 
ignored.  
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TIME & SAMPLE BASED DISPLAYS 
The “Trace Display Type” field located in the “Display Settings” tab of the “Properties” dialog allows for 
toggling between the “Time Based” display and the “Sample Based” display. The sample based display 
plots the channel data with one pixel distance between each displayed sample. Sample based displays 
are useful for showing changes in sampling frequency. The time based display plots the channel data in 
time. Time based displays are useful for showing changes in line frequency. 
 
To change the trace display type open the “Properties” dialog under the “File” menu. Click the “Display 
Settings” tab and change the “Trace Display Type” field to time based or sample based. 

FAULT REFERENCE TIME BAR 
The Fault Reference Time Bar is displayed between the analog and the digital traces. It displays the 
time difference from the fault time defined in the displayed file. The units are displayed in the Delta X 
status field. 
 
To show or hide the fault reference time bar open the “Properties” dialog under the “File” menu. Click 
the “Display Settings” tab and select “Yes” or “No” for the “Show Reference Time Bar” field. 

SUPERIMPOSING ANALOG CHANNELS 
To superimpose two or more analog channels, mark the channels and press F7 or select the “Super 
Impose” menu option from the “Data” menu. The marked channels are superimposed and placed at the 
top of the display. If no channels are marked, all channels are superimposed. Press F7 to turn this 
feature ON/OFF. 

CHANGING ANALOG CHANNEL COLORS 
To change the color of an analog channel, click the opposite mouse button on the channel ID. Select 
the channel color from the list or click “More Colors” to select from the color palette. Channels must be 
unmarked to change their colors. 

SYNCHRONIZING DATA CURSORS 
The Sync Data Cursors feature is used to synchronize the data bars for two or more display windows. 
Refer to Figure 5.17. To synchronize two or more data bars, open the files, select “Tile Horizontal” from 
the Windows menu, then select the “Sync Data Cursors” menu option from the “Data” menu. This 
feature offers two sync functions: “By Time” and “Manually”. When a function is selected, the data bars 
in the non-active windows are moved to the synchronization point of the active window. The two 
functions are described below: 
 

By Time 
When the time function is activated, the data bars in the non-active windows are moved to the 
sample time of the data bar in the active window. For example, if the data bar in the active window is 
positioned on a sample at time 01:12:34.5600 all of the non-active data bars are moved to the 
sample at that time. If the time cannot be found the data bar does not move. 
 
Manually 
The manual sync function allows for the selection of different cursor positions in the windows before 
synchronization is activated. For example, open four display windows and tile horizontally. Move the 
data bar to the beginning of the fault cycle in each window and select the Manual cursor sync 
function. Press the left arrow, right arrow, ctrl+left, ctrl+right, page up, page down, ctrl+page up, 
ctrl+page down, home and end keys or use the scrollbar to move the data bars. 
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Figure 5.17  Cursor Synchronization 
 
In Sync Mode phase angles can be referenced across analysis display windows. The phase angles in 
the opened data windows are referenced by the first marked channel in the active data window. This 
feature is activated from the “Properties” dialog under the "Display Setting" tab in the Sync Mode 
section. Sync Mode must be active for the angles to be referenced. 

APPEND OPEN FILES 
The “Append Open Files” menu option under the “File” menu appends all of the open windows into a 
new display window. There are two options available under the Append Open Files Menu: 

• Discard Common Times: Any common times found in the open files will be deleted from the 
oldest file. 

• Back to Back: The files are appended back to back. No samples are deleted. 

MERGE OPEN FILES 
The “Merge Open Files” option under the “File” menu merges all of the displayed or marked channels 
into one display window. There are three options available under the Merge Open Files Menu: 
 

• By Time: Merge channel samples if they have a common time segment. The reference time is 
taken from the file with the latest start date and time. The file with the least number of samples 
determines the length of the new merged file. Refer to Figure 5.20 and 5.21. 

• Manually:  Use the data bars to highlight the location of the common sample time in each 
window. Then Merge Manually will line up the data bars and adjust the time stamps accordingly. 
This option is used when the file times are not synchronized. The active window determines the 
time stamp of the new merged file and the open window with the least number of samples 
determines the length of the new merged file. Refer to Figure 5.22 and 5.23. 

• By Sample:  Merge without regard to time stamps and/or data bar positions. The reference time 
is taken from the active window.  The file with the least number of samples determines the 
length of the file. Refer to Figure 5.24. 
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When files with different sampling frequencies are merged a dialog will be displayed. The dialog 
contains a list of all the sampling frequencies in the opened files. Select the frequency for the merged 
file or enter a new frequency. Refer to Figure 5.18. 
 

 
Figure 5.18  Merge Open Files: Select Frequency 

 
Merging Open Files allows for flexibility of which channels are merged. “Merge Open Files” will merge 
either the marked channels only, if there are no marked channels then it will merge the visible channels. 
 
If the merged files have different data types (RMS Calibrated or Peak Values) the RMS values will be 
automatically converted to Peak values by multiplying the RMS values by Root 2. 
 
To identify the merged channels the station name for each file is added to the beginning of the analog 

and digital channel titles. To turn off this feature open the “Properties” dialog .  Click on the 
“Append/Merge” tab and uncheck the “Add the File’s Station Name to Beginning of the Analog/Digital 
Channels” field. Refer to Figure 5.19. 
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Figure 5.19  Append/Merge Properties 
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Figure 5.20  Merge Open Files – By Time: Open files and select channels to Merge 
 

 
Figure 5.21  Merge Open Files – By Time: Result: By Time 
 
Merge Open Files “By Time” only will merge the samples with common times. The reference time is the 
file with the latest start date and time. 
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Figure 5.22  Merge Open Files – Manually: Select Channels & Position Data Bars 
 
First, select the channels to merge by marking the channels and pressing the <enter> key. Next, 
position the data bars at the point representing the Same Point in time. 
 

 
Figure 5.23  Merge Open Files – Result: Manually 
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Merge Open Files Manually is used when the file times are not synchronized. Place the data bars in the 
position where the times should be synced and merge the files. Merge will align the samples according 
to the position of the data bar in each open file. The data bar with the least number of samples at the 
beginning determines the number of samples to truncate from the beginning of all other open files. The 
active window’s time stamp is used for the merged file and the open file with the least number of 
samples determines the length of the merged file. 
 

 
Figure 5.24  Merge Open Files – Result: By Sample (As Applied to Figure 1.70) 
 
Merge Open Files “By Sample” merges without regard for time stamps and/or data bar positions. It 
merges “as is”. The reference time is from the active window and the file with the least number of 
samples determines the length of the file. 

CHANGE FREQUENCY 
Change Frequency changes the current sampling frequency to the entered frequency. Refer to Figure 
5.25. If the entered frequency is greater than the current frequency samples are added. If the entered 
frequency is less than the current frequency samples are deleted. Refer to Figure 5.26 and 5.27 for an 
example that sets a multiple frequency file to a single frequency.  The entered frequency must be 
greater than two times the line frequency. 
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Figure 5.25  Change Frequency Dialog 

 
It also allows for defaulting a driver to always display its’ files using the entered frequency. For example, 
all SEL 4 samples/cycle (240ƒs) files can be set to automatically display 40 samples/cycle (2400ƒs). 
 
NOTE:  If Open Frequency is checked, the Restore Original is not available. 
 

 
Figure 5.26  Change Frequency: Change a Mutiple Frequency File 
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Figure 5.27  Change Frequency: Results 

TRUNCATE CYCLES 
Truncate Cycles removes the specified number of cycles from the analysis display. Refer to Figures 
5.28 and 5.29. Three options are available under the “Truncate Cycles” submenu option. 
 

• Left: Remove all cycles from the first sample to the data bar.  
• Right: Remove all cycles from the data bar to the last sample. 
• Middle: Remove all cycles from the data bar to the reference bar (blue dotted line). 
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Figure 5.28  Truncate Cycles: Append Non Time Matching Waveforms 
 
After appending two waveform files it may be necessary to truncate the cycle that did not match. First, 
align the reference bar on the peak before the appended position then align the data bar on the peak 
following the appended position and select the truncate middle menu option. 
 

 
Figure 5.29  Truncate Cycles: Results 



Chapter 5 – Analysis Quick Start 

173 

DUPLICATE CYCLES 
Duplicate Cycles duplicates the cycle at the data bar by the number of times entered in the Duplicate 
Cycles Dialog. Refer to Figure 5.30. This feature is useful for creating Comtrade files to play back to test 
set applications and for modeling and simulation applications.  Refer to Figures 5.31 and 5.32 for an 
example that adds five cycles of fault cycles to a file. 
 

 
Figure 5.30  Duplicate Cycles Dialog 

 

 
Figure 5.31  Duplicate Cycles: Initial File 
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Figure 5.32  Duplicate Cycles: Results 

RESTORE ORIGINAL DATA 
Restore Original Data will reread and display the sample values from the active waveform file on disk.  
Any changes made to the analysis window, such as: duplicate cycles, change frequency and truncate 
cycles will be lost when this feature is activated. If the Open Frequency option is checked in the 
“Change Frequency” dialog the Restore Original is not available.  

MARK RAW VALUES 
Mark Raw Values marks the raw values saved in the active waveform file on disk. A small hollow blue 
circle is placed at the raw value. This feature is helpful in highlighting the raw sample values saved in 
low sampling rate files. Refer to Figure 5.33. 
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Figure 5.33  Mark Raw Values 

MARK PEAK VALUES 
Mark Peak Values marks the peak sample values for all visible analog traces. A small solid gray square 
is placed at the peak values. Refer to Figure 5.34. This feature is helpful in highlighting the positive and 
negative peak values.  
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Figure 5.34  Mark Peak Values 

MARK CHANGE IN SIGN VALUES 
Mark Change In Sign marks all samples where a change in sign occurs.  A small solid gray triangle is 
placed at the change position. Refer to Figure 5.35. This feature is helpful in highlighting the position 
where a change in sign occurs in the signal. 
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Figure 5.35  Mark Change in Sign 

CHANGE ANALOG VALUES (PRIMARY ��������  SECONDARY) 
The values displayed in the analog table are either in primary or secondary quantities. If the file defines 
the type of values saved the type is displayed in the window header. Refer to Figure 5.36. Also, if the 
CT and PT ratios are defined in the configuration file the values can be changed from primary to 
secondary and vice versa. To change the values open the properties dialog and click on the “Driver 
Data Type” tab, and select the Primary or Secondary radio button to switch between values. Refer to 
Figure 5.37. 
 

 
Figure 5.36  Type of Analog Values Displayed 
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Figure 5.37  Change Analog Values (Primary �������� Secondary) 
 
The CT and PT ratio values can be viewed by clicking on the “View Ratio Values” button in the “Driver 
Data Type” tab. The values are listed in a table format for each analog channel. Refer to Figure 5.38. 
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Figure 5.38  Ratio Values 

ADJUST FILES TIME 
The Adjust Files Time allows for adjusting the time of the open file. To open the “Adjust File Time” 
dialog, select the "Adjust Files Time" menu option under the "Data" menu. You can specify to add or 
subtract a given time increment from the files current time. Enter the desired time increment for the 
hour, minutes, seconds and milliseconds. If there is no adjustment needed on a specific time field enter 
0. Refer to Figure 5.39. 
 

 
Figure 5.39  Adjust Files Time 
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To always have the file's time automatically adjusted when a specific driver is used to open a file check 
the "Adjust Open Time" check box. 
 

To show the file’s original date and time click on the “Restore Original” button  or select the “Restore 
Original Data” menu option under the “Data” menu. 

CREATING VIRTUAL CHANNELS 
The analysis window allows for six software analog channels (SAC) and eight software digital channels 
(SDC).  These additional virtual channels exist only in RAM. The sample values are created using a 
function of the existing analog/digital channels. Predefined operators can be used to calculate a missing 
phase, create positive/negative and zero sequence channels; convert channels to secondary or primary 
values; calculate the resistance of V/I, multiply, divide, add and subtract multiple channels; multiply, 
divide, add and subtract channel data by a constant value; create an envelope of an analog channel; 
define over-trigger or under-trigger values; calculate a missing phase; define the prefix and unit for the 
channel; or perform bit-wise ANDing/ORing on digital traces. 
 
All calculations are designed to operate "on the fly". For the forward looking SAC operator ("@" some 
positive angle) care must be taken. Upon opening a file and while the system is reading the data 
samples, the forward samples are not available. In that case, the system uses the current sample 
instead of the requested forward sample. To execute forward looking SAC instructions, wait until the file 
is read to use F5 to recalculate. 
 
SAC title and operators can be saved to an ASCII text file on disk by using the “Save” and “Save As” 
buttons located to the right of the SAC operators. The “Open” button allows for opening existing SAC file 
without having to manually enter the SAC titles and operators. These features are useful for reusing 
existing SAC operations on like files. The “New” button clears the existing SAC title and operators. 
 
The SAC and SDC instructions are composed of an operator and an operand. An operand can be a 
channel defined by the channel number or a constant. Constant values must have a “^” operator before 
each value to distinguish between channel numbers and constant values. To phase shift analog 
channels use the “@” sign before each angle defined. All angles must be defined in degrees.  Following 
is a list of all the software operators that are available: 
 

• “+” - Add (Analog)  
• “-“ - Subtract (Analog)  
• “*” - Multiply (Analog)  
• “:” - Divide (Analog)  
• “^” - Constant value (Analog)  
• “@” - Angle in degrees (Analog)  
• “e” - Half cycle envelope (Analog)  
• “a” - Envelope (Analog)  
• “<” - Under-trigger (Analog)  
• “>” - Over-trigger (Analog)  
• “h” - Harmonic for Channel 
• “h=” - Harmonic for all Back Operations  
• "x" - real component,  
• "y" -imaginary component,  
• "m" -magnitude,  
• "d" -angle,  
• "r" -true rms,  
• "f" -cyclic frequency,  
• "q" -instantaneous frequency,  
• "t" -delta time frequency,  
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• "b" -operate between bars only,  
• “|” - Absolute Value 
• “p=” - Prefix (Analog)  
• “u=” - Unit (Analog)  
• “+” - And (Digital)  
• “.” - Or (Digital)  
• “/” - Instruction terminator (Analog & Digital)  

 
NOTE: All SAC/SDC operations are performed in Reverse Polish Notation (one operation at a time). 

The instruction set must always terminate with a “/”.  An operation error is generated if the 
instruction formats are not followed.   

 
Operators are formatted as a stacked set of instructions. An instruction is composed of four attributes:  
 

1. The operator: +, -, *, :, ...  
 

2. The operand: channel index (1, 2, 3, ...) or constant value (such as ^3.14)  
 

3. The function: @, h, x, y, m, d, f, ...  
 

4. Instruction terminator: / 
 
Press F5 to display the SAC dialog or select “Software Analog Channels” from the Channels menu.  
Refer to Figure 5.40. To display the SDC dialog select “Software Digital Channels” from the Channels 
menu.  Below are some examples: 
 
Operations Example Description 
Addition +7/+8/+9/ Add channels 7, 8, & 9 and store the result in 

the SAC. 
Subtraction +7/-8/-9/ Subtract channel 8 from channel 7, and store 

the result in the SAC then subtract channel 9 
from the SAC and restore the values in the 
SAC. 

+ Sequence +1/+2@120/+3@240/:^3/p=k/u=volt/ Calculate the + sequence components and 
store the result in the SAC then set the SAC’s 
prefix and unit. 

- Sequence +1/+2@240/+3@120/:^3/p=k/u=volt/ Calculate the - sequence components and 
store the result in the SAC then set the SAC’s 
prefix and unit. 

0 Sequence +1/+2/+3/:^3/p=k/u=volt/ Calculate the zero sequence components and 
store the result in the SAC then set the SAC’s 
prefix and unit. 

Harmonics +16/h=1/p=k/u=volt/ Extract the 1st  Harmonic component from 
Channel 16 and store in the SAC then set the 
SAC’s prefix and unit. 

Multiplication +3/*^2.66/ Multiply all sample values in channel 3 with 
the constant value 2.66 and store the result in 
the SAC. 

Division +7/:3/ Divide all samples values in channel 7 by the 
sample values in channel 3 and store the 
result in the SAC. 

Half Cycle 
Envelope 

+2/e/ Calculate the half cycle envelope of channel 2 
and store the result in the SAC. 

Envelope +12/a/ Calculate the envelope of channel 12 and 
store the result in the SAC. 
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Operations Example Description 
Under-trigger +4/<135/ Store all the sample values from channel 4 

that are < 135 in the SAC. 
Over-trigger +62/>500/ Store all the sample values from channel 62 

that are > 500 in the SAC. 
Absolute 
Value 

+7/+8/+9/|/p=k/u=Volts/ Add channels 7, 8, & 9 and store the absolute 
value of the result in the SAC then set the 
SAC’s prefix and unit. 

Frequency +7f/u=Hz/ Store the cyclic frequency of channel 7, and 
set the SAC’s unit to Hertz. 

Frequency +7q/u=Hz/ Store the instantaneous frequency of channel 
7, and set the SAC’s unit to Hertz. 

Magnitude +11m/u=V/p=k/ Store the magnitude of channel 11, and set 
the SAC’s unit to Volt and the prefix to k. 

Real +4x/+5x/+6x/u=V/ Store the real components of the fundamental 
of 4, 5 and 6 and set the SAC’s unit to Volts. 

Imaginary +4/+5/+6/y2/u=V/ Store the imaginary components of 2nd 
harmonic of 4, 5 and 6 and set the SAC’s unit 
to Volts. 

AND +2/.33/ AND channel 2 with channel 33 and store the 
result in the SAC.  The “.” represents the AND 
operation. 

OR +2/.4/+14/ AND channel 2 with 4, then OR the result with 
channel 14 and store the result in the SAC.  
The “+” sign represents the OR operation. 
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Figure 5.40  SAC Dialog 
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Figure 5.41  SAC Results  
 
Engineers can use the additional channels as a generic tool for monitoring or modeling tasks. A virtual 
channel can be used to compute one of the phases of a monitored line by adding the remaining phases 
then subtracting the result from the residual channel. This in turn frees up a hardware channel for other 
monitoring needs. 
 
The SAC operators and titles can be saved to an ASCII text file on disk to save time when re-entering 
SAC operator and titles. The SAC files can have any filename but the extension must be .SAC. If an 
extension is entered when saving a SAC file then the extension is deleted and .SAC is added to the 
filename. The active SAC path and filename is displayed in the first status field. The second status field 
indicates if the SAC title or operator fields where modified. 
 
There are 4 options for the SAC files, Open, New, Save and Save As. Each option is explained below: 
 

SAC File Operator Description 
Open Open an existing SAC file. The Window’s open file dialog is displayed. 

Refer to Figure 5.42. Navigate to the desired folder and double click on the 
SAC file. The SAC title and operator fields are populated with the contents 
of the selected file. If the file is not a valid SAC file then an error message is 
displayed.  

New Clear the current SAC title and operators and change the SAC filename in 
the first status field to Untitled. If the previous SAC title and operators where 
modified then a message will be prompted asking to save the existing SACs 
before clearing the fields. 

Save Save the active SAC title and operators to the SAC file listed in the first 
status field. If the SAC filename is listed as Untitled then the “Save As” 
dialog is displayed.  

Save As Save the existing SAC title and operators to a new SAC file. The Window’s 
“Save As” dialog is displayed. Navigate to the desired folder and enter the 
new name in the “File name” field and click the “Save” button or press enter.  
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Figure 5.42  Open SAC File  

SINGLE ENDED FAULT LOCATION 
The Single Ended Fault Location Dialog is used to interface to the SingleEndFaultLocation.dll. The 
SingleEndFaultLocation.dll will calculate the fault location, fault type and fault time. 
 
The sampling frequency must be set to ensure 24 samples per cycle. The sampling frequency must be 
set prior to opening the fault location dialog. If the sampling frequency is not set to 1440 Hz for 60 Hz or 
1200 Hz for 50 Hz then the change sampling frequency dialog will automatically be displayed. Refer to 
Figures 5.43 & 5.44. Click OK or press enter to change the sampling frequency then reopen the Fault 
Location dialog.  
 

 
Figure 5.43  Fault Location Change Sampling Frequency Message 
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Figure 5.44  Fault Location Change Sampling Frequency Dialog 
 
Also, all sample values sent to the DLL must be in secondary quantities. If the sample values are in 
primary values then the CT and PT ratio values must be available in the data configuration file. If the CT 
and PT ratio values are not available a message will be displayed asking to ignore the request or abort 
displaying the fault location dialog. Refer to Figure 5.45. 
 

 
Figure 5.45  Fault Location Secondary Quantities Message 
 
If the analog values are in primary quantities and the CT and PT ratio values are available then the fault 
location dialog will automatically convert the sample values to secondary quantities before sending them 
to the DLL.  
 
The fault location window is divided into 6 sections; Inputs, Advanced, Analog Channels, Outputs, 
Configuration Buttons and Action Buttons. Refer to Figure 5.46. Each section is defined below. 
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Figure 5.46  Fault Location Dialog 
 

Input Fields 
All input fields must be entered in secondary quantities. 
 

Field Type Units Description 
Zline Real Per Unit Length Positive sequence impedance 

Zline Angle Real Degrees Positive sequence angle 
kZN Real Factor Compensated zero sequence impedance 

(Z0-Z1)/(3*Z1) 
kZN Angle Real Degrees Compensated zero sequence factor angle 

(Z0-Z1)/(3*Z1) 
kZM Real Factor Mutual compensation factor (Z0m)/(3*Z1) 

Line Length Real Not Required Line Length 
Vnom Real Voltage Nominal phase to phase voltage 
Inom Real Amps Nominal current 

 
Advanced Dialog 
The advanced dialog is used to enter specific information to help tune the fault location algorithms. 
Refer to Figure 5.47. Modify the advanced dialog to specify the phase selection, Z1 & Z2 % of line, 
thresholds and reach settings. Each field is explained below. 
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Figure 5.47  Fault Location Advanced Dialog 
 

Field Type Units Description 
Z1 (% of Line) Real Percent Zone 1 forward impedance (default value 

is 120% of line positive sequence 
impedance (=1.2 * Zline * Length)) 

Z2 (% of Line) Real Percent Zone 2 reverse impedance(default value is 
120% of line positive sequence impedance 
(=1.2 * Zline * Length)) 

R0 Real Ohms Phase loop resistance reach (default value 
set to 10/Inom) 

Rg Real Ohms Ground loop resistance reach (default 
value set to 20/Inom) 

I0 Threshold Real % of Inom Zero sequence current threshold for VTS 
(default value set to 10) 

I2 Threshold Real % of Inom Neg. sequence current threshold for VTS 
(default value set to 10) 

Ph. Select Index Integer Samples Index of the sample corresponding to the 
fault inception instance (this field is 
automatically calculated according to the 
position of the reference bar and the Pre 
and Post reference bar cycles defined in 
the Analog Channel section). 

Average Count Integer Samples Total post fault samples for averaging fault 
distance (default value set to 24) 

Ph. Select Mode N/A N/A Phase selection mode (Internal, AG, BG, 
CG, AB, BC, CA) 

 
If the Phase Section is set to internal then the fault location algorithms will automatically determine 
the fault position in the file. If it is set to external then the user must specify where the fault position is 
in the file. To do this move the Reference bar in the data plotting window to a ¼ cycle after the fault. 
The reference bar must be set prior to opening the fault location dialog.   
 
Analog Channels:  
Select the Current and Voltage channels from the drop down lists. Also, define how many cycles to 
send before the Reference bar (blue dotted line) and after the reference bar. The reference bar can 
be moved by right clicking on the desired sample. 
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Outputs: 
The results of the fault location calculations are displayed in the output section. The Fault Distance, 
Fault Type and Fault Time are displayed. Any errors or warnings sent from the 
SingleEndFaultLocation.dll are displayed in the Error and Warnings edit box. 
 
Configuration Buttons: 
The configuration buttons allow for saving the fault location fields, creating a new fault location 
configuration and for opening previously saved configurations. The configuration files must have a 
*.FLT extension. Click on the "Open" button to open an existing configuration. Window's file 
navigation dialog is displayed, navigate to the desired folder and double click on the fault location 
file. 
 
To save an existing configuration, under a new name click on the "Save As" button. Navigate to the 
desired folder enter the new name then click "Save". The extension must be .FLT.  
 
Click the "Save" button to save any changes made to an existing configuration. To create a new fault 
location configuration, click the "New" button. 
 
Action Buttons: 
The action buttons are used to perform specific actions. Each button is described below: 
 

� Start: The Start button initiates all communications with the SingleEndFaultLocation.dll. It 
first sends all of the input fields, next all samples are sent to the DLL. The starting sample 
and the total number of samples sent is defined by the reference bar position and the Pre 
and Post reference bar cycles. The starting sample number and the total number of samples 
sent are displayed in the status bar. Once all samples are sent it then calls calculate. If no 
errors occurred then the fault location results are displayed in the Output section. All errors 
or warnings are displayed in the Error & Warning edit box. 

 
� Print: The print button sends a screen dump of the fault location dialog to the system's 

default printer. 
 

� Help:  Show or hide the drop down help window. 
 

� Close: The close button closes the fault location dialog. If any changes were made to the 
fault location fields a message will be display asking to save the changes. 

PLAY CHANNELS AUDIO 
It is now possible to hear the characteristics of a signal through the analysis window. To play the audio 
of a specific analog channel first mark the channel. Then open the “Analog Channel Audio” dialog by 
selecting the “Play Channels Audio” menu option under the “Data” menu. The Analog Channel Audio 
dialog is displayed in the bottom right hand corner of the analysis window. Refer to Figure 5.48. 
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Figure 5.48  Play Audio Dialog   

 
The “Active Channel” section displays the analog channel marked in the analysis window. The “Audio 
Controls” section allows for playing the active analog channel’s data through the computers speakers 
and for increasing/decreasing the volume of the output. The “Save .WAV File” section allows for saving 
the analog channel data in the Window’s .WAV format. Click the folder button  to select a destination 
folder and to enter a new “.WAV” file or for selecting an existing “.WAV” file. The selected folder and 
filename will be updated in the “Audio Filename” field. 
 
To view the saved “.WAV” file exit the analysis window, navigate to the “.WAV” folder and double click 
on the wave file. A new display driver has been added to plot Microsoft’s “.WAV” files.  

ALIGN CHANNEL DATA 
The “Align Channel Data” option aligns the analog channel samples according to the defined phase shift 
angles. The alignment routines use the Thiran 3rd Order All Pass Fractional filter. The all-pass delay 
guarantees no magnitude deterioration and fractional because delays can be a fraction of the sample 
interval. 
 
To align the analog channels manually select the “Align Channel Data” menu option under the 
“Channel” menu. If the Thiran filter has already been applied to the displayed analog channels a 
message is displayed. Refer to Figure 5.49. 
 

 
Figure 5.49  Align Channel Message   
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To continue to the “Align Channel Data” dialog click “Yes”. To apply the filter to the file’s original 
unfiltered data click “No” or “Cancel”. Then select the “Restore Original Data” menu option under the 

“Data” menu or click on the “Restore Original” menu button.  
 
The “Align Channel Data” dialog applies the Thiran filter according to the entered Phase Shift angles. 
Enter the phase shift angle for each analog channel. Refer to Figure 5.50. If the filter does not apply to a 
specific analog channel enter 0 or leave the field blank or enter NONE. To display the coefficient values 
used for each analog channel click the “Calculate Coefficients” button. The “A0, A1, A2 and A3” fields 
will be updated with the coefficients for the entered phase shift angles.   
 

 
Figure 5.50  Align Channel Data Dialog   
 
To always apply the Thiran filter on files for the active driver click the “Always Apply” check box. Always 
apply automatically runs the Thiran filter with the defined phase shift angles before displaying the file. 

To display the files original samples click the “Restore Original” menu button  or select the 
“Restore Original Data” menu option under the “Data” menu. 
 
The coefficients used for the filter can be edited. If the coefficients are modified click the “Use Entered 
Coefficients Values” radio button. To have the coefficients automatically calculated when the filter is 
applied click the “Calculate Coefficients at Run” radio button.  
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USER VIEWS 
User Views allow for saving and displaying specific information about a selected view. When a view is 
saved the following information is saved to an ASCII text file in the user defined folder. 
 

• Displayed analog channels, 
• Analog channel order, 
• Superimposed channels, 
• Analog channel colors, 
• Digital channels displayed, 
• Sampling frequency, 
• Time scale, 
• Sliding window size (RMS bar to Data bar), 
• Phasor window size, 
• Table window size, 
• Red fault bar, 
• Auto scale and 
• Phasor or circular chart displayed 

 
To save a view, first setup the desired view. Then select the “Save View” menu option under the “View” 
menu. The “Save View” dialog is displayed. Refer to Figure 5.51. 
 

 
Figure 5.51  Save View Dialog 

 
Enter the view’s name in the “View Name” field and select or enter the destination folder into the “View 
File Path” field. By selecting the destination folder, it is possible to save a hierarchy of views that allows 
for easy access to specific views according to the users preference.  
 
To select a view open the view drop down menu. Refer to Figure 5.52. The drop down menu lists the 
last seven saved/selected views. If the view is not listed click on the “More View” option to open 
Microsoft’s select file dialog. Refer to Figure 5.53. Navigate to the view’s folder and double click on the 
view file.  
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Figure 5.52  Select View Drop Down Menu 
 

 
Figure 5.53  Select View File Dialog 
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To view the details of a saved view before selecting it, open the “Select View” dialog from the “View” 
menu. Refer to Figure 5.54. The select view dialog has four sections. On the left side of the dialog is the 
list of all the available views located in the displayed view path. To change the view path either use the 
browse button or select a previous navigated directory from the “View Path” drop down list. Under the 
view files is the window’s settings defined in the file. On the right side is the view information for each 
analog channel and digital channel in the view. 
 

 
Figure 5.54  Select View Details Dialog 
 
Double click on the view file or select the file and click “OK”. If the analog channel and digital channel 
names defined in the view file are not in the displayed file than an error message is displayed. To exit 
the dialog without selecting a view, click on the “Cancel” button. 
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C H A P T E R  6  

Fields & Features 
 
This chapter describes all of the fields and features available in the software.  They are listed 
alphabetically for your convenience. 

ACTIVE TOPIC - HELP 
Location: All child windows 
 
Description: Display the active window’s Help file. 
 
Activation: Menu: Alt-H, T 

ADJUST FILES TIME 
Location: Analysis  
 
Description: The Adjust Files Time allows for adjusting the time of the open file. To open the “Adjust 

File Time” dialog select the "Adjust Files Time" menu option under the "Data" menu. You 
can specify to add or subtract a given time increment from the files current time. Enter the 
desired time increment for the hour, minutes, seconds and milliseconds. If there is no 
adjustment needed on a specific time field enter 0. 

 
Activation: Menu: Alt-D, J 
 
Comments: To always have the file's time automatically adjusted when a specific driver is used to 

open a file check the "Adjust Open Time" check box. To show the file’s original date and 

time click on the “Restore Original” button  or select the “Restore Original Data” menu 
option under the “Data” menu 

 
See Also: Adjust Files Time in Chapter 1 

ALIGN CHANNEL DATA 
Location: Analysis 
 
Description: The Align Channel Data option allows for aligning the channel data using the Thiran 3rd 

Order All-Pass Fractional filter. To open the “Align Channel Data” dialog select the "Align 
Channel Data" menu option under the "Channel" menu. Enter the phase shift for each 
analog channel. If the filter does not apply to a specific analog channel, enter 0 or leave 
the field blank. Click the “Run Thiran Filter” to apply the filter. 

 
Activation: Menu: Alt-C, T 
 
Fields: Phase Shift:  The phase shift angle for each analog channel. 

A0:   The Thiran A0 coefficient for each analog channel. 
A1:   The Thiran A1 coefficient for each analog channel. 
A2:   The Thiran A2 coefficient for each analog channel. 
A3:   The Thiran A3 coefficient for each analog channel. 
Always Apply:  Always apply the filter when opening files for the active driver. 
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Coefficients:  Calculate coefficients at run or use the entered coefficients. 
 
Options: Calculate Coefficients: Calculate the Thiran coefficients for each analog channel. 

Run Thiran Filter: Run the Thiran filter. 
Esc/Cancel:  Exit the dialog without executing the command. 

 
Comments: To always have the filter automatically applied when a specific driver is used to open a 

file check the "Always Apply" check box. To show the file’s original date and time click on 

the “Restore Original” button  or select the “Restore Original Data” menu option under 
the “Data” menu. 

 
See Also: Align Channel Data in Chapter 1 

AMETEK TR*/DL*/PQR128 DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the Ametek TR*/DL*/PQR128 driver. 
 
Activation: Menu: Alt-D, P 
 
Comments: An error message is displayed if the selected file is not a valid Ametek file. Files that have 

a “.AMT” extension or files that have the first 2 characters in the name as “ZQ” and the 
file has no extension are automatically tagged as Ametek files. 

 
See Also: Display Oscillography in Chapter 1 

Associating File Types in Chapter 1 

ANALOG MARK/UNMARK ALL 
Location: Analysis 
 
Description: Mark all analog channels if there are no analog channels marked otherwise unmark all 

the marked channels. 
 
Activation: Menu: Alt-C, N 
 
Comments: The channels ID and titles are displayed in light red when marked. Press F8 to mark or 

unmark all the analog and digital channels. 

ANALOG TABLE VIEW  
Location: Analysis  
 
Description: Displays the channel titles, ASV, units, and associated data values. 
 
Comments: Use the  button or the shift-right/left arrow keys to scroll the columns in the table.  This 

button is located to the right of the analog table headers. 
 
See Also: Viewing Analog Data in Analysis Quick Start. 



Chapter 6 – Fields & Features 

197 

ANIMATED CAD- DXF 
Location: Device Manager 
 
Description: Display the DXF window to periodically execute the device’s assigned drivers and update 

the parsed information into the appropriate graphical DXF drawing. 
 

Activation: Direct: F8 – menu button  
Menu: Alt-O, D 

 
Comments: Information parsed by the device drivers can be used to populate a CAD-DXF drawing.  

In order to populate the drawing, control points must be added to offset the parsed data.  
The word “Device”, the associated device number, and/or the device title (optional) 
indicates a control point.  For example, if the CAD-DXF reader encounters the text 
“Device 12 SEL-321” in the DXF file, the information parsed by the assigned driver is 
offset at the upper left corner of the letter “D” in the word “Device”.  Refer to Appendix B 
for more information on setting up DXF control points. 
 
DXF drawings can be created using an off the shelf program such as AutoCAD, Turbo 
CAD, Technical Visio, Drafix, or MEDUSA.  The animated CAD-DXF reader also 
supports layered objects and multiple paging views.  To activate the animated CAD-DXF 
display, click the DXF menu button or press F8. 

 
See Also: Animated CAD-DXF in the Device Manager Quick Start. 

APPEND LOGS 
Location: File Manager 
 
Description: Combine a number of log files (ABB Load Profile, Comtrade Logs and SDC Logs), of the 

same types (the columns match), into one comma delimited file with the extension .CSV.    
 
Activation: Menu: Alt-O, R, A 
 
Comments: The files must be of the same type (columns must be equal and data extracted from the 

same device).  The save file can be displayed in a table or plotted in the log data viewer. 
 
See Also: Combine Logs 

APPEND OPEN FILES 
Location: Analysis  
 
Description: Combine a number of open files of the same type (the analog/digital channel titles must 

match) in time.  All of the currently open waveform files will be appended into a new 
analysis window. 

 
Activation: Menu: Alt-F, F, D (Append the open files by Discarding the common times) 

Menu: Alt-F, F, B (Append the open files Back-to-Back) 
 
Comments: The files must be of the same type (the analog/digital channel titles must match).  The 

results in the new analysis window can be saved in a Comtrade file for archiving. 
 
See Also: Append Waveform Files 

Append Open Files in Analysis Quick Start 
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APPEND WAVEFORM FILES 
Location: File Manager 
 
Description: Combine a number of waveform files of the same types (the analog/digital channel titles 

must match) in time into an analysis window. 
 
Activation: Menu: Alt-O, W, A, D (Append waveform files by Discarding the common times) 

Menu: Alt-O, W, A, B (Append waveform files Back-to-Back) 
 
Comments: The files must be of the same type (the analog/digital channel titles must match).  The 

results in the data analysis window can be saved in a Comtrade file for archiving. 
 
See Also: Append Open Files 

Append Waveform Files in File Manager Quick Start 

ASCENDING SORT 
Location: All Tables 
 
Description: Sort the device columns in ascending order with respect to the selected sort field.   
 
Activation: Menu: Alt-S, A 
 
Comments: To change the sort field, place the cursor in the desired column and select “Set Sort 

Field” in the “Sort” menu.  The sort field is displayed in the status bar at the bottom of the 
window.  To sort the columns directly press the column header button.  The header 
buttons toggle between ascending and descending order. 

 
See Also: Descending Sort  

Sorting in the Quick Starts 

ASCII DRIVER 
Location: File Manager 
 
Description: Display the file at the cursor position in the ASCII text editor. 
 
Activation: Menu: Alt-D, 1 
 
See Also: ASCII Editor 

ASCII EDITOR 
Location: File Manager 
 
Description: Edit the ASCII file at the cursor position.  
 
Activation: Direct: F2 

Menu: Alt-O, A (Options menu) or Alt-D, 1 (Driver menu) 
 
Comments: The file content is displayed in text format.  Use the up arrow, down arrow, left arrow, 

right arrow, page up, page down, home, end, Ctrl-home and Ctrl-end keys or the scroll 
bar to navigate through the data and the Edit menu options to cut, copy, or paste text.  A 
maximum of ten ASCII Editors may be opened simultaneously.  
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ASCII EVENT FILES 
Location: Device Manager 
 
Description: View the selected device event file in an ASCII editor.  The “Type” column in the device 

table indicates the type of editor displayed: ASCII or Binary (Hexadecimal). The type 
column is defined in the device record.  To open the device record, select the device and 
press F2. 

 

Activation: Direct: F6 – menu button  
Menu: Alt-O, E 

 
Comments: The file content is displayed in text format.  Use the up arrow, down arrow, left arrow, 

right arrow, page up, page down, home, end, Ctrl-home and Ctrl-end keys or the scroll 
bar to navigate through the data and the Edit menu options to cut, copy, or paste text.  A 
maximum of ten event files may be opened simultaneously.  

ASCII TERMINAL MODE 
Location: Device Manager 
 
Description: Display the ASCII terminal mode window to transmit ASCII characters, escape 

sequences and/or Function key definitions to the output device. 
 

Activation: Direct: <Enter> – menu button  
Menu: Alt-O, T 

 
Comments: The type of terminal mode window displayed is determined by the type field (ASCII or 

Binary) defined in the device record.  To communicate with an ASCII device place the 
cursor on the desired device and press <enter> or click the Terminal menu button.  Data 
is transmitted to the output device by pressing the predefined function keys or by 
manually pressing the numeric and letter keys.  If the device does not respond, check the 
device’s communication parameters (F2) or the device connection.  Use the up arrow, 
down arrow, right arrow, left arrow, page up, and page down keys to browse the data and 
the <esc> key to exit. 

 
See Also: Function Keys 

Binary Terminal Mode 

AS STATUS FIELD 
Location: Analysis (Status Bar)  
 
Description: Displays the current state of the Auto Scaling feature (ON, OFF or ++). 
 
Comments: To toggle through the Auto Scaling options (ON, OFF or ++), press F6 or select the “Auto 

Scale” menu option from the “Options” menu.  When auto scaling is turned “ON”, the 
channel data is scaled to the maximum value allocated for display from the zero 
reference line. When auto scaling is in the “++” state the signals are plotted using the 
maximum value allocated for display, ignoring the zero reference line.  The highest value 
is plotted at the maximum position and the smallest value is plotted at the lowest position.  
This feature shows the full profile of frequency, Vdc and load channels. In the “OFF” state 
all channels are scaled according to maximum and minimum values in all of the analog 
channels. 
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See Also: ASV Column 

Auto Scaling 

ATFILE  
Location: File Manager (Status Field)  
 
Description: Displays the file number of the selected file in the table. 

ATREC  
Location: Device Manager (Status Field)  
 
Description: Displays the record number of the selected device in the table. 
 
See Also:  TotRecs 

TotMarks 

ATTAB  
Location: Animated CAD-DXF (Status Field)  
 
Description: Displays the currently highlighted tab number. 
 
See Also:  AtTab 

AUDIO WAVE DRIVER 
Location: File Manager 
 
Description: Changes the driver at the cursor position to the Window’s Audio Wave driver (*.WAV) 

and plots the input channels. 
 
Activation: Menu: Alt-D, V 
 
Comments: All files that have a “.WAV” extension are tagged as Microsoft Audio Wave files.  

AUTO DETECT DRIVER 
Location: File Manager 
 
Description: Infers the filename at the cursor position and activates the associated driver. 
 
Activation: Menu: Alt-D, Z 
 
See Also: Associating File Types in File Manager Quick Start. 

AUTO SCALING 
Location: Analysis  
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Description: Turns the state of amplitude auto scaling to On, Off or ++ for all the visible analog 
channels. 

 

Activation: Direct: F6 - ASV menu button  
Menu: Alt-D, A, F-Off, O-On and P-Plus 

 
Comments: The AS field displayed in the status bar indicates the auto scale’s current state, ON, OFF 

or ++.  When auto scaling is turned “ON”, the channel data is scaled to the maximum 
value allocated for display from the zero reference line. When auto scaling is in the “++” 
state the signals are plotted using the maximum and minimum values allocated for 
display, ignoring the zero reference line. The highest value is plotted at the maximum 
position and the smallest value is plotted at the lowest position. This feature shows the 
full profile of frequency, Vdc and load channels. In the “OFF” state all channels are 
scaled according to maximum and minimum values in all of the analog channels. 

 
See Also: Increase Amplitude 

Decrease Amplitude 
Auto Scale Multiplier 
AS Status Field 

BACKGROUND COLOR 
Location: DXF Animated CAD (Properties dialog) 
 
Description: Select the background color for the active DXF tab drawing. 
 
Activation: Direct: F2 

Menu: Alt-T, D 
 
Default: Black 

BINARY EVENT FILE 
Location: Device Manager 
 
Description: View the selected device event file in a binary editor. The “Type” column in the device 

table indicates the type of editor displayed: ASCII or Binary (Hexadecimal). The type 
column is defined in the device record. To open the device record, select the device and 
press F2. 

 
Activation: Direct: F6 

Menu: Alt-O, E 
 
Comments: The file contents are displayed in a Binary (Hex) editor. Use the up arrow, down arrow, 

page up, page down, Ctrl-home and Ctrl-end keys to navigate through the file’s data, or 
use the scroll bar. When a hex value is over written the ASCII equivalent is displayed in 
the window to the right of the editor. A maximum of ten event windows can be 
simultaneously. 

BINARY TERMINAL MODE 
Location: Device Manager 
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Description: Display a binary terminal mode window to transmit hex values and/or Function key 
definitions to the output device. 

 

Activation: Direct: <Enter> – menu button  
Menu: Alt-O, T 

 
Comments: The type of terminal mode window displayed is determined by the type field (ASCII or 

Binary) defined in the device record. To communicate with a binary device place the 
cursor on the desired device and press <enter> or click the Terminal menu button. Data 
is transmitted to the output device by pressing the predefined function keys or by 
manually pressing the hex numeric and letter keys (0..9,A..F). If the device does not 
respond, check the device’s communication parameters (F2) and/or the device 
connection. Use the up arrow, down arrow, right arrow, left arrow, page up, and page 
down keys to browse the data and the <esc> key to exit. 

 
See Also: Function Keys 

ASCII Terminal Mode 

BPRO DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the NxtPhase BPRO driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, O 
 
Comments: NxtPhase files are displayed in the IEEE Comtrade Binary format. NxtPhase has 

developed an automatic conversion application called "AutoComtrade.exe". Wavewin 
calls "AutoComtrade.exe" to convert NxtPhase files to the Comtrade binary format for 
display. To view NxtPhase relay files double click or press enter on the original BPRO 
files. To obtain a copy of the “AutoComtrade.exe” file please contact NxtPhase. 

 
Files with the .BPR extension are automatically tagged as NxtPhase BPRO files. 

 
See Also: Tesla Files in File Manager Quick Start. 
  Display Oscillography in the File Manager Quick Start 

Associating File Types in the File Manager Quick Start 

CALIBRATION REPORT 
Location: File Manager 
 
Description: Generate a calibration report for all marked event files. 
 
Activation: Menu: Alt-O, R, C 
 
Comments: The Calibration report list the Maximum and Minimum analog summary information for 

the marked files. 
 

For this feature to work properly reports should be generated on non-fault data. The 
DVREPORT.DTB file, saved in the installed directory contains the last generated report.  
To archive the contents of this file use the Save As option to save the file under a new 
name. 
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See Also:  Waveform Summary 

CHANGE DEVICE CONFIGURATION 
Location: Device Manager 
 
Description: Change the active device configuration table. 
 
Activation: Menu: Alt-D, G 
 
Comments: The “Open Device Configuration” dialog allows for selecting configurations stored in 

different directories.  Navigate to the desired directory and select the “CFG_DEVS.DTB” 
file stored in the newly selected directory.  The device table is updated with the new 
configuration and all devices are initialized. 

 
See Also: New Device Configuration 

Copy Device Records 

CHANGE DRIVE/DIRECTORY 
Location: File Manager  
 
Description: Change the file table's active path. 
 
Activation: Direct: F7, ChDir button , Back button , Up button , Right Click, Folder Tree 

Menu: Alt-F, H, Alt-F, T 
 
Comments: There is a number of ways to change the file table’s active folder. Use the folder tree to 

navigate the connected drives. To enter a folder use the “Change Drive/Directory” dialog 
located in the File menu. To select from a list of the last 12 active folders click the 
opposite mouse button in the file table. To navigate back through the last 12 active 
folders use the Back menu button. To change to the previous folder use the “Up” menu 
button. An error message is displayed if the destination path is not found.   

 
See Also:  Navigating Files in the File Manager Quick Start 

CHANGE DXF FILES 
Location: Device Manager 
 
Description: Display the “Change DXF Files” dialog to change the DXF files displayed in the Animated 

CAD-DXF window tabs. 
 
Activation: Menu: Alt-O, C 
 
Fields: DXF Files List: Lists the currently selected DXF files to display in the Animated 

CAD-DXF window.  
Background Color: Select the background color for the highlighted DXF file in the 

DXF Files List. 
Max X Pixels: Set the Max X Pixels for the highlighted DXF file in the DXF Files 

List.  
Max Y Pixels: Set the Max Y Pixels for the highlighted DXF file in the DXF Files 

List. 



Chapter 6 – Fields & Features 
 

204 

 
Options: Add:  Add one or multiple DXF file(s) to the DXF Files List. 

Delete:  Delete the highlighted DXF file(s) from the DXF Files List. 
Clear:  Clear all the listed DXF files from the DXF Files List. 
OK/Enter: Exit and save the dialog then open the animated CAD-DXF window. 
Esc/Cancel: Exit the dialog without saving the dialog data. 

 
Comments: To add a new file, click the “Add” button. A file select dialog is displayed. To select 

multiple files use the Ctrl+click or Shift+Up/Down arrows. All selected files will be added 
to the DXF files list. To delete file(s) mark the file(s) in the DXF files list and click the 
“Delete” button. To clear the list, click the “Clear” button.   

 
The DXF drawing fields for each listed file can be defined in the dialog prior to opening 
the DXF drawing window. To set up the DXF drawing fields for each listed file select the 
file and tab to the drawing fields defined below the list. This dialog will be displayed if 
there are no DXF files selected before the animated CAD-DXF option is activated. 

 
See Also: Change DXF Files in the Device Manager Quick Start. 

CHANGE FREQUENCY 
Location: Analysis 
 
Description: Change the current sampling frequency. 
 

Activation: Direct: Change Frequency menu button  
Menu: Alt-D, F 

 
Fields: Current Sampling Frequency:  The current sampling frequency. 
  Enter the New Sampling Frequency: The new sampling frequency. 
  Open Frequency:   Sets the driver to open with the new frequency. 
 
Options: Enter/Ok:    Changes frequency. 

Esc/Cancel:    Exits the dialog without executing the command. 
 
Comments: The “Open Frequency” field will set the current display driver to always convert the files to 

the new frequency before displaying. 

CHANGE PASSWORDS 
Location: Device Manager 
 
Description: Activate the Change Passwords feature to verify modem connections and to 

automatically change the password on devices directly or remotely connected to the 
Wavewin system. 

 
Activation: Menu: Alt-O, P 
 
Comments: This feature secures all the existing modem and network connections to digital relays, 

communication processors, port switches and/or any other type of remotely accessible 
device used in the company. Upon activation change passwords performs the following 
steps for each connected device: 
 

• As applicable dial, switch to, or Ethernet connect and logon. 
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• Generate a new random password, 6 characters in length. 
• Change the old password to the new one using the appropriate communication 

driver. 
• Confirm the password was successfully changed. 
• Upon confirmation, update the password file (SETPSW.CSV), the database file 

(CFG_SHOT.DTB) and the device table. 
• Logout from the active device and as applicable hang-up, switch out or terminate 

the Ethernet connection. 
• Retry failures if any errors where encountered (up to 3 retries per failure). 

 
A small summary file is created in the system directory containing the performance 
results.  It is saved to the company network if any failed connections or logon attempts 
were detected. 
 
The random password generator is seeded once upon initial execution to ensure even 
distribution across a 6 character spectrum.  The new passwords are stored in 
SETPSW.CSV.  Before activation the existing SETPSW.CSV file is renamed using the 
IEEE long file naming format including the current date and time and the company name 
fields only, example: 040909,123456789,,,,South Electric,,,,.CSV”. 

 
See Also: Change Passwords in the Device Manager Quick Start. 

CHANGE QUERY OPERATORS 
Location: Query Fields 
 
Description: Change the operator for the active query field. 
 
Activation: Direct: F9 

Menu: Alt-Q, O 
 
Comments: To change the operator press F9 or click the mouse button on the operator symbol. 
 
See Also:  Equal To (=),  

Greater Than (>),  
Less Than (<) 

CHANNEL BACKGROUND COLOR 
Location: Analysis 
 
Description: Change the background colors for the analysis window. The background colors fields are 

listed in the “Window Properties” dialog under the “Colors” tab. 
 
Activation: Menu: Alt-F, T, Color’s Tab 

CHANNEL INFORMATION (ON/OFF) 
Location: Analysis 
 
Description: Show or hide the channel information table displayed in the frame to the right of the 

analog and digital traces. 
 
Activation: Direct: Analog table close button  
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Menu: Alt-V, C 
 
Comments: The channel information frame can be resized by selecting the vertical separator bar and 

dragging it to the right or left. The cursor changes to the vertical resize cursor when the 
mouse is positioned over the separator bar. 

CLEAR ANALOG COLORS 
Location: Analysis 
 
Description: Set the analog channel colors to the default color, black. 
 
Activation: Menu: Alt-C, C 
 
Comments: To change the color of an analog channel click the right mouse button on the channel ID 

or channel title. 

CLEAR QUERY AREA 
Location: Query Fields 
 
Description: Set all the query fields to blanks and default the query operators to equal (=). 
 
Activation: Direct: F8 

Menu: Alt-Q, C 

COMBINE LOGS 
Location: File Manager 
 
Description: Combine a number of log files (ABB Load Profile, Comtrade Logs and SDC Logs), of 

different types (different columns), into one comma delimited file with the extension .CSV.   
 
Activation: Menu: Alt-O, R, L 
 
Comments: The files can be of different types (columns do not have to be equal).  The substation and 

device names for the data will be added as the first two columns in the file.  The result file 
can be displayed in a table. 

 
See Also: Append Logs 

COMBINED VIEW 
Location: Analysis 
 
Description: Display all the selected information contained in the analog table in a condensed form. 
 
Activation: Direct: F4 

Menu: Alt-V, A 
 
Comments: Use the F4 key to toggle between the tabular view and the combination view.  The 

combination view is only available if there is enough space between the analog channels 
to display three lines of text.  To change the position of the data values select the 
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“Window Properties” option from the “File” menu, then click on the “Analog Combination” 
tab. 

 
See Also: Viewing Analog Information in the Analysis Quick Start. 

COMMA DELIMITED TABLE DRIVER  
Location: File Manager 
 
Description: Display the selected comma delimited file in a table format.  Comma delimited files have 

textual fields separated by commas, such as 0001,7834,872. 
 
Activation: Menu: Alt-D, 3, C 
 
Comments: The file data is presented in tabular form.  An unlimited number of rows and columns can 

be displayed. 
 
See Also: Viewing ASCII Files in Database Format in the File Manager Quick Start. 

Double Quotes/Comma Delimited Table Driver 
Tab Delimited Table Driver 

COMNAME PROPERTIES  
Location: File Manager 
 
Description: Setup the fields not available in the supported waveform files for the IEEE long file 

naming format. 
 
Activation: Menu: Alt-F, O 
 
Fields: Company Name: Enter the Company name that will be used in the long naming 

format. 
Time Code: Enter the time code for the device files to rename. 

  User Field 1:  Enter the 1st User Field. 
  User Field 2:  Enter the 2nd User Field. 
 
Options: Enter/Ok:  Save the entered data. 

Esc/Cancel:  Exit the dialog without saving. 
 
Comments: These fields are used for all the files renamed to the IEEE long file naming format.  

Update this dialog for file with different time code, latitude and longitude coordinates. 
 
See Also: ComName(s) Rename in the File Manager Quick Start 

ComName Properties in the File Manager Quick Start 
ComName(s) Rename 

COMNAME(S) RENAME  
Location: File Manager 
 
Description: Rename all the marked time sequenced data file to the IEEE long file naming format. 
 
Activation: Menu: Alt-F, A 
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Comments: A message box will be prompted before renaming the file to insure the execution of the 
rename feature.  This feature will permanently rename the files.  It is advisable to back up 
the files before renaming.  Some proprietary applications may not be able to read the files 
once they are renamed. 

 
See Also: ComName(s) Rename in the File Manager Quick Start. 

ComName Properties 

COMPANY COLUMN  
Location: File Manager 
 
Description: Displays the company name associated with the long file name.  The sixth field in the file 

name defines the company field for the IEEE long file-naming format. 
 
See Also: Long File Naming Format in the File Manager Quick Start. 

COMPANY NAME (SAVE & ARCHIVE) 
Location: Device Manager - Save & Archive Dialog 
 
Description: The name of the company where the connected devices are installed.  The company 

name is used in the IEEE long file naming format.  The sixth field in the file name defines 
the company name. 

 
Comments: The following characters are not permitted in a file name. :  ?  “  /  \  <  >  *  |  @  # and 

cannot be part of the company name. 
 
See Also: Long File Naming Format in the Device Manager Quick Start. 

COMPRESS COMTRADE FILES  
Location: File Manager 
 
Description: Convert all the marked COMTRADE ASCII files to COMTRADE Binary files. 
 
Activation: Menu: Alt-O, C 
 
Comments: This feature compresses the COMTRADE ASCII file size.  It is useful for porting files to 

floppy or transferring files through a medium. 
 
See Also: Compressing COMTRADE Files in the File Manager Quick Start. 

COMTRADE DRIVER 
Location: File Manager 
 
Description: Change the driver at the cursor position to the COMTRADE driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, 5 
 
Comments: All files that have a “.DAT” or ‘’D##” file extension, and a corresponding “.CFG” file are 

tagged as COMTRADE files.  If the selected file does not have a corresponding “.CFG” 
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file an error message is generated.  Both the COMTRADE ASCII and Binary formats are 
supported. 

CONDENSE TIME 
Location: Analysis 
 
Description: Condense the time scale for all visible channels. 
 

Activation: Direct: Ctrl-Page Down or the Condense menu button  
Menu: Alt-D, C  

 
See Also: Expand Time 

COPY/CUT/PASTE FILES 
Location: File Manager 
 
Description: Copy or Cut the marked files to the clipboard.  Navigate to the destination folder and 

Paste the files. 
 
Activation: Direct: Ctrl-X (Cut) , Ctrl-C (Copy) , Ctrl-V (Paste)  

Menu: Alt-E, T (Cut), Alt-E, C (Copy), Alt-E, P (Paste) 
 
Comments: Marked files are displayed in red.  The TotMarks and MrkSize fields displayed in the 

status bar are updated accordingly.  To copy/cut/paste files use the Edit menu options, 
the shortcut keys or right click in the file table and select the desired option.  

 
See Also:  Copy File 

Move Files 
Mark/Unmark File 

COPY DEVICE RECORDS 
Location: Device Manager 
 
Description: Copy the marked device records to the system clipboard files. 
 
Activation: Menu: Alt-D, Y 
 
Comments: Device records can be copied from one configuration to another.  To copy device records 

mark the desired records in the device table (marked devices are displayed in red) then 
select the “Copy” menu option under “Device” menu.  The marked records will be copied 
to the “DEV_CLIPBOARD.CLP” and the devices function keys will be copied to the 
“LOG_CLIPBOARD.CLP”.  These files are cleared before each copy operation. 

 
See Also: Change Device Configuration 

New Device Configuration 
Paste Device Records 

COPY FILES 
Location: File Manager 
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Description: Copy the marked files to the specified destination path.  If the path does not exist, type 

the directory name in the edit box.  The system prompts prior to creating the directory. 
 

Activation: Direct: F8 or the Copy menu button  
Menu: Alt-F, C 

 
Fields: Directory Name: The destination path where the marked files are to be copied.  

To specify a new path type the path directly into this edit box. 
Directories: Displays a tree of the system’s directories, double click to open a 

node in the tree and click on the desired directory to highlight it. 
  Files:   Displays a list of the files in the highlighted directory. 
  Drives:   A list of all the connected drives.  Select the desired drive. 
 
Options: Enter/Ok:  Copy the marked files to the destination path. 

Esc/Cancel:  Exit the dialog without executing the command. 
 
Comments: Marked files are displayed in red.  The TotMarks and MrkSize fields displayed in the 

status bar are updated accordingly.  Files that where unsuccessfully copied are marked 
and grouped at the top of the table. 

 
See Also:  Move Files 

Mark/Unmark File 

COPY TEXT 
Location: ASCII Event File 
 
Description: Copy the blocked text to the clipboard. 
 
Activation: Direct: Ctrl-C, Ctrl-Ins - Copy menu button  

Menu: Alt-E, C 
 
Comments: To block text use the shift key plus the up arrow, down arrow, page up and page down 

keys or the drag the mouse. 
 
See Also:  Cut Text 

Paste Text 

CREATE DIRECTORY 
Location: File Manager 
 
Description: Create a new directory. 
 
Activation: Menu: Alt-F, E 
 
Fields: Directory: The new directory's name. 
 
Options: Enter/Ok: Create the new directory. 

Esc/Cancel: Exit the dialog without executing the command. 
 
Comments: If there is no path defined the new directory is placed in the active directory. 
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CUT TEXT 
Location: ASCII Event File 
 
Description: Copy the blocked text to the Windows clipboard then delete the blocked text. 
 
Activation: Direct: Ctrl-X, Shift-Del - Cut menu button  

Menu: Alt-E, T 
 
Comments: Use the shift keys and the up arrow, down arrow, page up and page down keys to block 

text. 
 
See Also:  Copy Text 

Paste Text 

CYCLE HOP 
Location: Analysis  
 
Description: Move the data bar (vertical black solid line) one cycle forward or backward in time. 
 
Activation: Direct: Shift-Ctrl-Left arrow and Shift-Ctrl-Right arrow 
 
Comments: Use the shift+ctrl left/right keys to move one cycle in time.  The number of cycles is 

displayed in the status bar with the Reference bar (vertical blue dotted line) as the 
reference position. 

 
See Also:  Data Bar 

D&T 
Location: Analysis (Status Field)  
 
Description: Displays the data and time of the sample at the data bar. 
 
See Also:  Delta X Field 

DATA BAR 
Location: Analysis 
 
Description: Displays the channel’s instantaneous sample value.  The data bar is the solid black line 

that runs vertically across the analog and digital channels.   
 
Comments: The data bar is used to view channel information (such as analog sample values, RMS 

values, digital information, data and time…).  The information is displayed in the channel 
frame positioned to the right of the traces and in the status bar. The Ctrl-Left/Right keys 
moves the data peak to peak and the Shift-Ctrl-Left/Right keys moves the data one cycle 
in time. 

 
See Also:  RMS bar 

Reference bar 
Horizontal Bars 
Cycle Hop 
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Peak Hop 
Fault Bar 

DECREASE AMPLITUDE 
Location: Analysis 
 
Description: Decrease the amplitude of all or marked analog channels. 
 
Activation: Direct: Ctrl-Down Arrow or the AmpDn menu button  

Menu: Alt-D, D 
 
Comments: When the channels’ amplitude is decreased the Trace Scale Multiplier is divided into the 

Pixsdisp value.  To change the Trace Scale Multiplier, select “Window Properties” from 
the “File” menu then select the “Display Settings” tab. 

 
See Also: Increase Amplitude 

Trace Scale Multiplier  

DELETE DEVICES 
Location: Device Manager 
 
Description: Tag all the marked device records as deleted records. 
 
Activation: Direct: Delete 

Menu: Alt-D, D 
 
Comments: Marked records are displayed in red.  The TotMarks field displayed in the status bar is 

updated accordingly.  Records that were unsuccessfully deleted are marked and grouped 
at the top of the table. 

 
Restrictions: The marked records are tagged as deleted records and will not show up in the table 

again.  They are not physically removed from the device database (CFG_DEVS.DTB) file 
but are marked as deleted. 

 
See Also: Mark/Unmark Records 

DELETE FILES 
Location: File Manager 
 
Description: Remove all the marked files and empty directories from the active directory. 
 
Activation: Direct: Delete 

Menu: Alt-F, D 
 
Comments: Marked files and directories are displayed in red.  The TotMarks and MrkSize fields 

displayed in the status bar are updated accordingly.  Files and directories that were 
unsuccessfully deleted are marked and grouped at the top of the table. 

 
Restrictions: A marked directory must be empty in order to remove it from the file table. 
 
See Also: Mark/Unmark File 
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DELETE TEXT 
Location: ASCII Event File 
 
Description: Delete the blocked text from the file. 
 
Activation: Direct: Del 

Menu: Alt-E, D  
 
Comments: Use the shift keys and the up arrow, down arrow, page up and page down keys to block 

text. 
 
See Also:  Cut Text 

DELTA X 
Location: Analysis (Status Field)  
 
Description: Displays the time in microseconds, milliseconds, or seconds between the RMS bar and 

the data bar.  The number of cycles is also displayed if the samples in the file are 
microseconds or milliseconds apart. 

 
See Also:  D&T Field 

RMS bar 

DELTA Y 
Location: Analysis (Status Field)  
 
Description: Displays the difference between the data horizontal bar and the reference horizontal bar. 
 
See Also:  Delta X Field 

DESCENDING SORT 
Location: All Tables 
 
Description: Sort the device columns in descending order with respect to the selected sort field. 
 
Activation: Menu: Alt-S, D 
 
Comments: To change the sort field, place the cursor in the desired column and select “Set Sort 

Field” in the Sort menu.  The sort field is displayed in the status bar at the bottom of the 
window.  To sort the table columns directly press the column header button.  The header 
buttons toggle between ascending and descending order. 

 
See Also: Ascending Sort  

Sorting Devices in the Quick Starts 

DEVICE COLUMN  
Location: File Manager 
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Description: Displays the device name associated with the long file name.  The fifth field in the file 
name defines the device field for the IEEE long file-naming format.  It represents the 
name or code of the device that originated the file.   

 
See Also: Long File Naming Format in the File Manager Quick Start. 

DEVICE FIELD 
Location: IEEE Long File Name  
 
Description: The 5th field in the IEEE long file naming format.  The title and device number columns 

are used for the device field in the long naming format.  The device number is 
concatenated to the title by the #, example SEL 351#83. 

 
See Also: Long File Naming Format in the Device Manager Quick Start. 

DFR I II IIB & 2000 DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the Hathaway DFR I II IIB and 2000 driver. 
 
Activation: Menu: Alt-D, 6 
 
Comments: An error message is displayed if the system cannot find the files DAU header file or there 

was a problem reading the file. 
 
See Also: Display Oscillography in the File Manager Quick Start 

Associating File Types in the File Manager Quick Start 

DIGITAL MARK/UNMARK ALL 
Location: Analysis 
 
Description: Marked all digital channels if there are no digital channels marked else unmark all the 

marked digital channels. 
 
Activation: Menu: Alt-C, I 
 
Comments: The channels ID and titles are displayed in light red when marked.  Press F8 to mark or 

unmark all the analog and digital channels. 

DISPLAY DIALOG 
Location: All Tables 
 
Description: Reposition the columns in the table. 
 
Activation: Menu: Alt-O, I 
 
Fields: File Column List: A list of all the columns in the table. 

Table Font Size: A list of the font sizes for the table. 
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Options: Move Up: Move the highlighted column before the previous column. 
Move Down: Move the highlighted column after the next column. 
Reset: Default the order of the columns to how they were when the software 

was first installed. 
OK:  Change the order of the columns and redraw the device table. 
Cancel:  Exit the dialog without executing the command. 

 
Comments: To resize the table columns place the mouse over the column separator and drag the 

mouse to the left or the right or double click on the column separator to expand to the 
maximum area for that column. 

 
See Also:  Customizing the Table in the Quick Starts 

Resize Columns 

DISTURBANCE REPORT  
Location: File Manager (Universal Viewer) 
 
Description: Create a disturbance report from the defined fault files. 
 
Activation: Menu: Alt-O, R, D 
 
Fields: Destination File:  The folder and filename where the report is saved. 

Source Folder(s):  The source folder(s) where the event files are located. 
  Filter: Faulted Phases:  Enter the valid faulted phases (separated by commas). 
  Filter: Fault Location:  Enter the maximum % of the line length to detect. 

Filter: Voltage Class: Enter the voltage kv value that is above the phase to 
ground level. 

Filter: Fault Current: Enter the minimum magnitude value. 
Filter: System Frequency: Enter the deviation from the line frequency to detect. 

 
Options: Process:   Process the report and display the results. 

Save Script:   Save the entered values to the Disturbance.ini script file. 
Edit Script:   Edit the Disturbance.ini script file. 
Show Help:   Show the help file below the buttons. 
Close:    Close the disturbance dialog without saving. 

 
Comments: The result disturbance report is saved to the defined destination file and displayed in a 

comma delimited table. The table allows for sorting, querying, deleting of rows and 
saving. 

 
See Also: Disturbance Report in the File Manager Quick Start. 

DLP1/DLP3 DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Plot the contents of the oscillography file using the DLP1/DLP3 driver.  If the driver 

encounters an error while reading the file an “Invalid Driver Message” is displayed 
indicating the line number in which the error was encountered.  Use the ASCII or 
Hexadecimal editors to locate and correct the error.  The ASCII and hexadecimal editors 
display the cursor’s line and character number in the lower left corner of the window. 

 
Activation: Menu: Alt-D, C 
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Comments: An error message is displayed if the file is not a valid DLP file.  All files that have an 
“.OSC” extension are tagged as DLP files.  

DOUBLE QUOTES/COMMA DELIMITED TABLE DRIVER  
Location: File Manager 
 
Description: Display the double quote delimited file in a table format.  Double quote-delimited files 

have textual fields separated by double quotes and commas, such as 
“CHANNEL”,”DATE”,”TIME”. 

 
Activation: Menu: Alt-D, 3, Q 
 
Comments: The file data is presented in tabular form.  An unlimited number of rows and columns can 

be displayed. 
 
See Also: Viewing ASCII Files in Database Format in the File Manager Quick Start. 

Comma Delimited Table Driver 
Tab Delimited Table Driver 

DRAWING PROPERTIES 
Location: DXF Animated CAD 
 
Description: Display the DXF “Drawing Properties” dialog to define the background color and Zoom X 

& Y resolution values. 
 

Activation: Direct: F2, menu button  
Menu: Alt-T, D 

 
Fields: Background Color: Set the DXF drawings background color. 

Max X Pixels: Set the DXF drawings max X pixels for display. 
Max Y Pixels: Set the DXF drawings max Y pixels for display. 

 
Options: Apply:  Apply and save the changes made without exiting the dialog. 

Enter/OK: Exit, apply and save the changes made. 
Esc/Cancel: Exit the dialog without executing or saving the changes made. 

 
Comments: Use the tab or shift+tab keys to navigate between the fields and the up and down arrow 

keys to view the selectable options. 
 
See Also: Drawing Properties in Chapter 1 

DRIVER COLUMN  
Location: File Manager 
 
Description: Displays the display driver associated with the file. 
 
See Also: Associating File Types in Chapter 1. 
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DRIVER CONFIGURATION DIALOG 
Location: File Manager 
 
Description: Display the driver configuration dialog.  The driver configuration dialog allows for setting 

certain features pertaining to a specific driver. 
 
Activation: Menu: Alt-O, N 
 
Fields: Driver List:  A list the supported drivers in the system. 
  Devices Data Type: Select the type of data that the device saves (RMS or Peak). 

Device Header Dir: Enter a localized directory for all support files needed to display 
the files. 

Default Frequency: Enter the default frequency to display the device’s file when the 
files are first displayed. 

 
Options: Ok:   Save the changes made and close the dialog. 

Cancel:   Ignore any changes made and close the dialog. 
 
Comments: The file data is presented in tabular form.  An unlimited number of rows and columns can 

be displayed. 
 
See Also: Driver Configuration in the File Manager Quick Start.  

DRIVER DATA TYPE 
Location: Analysis 
 
Description: Set the active display driver’s data type. 
 

Activation: Direct: Window Properties menu button  
  Menu: Alt-F, T, Driver Data Type Tab 
 
Comments: The data stored in the displayed file can be instantaneous values or RMS values.  The 

default setting for all drivers is instantaneous values.  If the display device saves the 
sample values as RMS calibrated then select RMS Calibrated Type from the drop down 
list.  If the data type is RMS Calibrated and the data type is not set to RMS calibrated 
type then the analog column data will be displayed incorrectly. 

DUPLICATE CYCLES 
Location: Analysis 
 
Description: Duplicate the cycle between the Data bar and the RMS bar. 
 

Activation: Direct: Duplicate Cycles menu button  
  Menu: Alt-D, L 
 
Fields: # Cycles: Enter the number of time to duplicate the highlighted cycle(s). 
 
Options: Enter/Ok: Duplicate the highlighted cycle(s) . 

Esc/Cancel: Exit the dialog without executing the command. 
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Comments: This feature is useful for creating test set files or for creating file to play back into 
simulation or modeling applications. 

 
See Also:  Duplicate cycles in the Analysis Quick Start. 

Truncate Cycles 

DUPLICATE DEVICE RECORD 
Location: Device Manager 
 
Description: Duplicate the selected device record in the table.  
 
Activation: Menu: Alt-D, U 
 
Fields: Device Settings:  

Device Number: Set the number of the device. Each device must have a unique 
number.  The device number is used in the IEEE long file naming 
format. 

Address: Set the address of the device. The address can be the port 
number off a 2020/2030 or a modbus address. 

Station ID: Set the ID number for the station each station must have a 
unique number. 

Data Type: Select the type of data being polled (ASCII/Binary). 
Print : Select if the data polled is sent to the connected printer (On/Off). 
Title: Set the device title. 
Driver: Select the main driver that will poll the device. 
Station Name: Set the station name. 
Time Code: Select the main driver that will poll the device. 
EscSeq: The EscSeq field contains 7 separate fields separated by a 

blank. Set the appropriate information in the appropriate fields.  
The fields can contain passwords, phone numbers, file names, 
FTP settings, TCP/IP settings for a specific device refer to the 
“Device Configuration” document. 

Port Settings:  
Port Number: Select the COM port number from the list of COM ports 

registered on the machine or enter a new COM port number.  
For TCP/IP and FTP connections each device must have a 
unique COM port number. 

Baud Rate: Select the port’s baud rate. 
Parity: Select the port’s parity (None, ODD, Even, Mark). 
Data Bits: Select the port’s Data Bits (7 or 8). 
Stop Bits: Select the port’s stop bits (1 or 2). 
Flow Control: Select the port’s flow control (None, Software or Hardware). 
Terminal Settings:  
CR/LF: Select if a CR/LF is added after a TX string, RX string, both or 

none in terminal mode. 
Local Echo: Select if the transmitted text is echoed to the terminal window. 
Terminal Settings:  
CR/LF: Select if a CR/LF is added after a TX string, RX string, both or 

none in terminal mode. 
TX Delay:  
Inter Char Delay: Enter the number of milliseconds to wait when transmitting 

characters to the device. 
 
Options: Save/Enter: Exit and save the dialog fields. 
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Esc/Cancel: Exit the dialog without saving the dialog fields. 
 
Comments: The selected device in the table is duplicated as a new record at the end of the table.  

The device number must be changed.  All device numbers must be unique.  An error 
message will be displayed if any invalid fields are encountered.  The Title and Substation 
fields are used in the IEEE long file naming format.  The following characters (:  ?  “  /  \  <  
>  *  |  @  #) are not valid in file names and cannot be used in the title and substation 
fields. 

 
See Also: New Device Record 

Edit Device Record 

DXF ANIMATED CAD 
Location: Device Manager 
 
Description: Poll the devices defined in a graphical one line diagrams and display the parsed data. 
 
Activation: Menu: Alt-O, D 
 
Comments: For the DXF window to poll the connected devices the polling drivers must be written and 

configured and the DXF drawings must have the device control points defined.  Refer to 
Appendix A for an example of polling drivers and Appendix B for setting control points in 
a DXF file. 

 
See Also:  Animated CAD/DXF in the Device Manager Quick Start. 

Appendix A 
Appendix B 

DXF CONTROL DIALOG 
Location: DXF Animated CAD 
 
Description: Display the “DXF Control” dialog to communicate directly to a device. 
 

Activation: Direct: menu button  
Menu: Alt-T, O 

 
Fields: Control Menu List: Select the DXF tab containing the device to communicate with, 

select the device then select the communication driver. 
 
Options: Operate/Enter: Exit the dialog and execute the selected communication driver. 

Esc/Cancel: Exit the dialog without executing the communication driver. 
 
Comments: The “Control Menu” list box to the right contains all tab names displayed in the DXF 

window.  Select the tab to send commands to.  Once a tab is selected the list is updated 
with all the devices defined the tab’s drawing.  Select the device to communicate with.  
The list again is updated with the available communication drivers defined in the 
“Drivers.ini” file.  The “Control Level” window is updated upon entry into each level. Once 
the communication driver is selected the “DXF Control” dialog is closed and the 
command is sent to the selected device.  The device’s response is parsed and updated in 
the selected DXF tab. 

 
See Also: DXF Control in the Device Manager Quick Start. 
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DXF DRIVER 
Location: File Manager 
 
Description: Displays the file(s) drawing information in graphical form. 
 
Activation: Menu: Alt-D, 4, S or M 
 
Comments: An error message is displayed if the file is not a valid DXF file.  All files that have the 

“.DXF” extension are tagged as DXF files.  A single file can be opened or multiple files 
can be opened at the same time.  For multiple files first mark the files then select Marked 
files from the DXF submenu option. 

EDIT DAU-DEF 
Location: File Manager 
 
Description: Display the DAU-DEF editor for Hathaway DAU-DEF files.  The DAU-DEF editor allows 

for changing certain fields defined in the DAU-DEF records.  A Windows file selection 
dialog is display to select the DAU-DEF to edit.  Navigate to the desired directory and 
double click on the DAU-DEF file to edit. 

 
Activation: Menu: Alt-O, E 
 
Fields: DAU-DEF Records: A list the all DAU-DEF records defined in the selected file. 
  Analog Channels: A list of all the analog channels defined for the selected record. 

Analog Name: Edit the analog name for the selected analog channel. 
Analog Full Scale: Edit the analog full scale value for the selected analog channel. 
Analog Prefix: Edit the analog prefix for the selected analog channel. 
Analog Unit: Edit the analog unit for the selected analog channel. 
Event Channels: A list of all the event channels defined for the selected record. 
Event #: Edit the event’s number for the selected event channel. 
Event Name: Edit the event name for the selected event channel. 
Event NoNc: Edit the event’s normally open normally close value for the 

selected event channel. 
Sensor Channels: A list of all the sensors channels defined for the selected record. 
Sensor #: Edit the sensor number for the selected sensor channel. 
Sensor Name: Edit the sensor name for the selected sensor channel. 
Sensor NoNc: Edit the sensor’s normally open normally close value for the 

selected sensor channel. 
 
Options: Save:   Save the selected DAU-DEF record. 

Ok:   Save all changes made and close the dialog. 
Cancel:   Ignore any changes made and close the dialog. 
Default Sensor #8:  Checking this option will always default Sensor channel #8;s 

NoNc value to be 1.  
 
Comments: When this feature is activated a Windows file selection dialog is display, navigate to the 

desired directory and double click on the DAU-DEF file to edit. 
 
See Also: Edit DAU-DEF in the File Manager Quick Start. 

EDIT DEVICE RECORD 
Location: Device Manager 
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Description: Edit the selected device record in the table. 
 

Activation: Direct: F2 –menu button  
Menu: Alt-D, E 

 
Fields: Device Settings:  

Device Number: Set the number of the device. Each device must have a unique 
number.  The device number is used in the IEEE long file naming 
format. 

Address: Set the address of the device. The address can be the port 
number off a 2020/2030 or a modbus address. 

Station ID: Set the ID number for the station each station must have a 
unique number. 

Data Type: Select the type of data being polled (ASCII/Binary). 
Print : Select if the data polled is sent to the connected printer (On/Off). 
Title: Set the device title. 
Driver: Select the main driver that will poll the device. 
Station Name: Set the station name. 
Time Code: Select the main driver that will poll the device. 
EscSeq: The EscSeq field contains 7 separate fields separated by a 

blank. Set the appropriate information in the appropriate fields.  
The fields can contain passwords, phone numbers, file names, 
FTP settings, TCP/IP settings for a specific device refer to the 
“Device Configuration” document. 

Port Settings:  
Port Number: Select the COM port number from the list of COM ports 

registered on the machine or enter a new COM port number.  
For TCP/IP and FTP connections each device must have a 
unique COM port number. 

Baud Rate: Select the port’s baud rate. 
Parity: Select the port’s parity (None, ODD, Even, Mark). 
Data Bits: Select the port’s Data Bits (7 or 8). 
Stop Bits: Select the port’s stop bits (1 or 2). 
Flow Control: Select the port’s flow control (None, Software or Hardware). 
Terminal Settings:  
CR/LF: Select if a CR/LF is added after a TX string, RX string, both or 

none in terminal mode. 
Local Echo: Select if the transmitted text is echoed to the terminal window. 
Terminal Settings:  
CR/LF: Select if a CR/LF is added after a TX string, RX string, both or 

none in terminal mode. 
TX Delay:  
Inter Char Delay: Enter the number of milliseconds to wait when transmitting 

characters to the device. 
 
Options: Save/Enter: Exit and save the dialog fields. 

Esc/Cancel: Exit the dialog without saving the dialog fields. 
 
Comments: An error message will be displayed if any invalid fields are encountered.  The Title and 

Substation fields are used in the IEEE long file naming format.  The following characters 
(:  ?  “  /  \  <  >  *  |  @  #) are not valid in file names and cannot be used in the title and 
substation fields. 

 
See Also: New Device Record 
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Duplicate Device Record 

EMAIL FILES 
Location: File Manager and  Analysis 
 
Description: Email a group of files or a single file using the users default email application.  All support 

files needed to display the selected files will be automatically attached.  Support files 
include Comtrade configuration (*.CFG), header (*.HDR) & information (*.INF) files, 
DFR’s analog and digital information files such as: Hathaway DAU files, Rochester 
preamble and header files, Faxtrax/Director CTL files, Transcan SCF and TCF files. 

 
Activation: Menu: File Manager: Alt-F, L  Analysis: Alt-F, E 
 
Fields: To:   Recipient of the email, initially empty. 

From: Sender, automatically defaulted. 
Subject: Empty. 
Attachment: All selected files and their support files automatically attached. 

 
Comments: Files can be email either in the file table or in the analysis window. To email a set of files, 

mark the desired files in the file table and select the “Email Marked Files” option from the 

“File” menu or right click on the file table and select the “Email”  option from the 
pop-up menu.  To email a file from the analysis window select the “Email Active File” 
option under the “File” menu.  All support files needed to display the file(s) are 
automatically attached. 

 
See Also: Email Files and Email Active File in the File Manager and Analysis Quick Starts. 

EMAX LONG TERM DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the Emax Long Term driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, Q 
 
Comments: If the selected file is not a valid EMAX Long Term file an error message is generated.  All 

files that have the “.DAT” extension along with a corresponding .SET file are tagged as 
EMAX Long Term files. 

 
See Also: Display Oscillography in the File Manager Quick Start 

Associating File Types in the File Manager Quick Start 

EQUAL TO (=) 
Location: Query Fields 
 
Description: Search the active configuration for records that match the entered criteria. 
 
Comments: To change the query operator press F9 or click the mouse button on the operator symbol. 
 
See Also:  Greater Than (>) 

Less Than  (<) 
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EXPAND TIME 
Location: Analysis 
 
Description: Expand the time scale of all visible analog channels. 
 

Activation: Direct: Ctrl-Page Up or the Expand menu button  
Menu: Alt-D, E 

 
See Also: Condense Time 

EXPORT 
Location: Device Manager 
 
Description: Export all or marked devices to a tab delimited ASCII file. 
 
Comments: This feature is useful for changing common information for all devices quickly. For 

example if a COM port number has changed for a number of devices then those devices 
can be exported. The export file can be opened in “Excel” and all of the Com port fields 
can be changed easily. To import the changes back into the device configuration table 
use the “Import” menu option under the “Device” menu. 

 
See Also:  Import 

F-TYPE COLUMN  
Location: File Manager 
 
Description: Displays the file type.  The “/dr” indicates that the file is a sub-directory.  The DAU ID 

number is displayed for DFR I, II, IIB and 2000 files and the extension of the file is 
displayed for all other files. 

 
Comments: If the active directory is a sub-directory then the first 2 rows of the table are reserved for 

the “.” and “..” navigation shortcuts.  The “.” is a shortcut to the root directory and the “..” 
is a shortcut to the previous directory.   

FAULT BAR 
Location: Analysis 
 
Description: The Fault bar is the red dotted line that runs vertically across the analog and digital 

channels.   
 
Comments: The fault bar is fixed and positioned at the fault time defined in the configuration file. The 

fault bar can be shown or hidden by selecting “Yes” or “No” for the “Show Vertical Fault 
Bar” field in the properties dialog under the “Display Settings” tab.   
 

See Also:  Data bar 
RMS Bar 
Reference Bar 
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FAULT DATE COLUMN  
Location: File Manager 
 
Description: Displays the fault date of the oscillography files.  This column is left blank if the file is not 

a valid oscillography file or the fault date and time is not available in the file name.   
 
See Also: Fault Time Column 

FAULT REFERENCE TIME BAR 
Location: Analysis 
 
Description: Displays the time difference from the fault time defined in the displayed file.  The units are 

displayed in the Delta X status field. 
 
Comments: The fault reference time bar is displayed between the analog channels and the digital 

channels.  To show or hide the fault reference time bar open the “Window Properties” 
dialog under the “File” menu.  Click the “Display Settings” tab and toggle the “Show 
Reference Time Bar” field. 

 
See Also: Fault Reference Time Bar in the Analysis Quick Start 

FAULT TIME COLUMN  
Location: File Manager 
 
Description: Displays the fault time of the oscillography files.  This column is left blank if the file is not 

a valid oscillography file or the fault date and time is not available in the file name.   
 
See Also: Fault Date Column 

FAXTRAX II (12-BIT) & DIRECTOR DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the Faxtrax II (12-bit) driver or the Director 

format depending on the format of the file. 
 
Activation: Menu: Alt-D, 8 
 
Comments: If the selected file does not have a corresponding “.CTL” file an error message is 

generated.  All files that have the “.RCD”, “.RCL” and “.RCU” extensions, and there is a 
corresponding “.CTL” file in the same directory, are tagged as Faxtrax/Director files. 

FILE NAME COLUMN  
Location: File Manager 
 
Description: Displays the name of the files/directories in the active directory. 
 
Comments: If the active directory is a sub-directory then the first 2 rows of the table are reserved for 

the “.” and “..” navigation shortcuts.  The “.” is a shortcut to the root directory and the “..” 
is a shortcut to the previous directory. 
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See Also: F-Type Column 

FLIP MARKS 
Location: All Tables 
 
Description: Mark all the unmarked records and unmark all the marked records. 
 
Activation: Menu: Alt-M, F  
 
Comments: Marked records are displayed in red.  The TotMarks field displayed in the status bar is 

updated accordingly. 
 
See Also: Unmark Marked Records 

Mark/Unmark Records 

FOLDER TREE 
Location: File Manager 
 
Description: Displays all connected drives and folders in a tree structure. 
 
Activation: Menu: Alt-F, T – Toggle Show/Hide Tree  
 
Comments: To show/hide the folder tree select the “Show/Hide Folder Tree” option under the “Files” 

menu.  Folders can be renamed by left mouse clicking on the folder name until the editor 
is displayed. Also, folders that reside on the computer can be sent to the recycle bin by 
selecting the “Delete” option under the folder tree’s right click pop-up menu. If the folders 
reside on external drives then they are permanently deleted. 

 
See Also: Navigating in the File Manager Quick Start 

Change Drive/Directory 

FPRO DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the NxtPhase FPRO driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, O 
 
Comments: NxtPhase files are displayed in the IEEE Comtrade Binary format. NxtPhase has 

developed an automatic conversion application called "AutoComtrade.exe". Wavewin 
calls "AutoComtrade.exe" to convert NxtPhase files to the Comtrade binary format for 
display. To view NxtPhase relay files double click or press enter on the original FPRO 
files. To obtain a copy of the “AutoComtrade.exe” file please contact NxtPhase. 

 
Files that have an “.FPR” extension are automatically tagged as NxtPhase FPRO files. 

 
See Also: Tesla Files in the File Manager Quick Start 
  Display Oscillography in the File Manager Quick Start 

Associating File Types in the File Manager Quick Start 
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FREE   
Location: File Manager (Status Field)  
 
Description: Displays the amount of free hard disk space on the active drive, displayed in Kbytes. 
 
See Also:  Size 

MrkSize 

FS 
Location: Analysis (Status Field)  
 
Description: Displays the sampling frequency of the sample at the data bar. 

FST 
Location: Waveform Summary (Events/Sensors Activity Summary)  
 
Description: Displays the status of the first digital samples in the file.  Fst is the first column in the 

Events/Sensors Activity Summary.  A=Alarm, N=Normal. 
 
Comments: This data is also displayed in the second column of the digital information table view. 

FST-CHANGE   
Location: Waveform Summary (Events/Sensors Activity Summary)  
 
Description: Displays the date and time the channel first changed state.  Fst-Change is the third 

column in the Events/Sensors Activity Summary. 
 
Comments: This data is also displayed in the forth column of the digital information table view. 

FTP CONNECTION 
Location: Device Manager 
 
Description: Define the selected device to collect fault records using the FTP protocol. 
 

Activation: Direct: Ethernet configuration button  in the Device Configuration dialog. 
 
Fields: Ethernet Connections: Select the FTP client option from the list box.  The fields in the 

connection properties changes according to the selection in the 
connections list box. 

Connection Properties:  
Port Number: Set the FTP port number. 21 is designated as the FTP port 

number. 
IP Address: Set the device’s IP address. 
User Name: Set the FTP sessions user name. 
Password: Set the FTP sessions password. 
Remote Path: Set the device’s FTP remote path to poll. 
Local Path: Set the path on the local machine where the downloaded file are 

saved. 



Chapter 6 – Fields & Features 

227 

File Types: Set the type of file to download, leave blank to check all files. 
File Names: Set how to name the downloaded files, (0 – Don’t change, 1 – 

change to the IEEE long file naming format maintaining the 
original file’s extension, 2 – change to the IEEE long file naming 
format and make the file’s extension to the Tesla *.TLR). 

 
Options: OK/Enter:  Exit and update the Device’s EscSeq field. 

Cancel/Esc:  Exit the dialog without saving the changes made. 
 
Comments: If the Local Path does not exist then the directory will be created. 
 
See Also: New Device Record 

Duplicate Device Record 
Edit Device Record 
TCP/IP Client 
TCP/IP Server 

FUNCTION KEYS 
Location: Device Manager 
 
Description: Setup the device’s Function keys to be displayed in the terminal mode window. 
 

Activation: Direct: F5, menu button  
Menu: Alt-O, F 

 
Fields: F1-9 : name: The function key name displayed in the Terminal Mode window. 

TX: A string of ASCII characters or hexadecimal values transmitted 
to the connected device. 

 
Options: Enter/Save:  Exit the dialog and save the function keys (CFG_SHOT.DTB). 

Esc/Cancel:  Exit the dialog without executing the command. 
 
Comments: Programmable function keys allow for a string of ASCII characters or hexadecimal values 

to be transmitted to the output device through a single keystroke.  The function keys are 
active in ASCII and hexadecimal terminal emulators.  Each device contains up to nine 
function keys. 

 
See Also: ASCII Terminal Mode 

Binary Terminal Mode 

GROUP MARKED ANALOG CHANNELS 
Location: Analysis 
 
Description: Group all the marked analog channels and move them to the top of the display area. 
 
Activation: Menu: Alt-C, G 
 
See Also: Mark/Unmark Channels 

GROUP MARKED ROWS 
Location: All Tables 
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Description: Group all the marked rows and move them to the top of the table. 
 
Activation: Menu: Alt-M, G 
 
See Also: Unmarked Marked Rows 

Toggle Marked Rows 
Mark/Unmark Row 

HARMONICS TABLE 
Location: Analysis  
 
Description: View the harmonics table. 
 
Activation: Direct: F11, Right click on phasor diagram or information header 

Menu: Alt-V, T 
 
Comments: The harmonics table displays the number of harmonics according to the file’s sampling 

frequency with a maximum of 200 harmonics supported. The table displays one channel 
at a time.  It will display the 1st marked analog channel, or if no channels are marked then 
the first visible channel.  The harmonic calculation is performed on one cycle of data, 
starting at the RMS bar to the data bar.  The display values include DFT Peak, DFT 
RMS, DFT Angles, % of fundamental and % of TrueRMS.  When the data bar is moved in 
the data plotting window the harmonics values will be automatically updated.  To view the 

harmonics in a histogram click on the harmonics toggle  button located next to the 
channel name. 

 
See Also: Harmonics in the Analysis Quick Start 

Histogram 
Harmonics Vectors 

HARMONIC VECTORS 
Location: Analysis  
 
Description: View the harmonics vectors in the phasor diagram. 
 
Activation: Menu: Alt-V, H 
 
Comments: The harmonics of the first marked analog channel, or if no channels are marked then the 

first visible analog channel, is displayed in a vector format in the phasor diagram.  The 
harmonic calculation is performed on one cycle of data.  It starts at the RMS bar and 
goes forward one cycle.  To hide/show the harmonic vectors toggle the "Vector 
Harmonics" menu option under the "View" menu from checked=ON to unchecked=OFF. 

 
See Also: Harmonics in the Analysis Quick Start 

Histogram 
Harmonics Table 

HELP 
Location: All Child Windows.  
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Description: Displays the help file for the active child window. 
 
Activation: Direct: F1 

Menu: Alt-H, T 
 
Comments: The information contained in the help window is organized in the following fashion:  

Specific Features for the active window, 
Function Keys, 
Menu Options, 
Button Menu Bar, 
Cursor Keys, 
Mouse Actions and 
Status Bar 

HEXADECIMAL EDITOR 
Location: File Manager 
 
Description: Edit the file at the cursor position in a binary editor. 
 
Activation: Direct: F3 

Menu: Alt-O, X 
 
Comments: The file contents are displayed in a Hex editor.  Use the up arrow, down arrow, page up, 

page down, Ctrl-home and Ctrl-end keys to navigate through the file’s data, or use the 
scroll bar.  When a hex value is over written the ASCII equivalent is displayed in the 
window to the right of the editor.  A maximum of 10 viewing windows can be 
simultaneously.  The F4 and F3 function keys allow for searching ASCII data or Hex 
values.  To search for hex values insert the “#” character before the hex value in the 
“Find Text” field. 

HEXADECIMAL DRIVER 
Location: File Manager 
 
Description: Change the driver at the cursor position to the Hexadecimal driver and display the file in 

binary format. 
 
Activation: Menu: Alt-D, 2 
 
See Also: Hexadecimal Editor 

HIDE MARK(S) 
Location: Analysis  
 
Description: Hide all the marked analog channels and re-space the unmarked channels. 
 
Activation: Direct: Delete 

Menu: Alt-C, H 
 
Comments: To mark/unmark an analog channel, click the channel ID or the channel data. 
 
See Also: View Mark(s) 
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Show All Hidden 
Restore Mark(s) 

HISTOGRAM 
Location: Analysis  
 
Description: View the harmonics histogram. 
 
Activation: Direct: F11, Right click on phasor diagram or information header 

Menu: Alt-V, T 
 
Comments: The histogram displays the number of harmonics according to the file’s sampling 

frequency with a maximum of 200 harmonics supported. The histogram displays one 
channel at a time.  It will display the 1st marked analog channel, or if no channels are 
marked then the first visible channel.  The harmonic calculation is performed on one 
cycle of data, starting at the RMS bar to the data bar.  The display values can be DFT 
Peak, DFT RMS, DFT Angles, % of fundamental and % of TrueRMS. The default view is 
% of fundamental. To change the data displayed click on the drop down menu button 

and select from the list. When the data bar is moved in the data plotting window 
the harmonics values will be automatically updated.  To view the harmonics in a table 

click on the harmonics toggle  button located next to the channel name. 
 
See Also: Harmonics in the Analysis Quick Start 

Harmonics Table 
Harmonics Vectors 

HORIZONTAL BARS 
Location: Analysis  
 
Description: Displays a solid black line that follows the data bar and displays a dotted blue line that 

follows the reference bar.   
 
Activation: Menu: Alt-V, B 
 
Comments: The bars will be positioned at the first marked analog channel (displayed in red).  If no 

channels are marked then they are positioned at the first displayed channel.  The Delta Y 
field in the status bar shows the difference between the two bars. 

 
See Also:  RMS bar 
  Data Bar 
  Reference Bar 

HP-DIF   
Location: Waveform Summary 
 
Description: Displays the absolute value of the HPeak-Up minus the absolute value of the HPeak-Dn 

divided by the OneBit value. 
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Comments: The Hpeak-Up value is the highest positive peak in the channel.  The Hpeak-Dn is the 
highest negative peak in the channel.  The OneBit value is the channel's full-scale value 
divided by the channel's resolution. 

 
See Also: Viewing Waveform Summaries in the File Manager Quick Start 

HPEAK-DN   
Location: Waveform Summary 
 
Description: The highest negative peak value in the channel. 
 
See Also: Viewing Waveform Summaries in the Analysis Quick Start 

HPEAK-UP   
Location: Waveform Summary 
 
Description: The highest positive peak value in the channel. 
 
See Also: Viewing Waveform Summaries in the File Manager Quick Start 

IEEE LONG FILE NAMING FORMAT 
Location: IEEE Long File Name 
 
Description: All data polled from the connected devices are saved to files using the IEEE long file 

naming format.  The start date and time comes from the data polled and the time code, 
substation name, device name, and company name comes from the fields in the device 
record. 

 
See Also: Long File Naming Format in the Device Manager Quick Start. 

IMPORT 
Location: Device Manager 
 
Description: Import all changes made to the exported tab delimited ASCII file. 
 
Comments: The import feature is used to import all device information from the exported tab delimited 

ASCII file. It is advisable to always keep a backup of the existing Device Configuration 
files before using the import feature. This allows for a quick recovery if any of the 
changes made to the export file were incorrect. The 3 files to backup are the 
CFG_DEVS.DTB, CFG_SHOT.DTB & DRIVERS.INI files located in the Wavewin 
directory. 

 
To import a previously exported file select the “Import” menu option under the “Device” 
menu. Enter the exported files path and filename or use the “Browse” button to select the 
file. All device information contained in the imported file will be updated in the active 
device configuration table. 

 
See Also:  Export 
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INCREASE AMPLITUDE 
Location: Analysis  
 
Description: Increase the amplitude of all or marked analog channels. 
 
Activation: Direct: Ctrl-Up arrow or the AmpUp menu button  

Menu: Alt-D, I 
 
Comments: When the channels’ amplitude is increased the Trace Scale multiplier is multiplied into 

the Pixsdisp value.  To change the Trace Scale Multiplier select “Window Properties” 
from the “File” menu then select the “Display Settings” tab. 

 
See Also: Decrease Amplitude 

Auto Scale Multiplier 

INSTPEAK COLUMN 
Location: Analysis (Analog Table)  
 
Description: Displays the peak value measured between the two reference crossings surrounding the 

data bar (black solid line).  The value is displayed as Peak type.  If the data type for the 
loaded driver is set to RMS calibrated then the value is multiplied by the square root of 2. 

 
Comments: The value is displayed as Peak type.  If the data type for the loaded driver is set to RMS 

calibrated then the value is multiplied by the square root of 2. 
 
See Also: Viewing Analog Data in the Analysis Quick Start 

INSTVAL COLUMN 
Location: Analysis (Analog Table)  
 
Description: Displays the instantaneous sample value at the data bar. 
 
Comments: This value is multiplied by the square root of 2 if the driver’s data type is set to RMS 

calibrated. 
 
See Also: Viewing Analog Data in the Analysis Quick Start 

Data Bar 

INTELLIRUPTER DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the S&C IntelliRupter driver. 
 
Activation: Menu: Alt-D, S 
 
Comments: An error message is displayed if the selected file is not a valid IntelliRupter file. Files that 

have a “.WFC” extension are automatically tagged as IntelliRupter files. 
 
See Also: Display Oscillography in the File Manager Quick Start 

Associating File Types in the File Manager Quick Start 
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LATITUDE FIELD 
Location: IEEE Long File Name  
 
Description: An optional field in the IEEE long file naming format.  The latitude defines the 

geographical position of the substation associated with the file name.  The letter N 
indicates latitude in the Northern Hemisphere. 

 
See Also: Long File Naming Format in Chapter 1. 

LESS THAN (<) 
Location: Query Fields 
 
Description: Search the active configuration for records that are less than the entered criteria. 
 
Comments: To change the operator press F9 or click the mouse button on the operator symbol. 
 
See Also:  Equal To (=) 

Greater Than (>) 

LP-DIF 
Location: Waveform Summary 
 
Description: Displays the absolute value of the LPeak-Up minus the absolute value of the LPeak-Dn 

divided by the OneBit value. 
 
Comments: The Lpeak-Up value is the lowest positive peak in the channel.  The Lpeak-Dn is the 

lowest negative peak in the channel.  The OneBit value is the channel's full-scale value 
divide by the channel's resolution. 

 
See Also: Viewing Waveform Summaries in the File Manager Quick Start 

LPEAK-DN   
Location: Waveform Summary 
 
Description: The lowest negative peak value in the channel. 
 
See Also: Viewing Waveform Summaries in the File Manager Quick Start 

LPEAK-UP   
Location: Waveform Summary 
 
Description: The lowest positive peak value in the channel. 
 
See Also: Viewing Waveform Summaries in the File Manager Quick Start 

LPRO DRIVER 
Location: File Manager (Universal Viewer) 
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Description: Change the driver at the cursor position to the NxtPhase LPRO driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, O 
 
Comments: NxtPhase files are displayed in the IEEE Comtrade Binary format. NxtPhase has 

developed an automatic conversion application called "AutoComtrade.exe". Wavewin 
calls "AutoComtrade.exe" to convert NxtPhase files to the Comtrade binary format for 
display. To view NxtPhase relay files double click or press enter on the original LPRO 
files. To obtain a copy of the “AutoComtrade.exe” file please contact NxtPhase. 

 
Files that have an “.LPR” extension are automatically tagged as NxtPhase LPRO files. 

 
See Also: Tesla Files in the File Manager Quick Start 
  Display Oscillography in the File Manager Quick Start 

Associating File Types in the File Manager Quick Start 

LST   
Location: Waveform Summary (Events/Sensors Activity Summary)  
 
Description: Displays the status of the last digital samples in the file.  Lst is the second column in the 

Events/Sensors Activity Summary.  A=Alarm, N=Normal. 
 
Comments: This data is also displayed in the third column of the digital information table view. 

LST-CHANGE 
Location: Waveform Summary (Events/Sensors Activity Summary)  
 
Description: Displays the date and time the digital channel last changed state.  Lst-Change is the forth 

column in the Events/Sensors Activity Summary.   
 
Comments: This data is also displayed in the fifth column of the digital information table view. 

MARK ALL ROWS 
Location: All Tables 
 
Description: Mark all the rows in the table. 
 

Activation: Direct: Mark menu button (if no files are marked).  
Menu: Alt-M, A 

 
Comments: Marked rows are displayed in red.  The TotMarks field displayed in the status bar is 

updated accordingly.  The Mark menu button toggles between marking and unmarking all 
rows in the table. 

 
See Also: Unmarked Marked Rows 

Flip Marks 
Group Marked Rows 
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MARK/UNMARK ALL CHANNELS 
Location: Analysis 
 
Description: Unmark all analog & digital channels if the total number of marked channels is less than 

the total number of displayed channels otherwise mark all the channels. 
  
Activation: Direct: F8 

Menu: Alt-C, M 
 
Comments: When an analog channel is marked the ID, title, ASV, and units are displayed in light red.  

When a digital channel is marked the ID and titles are displayed in light red.  To mark or 
unmark a channel click the channel’s corresponding ID number or title, or use the space 
bar. 

MARK/UNMARK ROW 
Location: All Tables 
 
Description: Toggle the row at the cursor position between the marked and unmarked state. 
 
Activation: Direct: Spacebar, Ctrl-Left Mouse Click 

Menu: Alt-M, M 
 
Comments: Marked rows are displayed in red.  The TotMarks field displayed in the status bar is 

updated accordingly.  The Mark menu button toggles all the rows in the table between the 
marked and unmarked state. 

MARK CHANGE IN SIGN 
Location: Analysis 
 
Description: Mark all positions in the analog channels where the waveform changes in sign. 
  
Activation: Menu: Alt-A, H 
 
Comments: A small gray triangle marks the change in sign position. 
 
See Also: Mark Raw Values 

Mark Peak Values 

MARK PEAK VALUES 
Location: Analysis 
 
Description: Mark all positive and negative peaks on the analog channels. 
  
Activation: Menu: Alt-A, H 
 
Comments: A small gray square marks the positive and negative peaks. 
 
See Also: Mark Change in Sign 

Mark Raw Values 
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MARK RAW VALUES 
Location: Analysis 
 
Description: Mark all the raw samples read from the active waveform file. 
  
Activation: Menu: Alt-A, M 
 
Comments: A small hollow blue circle is placed at the raw samples read from the file. 
 
See Also: Mark Change in Sign 

Mark Peak Values 

MAX X PIXELS  
Location: DXF Animated CAD (Drawing Properties Dialog)  
 
Description: Displays the total number of X pixels allocation for the active DXF drawing. 
 

Activation: Direct: F2 – drawing properties menu button  
Menu: Alt-T, D 

 
Comments: This value changes automatically when the Zoom In/Out features are used and is 

updated accordingly in the DXF status bar. 
 
See Also: Zoom In 

Zoom Out 
Zoom X, Y Resolution Properties 

MAX Y PIXELS  
Location: DXF Animated CAD (Drawing Properties Dialog)  
 
Description: Displays the total number of Y pixels allocation for the active DXF drawing. 
 

Activation: Direct: F2 – drawing properties menu button  
Menu: Alt-T, D 

 
Comments: This value changes automatically when the Zoom In/Out features are used and is 

updated accordingly in the status bar. 
 
See Also: Zoom In 

Zoom Out 
Zoom X, Y Resolution Properties 

MAXPEAK COLUMN 
Location: Analysis (Analog Table)  
 
Description: Displays the maximum peak value of the channel. 
 
Comments: If the active driver’s data type is set to RMS calibrated then the files maxpeak value is 

multiplied by Root 2. 
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See Also: Viewing Analog Data in the Analysis Quick Start 

MAXVAL COLUMN 
Location: Analysis (Analog Table)  
 
Description: Displays the maximum value of the channel. 
 
Comments: This column is displayed if the active driver’s data type is set to Non-Sinusoidal-Log Files. 
 
See Also: Viewing Analog Data in the Analysis Quick Start 

MAXWIN COLUMN 
Location: Analysis (Analog Table)  
 
Description: Displays the absolute maximum value between the RMS bar (black dotted line) and the 

data bar (black solid line). 
 
Comments: This column is displayed if the active driver’s data type is set to Non-Sinusoidal-Log Files. 
 
See Also: Viewing Analog Data in the Analysis Quick Start 

Data Bar 
RMS Bar 

MDAR REL 301/302 DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the MDAR REL 301/302 driver and plot the 

input channels. 
 
Activation: Menu: Alt-D, D 
 
Comments: If the selected file is not a valid REL file an error message is generated.  All files that 

have the “.REL” extension are tagged as MDAR REL files.  The MDAR REL driver uses 
circular interpolation techniques to convert the input sampling frequency to a higher 
frequency suitable for display.  The input sampling frequency is 8 samples per cycle (45 
degrees apart). 

MEDIUM DISPLAY 
Location: Analysis 
 
Description: Display the analog channel using the maximum pixels allowed with no zero reference 

point.  The medium display is activated through the Auto Scale feature. 

Activation: Direct: F6, - Auto Scale button  
Menu: Alt-D, A, P 

 
Comments: The Auto Scale toggles between (Off, On and ++).  ++ plots the signal using the number 

of maximum pixels allowed for the channel.  The highest value is plotted at the maximum 
position allowed and the smallest value is plotted at the lowest position allowed.  This 
feature was added to clearly show the profile of frequency, Vdc and load data channels. 
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See Also: Scaling Analog Channels in the Analysis Quick Start 
 AS Status Field 
 Auto Scaling 

MERGE OPEN FILES 
Location: Analysis 
 
Description: Merge the visible or marked channels from all the open analysis windows into a new data 

window.  There are three Merge options available.  Merge files “By Time” will merge only 
the common times in the open files.  Merge files “Manually” will merge the data according 
to the positions of the data bars in each open window.  Merge files “By Sample” will 
merge the files by lining up the samples in each open window. 

 
Activation: Menu: Alt-F, G, B-“By Time”, M-“Manually”, S-“By Sample” 
 
Comments: To distinguish between the merged channels the station name is placed before each 

channel merged.  To deactivate this feature open the “Window Properties” dialog, select 
the “Append/Merge” tab and click the “Merge Files” option.  If the files have different 
sampling frequencies a dialog will be display to select the frequency for the new window. 

 
See Also: Merge Open Files in the Analysis Quick Start 
 Merge Waveform Files 

MERGE WAVEFORM FILES 
Location: File Manager 
 
Description: Merge all the channels from the marked waveform file into a analysis window.  There are 

two Merge options available.  Merge files “By Time” will merge only the common times in 
the open files.  Merge files “By Sample” will merge the files by lining up the samples in 
each open window. 

 
Activation: Menu: Alt-O, W, M, B-“By Time”, S-“By Sample” 
 
Comments: To distinguish between the merged channels the station name is placed before each 

channel merged.  To deactivate this feature open the analysis “Window Properties” 
dialog, select the “Append/Merge” tab and click the “Merge Files” option.  If the files have 
different sampling frequencies a dialog will be display to select the frequency for the new 
window. 

 
See Also: Merge Waveform Files in the File Manager Quick Start 
 Merge Open Files 

MINPEAK COLUMN 
Location: Analysis (Analog Table)  
 
Description: MinPeak is the column that displays the minimum peak value of the channel. 
 
Comments: If the active driver’s data type is set to RMS calibrated then the files minpeak value is 

multiplied by Root 2. 
 



Chapter 6 – Fields & Features 

239 

See Also: Viewing Analog Data in the Analysis Quick Start 

MINVAL COLUMN 
Location: Analysis (Analog Table)  
 
Description: Displays the minimum value of the channel. 
 
Comments: This column is displayed if the active driver’s data type is set to Non-Sinusoidal-Log Files. 
 
See Also: Viewing Analog Data in the Analysis Quick Start 

MOVE FILES 
Location: File Manager 
 
Description: Copy the marked files to the specified destination path then delete the files from the 

source directory.  If a file is not copied successfully it is marked and grouped at the top of 
source directory.  To create a new destination directory enter the name into the 
Directories edit box.  The system prompts prior to creating the new directory. 

 

Activation: Direct: F9, - Move menu button  
Menu: Alt-F, M 

 
Fields: Directory Name: The destination path where the marked files are to be moved.  

To specify a new path, type the path directly into this edit box. 
Directories: Displays a tree of the system’s directories, double click to open a 

node in the tree and click on the desired directory to highlight it. 
  Files:   Displays a list of the files in the highlighted directory. 
  Drives:   A list of all the connected drives.  Select the desired drive. 
 
Options: Enter/Ok:  Move the marked files to the selected destination path. 

Esc/Cancel:  Exit the dialog without executing the command. 
 
Comments: Marked files are displayed in red.  The TotMarks and MrkSize fields displayed in the 

status bar are updated accordingly.   
 
See Also:  Copy Files 

Mark/Unmark File 

MOVE RMS BAR TO REFERENCE BAR 
Location: Analysis 
 
Description: Move the RMS bar (black dotted line) to the sample at the Reference bar position (blue 

dotted line). 
 
Activation: Direct: Ctrl-Z – Set RMS bar menu button  

Menu: Alt-V, R 
 
Comments: The RMS and Data bars define the RMS sliding window. 
 
See Also: Setting the Cursor Bars in the Analysis Quick Start 
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RMS Bar 

MOVE REFERENCE BAR TO DATA BAR 
Location: Analysis 
 
Description: Move the Reference bar (blue dotted line) to the sample at the Data bar position (black 

solid line). 
 
Activation: Direct: Ctrl-A – Set Reference Bar menu button  

Menu: Alt-V, M 
 
Comments: The Delta time field (Delta X) in the status bar at the bottom of the screen displays the 

time difference between the reference bar and the data bar.  If the time difference 
between the samples is in milliseconds or microseconds then the number of cycles 
between the two bars is also displayed.   

 
See Also: Setting the Cursor Bars in the Analysis Quick Start 

Data Bar 
Reference Bar 

MRKSIZE   
Location: File Manager (Status Field)  
 
Description: Displays the combined size  (in Kbytes) for all marked files. 
 
See Also:  Size 

Free 

MULTIPORT INTERROGATION DISPLAY (MID) 
Location: Device Manager 
 
Description: Display the MID window to periodically execute the device’s assigned drivers and 

updates the parsed information into the device panel. 
 

Activation: Direct: F7 – menu button  
Menu: Alt-O, M 

 
Comments: The Multiport Interrogation Display (MID) contains four device panels per page.  A 

maximum of 999 device panels can be opened at one time.  To activate the MID window 
press F7.  If no devices are marked, all devices assigned a driver are displayed and 
polled.  Use the up, down, page up, and page down keys to view the device panels.  
When F7 is pressed the device’s TXCOMMAND assigned in the DRIVERS.INI file is 
periodically sent to the output device.  The response data is parsed by the RXSTRIP 
commands and updated in the device panel.  Each panel displays the device title (Hdr), 
the assigned active device drive (Drv), the device number (Dev#), and the number of 
times the driver executed (Cycle). 

 
See Also: Multiport Interrogation Display in the Device Manager Quick Start 
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NEW DEVICE CONFIGURATION 
Location: Device Manager 
 
Description: Open a new device configuration table with 0 devices defined in the table and database 

files. 
 
Activation: Menu: Alt-D, W 
 
Comments: A “Select Directory” dialog allows for selecting an existing directory or for creating a new 

directory for the new configuration.  To create a new directory type the directory name in 
the “Directory Name” field.  If the directory does not exists the system prompts a 
message for confirmation to create the directory.  The “CFG_DEVS.DTB” and 
“CFG_SHOT.DTB” files are created with zero records.  If these files exist in the selected 
directory then they are cleared.  The system will prompt a message asking to copy the 
existing “DRIVERS.INI” file to the new configuration directory   Select “Yes” to use the 
existing “DRIVERS.INI” for the new configuration or “No” to create a new “DRIVERS.INI” 
file. 

 
See Also: System Files in the Device Manager Quick Start  

New Device Record 
Duplicate Device Record 

NEW DEVICE RECORD 
Location: Device Manager 
 
Description: Create a new device record in the table. 
 

Activation: Direct: F4 –menu button  
Menu: Alt-D, N 

NEW DEVICE CONFIGURATION 
Location: Device Manager 
 
Description: Open a new device configuration table with 0 devices defined in the table and database 

files. 
 
Activation: Menu: Alt-D, W 
 
Fields: Device Settings:  

Device Number: Set the number of the device. Each device must have a unique 
number.  The device number is used in the IEEE long file naming 
format. 

Address: Set the address of the device. The address can be the port 
number off a 2020/2030 or a modbus address. 

Station ID: Set the ID number for the station each station must have a 
unique number. 

Data Type: Select the type of data being polled (ASCII/Binary). 
Print : Select if the data polled is sent to the connected printer (On/Off). 
Title: Set the device title. 
Driver: Select the main driver that will poll the device. 
Station Name: Set the station name. 
Time Code: Select the main driver that will poll the device. 
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EscSeq: The EscSeq field contains 7 separate fields separated by a 
blank. Set the appropriate information in the appropriate fields.  
The fields can contain passwords, phone numbers, file names, 
FTP settings, TCP/IP settings for a specific device refer to the 
“Device Configuration” document. 

Port Settings:  
Port Number: Select the COM port number from the list of COM ports 

registered on the machine or enter a new COM port number.  
For TCP/IP and FTP connections each device must have a 
unique COM port number. 

Baud Rate: Select the port’s baud rate. 
Parity: Select the port’s parity (None, ODD, Even, Mark). 
Data Bits: Select the port’s Data Bits (7 or 8). 
Stop Bits: Select the port’s stop bits (1 or 2). 
Flow Control: Select the port’s flow control (None, Software or Hardware). 
Terminal Settings:  
CR/LF: Select if a CR/LF is added after a TX string, RX string, both or 

none in terminal mode. 
Local Echo: Select if the transmitted text is echoed to the terminal window. 
Terminal Settings:  
CR/LF: Select if a CR/LF is added after a TX string, RX string, both or 

none in terminal mode. 
TX Delay:  
Inter Char Delay: Enter the number of milliseconds to wait when transmitting 

characters to the device. 
 
Options: Save/Enter: Exit and save the dialog fields. 

Esc/Cancel: Exit the dialog without saving the dialog fields. 
 
Comments: A “Select Directory” dialog allows for selecting an existing directory or for creating a new 

directory for the new configuration.  To create a new directory type the directory name in 
the “Directory Name” field.  If the directory does not exists the system prompts a 
message for confirmation to create the directory.  The “CFG_DEVS.DTB” and 
“CFG_SHOT.DTB” files are created with zero records.  If these files exist in the selected 
directory then they are cleared.  The system will prompt a message asking to copy the 
existing “DRIVERS.INI” file to the new configuration directory   Select “Yes” to use the 
existing “DRIVERS.INI” for the new configuration or “No” to create a new “DRIVERS.INI” 
file. 

 
Comments: Some of the fields are set to default values such as: port number, baud rate, parity, data 

bits, stop bits and flow control.  The device number is a required field and must be 
unique.  An error message will be displayed if any invalid fields are encountered. 

 
See Also: New Device Record  

Edit Device Record 
Duplicate Device Record 

NEW FILE 
Location: ASCII Editor 
 
Description: Open a new empty ASCII edit window with the title defaulted to Untitled. 
 
See Also: Open File 
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ONEBIT   
Location: Waveform Summary 
 
Description: Displays the analog channel's full-scale value divide by the channel's resolution. 
 
Comments: The OneBit value is used to calculate the HP-Dif and the LP-Dif. 
 
See Also: Viewing Waveform Summaries in the File Manager Quick Start 

HP-Dif 
LP-Dif 

OPEN ALL MARKED WAVEFORM FILES 
Location: File Manager 
 
Description: Open all the marked waveform files in the file table and minimize the file table. 
 
Activation: Menu: Alt-O, W, F 
 
Comments: All the marked waveform files are opened, tiled and the file table is minimized.  A 

maximum of 10 data windows can be open at one time. 
 
See Also: Open All Marked Files in the File Manager Quick Start 

OPEN FILE   
Location: ASCII Editor 
 
Description: Open the window open file dialog box to select an existing file.  The open file will be put 

in a new ASCII edit window. 
 
See Also: New File 

OPTIONAL COLUMNS  
Location: File Manager 
 
Description: The IEEE PSRC long file naming convention allows for user defined fields appended at 

the end of the filename.  The file table reserves 4 columns for the first 4 user defined 
fields.  The columns are named Optional-1 to Optional-4. 

 
See Also: Long File Naming Format in the File Manager Quick Start 

PASTE DEVICE RECORDS 
Location: Device Manager 
 
Description: Paste the device records from the system clipboard files to the active device 

configuration. 
 
Activation: Menu: Alt-D, T 
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Comments: Device records copied to the system clipboard files (“DEV_CLIPBOARD.CLP”, 
“LOG_CLIPBOARD.CLP”) can be pasted into the active device configuration files.  After 
each paste operation the device table is updated and all devices are initialized. 

 
See Also: Change Device Configuration 

New Device Configuration 
Copy Device Records 

PASTE TEXT 
Location: ASCII Editor 
 
Description: Paste the contents of the clipboard into the document at the cursor position.  Existing 

blocked text is overwritten with the contents of the clipboard. 
 
Activation: Direct: Ctrl-V, Shift-Ins - Paste menu button  

Menu: Alt-E, P 
 
Comments: Use the shift keys and the up, down, page up and page down keys to block file text. 
 
See Also:  Copy Text 

Cut Text 

PATH/FILENAME (NO EXT.) 
Location: Save as COMTRADE Dialog (ASCII/Binary) 
 
Description: Displays the destination path and filename of the new COMTRADE file. 
 
Comments: The oscillography file at the cursor position is saved in COMTRADE format to the 

specified filename.  When specifying a filename do not enter an extension, the “.CFG” 
and “.DAT” files are automatically created.  If a path is not specified the files are saved to 
the active directory. 

 
Restrictions: The filename cannot contain an extension. 

PHASOR/CIRCULAR CHART SCALE MULTIPLIER (ASM) 
Location: Analysis (Window Properties Dialog)  
 
Description: Used as a multiplier to increase/decrease the length of a vector in the phasor diagram or 

to increase/decrease the circular chart data. 
 
Activation: Menu: Alt-F, T, “Display Settings” Tab 
 
Range: Greater Than 1.00 
 
Default: 2.00 
 
Comments: When a channel's amplitude is increased, the phasor/circular chart scale value is 

multiplied with the Pixsdisp value, and when the channel's amplitude is decreased the 
phasor/circular chart scale value is divided by the Pixsdisp value. 
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PIXSDISP COLUMN 
Location: Analysis 
 
Description: Displays the number of pixels allocated for the channels.   

 
Comments: When a channels’ amplitude is increased or decreased the trace scale multiplier, set in 

the “Window Properties” dialog, is multiplied or divided with the PixsDisp values in the 
analog information table.  To increase or decrease the channels’ amplitude, select 
“Increase Amplitude” or “Decrease Amplitude” from the Data menu.  If no channels are 
marked, all channels are scaled accordingly. 

 
See Also: Trace Scale Multiplier  

Auto Scaling 

PLAY CHANNELS AUDIO 
Location: Analysis 
 
Description: Plays the audio of the first marked analog channel. If no channels are marked then it 

plays the audio of the first displayed channel. 
 
Activation: Menu: Alt-D, P 
 
Fields: Analog Channel: Title of the active analog channel. 

Save Audio: Active saving the analog channel data to the window’s .WAV 
format. 

  Audio Filename: The path and name of the saved .WAV file. 
  Drives:   A list of all the connected drives.  Select the desired drive. 
 
Options: Play:   Play the active analog channels data. 

Volume:  Decrease/Increase the volume of the output. 
 
Comments: Marked channels are displayed in red. The “Active Channel” section displays the active 

analog channel in the analysis window. The “Audio Controls” section allows for playing 
the active analog channel’s data through the computers speakers and for 
increasing/decreasing the volume of the output. The “Save .WAV File” section allows for 
saving the analog channel data in the Window’s .WAV format. Click the folder button  
to select and destination directory and to enter a new “.WAV” file or for selecting an 
existing “.WAV” file. The selected file path and name will be updated in the “Audio 
Filename” field. 

 
See Also:  Play Channels Audio in the Analysis Quick Start 

PRIMARY VALUES 
Location: Analysis (Analog Table)  
 
Description: The values displayed in the analog table are either in primary or secondary quantities. If 

the file defines the type of values saved then the type is displayed in the window header. 
Also, if the CT and PT ratios are defined in the configuration file then the values can be 
changed from primary to secondary and vice versa. To change the values open the 
properties dialog and click on the “Driver Data Type” tab, select the Primary or Secondary 
radio button to switch between values. 
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See Also: Changing Analog Values in the Analysis Quick Start 
Secondary Values 

PRINT ALL DATA 
Location: Analysis 
 
Description: Print all the data for the visible analog and digital channels. 
 
Activation: Menu: Alt-F, P, A 
 
Comments: The printer must be registered in the system's WIN.INI file.  The printed pages include the 

page number and the date/time of the first sample in the page.  The channel information 
is printed at the end of the data.  Use the print page option to print only the contents of 
the data window. 

   
See Also: Printer Setup 

PRINT ALL ROWS 
Location: All Tables 
 
Description: Print all the rows in active table. 
 
Activation: Menu: Alt-F, P, A  
 
Comments: The printer must be registered in the system's WIN.INI file.  Use the Print Marked option 

to print only the marked files. 
 
See Also:  Printer Setup 

PRINT DXF FILE 
Location: DXF Animated CAD 
 
Description: Print the contents of the active DXF file. 
 
Activation: Menu: Alt-T, P, F 
 
Comments: The printer must be registered in the system's WIN.INI file.  Use the Print DXF Page 

option to print only the contents displayed in the window. 
 
See Also:  Printer Setup 

PRINTER SETUP 
Location: All child windows. 
 
Description: Change the printer type and setup the current printer. 
 
Activation: Menu: Alt-F, S – Device Manager/ASCII/Binary Event Editor 

Menu: Alt-T, S – DXF Display 
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PRINT FILE 
Location: ASCII/Binary Event File 
 
Description: Print all pages in the open file. 
 
Activation: Menu: Alt-F, P, F 
 
Comments: The printer must be registered in the system's WIN.INI file.  In the ASCII/Binary editors, 

use the “Print/File Page” option to print the current page. 
 
See Also:  Printer Setup 

QUERY ALL ROWS 
Location: Query Fields 
 
Description: Compare the entered criteria to all the records in the active configuration. 
 
Activation: Direct: F6, <enter> 

Menu: Alt-Q, A 
 
Comments: All the records in the active configuration are compared to the entered query criteria.  A 

marked record that does not meet the query requirements is unmarked.  The records that 
meet the query requirements are marked and grouped at the top of the table.  Marked 
records are displayed in red. 

 
The Enter key searches all the records in the table. 

 
See Also: Query Marked Records 

Query Unmarked Records 
Clear Query Criteria 

QUERY MARKED ROWS 
Location: Query Fields 
 
Description: Compare the entered criteria to the marked records in the active configuration. 
 
Activation: Direct: F5 

Menu: Alt-Q, M 
 
Comments: The marked records that meet the query requirements are marked and grouped at the 

top of the table.  All other marked records are unmarked.  Marked records are displayed 
in red. 

 
See Also: Query Unmarked Records 

Query All Records 

QUERY UNMARKED ROWS 
Location: Query Fields 
 
Description: Compare the entered criteria to the unmarked records in the active configuration. 
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Activation: Direct: F7 
Menu: Alt-Q, U 

 
Comments: The unmarked records that meet the query requirements are marked and grouped below 

previous marked records.  Marked records are displayed in red. 
 
See Also: Query Marked Records 

Query All Records 

RECORDED CHANNELS 
Location: Analysis 
 
Description: Display the following information for the active oscillography file: 

Channel # Analog Channel Titles  Full Scale Values 
SAC #  SAC Titles   Full Scale Values 
Channel # Digital Channel Titles  Original State Values 
SDC #  SDC Titles   Original State Values 

 
 

Activation: Direct: F2 - Channel menu button  
Menu: Alt-F, R 

 
Comments: Triggered digital channel titles are displayed in red.  All valid and invalid channels are 

displayed. 

REFERENCE BAR 
Location: Analysis 
 
Description: Displays the instantaneous sample value at the reference bar position (dotted blue line 

that runs vertically across the analog and digital channels).  This value is displayed in the 
RefVal column of the analog table view. 

 
Comments: The reference bar is used to resize the RMS sliding window and display the 

instantaneous value at the sample position.  To resize the sliding window, click the right 
mouse button to set the reference bar position and the left mouse button to set the data 
bar position then select the Set RMS Bar  menu button.   

 
The Delta time (Delta X) field, displayed in the status bar shows the time difference 
between the reference bar and the data bar.  If the time difference between the samples 
is in milliseconds or microseconds then the number of cycles between the two bars is 
also displayed. 
 
The default position of the reference bar is at the fault time. 

 
See Also:  Data Bar 

RefVal 
Fault Bar 

REFRESH 
Location: File Manager 
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Description: Update the contents of the active directory from the operating system's allocation table. 
 

Activation: Direct: Refresh menu button  
Menu: Alt-F, F 

REFVAL COLUMN 
Location: Analysis (Analog Table)  
 
Description: Displays the sample value at the Reference bar (blue dotted line). 
 
Comments: If the active driver’s data type is set to RMS calibrated, the sample value at the data bar 

position is multiplied by the square root of 2. 
 
See Also: Viewing Analog Data in the Analysis Quick Start 

Reference Bar 

RENAME FILE/DIRECTORY 
Location: File Manager 
 
Description: Rename the file or directory at the cursor position. 
 
Activation: Menu: Alt-F, N 
 
Fields: From: The current name of the file. 

To: The new name of the file. 
 
Options: Enter/Ok: Change the name. 

Esc/Cancel: Exit the dialog without executing the command. 

REOPEN WAVEFORM FILE 
Location: Analysis 
 
Description: Reopen a file that was previously viewed. 
 

Activation: Menu Bar:  Open File drop down menu button  
 
Comments: A list of the last 14 open files is displayed in a drop down menu button.  Click the on the 

file to reopen. 
 
See Also: Reopen Waveform File in the Analysis Quick Start 

REPLAY PLUS DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the Hathaway Replay Plus driver and plot the 

input channels. 
 
Activation: Menu: Alt-D, R 
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Comments: The Replay Plus driver reads and displays waveform (dfr), disturbance (css) and trend 
(tss) files. If the selected file is not a valid Replay Plus file an error message is generated.  
All files that have the “.DAT” extension, with no corresponding “.CFG” file are tagged as 
Replay Plus files. 

 
See Also: Display Oscillography in the File Manager Quick Start 

Associating File Types in the File Manager Quick Start 

RESIZE COLUMNS 
Location: All Tables 
 
Description: Resize the columns in the table. 
 
Activation: Direct: Mouse Drag 
 
Comments: To resize the table columns, place the mouse over the column separator and drag to the 

right or the left.  The cursor changes to the vertical resize cursor when the mouse is 
positioned over the column separator.  Double click the mouse over the separators to 
make the column size the maximum area to display all the text in the column. 

RESIZE SLIDING WINDOW 
Location: Analysis 
 
Description: Resize the RMS sliding window. 
 

Activation: Direct: Resize Sliding Window menu button  
Menu: Alt-V, W 

 
Comments: To automatically resize the RMS sliding window click on the Resize Sliding Window 

menu button  or open the “Resize Sliding Window” menu option under the “View” 
menu. To manually resize the RMS sliding window click the right mouse button to set the 
reference position and the left mouse button to set the ending data position then click the 
SetRMS  menu button.  The RMS bar is moved to the reference position.  The Delta 
time (Delta X) field displayed in the status bar at the bottom of the screen shows the time 
difference (in milliseconds or seconds) and the number of cycles between the reference 
and data bars. Use the left, right, ctrl+left, and ctrl+right keys or the horizontal scroll bar 
to move the sliding window.  

 
See Also: Setting the Cursor Bars in the Analysis Quick Start 

Data Bar 
RMS Bar 
Reference Bar 

RESTORE MARK(S) 
Location: Analysis 
 
Description: Restore all the hidden analog channels.  The delete key removes the marked analog 

channels and the insert key restores the channels. 
 
Activation: Direct: Insert or the ViewAll menu button  
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Menu: Alt-C, R 
 
See Also: View Mark(s) 

Hide Mark(s) 
Show All Hidden 

RESTORE ORIGINAL 
Location: Analysis 
 
Description: Restore the displayed file to the original samples stored in the file.  This feature will undo 

all changes made using the change frequency, duplicate cycles and truncate cycles 
features. 

 

Activation: Direct: Restore Original menu button  
Menu: Alt-D, R 

 
See Also: Duplicate Cycles 

Truncate Cycles 
Change Frequency 

RFL 9300 DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the RFL 9300 driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, F 
 
Comments: If the selected file is not a valid RFL 9300 file an error message is generated. 

RMS COLUMN 
Location: Analysis (Analog Table)  
 
Description: Displays the RMS value for all samples positioned between the RMS bar (black dotted 

line) and the data bar (black solid line).  If the data is RMS calibrated, each sample value 
is multiplied by the square root of 2 before it is squared. 

  
See Also: Viewing Analog Data in the Analysis Quick Start 

RMS Bar 
Data Bar 

RMS BAR 
Location: Analysis 
 
Description: The RMS bar is the black dotted line that runs vertically across the analog and digital 

channels.  The RMS bar and data bar define the RMS sliding window.   
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Comments: When the analysis window is initially opened the sliding window is defaulted to one cycle.  
The sliding window is used to calculate the RMS value for all samples positioned 
between the data bar and the RMS bar.  This value is displayed in the Analog View.   

 
To resize the sliding window, click the right mouse button to set the reference bar position 
and the left mouse button to set the data bar position then select the Set RMS Bar menu 
button.  This button will move the RMS bar to the reference bar. 
 

See Also:  Data bar 
RMSVal Column 
TrueRMS Column 
Fault Bar 

RUN 
Location: File Manager 
 
Description: Execute the specified command. 
 
Activation: Direct: F5 

Menu: Alt-F, R 
 
Fields: Open:  The path and filename of the application to run. 
 
Options: Enter/Ok: Run the specified application. 

Esc/Cancel: Exit the dialog without executing the command. 
Browse: Display the Windows open dialog to browse for a file.  

SAMPLE BASED DISPLAY  
Location: Analysis 
 
Description: The sample base display plots the channel data with 1 pixel distance between each 

displayed sample.  Sample based displays are useful for showing changes in sampling 
frequency. 

 
Comments: To change the trace display settings open the “Window Properties” dialog under the “File” 

menu.  Click the “Display Settings” tab and change the “Trace Display Type” field to time 
based or sample based. 

 
See Also: Time & Sample Based Displays in the Analysis Quick Start 

SAVE & ARCHIVE DIALOG 
Location: Device Manager 
 
Description: Display the “Save & Archive” dialog to define the system and file settings. 
 
Activation: Menu: Alt-O, S 
 
Fields: System Settings:  

Station ID: Set the Station number where the system is running. 
Station Name: Set the Station name where the system is running 
Company Name: Set the company name. 
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Password: Set the password to gain access to this platform from another 
station.  Refer to Interrogating a Remote Device for more 
information on using the password to gain access to the 
Wavewin platform via a remote computer. 

File Settings:  
Save Rx Data: Save all received data from the devices in a device DTB file. 
Save Path: Set the path where the device DTB files are to be saved.  

Maximum 80 characters. 
Duration (min): Set the duration of the DTB files saved. 
End With: Action to take when the duration field has been exceeded. 

Archive will rename the DTB files using the IEEE long file 
naming format and delete will delete the DTB files from disk. 

 
Options: Save/Enter: Exit and save the dialog fields. 

Esc/Cancel: Exit the dialog without saving the dialog fields. 
 
Comments: Use the tab key to navigate between fields. 

 
See Also: Change DXF Files in Chapter 1 

IEEE Long File Naming Format in Chapter 1 
Interrogating A Remote Device in Chapter 1 

SAVE AS 
Location: ASCII/Binary Editor 
 
Description: Save the active event file to a new name. 
 
Activation: Menu: Alt-F, A 
 
See Also: Save As Text 

SAVE AS COMTRADE (ASCII/BINARY) 
Location: File Manager and Analysis 
 
Description: Save the waveform file at the cursor position or the displayed analog/digital channels to 

COMTRADE ASCII or Binary format. 
 
Activation: Menu: Alt-O, V, A – Save in COMTRADE ASCII format 

Menu: Alt-O, V, B – Save in COMTRADE Binary format 
 
Fields: Path:  The destination path. 

Filename: The filename with no extension. 
 
Options: Enter/Ok: Read the file contents and save it in COMTRADE format. 

Esc/Cancel: Exit the dialog without executing the command. 
 
Comments: Do not enter a filename extension.  The COMTRADE configuration (.CFG) and data 

(.DAT) files are automatically created.  If a path is not defined, the files are saved in the 
active directory.   
 
Currently there are two Comtrade versions supported: the older 1991 format and the 
newer 1999 format.  The Comtrade format can be selected from the “Window Properties” 
dialog in the analysis window.  The default format is the newer 1999 format.   
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If the sample values in the selected file are RMS calibrated and the outcome Comtrade 
file must have instantaneous values then set the “Comtrade Settings” fields to 
automatically convert the RMS data to instantaneous values.  To set the “Comtrade 
Settings” fields open the “Window Properties” dialog in the analysis window.  Select the 
“Comtrade” tab then select “Yes” for the “Convert RMS Calibrated Data to Peak Data” 
field. 
 
To automatically convert the selected channels to Comtrade using the IEEE long file 
naming convention check the “Use the ComNames Naming Convention to Name the 
Comtrade File(s)” field in the “Save As Comtrade” Dialog and leave the File Name field 
empty.  The selected channels are converted to the selected Comtrade format and are 
named using the IEEE long file naming convention. 

 
Restrictions: The selected file must be a supported oscillography file. 
 
See Also: Save As Comtrade in the File Manager & Analysis Quick Start 

SAVE AS TEXT 
Location: Binary Editor 
 
Description: Save the binary values in the hex editor file to an ASCII text file. 
 
Activation: Menu: Alt-F, T 
 
See Also: Save As 

SAVE DATE COLUMN 
Location: File Manager 
 
Description: Displays the date the file was last saved on disk. 
 
Comments: Click the table’s Save Date header to sort the files in ascending or descending order with 

respect to the Save Date. 
 
See Also: Fault Date/Time Column 

Save Time 

SAVE DISPLAYED VALUES(DEFAULT FORMAT) 
Location: Analysis 
 
Description: Save the displayed values in the analog table to a file or to the Windows clipboard. 
 
Activation: Menu: Alt-F, T “Values File” Tab 
 
Fields: Save To:  Where to save the values: file, clipboard or both 

Select Values File: Select the file for the displayed values. 
Save Type:  How to maintain the file: append or rewrite 
Save Format:  How to save the data: fixed ASCII or comma delimited 
Add Titles:  Add the titles to the file or no titles. 
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Options: Enter/Ok: Set the format. 
Esc/Cancel: Exit the dialog without executing the command. 

 
Comments: To save the samples values to a file select the “Mark & Save” menu option under the 

“Values” menu.  Select the format for the selected sample.  To view the values file, select 
the “Values File/Open” menu option under the “Values” menu. 

 
See Also: Save Displayed Values in the Analysis Quick Start 

SAVE TIME COLUMN  
Location: File Manager 
 
Description: Displays the time the file was last saved on disk. 
 
Comments: Click the table’s Save Time header to sort the files in ascending or descending order with 

respect to the Save Time. 
 
See Also: Fault Date/Time Column 

SAVE USER VIEWS 
Location: Analysis 
 
Description: Save the displayed view information in an ASCII text file. 
 
Activation: Menu: Alt-V, S 
 
Fields: View File Path: Destination path for the file. 

View Name: The name of the view. A file extension is not needed. The “.VIW” 
extension is automatically assigned. 

 
Options: Enter/Ok: Save the view. 

Esc/Cancel: Exit the dialog without executing the command. 
 
Comments: The following information is saved: 

• Displayed analog channels, 
• Analog channel order, 
• Superimposed channels, 
• Analog channel colors, 
• Digital channels displayed, 
• Sampling frequency, 
• Time scale, 
• Sliding window size (RMS bar to Data bar), 
• Phasor window size, 
• Table window size, 
• Red fault bar, 
• Auto scale and 
• Phasor or circular chart displayed 

 
See Also: Select User Views 

User Views in the Analysis Quick Start 
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SECONDARY VALUES 
Location: Analysis (Analog Table)  
 
Description: The values displayed in the analog table are either in primary or secondary quantities. If 

the file defines the type of values saved then the type is displayed in the window header. 
Also, if the CT and PT ratios are defined in the configuration file then the values can be 
changed from primary to secondary and vice versa. To change the values open the 
properties dialog and click on the “Driver Data Type” tab, select the Primary or Secondary 
radio button to switch between values. 

  
See Also: Changing Analog Values in the Analysis Quick Start 

Primary Values 

SEL LOAD PROFILE DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the SEL load profile driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, O 
 
Comments: If the selected file is not a valid SEL load profile file an error message is generated.  All 

files that have the “.BSV” extension are tagged as SEL load profile files.   

SEL RELAY DRIVER 
Location: File Manager 
 
Description: Change the driver at the cursor position to the SEL event driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, A 
 
Comments: If the selected file is not a valid SEL file an error message is generated.  All files that 

have the “.SEL”, “CEV” and “.EVE” extensions are tagged as SEL files.  Use the Drivers 
menu to change the file’s SEL driver type.  All SEL relay display formats are supported. 

SELECT LINES/VIEWS 
Location: Analysis 
 
Description: Select a specific line or view for display. 
 

Activation: Direct: Line/View drop down menu button  
Menu: Alt-C, L 

 
Comments: The DFR Transcan and Faxtrax records have predefined views encoded into their format.  

To select the predefined views click on the “Show All/ Select View” drop down menu 
button or select the “Select Views” menu option under the “Channels” menu option.  A list 
of the available lines/graphs will be displayed.  To view all the analog channels in the file 
press the <esc> key, the <backspace>, or click the “Show All” menu button or click the 
ViewAll  menu button.  
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See Also: Selecting Predefined Views in the Analysis Quick Start 

SELECT USER VIEWS 
Location: Analysis 
 
Description: Select a view file from the list of files located in the displayed view path. 
 
Activation: Menu: Alt-V, V 
 
Fields: View Files:  A list of all the view files in the displayed view path. 

Analog Channels: All analog channel information defined in the view file. 
Digital Channels: All digital channel information defined in the view file. 

 
Options: Enter/Ok:  Select the highlighted view. 

Esc/Cancel:  Exit the dialog without executing the command. 
 
Comments: The following information is read from the selected view file and applied to the displayed 

file: 
• Displayed analog channels, 
• Analog channel order, 
• Superimposed channels, 
• Analog channel colors, 
• Digital channels displayed, 
• Sampling frequency, 
• Time scale, 
• Sliding window size (RMS bar to Data bar), 
• Phasor window size, 
• Table window size, 
• Red fault bar, 
• Auto scale and 
• Phasor or circular chart displayed 

 
If the analog channel and digital channel names defined in the view file are not in the 
displayed file than an error message is displayed. 

 
See Also: Save User Views 

User Views in the Analysis Quick Start 

SEQUENCE OF EVENTS LIST 
Location: File Manager 
 
Description: View a table of sequence of events for a number of waveform files.  Mark all the desired 

files then press F11 or select the "SOE List" menu option from the "Reports" submenu 
under the "Options" menu.  A table will be displayed listing all the events triggered in the 
selected files. 

 
Activation: Direct: F11 

Menu: Alt-O, R, S 
 
Fields: Substation:  The substation where the device is installed. 

Device:   The device the channel came from. 
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State:   The state of the channel at that time (A=Abnormal, N=Normal). 
Trigger Date:  The trigger date. 
Trigger Time:  The trigger time. 
Channel:  The channel number of the event in the file. 
Channel Title:  The title of the channel. 
File:   The file containing the event/sensor channel. 

 
Comments: The table is sorted according to the date and time.  The Query section at the bottom of 

the table allows for searching events from specific substations, devices, channels and 
more...  To view the file containing the specific events press enter or double click on the 
event. 

SEQUENCE OF EVENTS SUMMARY 
Location: File Manager 
 
Description: View a table of summarizing the sequence of events for a number of waveform files.  

Mark all the desired files then select the "SOE Summary" menu option from the "Reports" 
submenu under the "Options" menu.  A table will be displayed listing a summary of the 
events triggered in the selected files. 

 
Activation: Menu: Alt-O, R, O 
 
Fields: Substation:  The substation that triggered the event/sensor 

Device:   The device the channel originated from. 
Fst-State:  The state the channel started at, A=alarm and N=normal. 
Lst-State:  The state the channel ended at, A=alarm and N=normal. 
First Change Date  The date the channel first changed state. 
First Change Time: The time the channel first changed state. 
Last Change Date  The date the channel last changed state. 
Last Change Time: The time the channel last changed state. 
Changes:  The number of times the channel changed state. 
Chan#:   The channel number in the file. 
Channel Title:  The title of the channel. 
File:   The file containing the event/sensor channel. 

 
Comments: The table is sorted according to the first change date and time.  The Query section at the 

bottom of the table allows for searching events from specific substations, devices, 
channels and more...  To view the file containing the specific events press enter or 
double click on the event. 

SET DRAWING PROPERTIES 
Location: DXF Animated CAD 
 
Description: Set the DXF drawing properties. 
 

Activation: Direct: F2 - Properties menu button  
Menu: Alt-T, D 

 
Fields: File Name:  Displays the file name for the currently select tab. 

Background Color: Set the background color for the currently select tab. 
Max X Pixel:  Set the maximum X resolution value. 
Max Y Pixel:  Set the maximum Y resolution value. 
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Options: Enter/Ok: Exit the dialog, then save and execute the entered information. 

Esc/Cancel: Exit the dialog without saving the information. 
Apply : Apply and save the entered parameters without closing the dialog. 

 
Comments: The Max X Pixel and Max Y Pixel values cannot exceed 32000. 

SET OPENING FREQUENCY  
Location: Analysis 
 
Description: Set a driver’s open frequency.  This feature is available in the “Change Frequency” 

dialog. 
 

Activation: Direct: Change Frequency menu button  
Menu: Alt-D, F 

 
Fields: Open Frequency: Specify to always open the files associated with the active driver 

using the entered frequency. 
 
Options: Enter/Ok: Exit the dialog, then save and execute the entered information. 

Esc/Cancel: Exit the dialog without saving the information. 
 
Comments: Setting the Always Open field will open all files associated with the active driver using the 

entered frequency.  This feature is useful for files with low sampling frequency. 
 
See Also: Change Frequency 

SET SORT FIELD 
Location: All Tables 
 
Description: Set the active sort field to the column at the cursor position. 
 
Activation: Direct: Left Mouse Click on the Column’s header 

Menu: Alt-S, S  
 
Comments: The “Ascending” and “Descending” options in the “Sort” menu sorts the table data with 

respect to the select sort field.  To sort the columns directly, click the column header 
button to toggle between ascending and descending. 

 
See Also: Sort All Rows 

SHIFT MARKS DOWN 
Location: Analysis 
 
Description: Shift all the marked analog channels down one position. 
 
Activation: Direct: "-" key 

Menu: Alt-C, D 
 



Chapter 6 – Fields & Features 
 

260 

Comments: Individual channels can be marked or unmarked by clicking on the channels 
corresponding display ID or channel information or by pressing the spacebar.  Marked 
analog channels are displayed in red. 

 
See Also: Shift Marks Up 

SHIFT MARKS UP 
Location: Analysis 
 
Description: Shift all the marked analog channels up one position. 
 
Activation: Direct: "+" key 

Menu: Alt-C, U 
 
Comments: Individual channels can be marked or unmarked by clicking the channels corresponding 

display ID or channel data, or by pressing the spacebar.  Marked analog channels are 
displayed in red. 

 
See Also: Shift Marks Down 

SHOW/HIDE CHANNEL TITLES 
Location: File Manager 
 
Description: The Show/Hide Channel Titles allows for showing invalid channel titles, remove titles 

from the invalid title list and adding new titles to the invalid channel title list. 
 
Activation: Menu: Alt-O, T 
 
Fields: Title List Box:  Lists all invalid channel titles. 

Add Title:  Add a new title to the list. 
Remove Title:  Remove a title from the list. 

 
Options: Enter/Ok:  Execute changes. 

Esc/Cancel:  Exit the dialog without executing the command. 
 
Comments: To show a title, uncheck the checkbox next to the title. All new titles are added to the end 

of the list with the checkbox automatically checked. 
 
See Also: Show/Hide Channel Titles in the File Manager Quick Start 

SHOW ALL DIGITAL CHANNELS 
Location: Analysis 
 
Description: Show all digital channels or just the triggered digital channels.  This menu option toggles 

between the two views. 
 
Activation: Direct: F9 

Menu: Alt-V, D 
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Comments:   Placing the mouse on the horizontal separator bar and dragging it up or down can resize 
the digital channel display area.  The cursor changes to the horizontal resize cursor when 
the mouse is positioned over the bar. 

SHOW ALL HIDDEN 
Location: Analysis 
 
Description: Show all hidden analog and digital channels. 
 
Activation: Direct: ViewAll menu button  , the <esc> key or the <backspace> key 

Menu: Alt-C, S 
 
See Also: View Mark(s) 

Hide Mark(s) 
Restore Mark(s) 

SHOW CHANNEL INFORMATION 
Location: Analysis 
 
Description: Show or hide the channel information window.  This menu option toggles between the 

two views. 
 
Activation: Menu: Alt-V, C 
 
Comments: The channel information window can be resized by placing the mouse on the vertical 

separator bar and dragging it to the right or the left.  The cursor changes to the vertical 
resize cursor when the mouse is positioned over the bar. 

SINGLE ENDED FAULT LOCATION  
Location: Analysis 
 
Description: Display the single ended fault location dialog. The Single Ended Fault Location Dialog is 

used to interface to the SingleEndFaultLocation.dll. The SingleEndFaultLocation.dll will 
calculate the fault location, fault type and fault time. 

 
Activation: Menu: Alt-D, O 
 
Fields: ZLine:  Positive sequence impedance. 

ZLine Angle: Positive sequence angle. 
kZN:  Compensated zero sequence impedance (Z0-Z1)/(3*Z1). 
kZN Angle: Compensated zero sequence factor angle (Z0-Z1)/(3*Z1). 
kZM:  Mutual compensation factor (Z0m)/(3*Z1). 
Line Length: Line Length. 
Vnom:  Nominal phase to phase voltage. 
Inom:  Nominal current. 
Analog Chans: Select the analog channels from the drop down lists. 
Pre Cycles: Number of cycles to send before the reference bar. 
Post Cycles: Number of cycles to send after the reference bar. 
 
Advanced Dialog Fields: 
Z1 (% of Line): Zone 1 forward impedance. 
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Z2 (% of Line): Zone 2 reverse impedance. 
R0:  Phase loop resistance reach. 
Rg:  Ground loop resistance reach. 
IO Threshold: Zero sequence current threshold for VTS. 
I2 Threshold: Neg. sequence current threshold for VTS. 
Ph Select Ind: Index of the sample corresponding to the fault inception. 
Average Count: Total post fault samples for averaging fault distance. 
Ph Select Mode: Phase selection mode (Internal, AG, BG, CG, AB, BC, CA). 

 
Options: Advanced: Display the Advanced dialog for fine turning the algorithms. 

Start:  Start the fault location algorithms. 
Print:  Send a screen dump of the outputs to the system's default printer. 
Show Help: Show/Hide the fault location drop down help window. 
Open:  Open a fault location (*.flt) file. 
New:  Create a new fault location file. 
Save:  Save the active fault location file. 
Save As: Save the active fault location file under a new name. 

 
Comments: The sampling frequency must be set to ensure 24 samples per cycle. The sampling 

frequency must be set prior to opening the fault location dialog. If the sampling frequency 
is not set to 1440 Hz for 60 Hz or 1200 Hz for 50 Hz then the change sampling frequency 
dialog will automatically be displayed. Click OK or press enter to change the sampling 
frequency then reopen the Fault Location dialog.  

 
All sample values sent to the DLL must be in secondary quantities. If the sample values 
are in primary values then the CT and PT ratio values must be available in the data 
configuration file. If the CT and PT ratio values are not available a message will be 
displayed asking to ignore the request or abort displaying the fault location dialog. 

 
See Also: Single Ended Fault Location in the Analysis Quick Start 

SIZE 
Location: File Manager (Status Field) 
 
Description: Displays the total size (in Kbytes) of all files in the active directory.   
 
See Also: Free 

MrkSize 

SIZE COLUMN 
Location: File Manager 
 
Description: Displays the size (in bytes) of the file.   

SIZE TO ORIGINAL COORDINATES 
Location: DXF Animated CAD  
 
Description: Size the DXF drawing to the original display coordinates (coordinates of the drawing 

when it was first opened).   
 
Activation: Direct: Original Display menu button  
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Menu: Alt-V, Z 
 
Comments: The Max X and Max Y Pixel values in the status bar are updated according to the new 

coordinates. 

SIZE TO WINDOW 
Location: DXF Animated CAD  

 
Description: Size the DXF drawing to fit in the window. 
 
Activation: Direct: Fit in Window menu button  

Menu: Alt-V, W 
 

Comments: The Max X and Max Y Pixel values in the status bar are updated according to the new 
coordinates. 

SOFTWARE ANALOG CHANNELS 
Location: Analysis 
 
Description: Display the software analog channel dialog. 
 
Activation: Direct: F5 

Menu: Alt-C, A 
 
Fields: Titles:  The titles for the software analog channels. 

Operators: Each analog operation followed by an operator terminator “/”. 
 
Options: Enter/Ok: Exit the dialog then save and execute the operators. 

Esc/Cancel: Exit the dialog without saving or executing the operators. 
F1/Help: Display the help window. 
Open:  Open a *.SAC file. 
New:  Create a new *.SAC file. 
Save:  Save the active SAC file. 
Save As: Save the active SAC file under a new name. 

 
Comments: Software analog channels (SAC's) are extra channels provided by the system.  These 

channels can be used to calculate a missing phase, create +, - and 0 sequence 
channels, create an envelope of a selected trace, or define an under/over-trigger values 
to monitor a given channel.  The SAC window is split into two sections: the titles and the 
operators.  To navigate between fields use the tab, up arrow and down arrow keys. 

 
See Also: Creating Virtual Channels in the Analysis Quick Start 

SOFTWARE DIGITAL CHANNELS  
Location: Analysis 
 
Description: Display the software digital channel dialog. 
 
Activation: Menu: Alt-C, D 
 
Fields: Titles:  The titles for the software digital channels. 
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Operators:  Each digital operation followed by an operator terminator “/”. 
 
Options: Enter/Ok: Exit the dialog then save and execute the operators. 

Esc/Cancel: Exit the dialog without saving or executing the operators. 
F1/Help: Display the help window. 

 
Comments: Software digital channels (SDC's) are extra channels provided by the system.  The SDC 

window is split into two sections: the SDC titles, and the SDC operators.  To navigate 
between fields use the tab, up arrow and down arrow keys. 

 
See Also: Creating Virtual Channels in the Analysis Quick Start. 

SORT ALL ROWS 
Location: All Tables 
 
Description: Sort all the rows in the table in ascending or descending order. 
 
Activation: Menu:  Alt-S, A – Ascending 

Menu:  Alt-S, D – Descending 
Shortcut: Column headers 

 
Comments: All the rows in the active table are sorted with respect to the sort field displayed in the 

table’s status field. 
 
See Also: Set Sort Field 

SORT FIELD 
Location: All Tables (Status Field) 
 
Description: Displays the active sort field. 
 
Activation: Direct: Mouse Click on the Column’s header 

Menu: Alt-S, S  
 
Comments: The “Ascending” and “Descending” options in the “Sort” menu sorts the table data with 

respect to the select sort field.  To sort the columns directly and to set the sort field, click 
the column header button. 

 
See Also: Sort All Rows 

SORT MARKED ROWS 
Location: All Tables 
 
Description: Sort the marked rows according to the previously selected sort order. 
 
Comments: All marked records are sorted and grouped at the top of the table. 

SR745/489 DRIVER 
Location: File Manager (Universal Viewer) 
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Description: Change the driver at the cursor position to the GE SR745/489 driver and plot the input 
channels. 

 
Activation: Menu: Alt-D, K 
 
Comments: If the selected file is not a valid SR745/489 file an error message is generated.  All files 

that have the “.CSV” extension, and have “CSV format” in the first line of the file are 
tagged as GE SR745/489 files. 

 
See Also: Display Oscillography in the File Manager Quick Start 

Associating File Types in the File Manager Quick Start 

START DATE FIELD 
Location: IEEE Long File Name 
 
Description: The first field in the IEEE long file naming format.  The start date is extracted from the 

event files downloaded and stored in the following format: Year (2 digits) Month Day: 
040909. 
Example File Name: 
040909,113109123,+3S,Barton Substation#12,SEL421-432#34,ArkElectric,,,.DAT 

 
See Also: Start Time Field 

START TIME FIELD 
Location: IEEE Long File Name  
 
Description: The second field in the IEEE long file naming format.  The start time is extracted from the 

event files downloaded and stored in the following format: Hour Minute Second 
Millisecond: 113109234. 
Example File Name: 
040909,113109123,+3S,Barton Substation#12,SEL421-432#34,ArkElectric,,,,.DAT 

 
See Also: Start Date Field 

SUBSTATION FIELD 
Location: IEEE Long File Name  
 
Description: The fourth field in the IEEE long file naming format.  The substation name is extracted 

from the device record. 
Example File Name: 
040909,113109123,+3S,Barton Substation#12,SEL421-432#34,ArkElectric,,,,.DAT  

 
See Also: Long File Naming Format in the File & Device Managers Quick Starts 

SUPER IMPOSE 
Location: Analysis 
 
Description: Superimpose all or marked analog channels. 
 
Activation: Direct: F7 
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Menu: Alt-D, S 
 
Comments: Marked channels are superimposed and grouped at the top of the display window.  The 

superimpose menu option and the F7 function key toggles superimposing on and off. 

SYNC DATA CURSORS  
Location: Analysis 
 
Description: Synchronize the data cursors for two or more open display windows by time or manually.     
 
Activation: Menu: Alt-D, Y, T – “By Time” 

Menu: Alt-D, Y, M – “Manually” 
 
Options: By Time: When the "By Time" sync cursor feature is turned ON the data cursors in the 

non-active windows are moved to the sample value time in the active 
window.  For example if the active data cursor is positioned on sample time 
01:12:34.560, all non active data cursors are moved to the sample value at 
that time.  If the time is not found in the non-active window, the cursor 
position is unchanged.  The active window defines the master data cursor 
and all other cursors follow this position.   

Manually: This feature allows for selection of different cursor positions in the open data 
windows before synchronization is turned ON.  For example, open two data 
windows and tile horizontally, move the data cursors to the beginning of the 
fault cycles, and select the sync manual cursor option.  When the left, right, 
ctrl-left, ctrl-right, page up, page down, ctrl-page up, ctrl-page down, home 
and end keys are pressed the data cursors move simultaneously. 

   
Comments: A check mark indicates that the sync feature is ON.  To turn synchronizing OFF click on 

the active sync menu option to remove the check mark.  When synchronizing is ON the 
channel information displayed to the right of the traces is updated for all open data 
windows. 

 
See Also: Synchronizing Data Cursors in the Analysis Quick Start 

SYSTEM FILES  
Location: Device Manager 
 
Description: There are 3 system files needed for the proper operation of the system.  The 

CFG_DEV.DTB file stores the device records stored in the device table.  The 
CFG_SHOT.DTB file stores the device’s function keys and the EscSeq field in the device 
records.  The DRIVERS.INI file has all the script code for polling the connected devices 
and transferring files to a remote computer. 

TAB DELIMITED TABLE DRIVER  
Location: File Manager 
 
Description: Display the tab delimited file at the cursor position in a table format.  Tab delimited files 

have textual fields separated by blank spaces, such as: CHANNEL DATE TIME. 
 
Activation: Menu: Alt-D, 3, T 
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Comments: The data in the file is presented in tabular form.  An unlimited number of rows and 
columns can be displayed. 

 
See Also: Viewing ASCII Files in Database Format in the File Manager Quick Start 

Double Quotes/Comma Delimited Table Driver 
Comma Delimited Table Driver 

TCODE FIELD 
Location: IEEE Long File Name 
 
Description: The third field in the IEEE long file naming format.  The TCode is extracted from the 

device record. 
Example File Name: 
040909,113109123,+3S,Barton Substation#12,SEL421-432#34,ArkElectric,,,,.DAT 

 
See Also: Long File Naming Format in the File & Device Managers Quick Starts 

TESLA DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the Tesla driver and plot the input channels. 
 
Activation: Menu: Alt-D, N 
 
Comments: Tesla Files are displayed in the IEEE Comtrade Binary format. NxtPhase has developed 

an automatic conversion application called "AutoComtrade.exe". Wavewin calls 
"AutoComtrade.exe" to convert Tesla files to the Comtrade binary format for display. To 
view Tesla Files double click or press enter on the original Tesla files. To obtain a copy of 
the “AutoComtrade.exe” file please contact Tesla. 

 
Files that have a .TLR extension are automatically tagged as NxtPhase Tesla files. 

 
See Also: Tesla Files in the File Manager Quick Start. 

TCP/IP CLIENT 
Location: Device Manager 
 
Description: Define the selected device to communicate using the TCP/IP protocol. 
 

Activation: Direct: Ethernet configuration button  in the Device Configuration dialog. 
 
Fields: Ethernet Connections: Select the TCP/IP client option from the list box.  The fields in the 

connection properties section changes according to the selection 
in the connections list box. 

Connection Properties:  
Port Number: Set the TCP/IP port number. 
IP Address: Set the device’s IP address. 

 
Options: OK/Enter:  Exit and update the Device’s EscSeq field. 

Cancel/Esc:  Exit the dialog without saving the changes made. 
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Comments: If the Local Path does not exist then the directory will be created. 
 
See Also: New Device Record 

Duplicate Device Record 
Edit Device Record 

TEST PORTS 
Location: Device Manager 
 
Description: Test the connected port using the loop back test option. 
 
Activation: Direct: F3 

Menu: Alt-O, L 
 
Comments: Use the loop back plug detection test to check the port connection.  Place the loop back 

plug in the desired port, select the corresponding port, and press F3 or select “Loop Back 
Test” from the Options menu.  A message appears displaying the status of the port: Loop 
back plug detected or not detected. 

TIME BASED DISPLAY  
Location: Analysis 
 
Description: The time base display plots the channel data in time.  Time base displays are useful for 

showing changes in line frequency. 
 
Comments: To change the trace display properties open the “Window Properties” dialog under the 

“File” menu.  Click the “Display Settings” tab and change the “Trace Display Type” field to 
time based or sample based. 

 
See Also: Time & Sample Based Displays in the Analysis Quick Start 

TIS DRIVER 
Location: File Manager 
 
Description: Change the driver at the cursor position to the TIS driver and plot the input channels. 
 
Activation: Menu: Alt-D, M 
 
Comments: The TIS file format is an ASCII comma delimited format with the channel information 

defined in the first line of the file. If the selected file is not an ASCII comma delimited file 
then an error message is generated.  All files that have a “.TIS” extension are tagged as 
TIS files. 

 
See Also: Associating File Types in the File Manager Quick Start 

TOTAL HARMONICS DISTORTION 
Location: Analysis (Harmonics Dialog)  
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Description: The "Total Harmonic Distortion" field displays the square root of the summation of the 
squares of DFT Magnitudes for harmonics 2 to n divided by square root of 2 and that 
quantity divided by the DFT Magnitude of the Fundamental.  

 
See Also:  Harmonics 

Histogram 

TOTFILES 
Location: File Manager (Status Field)  
 
Description: Displays the total number of hidden and unhidden files/directories in the active directory.  

The ”.” and “..” navigation shortcuts are included in the unhidden total.  
 
See Also:  TotMarks 

TOTMARKS 
Location: All Tables (Status Field)  
 
Description: Displays the total number of marked rows in the active table.  Marked rows are displayed 

in light red.  

TOTRECS 
Location: Device Manager (Status Field)  
 
Description: Displays the total number of records in the active configuration. 
 
See Also:  AtRec 

TotMarks 

TOTTABS 
Location: Animated CAD-DXF(Status Field)  
 
Description: Displays the total number of tabs in the Animated CAD-DXF window. 
 
See Also:  AtTab 

TPRO DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the NxtPhase TPRO driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, O 
 
Comments: NxtPhase files are displayed in the IEEE Comtrade Binary format. NxtPhase has 

developed an automatic conversion application called "AutoComtrade.exe". Wavewin 
calls "AutoComtrade.exe" to convert NxtPhase files to the Comtrade binary format for 
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display. To view NxtPhase relay files double click or press enter on the original TPRO 
files. To obtain a copy of the “AutoComtrade.exe” file please contact NxtPhase. 

 
Files that have a “.TPR” extension are automatically tagged as NxtPhase TPRO files. 

 
See Also: Tesla Files in the File Manager Quick Start 
  Display Oscillography in the File Manager Quick Start 

Associating File Types in the File Manager Quick Start 

TPU/DPU/GPU DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the ABB TPU/DPU/GPU driver and plot the 

input channels. 
 
Activation: Menu: Alt-D, E 
 
Comments: If the selected file is not a valid TPU or DPU or GPU file an error message is generated.  

All files that have the “.CAP” extension are tagged as TPU/DPU/GPU files.   

TRACE SCALE MULTIPLIER (ASM) 
Location: Analysis (Window Properties Dialog)  
 
Description: Used as a multiplier to increase/decrease the amplitude of the visible analog channels 
 
Activation: Menu: Alt-F, T 
 
Range: Greater Than 1.00 
 
Default: 2.00 
 
Comments: When a channel's amplitude is increased, the trace scale value is multiplied with the 

Pixsdisp value, and when the channel's amplitude is decreased the trace scale value is 
divided by the Pixsdisp value. 

TRANSCAN DRIVER 
Location: File Manager (Universal Viewer) 
 
Description: Change the driver at the cursor position to the Mehta Transcan driver and plot the input 

channels. 
 
Activation: Menu: Alt-D, 7 
 
Comments: If the selected file does not have a corresponding SCF file an error message is 

generated.  All files that have an extension that starts with “.X”, and there is a 
corresponding “.SCF” file in the same directory, are tagged as Transcan files. 

 
See Also: Associating File Types in the File Manager Quick Start 
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TRIGGER-TIME  
Location: Waveform Summary (Events/Sensors Activity Log)  
 
Description: Displays the time the digital channel changed state.  This value is displayed in the third 

column of the Events/Sensors Activity Log.   
 
Comments: The Events/Sensors Activity Log displays a time-sequenced list of all the events and 

sensors activity. 

TRUERMS 
Location: Harmonics Table (Analysis)  
 
Description: Displays the RMS value for all the samples between the RMS bar (black dotted line) and 

the data bar (black solid line). 
  
Comments: This value is taken directly from the RMS column inside the analog information table.  
 
See Also: Harmonics Table 

TRUNCATE CYCLES 
Location: Analysis 
 
Description: Remove beginning, middle or end cycles from the active analysis window. 
 
Activation: Menu: Alt-D, T, L: Left-Start to Data Bar 

Menu: Alt-D, T, R: Data Bar to End 
Menu: Alt-D, T, M: Data Bar to Reference Bar 

 
Comments: There are 3 options available under the Truncate Cycles menu option.  Left removes the 

cycles from the first sample to the data bar (solid black vertical line).  Right removes the 
cycles from the data bar to the last sample.  Middle removes the cycles from the data bar 
to the reference bar (dotted blue vertical line) 

 
See Also: Truncate Cycles in the Analysis Quick Start 

TYPE COLUMN  
Location: File Manager 
 
Description: Displays the fault type associated with the long file name.  The eighth field in the file 

name defines the type field for the IEEE long file-naming format.  This field represents the 
fault type or contents type of the file. 

 
See Also: Long File Naming Format in the File Manager Quick Start 

UN/MARK ROWS 
Location: All Tables 
 
Description: Mark or unmark the row at the cursor position. 
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Activation: Direct: Spacebar - Ctrl-Mouse Button 
Menu: Alt-M, M 

 
Comments: Marked rows are displayed in red.  The TotMarks field displayed in the status bar is 

updated accordingly. 
 
See Also: Unmarked Marks 

Group Marked Rows 

UNMARK MARKS 
Location: All Tables 
 
Description: Unmark all the marked rows in the table. 
 
Activation: Menu: Alt-M, U 
 
Comments: Marked rows are displayed in red.  The TotMarks field, displayed in the status bar, is 

updated accordingly. 
 
See Also: Mark/Unmark Rows 

Group Marked Rows 

VIEW MARK(S) 
Location: Analysis  
 
Description: Hide all the unmarked channels and resize the marked channels. 
 
Activation: Direct: Enter 

Menu: Alt-C, V 
 
Comments: Individual channels are marked and unmarked by clicking the left mouse button on the 

channel’s corresponding display ID or channel information or by pressing the spacebar.  
Marked channels are displayed in red. 

 
See Also: Hide Mark(s) 

Show All Hidden 
Restore Mark(s) 

VIEW RAW DATA FILE 
Location: Analysis  
 
Description: View the contents of the active displayed file in an ASCII editor or a hexadecimal editor. 
 

Activation: Direct: Menu button  
Menu: Alt-F, V 

 
Comments: The waveform file is displayed in an ASCII editor if the contents of the file are in text 

format and displayed in a hex editor if the file is in binary format. 
 
See Also: Viewing/Modifying ASCII Files 

Viewing/Modifying Binary Files 
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WAVEFORM DATA 
Location: File Manager 
 
Description: Plot the contents of the event file at the cursor position if there are no marked waveform 

files else plot all the marked waveform files. 
 
Activation: Direct: <enter>, Plot menu button  

Menu: Alt-O, W, O 
 
Comments: A maximum of 10 oscillography/log files can be opened simultaneously. 

WAVEFORM SUMMARY 
Location: File Manager and Analysis 
 
Description: Generates and displays analog and digital summaries for the active file in the file table or 

in the analysis window. 
 

Activation: Direct: Sum menu buttons  - File Table,  - Analysis  
Menu: Alt-O, S – File Table, Alt-F, S – Analysis 

 
Comments: The summary file displays the following information: 
  

Waveform Information 
Station: Name of the Station associated with the waveform. 
Filename: The name of the waveform file. 
File Size: The size of the file in kilobytes. 
Prefault-Time: The date and time of the first prefault sample. 
Fault-Time: The date and time of the first fault sample. 
Save-Time: The date and time the file was saved to hard disk. 
Process-Time: The date and time the file was processed into this summary. 
Start Date & Time: Date and time of the first sample in the file. 
End Date & Time: Date and time of the last sample in the file. 
File Duration: Duration of the file measured in days, hours, seconds, milliseconds and/or 

microseconds, depending on the type of file. 
Sampling Frequency: Sampling frequency and the time between each sample. 
Line Frequency: Line Frequency defined in the file. 
 
Fault Information 
Fault Information is displayed for SEL, DLP and Transcan files.  The fault information 

includes: Fault Type, Fault Time, Location, Targets, Triggers, Frequency, Event and 
Targets. 

 
Maximum/Minimum Analog Summary 
Max-Inst: Instantaneous maximum values. 
Min-Inst: Instantaneous minimum values. 
Max-RMS: RMS maximum values. 
Min-RMS: RMS minimum values. 
OneBit: The channel's full-scale value divided by the channel's resolution. 
Inst-Diff: The difference between the Max-Inst and Min-Inst values. 
RMS-Diff: The difference between the Max-RMS and Min-RMS values. 
pU: The channel's prefix and units. 
Description: The number and title of the channel. 
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Events/Sensors Activity Summary 
Fst: The state the channel started at, A=alarm, N=normal. 
Lst: The state the channel ended at, A=alarm, N=normal. 
Fst-Change: The date and time the channel first changed state. 
Lst-Change: The date and time the channel last changed state. 
Changes: The number of times the channel changed state. 
Description: The number and title of the channel. 
 
Events/Sensors Activity Log 
State: The state of the channel at the triggered time, A=alarm, N=normal. 
Trigger Time: The time the channel changed state. 
Description: The number and title of the channel. 

 
Note: An xx:xx:xx.xxx in the events/sensors activity summary indicates that the digital channel's 

state did not change from the initial state (Fst). 

WINDOW PROPERTIES 
Location: Analysis 
 
Description: Reposition the columns in the analog table, change the fields displayed in the 

combination view, change the background colors and trace colors; change the driver’s 
data type, change the trace/phasor scale multipliers and more refer to the fields below. 

 

Activation: Direct: Properties Menu Button  
Menu: Alt-F, T 

 
Fields: Analog Table Tab:  Reorder/Show/Hide the columns in the analog table. 

 Analog Combination Tab: Change the display positions in the analog combination 
view. 

 Comtrade: Define the Comtrade format for saving, the date and 
time format for display and set automatic conversion 
from RMS data to Peak data when using the “Save As 
Comtrade” feature. 

 Colors: Change the background colors and trace colors. 
 Values File: Format the save displayed values feature. 
 Display Settings: Change the trace/phasor scale multipliers and set 

general display properties. 
 Append/Merge: Set the append/merge properties. 
 Driver Data Type: Set the current display driver’s data type to Peak type or 

RMS calibrated. 
 Filters: Define to delete spikes and set up spike properties. 
 

 
Options: OK:  Apply the selected changes and redraw the analysis window. 

Cancel:  Exit the dialog without executing the changes. 
 
Comments: All data windows are defaulted to the display settings.  The analog data columns depend 

on the data type specified. 
 
See Also:  Customizing the Analysis Display in the Analysis Quick Start 

Viewing Analog Data in the Analysis Quick Start 
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ZIP FILES 
Location: File Manager  
 
Description: Zip a group of files or a single file using the “Zip Marked Files” option under the “File” 

menu. All support files needed to display the selected files will be automatically included 
in the zip file.  Support files include Comtrade configuration (*.CFG), header (*.HDR) & 
information (*.INF) files, DFR’s analog and digital information files such as: Hathaway 
DAU files, Rochester preamble and header files, Faxtrax/Director CTL files, Transcan 
SCF and TCF files. 

 

Activation: Direct: Right Click Pop-up menu Button  
Menu: Alt-F, Z 

 
Fields: New Zip File Name: Enter a path and name for the new zip file. 

EncryptHeaders: Click to encryptheaders. 
 
Comments: To zip files, mark the desired files in the file table and select the “Zip Marked Files” option 

from the “File” menu or right click on the file table and select the “Zip” option from 
the pop-up menu.  All support files needed to display the file(s) are automatically 
included. 

 
See Also: Zip Files in the File Manager Quick Start 

ZOOMING 
Location: DXF Animated CAD 
 
Description: Change the DXF display viewing area. 
 
Activation: Menu: Alt-V, I, O 

Direct: “+” & “-“ keys, Menu buttons  &  
 
Comments: To zoom in press the “+” key, to zoom out press the “-“ key or use the Zoom In and Out 

menu buttons to change the viewing area.  If the Max X and Max Y variables, inside the 
status bar, are at 32000 then this feature is not be available 

ZOOM IN 
Location: DXF Animated CAD 
 
Description: Increase the drawing's resolution by multiplying 2.5 with the current X, Y resolution. 
 

Activation: Direct: “+” key – Zoom in menu button  
Menu: Alt-V, I  

 
Comments: The Max X and Max Y variables inside the status bar are updated accordingly. 
 
Restrictions: The Max X and Max Y resolution values cannot exceed 32000. 

ZOOM OUT 
Location: DXF Animated CAD 
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Description: Decrease the drawing's resolution by dividing 2.5 by the current X, Y resolution. 
 

Activation: Direct: “-” key – Zoom out menu button  
Menu: Alt-V, O  

 
Comments: The Max X and Max Y variables inside the status bar are updated accordingly. 

ZOOM X, Y RESOLUTION PROPERTIES 
Location: DXF Animated CAD 
 

Activation: Direct: F2 - Properties menu button  
Menu: Alt-T, D 

 
Description: Set the drawings max X and max Y resolution values. 
 

Max X Pixel:  The maximum X resolution value. 
Max Y Pixel:  The maximum Y resolution value. 

 
Range: Less than 32000 
 



Appendix A - Device Drivers 

 A-1  

A P P E N D I X  A  

Device Drivers 
 
The DRIVERS.INI file, located in the system directory is used to create device drivers.  The driver consists 
of script commands that periodically interrogate a device, parse information from the response, display the 
parsed response in a text window or graphical display, activate automatic triggers, generate reports, and/or 
archive the data.  The drivers are created in the DRIVERS.INI file and assigned in the device record dialog. 

CHANGE POLLING DRIVERS 

There are a number of drivers in the drivers.ini file that have specific information pertaining to current master 
station being developed, such as polling start times & location on a server where files are saved. The 
sections below explain how to edit the drivers.ini to make the needed changes.  

POLLING TIMES 

To change the polling times for the master station open the Drivers.ini file located in the Wavewin32 
directory.  Navigate to driver # 131. Below are the driver fields.  
 
[MASTER POLL DAILY] 
DRIVER#=131 &1 
TYPE=ASCII 
SETMESSAGE=^[^CMND] 
;TXPERIOD=0 
;TXDELAY=0 
TXPERIOD=T0400 
RXSTAY=1 
 
The SETMESSAGE=^[^CMND] command sets the defined messages in the device’s EscSeq command.  
This tells all devices with the same ATMESSAGE to begin the polling sequence. 
 
The TXPERIOD=0 and TXDELAY=0 commands are used to poll the devices periodically. If serial modems 
are used then it is not advisable to use periodical polling. This produces large phone bills. In this driver the 
TXPERIOD=0 and TXDELAY=0 are deactivated. Placing a semicolon before the command deactivates the 
command. The TXPERIOD=T0400 defines a specific time when to start the polling process in a 24 hour 
period. The time is defined in military time 0000-2300. T0400 starts polling the devices at 4:00 am. To 
change the polling start time, change the 0400 to the desired time.   

FILE LOCATIONS 

To change where the files are saved on the connected server open the Drivers.ini file located in the 
Wavewin32 directory. Navigate to driver # 130. Below are the driver fields.  
 
[MONITOR PATH & XMITFILES] 
DRIVER#=130 &133 
TYPE=ASCII 
SETMESSAGE=MOVEXFR^@ 
DIRMESSAGE=W:\FAULTLIBRARY\STATIONS 
TXPERIOD=120 
TXDELAY=-101 
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[XMITFILES TO BRIDGE] 
DRIVER#=133 
TYPE=ASCII 
ATMESSAGE=MOVEXFR 
TXFILE=C:\SDCSAVE\*.SLH W:\FAULTLIBRARY\HISTORY /MOVE 
TXFILE=C:\SDCSAVE\*.3EH W:\FAULTLIBRARY\HISTORY /MOVE 
TXFILE=C:\SDCSAVE\*.3TH W:\FAULTLIBRARY\HISTORY /MOVE 
TXFILE=C:\SDCSAVE\*.SLS W:\FAULTLIBRARY\SUMMARY /MOVE 
TXFILE=C:\SDCSAVE\*.DLS W:\FAULTLIBRARY\SUMMARY /MOVE 
TXFILE=C:\SDCSAVE\*.30S W:\FAULTLIBRARY\SUMMARY /MOVE 
TXFILE=C:\SDCSAVE\*.SOP W:\FAULTLIBRARY\SUMMARY /MOVE 
TXFILE=C:\SDCSAVE\*.SLP W:\FAULTLIBRARY\SUMMARY /MOVE 
TXFILE=C:\SDCSAVE\*.SEL W:\FAULTLIBRARY\EVENT /MOVE 
TXFILE=C:\SDCSAVE\*.OSC W:\FAULTLIBRARY\EVENT /MOVE 
TXFILE=C:\SDCSAVE\*.30X W:\FAULTLIBRARY\EVENT /MOVE 
TXFILE=C:\SDCSAVE\*.DFR W:\FAULTLIBRARY\EVENT /MOVE 
TXFILE=C:\SDCSAVE\*.X01 W:\FAULTLIBRARY\EVENT /MOVE 
TXFILE=C:\SDCSAVE\*.EOP W:\FAULTLIBRARY\EVENT /MOVE 
TXFILE=C:\SDCSAVE\*.FLP W:\FAULTLIBRARY\EVENT /MOVE 
TXFILE=C:\SDCSAVE\*.TLR W:\FAULTLIBRARY\EVENT /MOVE 
TXFILE=C:\SDCSAVE\*.DXF W:\FAULTLIBRARY\STATIONS /MOVE 
TXFILE=C:\SDCSAVE\*.DN* W:\FAULTLIBRARY\STATIONS /MOVE 
TXFILE=C:\SDCSAVE\*.OK* W:\FAULTLIBRARY\STATIONS /MOVE 
TXFILE=C:\SDCSAVE\*.BSV W:\FAULTLIBRARY\LOADPROFILE /MOVE 
 
Driver # 131, [MONITOR PATH & XMITFILES] sets a message telling driver # 133 [XMITFILES TO 
BRIDGE] to execute. Also, driver number 133 must be included in driver’s 131 DRIVER# field for the 133 
driver to execute, DRIVER#=130 &133.  
 
The subdirectories defined on the master station computer in driver # 133 must remain fixed and cannot be 
changed (C:\). The destination drive for the files on the server can be changed. Change the drive letter (W:\) 
to the mapped driver letter for the connected server. All files with the listed extensions are moved from the 
polling computers C:\SDCSAVE directory to the specified directories on the server. 
 
NOTE: Make sure the above directories exist on the server before starting the polling process. 

SCRIPT COMMAND DEFINITIONS 

All available script commands are defined below.  In the definitions below there are references to Escape 
Sequence Commands.  The escape sequence commands are used to access system and user variables.  
The “^”, “[“ and “]” characters specify the use of an escape sequence command.  To insert a carriage return 
and a line feed after an ASCII TXCOMMAND insert ^[13;10] after the ASCII characters to transmit to the 
device. For example to transmit an SEL meter command, insert the following command in the drivers 
TXCOMMAND field: meter^[13;10]. 

ESCAPE CODE COMMANDS 

Available Escape Code Commands.  The following commands are reserved system variables.  Their names 
cannot be used for user variables.  
 

• 13:  Carriage Return 
• 10:  Line Feed 
• Y:    2 Digit Year (Current Date & Time from the System Clock) 
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• YR:  4 Digit Year 
• MON:  Month 
• DAY:  Day 
• HR:  Hour 
• MIN:  Minute 
• SEC:  Second 
• HSEC:  Hundredth of a Second 
• ID:   Device Number 
• PID:  Port Number 
• HDR:  Device Name 
• ADDR:  Device Address 
• SID:  Station Number 
• STN:  Station Name 
• VER:  Program’s Version Number 
• CRCSATEC: Proprietary SATEC Meter 8-Bit Checksum 
• CRCMDAR: Proprietary ABB MDAR Relay 16-Bit CRC Checksum 
• CRCBI:  Proprietary BiTRONICS Meter 8-Bit Checksum 
• CRCDLP:  Proprietary DLP Relay 16-Bit CRC Checksum 
• CRCHYDRAN: Proprietary Hydran CRC Checksum 
• CRCHATH: Proprietary Hathaway DFR I, II and IIB CRC Checksum 
• CRCDPU:  Proprietary DPU Modbus CRC Checksum 
• CRCPASS: Creates a 6 character random password. 
• P#:  Pause # of Seconds (Maximum Delay is 99 Seconds) 
• #:   Any 1 Byte integer Number in Decimal (0 to 255) 
• ^X^Y:  The Variable Name "X" From Device# "Y" 
• %#:N:  The text # will be left justified with blanks to the length specified in N. 
• $FILE:N:  Read Nth line in the file specified in “FILE” and insert in the command. 

The file specified in the “FILE” field must be in the Wavewin directory. 
• CMND:  The first parameter in the "EscSeq Command" Field. 
• CMND1:  The second parameter in the "EscSeq Command" Field. 
• CMND2:  The third parameter in the "EscSeq Command" Field. 
• CMND3:  The fourth parameter in the "EscSeq Command" Field. 
• CMND4:  The fifth parameter in the "EscSeq Command" Field. 
• CMND5:  The sixth parameter in the "EscSeq Command" Field. 
• CMND6:  The seventh parameter in the "EscSeq Command" Field. 

 

DRIVER DEFINITION COMMANDS 

[ ... ]: 
The “Driver Name” is assigned between brackets.  Each driver must be assigned a unique name.  
The driver name is displayed in the device record’s “Driver” drop down list.  A maximum of 24 
characters is permitted.  Up to 255 drivers is supported.  

 
DRIVER#: 

Each driver must have a unique ID number assigned (range 1 to 255).  A driver is used to 
automatically transmit a predefined sequence of characters or bytes 
("TXSTART"+"TXCOMMAND"+"TXEND") to an external device, then capture the response, parse 
and display the response (RXSTRIP) and/ or save the parsed data (LOGCOMMAND).  
 
If a unique driver number is assigned then the driver is loaded into memory and the driver’s name 
is added to the driver drop down list in the device record dialog. 
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Other drivers can also be included by using the "&" character followed by the driver number.  For 
example: "DRIVER#=2 &7 &1" will cause drivers 2, then 7 then 1 to execute.  The maximum 
number of included drivers is 64.  Included drivers can also include other drivers.  Below is an 
example where included drivers can be used, there are 5 driver defined: 
 
SEL Logon driver defined at Driver # 1. 
SEL History driver defined at Driver # 2. 
SEL Events driver defined at Driver 3. 
SEL Meter driver defined at Driver # 4. 
SEL Logout driver defined at Driver # 5. 
 
To execute each driver for an SEL device create and new driver at Driver # 5 and include the top 
five drivers: DRIVER#=6, &1, &2, &3, &4, &5.  Below is an example of Driver #6. 
 
[SEL, POLL SEL-351/311] 
DRIVER#=6 &1 &2 &3 &4 &5 
 
Drivers are executed in the order that they are included.  In general there are six different ways to 
execute a driver: 
 

• PERIODICALLY: "TXPERIOD=4" will execute once every 4 seconds. 
• 2) DAILY:  "TXPERIOD=T1830" will execute once @ 6:30 p.m. 
• 3) WEEKLY:  "ONDOW=7" will execute on Sunday @ the defined "TXPERIOD". 
• 4) MONTHLY:  "ONDAY=14" will execute on the 14th @ the defined "TXPERIOD". 
• 5) CONDITIONALLY: Using "SETMESSAGE", "ATMESSAGE" and "M" commands. 
• 6) MANUALLY: By selecting from the “Control” options menu. 

 
Periodically executed drivers are called interrogation drivers and are executed when the 
“TXPERIOD elapses.  Manually executed drivers ("TXPERIOD=0" AND "TXDELAY=0") are called 
“Control Menus” and are executed from the “Control Menu” list in the DXF display window.  Refer 
to the examples below on how to create control drivers. 

 
TYPE: 

Defines the type of data specified in the "TX" & "LOG" commands.  The two available types are 
“ASCII” or “Hexadecimal”.  

SYSTEM COMMANDS 

REPORTIF: 
A sequence of characters to search for (ASCII or Hex) in the captured data.  If the sequence is 
found then the captured data is saved to a file using the IEEE long file naming convention and 
transmitted to a remote computer.  A file transmit driver must exists for the reportif file to be sent.  
The maximum Reportif length is 255 characters.  The reportif can also include escape sequence 
commands.  

 
SETPORT: 

A command used to reinitialize the port configuration dynamically.  Use this command to reinitialize 
a port’s baud rate, byte size, parity and stopbits before the driver is executed.  This feature is useful 
when switching between different devices connected via the same port. For example if 2 SEL 2030 
with different port configurations are being polled from the same modem or direct connection then 
setport will insure the proper port configuration for both SEL 2030s.  
 

SETSYSVAR: 
An internal command use to change the value of any one of the 7 EscSeq internal variables.  The 
EscSeq variables are defined in the device record.  The command sequence is 
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SETSYSVAR=ExistingVarName NewVarName.  This feature was created for the “Change 
Password” feature but can be used for any one of the EscSeq variables defined.  The example 
below changes the password defined in the 3rd EscSeq variable defined in the device record with a 
randomly generate 6 character password.  The “CRCPASS” Escape Code Command creates a 6 
character randomly generated string.  The device record in the database (CFG_SHOT.DTB) and 
on screen is updated with the variable string.  The maximum length is 80 characters and escape 
code sequence commands are allowed.  
 
Example:  SETSYSVAR ^[^CMND2] ^[CRCPASS] 

LOG COMMANDS 

LOGPERIOD: 
The save cycle in seconds (an integer number up to 2 million).  For example, if "LOGPERIOD=90" 
was specified in a driver then the variables and text that are specified in the "LOGCOMMAND" will 
be saved to disk once every 90 seconds.  The saved data is stored in text format in the filename 
specified in the “LOGFILE=" command to the save directory defined in the “Save and Archive” 
dialog.  If "LOGPERIOD=0" was specified then these actions will not occur unless "LOGDELAY>0" 
was specified in which case the driver will execute one time only.  If "LOGPERIOD=T0800" was 
specified then the driver will execute at 08:00 am every day.  T commands are specified in military 
time.  

 
LOGDELAY: 

The duration in seconds to wait before the Log cycle begins.  For example, if "LOGDELAY=3" was 
specified then only the first occurrence of "LOGPERIOD" is delayed by 3 seconds 
(LOGPERIOD+LOGDELAY).  In the previous example the first period will occur after 93 seconds, 
all others will occur 90 seconds apart.  To have the log cycle begin immediately set 
“LOGPERIOD=-89 (90+-89).  If "LOGPERIOD=0" was specified than specifying "LOGDELAY" will 
cause the driver to execute one time only (this is useful for writing headers to the log file).  

 
LOGFILE: 

The path and file name of the text file that will contain the outputs of the "LOGCOMMAND=". If the 
path is not specified than the default save path (save path specified in the “Save & Archive” dialog) 
is used.  If the command "LOGFILE" is not included than the system will automatically assign an 
IEEE long file name with a “.CSV” extension. The maximum length is 255 character and escape 
code commands are allowed.  

 
LOGRENAME: 

Automatically renames the specified “LOGFILE=” file to an IEEE long file name with a “.CSV” 
extension.  The specified file must exist in the specified path (path defined in the “LOGFILE” 
command or the save path define din the “Save & Archive” dialog).  If the path is not specified in 
the “LOGFILE=” command than the default save path is used.  This command is required in order 
to transfer files that are being periodically appended.  LOGRENAME occurs upon TXPERIOD and 
not upon LOGPERIOD.  The maximum length is 255 characters and escape code commands are 
allowed.  

 
LOGCOMMAND: 

Specifies a sequence of characters to save (ASCII OR BINARY) to the “LOGFILE=” when the 
"LOGPERIOD" command expires.  The maximum length is 1024 characters and escape code 
commands are allowed.  For example the following LOGCOMMAND:  
 

^[10;13;YR;MON;DAY;HR;MIN;SEC;HSEC;ID;HDR;ADDR;SID;STN;VER;^TOTMW^2] 
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Will cause a carriage return, line feed, 4 digit year, month, day, hour, minute, second, hundredth of 
second, device number, device name, device address, station number, station name, version and 
the values of the user variable "TOTMW" from device # 2, to be saved to the log file.  
 
WARNING: Using a Pause command in this escape sequence will generate errors.  Pause 
command are mainly used in TXCOMMANDS  

 
LOGHEADER: 

Specifies a sequence of characters to save as the first line upon, creation of the log file specified in 
the "LOGFILE" COMMAND.  The maximum length is 1024 characters and escape code commands 
are allowed.  
 
Example driver with LOG commands defined: 
 
[GE-DLP VALUES] 
DRIVER#=125 
TYPE=ASCII 
ATMESSAGE=^[^STN],^[^SID],RUN 
RXSTAY=2 
;SCAN 
RXSTRIP=N00, C00, X52, Y1, H6, "     Scan GE-DLP Relay" 
RXSTRIP=N00, C06, X52, Y3, H1, "             Time:", %^DTM 
RXSTRIP=N00, C14, X52, Y4, H1, "           Status:", %^STS 
RXSTRIP=N00, C02, X52, Y6, H0, "Total to Download:", %^TOT 
RXSTRIP=N00, C01, X52, Y7, H0, "         At Event:", %^ATF 
;METER 
RXSTRIP=N00, C14, X01, Y1, H1, "    DLP METER: ", %^DDT 
RXSTRIP=N00, C14, X01, Y2, H1, "  --------------------------" 
RXSTRIP=N00, C14, X05, Y3, H1, "IA: ",       %^IA 
RXSTRIP=N00, C14, X15, Y3, H1, "Angle: ",    %^AIA 
RXSTRIP=N00, C14, X05, Y4, H1, "IB: ",       %^IB 
RXSTRIP=N00, C14, X15, Y4, H1, "Angle: ",    %^AIB 
RXSTRIP=N00, C14, X05, Y5, H1, "IC: ",       %^IC 
RXSTRIP=N00, C14, X15, Y5, H1, "Angle: ",    %^AIC           
RXSTRIP=N00, C14, X05, Y6, H1, "IN: ",       %^IN 
RXSTRIP=N00, C14, X15, Y6, H1, "Angle: ",    %^AIN 
RXSTRIP=N00, C14, X28, Y3, H1, "VA: ",       %^VA 
RXSTRIP=N00, C14, X40, Y3, H1, "Angle: ",    %^AVA 
RXSTRIP=N00, C14, X28, Y4, H1, "VB: ",       %^VB 
RXSTRIP=N00, C14, X40, Y4, H1, "Angle: ",    %^AVB 
RXSTRIP=N00, C14, X28, Y5, H1, "VC: ",       %^VC 
RXSTRIP=N00, C14, X40, Y5, H1, "Angle: ",    %^AVC 
RXSTRIP=N00, C14, X05, Y7, H1, "P(MWatt): ", %^PW 
RXSTRIP=N00, C14, X05, Y8, H1, "Q(MVar): ",  %^QV 
;DUN FILE 
LOGFILE=C:\SDCSAVE\^[^STN].ZNN 
LOGHEADER=STATION#(6/INFO), DEVICE#(6/INFO), HDRONOFF(6/INFO), 
LOGHEADER= DATE(0/DATE), TIME(1/TIME), (4/DATE), (4/PORT),  
LOGHEADER= Va(4/kV), Vb(4/kV), Vc(4/kV), 
LOGHEADER= Ia(4/Amp), Ib(4/Amp), Ic(4/Amp), 
LOGHEADER= P(4/Mwatt), Q(4/Mvars), (4/EVENTS), (4/STATUS), 
TITLE(6/INFO)^[13;10] 
LOGCOMMAND=^[^SID], ^[ID], ^[^CMND1], 
LOGCOMMAND= ^[MON]/^[DAY]/^[YR], ^[HR]:^[MIN]:^[SEC], ^[^DTM], ^[^PID], 
LOGCOMMAND= ^[^VA], ^[^VB], ^[^VC], 
LOGCOMMAND= ^[^IA], ^[^IB], ^[^IC], 
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LOGCOMMAND= ^[^PW], ^[^QV], ^[^TOT], ^[^STS], ^[HDR]^[13;10] 
 
**Multiple LOGHEADER and LOGCOMMAND fields are concatenated together to form one 
LOGHEADER and one LOGCOMMAND. 

FILE COMMANDS 

RENFILE: 
Automatically renames an existing file to a new name.  The command sequence is 
RENFILE=path+existing file name | new file name.  The specified file must exist in the specified 
path.  The pipe sign is used as a separator between the old path & filename and the new path & file 
name. RENFILE executes upon a "TXPERIOD" command or upon an “ATMESSAGE” command.  
The maximum length is 255 characters and escape code commands are allowed.  
 
Example:  RENFILE=C:\TEMP\^[^CMND].CSV | C:\TEMP\^[^CMND1].CSV 
 

DELFILE: 
Automatically deletes the specified file.  The command sequence is DELFILE=path+filename.  
DELFILE executes upon a "TXPERIOD" command or upon an “ATMESSAGE” command.  The 
maximum length is 255 characters and escape code commands are allowed.  
 
Example:  DELFILE=C:\TEMP\^[^CMND].CSV 
 

RUNFILE: 
Runs the specified file and passes the defined command line parameters to the specified 
application. The command sequence is RUNFILE=path+existing file name | command line 
parameters.  If the path is not in the system environment then the path is required. If command line 
parameters are used then they must have a pipe sign preceding the command line parameters. 
RUNFILE executes upon a "TXPERIOD" command or upon an "ATMESSAGE" command.  The 
maximum length is 255 characters and escape code commands are allowed. 
 
Example:  RUNFILE=C:\TEMP\FTP_SCRIPT.EXE | "C:\TEMP\ACTIVE_SCRIPT" 
 

DUNRENAME: 
Automatically renames all files with a “.ZUN” extension to the same file name with a “.DUN” 
extension.  Also, all files with a “*.ZN*” extension are renamed with a “*.DN*” extension. The 
command sequence is DUNRENAME=path.  The path is the file path where all *.ZUN” and “*.ZN*” 
are located on disk.  DUNRENAME executes upon a "TXPERIOD" command or upon an 
“ATMESSAGE” command.  The maximum length is 255 characters and escape code commands 
are allowed.  
 
Example:  DUNRENAME=C:\SDCSAVE\^[^STN] 

MESSAGE COMMANDS 

SETMESSAGE: 
Sequence of characters sent as a message to all loaded drivers.  All drivers that have an 
"ATMESSAGE=" command matching the sent message will be executed in the order defined in the 
device manager table.  The maximum length is 255 characters.  The system can handle up to 32 
messages per second.  For example the command "SETMESSAGE=DIAL,LOGON,HANGUP^2" 
will send the messages 'DIAL' & 'LOGON' to all loaded drivers and will send the message 
'HANGUP' to the drivers on device #2 only.  The maximum length for each message in the 
sequence is 24 characters.  
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ATMESSAGE: 
Sequence of characters that will cause the driver to execute if it is equal to the received 
"SETMESSAGE=" command string.  The "SETMESSAGE=" and "ATMESSAGE=" commands can 
appear together in the same driver as long as they are not equal. This is useful for organizing 
drivers in a link list and executing them in order.  If the "SETMESSAGE=" and "ATMESSAGE=" are 
equal in the same driver than the system will fall into and endless loop.  The maximum length for 
each “ATMESSAGE” is 24 characters.  
 
Example drivers with "SETMESSAGE=" and "ATMESSAGE=" commands defined: 
 
[INITIATE SDC POLLING] 
DRIVER#=143 
TYPE=ASCII 
SETMESSAGE=RUN 
TXPERIOD=300 
TXDELAY=-250 
 
[SEL SWITCH LOGON] 
DRIVER#=10 &127 
TYPE=ASCII 
ATMESSAGE=^[^STN],^[^SID],RUN 
TXCOMMAND=^[P2]ACC^[13;P3;^CMND1;13] 
RXSTAY=30 
RXEND=*> 
RXWAIT=4 
RXQUIT=SDCEND^[^SID] 
;CHK 
RXSTRIP=N00, %NoRsp, @STS 
RXSTRIP=N01, B01, X01, Y03, D00, C07, H07, "", V=ACC, P0, JC0, J01 
RXSTRIP=N00, %Done, @STS 
;MID 
RXSTRIP=N01, S01, T40, X01, Y04, D00, C14, H11, "", @D3 
RXSTRIP=N02, S01, T40, X01, Y05, D00, C08, H11, "", @D4 
RXSTRIP=N00, C14, H01, X01, Y07, "PORT-ID:", %^PID, @PORT 
RXSTRIP=N00, C06, H01, X01, Y08, "DIAL-AT:", %^[MON]/^[DAY]/^[YR]-, 
%^[HR]:^[MIN]:^[SEC], @CALL 
;LOG 
LOGFILE=PORT-^[^PID].SOE 
LOGCOMMAND=^[Mon]/^[Day]/^[Yr]-^[Hr]:^[Min]:^[Sec]> ^[^STN](^[^SID]), 
SEL-SWITCH LOGON, STS=^[^STS;13;10] 

 
DIRMESSAGE: 

The name of a directory path for the system to monitor.  If any "*.MSG" files are detected then the 
name portion of the filenames will be used as messages to the system as in "SETMESSAGE". 

TRANSMIT (TX) COMMANDS 

TXFILE: 
Copies or moves one or more files from a specified source folder to a destination folder. The format 
is "TXFILE=SOURCE_PATH\WHICH_FILES  DESTINATION_PATH /MOVE (optional)".  
 
All specified file names must include fully qualified path strings.  When the "TXFILE" command is 
used the "TXCOMMAND" is ignored. The ";" character is reserved and should not be used in this 
command, the software uses the ";" to separate between multiple "TXFILE" commands.  All of the 
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listed "TXFILE" commands are concatenated to a single data buffer of 1024 characters maximum 
length. 
 
FILE TRANSFER PROTOCOL: 
 
The protocol is very simple, designed to be quick and highly dependent on the quality of the 
communication link.  First, the transmit end sends: (START BLOCK)+(FILE CONTENTS)+(END 
BLOCK) and then upon "END BLOCK" the received-end sends: (ACK BLOCK). 
 
In the event that the "END BLOCK" terminator was not received then the receive-end will terminate 
and reset in 30 seconds from the time that the last byte was received.  The block formats are as 
follows (all values, messages and parameters are enclosed by parenthesis and all messages are 
case sensitive): 

 
Start Block: 
 

BYTE   1-2: The values (TEN)+(ELEVEN) 
BYTE  3-23: The message (File Transfer Enable:) 
BYTE    24: The value (TEN) 
BYTE  25--: The parameters (DESTINATION PATH)+(;)+  

(FILE NAME)+(;)+  
(SIZE)+(;)+  
(PACKED FILE-DATE&TIME BORLAND FORMAT)+(;)+  
(ASCII TRANSMIT-DATE&TIME)+(;)+  
(OPTIONAL FIELD=LONG TSD FILE NAME) 

BYTE  LAST: The values (TEN)+(ELEVEN) 
 
File Contents: 
 

The actual file contents starting from the first to the last byte. 
 
End Block: 
 

BYTE     1:  The value (SEVEN) 
BYTE   2-7: The message (Crc:= ) 
BYTE  8-11: The parameter (16-bit CRC calculated for the file contents block only.   

The mask is 8408 hex and the CRC is shipped in ASCII hex format where 4 
characters make a word - HI Byte first - The CRC is initialized to FFFF and 
is not flipped at the end and must be in uppercase HEX notation). 

BYTE 12-13: The values (SEVEN)+(TEN) 
 
Ack Block: 
 

BYTE   1-2: The values (TEN)+(ELEVEN) 
BYTE  3-21: The message (File Transfer Done:) 
BYTE    22: The value (TEN) 
BYTE 23-27: The message (Crc: ) 
BYTE 28-31: The parameter (16-bit CRC calculated for the received file block only.   

The mask is 8408 hex and the CRC is shipped in ASCII hex format where 4 
characters make a word - HI byte first – the CRC is initialized to FFFF and 
is not flipped at the end and must be in uppercase hex notation. 

BYTE    32: The value (TEN) 
BYTE  33--: A duplicate of the "Byte 25--" section of the received "START BLOCK". 
BYTE  LAST: The values (TEN)+(ELEVEN) 

 
Example: 
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For example the exact protocol to transfer a 2 byte file named HELLO.TXT containing the word 
"HI" is as follows (the skipped lines are transmitted line feeds (VALUE=10)): 
TX ->| 

| File Transfer Enable: 
| C:\TEMP;HELLO.TXT;000000002;645175976;4/10/2001 19:54:50; 
| HICrc:= A7DB 
| 

RX <-| 
| File Transfer Done: 
| Crc: A7DB 
| C:\TEMP;HELLO.TXT;000000002;645175976;4/10/2001 19:54:50; 
| 

 
TXDIAL: 

This command is only valid when "TXFILE" is specified.  If "TXFILE" finds files to transfer then the 
sequence of characters specified in "TXDIAL" will be transmitted first.  The maximum sequence 
length is 255 characters.  Example:  TXDIAL=^[13;P1]ATDT 1,123-456-7899^[13;P60]. 
Note:  The "P60" (pause 60 seconds) above will be aborted when "CONNECT" is detected.  

 
TXHANGUP: 

This command is only valid when "TXFILE" is specified.  When "TXFILE" file transfer is complete 
the sequence of characters in the "TXHANGUP" command will be transmitted.  The maximum 
sequence length is 255 characters.  
 
Example driver with "TXDIAL", “TXFILE” and "TXHANGUP" commands defined: 
 
[TRANSMIT FILES EXAMPLE] 
DRIVER#=11 
TYPE=ASCII 
TXDIAL=AT^[13;10;P2]ATDT 1,700-555-1234^[13;10;P45] 
TXFILE=C:\FAULTLIB\MEHTA\SHIP\*.SCF S:\SYSPROT\RECORDS\DFR  
TXFILE=C:\FAULTLIB\MEHTA\SHIP\*.X01 S:\SYSPROT\RECORDS\DFR 
TXHANGUP=^[P2]+++^[P2]ATH0^[13;10;P3]AT&F^[13;10;P2]ATS0=1^[13;10;P2] 
TXPERIOD=900 
TXDELAY=5 
 
If no files are present in the source directory then the driver is not executed. 

 
TXSTART: 

Sequence of characters to transmit (ASCII OR BINARY) before "TXCOMMAND" and "TXLOGON" 
("TXSTART" is inserted at the beginning of these commands).  The “TXSTART” + “TXLOGON” + 
‘TXCOMMAND” definitions are concatenated together to form the final transmit command sent to 
the device upon a "TXPERIOD" or upon “ATMESSAGE”.  The maximum length for TXSTART is 
1024 characters and escape code commands are allowed. 

 
TXLOGON: 

A sequence of characters to transmit (ASCII or Binary) when the driver is loaded for the first time.  
The maximum sequence length is 255 characters.  TXLOGON will only work from the parent driver.  
Escape code sequences are allowed. 

 
TXCOMMAND: 

A sequence of characters to transmit (ASCII or Binary) upon "TXPERIOD" or upon “ATMESSAGE” 
or by request by the control options menu.  The maximum length is 1024 characters and escape 
code commands are allowed.  For example, to request a meter command from a DLP relay use the 
following driver to transmit the TXCOMMAND:  
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02^[ADDR]35CA00^[CRCDLP;P1]05FA^[P1]06F9^[P1]06F9 
 
[DLP METER] 
DRIVER#=69 
TYPE=HEX 
ATMESSAGE=^[^STN],^[^SID],RUN 
TXCOMMAND=02^[ADDR]35CA00^[CRCDLP;P1]05FA^[P1]06F9^[P1]06F9 
RXSTAY=5 
RXEND=04FB 
RXWAIT=3 
RXSTRIP=N01, S11,  T20, D0, C8, X01, Y1, H8,"    DLP METER: ", @DDT  
RXSTRIP=N00,            D0, C8, X01, Y2, H8,"  -------------------------" 
RXSTRIP=N01, S31,  T6,  D0, C8, X05, Y3, H8, "IA: ",      @IAV 
RXSTRIP=N01, S37,  T4,  D0, C8, X15, Y3, H8, "Angle: ",   @AIA 
RXSTRIP=N01, S41,  T6,  D0, C8, X05, Y4, H8, "IB: ",      @IBV 
RXSTRIP=N01, S47,  T4,  D0, C8, X15, Y4, H8, "Angle: ",   @AIB 
RXSTRIP=N01, S51,  T6,  D0, C8, X05, Y5, H8, "IC: ",      @ICV 
RXSTRIP=N01, S57,  T4,  D0, C8, X15, Y5, H8, "Angle: ",,  @AIC           
RXSTRIP=N01, S61,  T6,  D0, C8, X05, Y6, H8, "IN: ",      @INV 
RXSTRIP=N01, S67,  T4,  D0, C8, X15, Y6, H8, "Angle: ",   @AIN 
RXSTRIP=N01, S71,  T5,  D0, C8, X28, Y3, H8, "VA: ",      @VAV 
RXSTRIP=N01, S76,  T4,  D0, C8, X40, Y3, H8, "Angle: ",   @AVA 
RXSTRIP=N01, S80,  T5,  D0, C8, X28, Y4, H8, "VB: ",      @VBV 
RXSTRIP=N01, S85,  T4,  D0, C8, X40, Y4, H8, "Angle: ",   @AVB 
RXSTRIP=N01, S89,  T5,  D0, C8, X28, Y5, H8, "VC: ",      @VCV 
RXSTRIP=N01, S94,  T4,  D0, C8, X40, Y5, H8, "Angle: ",   @AVC 
RXSTRIP=N01, S98,  T6,  D0, C8, X05, Y7, H8, "P:(MWatt): ",@PMW 
RXSTRIP=N01, S104, T6,  D0, C8, X05, Y8, H8, "Q:(MVar): ", @QMV 
 
The DLP meter TXCOMMAND will transmit a hex 02 byte, the address stored in the device’s 
record, the hex values 35 CA 00, and the DLPCRC values.  It will then pause for 1 second then 
transmit the hex values 05 FA pause again for 1 second then transmit the 06 F9, pause for 1 
second and transmit the 06 F9 again.   
 
Another example is the terminate modem connection command: 
 
^[10;13;P1]+++^[P3]ATH0^[13;10] 
 
There are a number of pre-canned drivers used for downloading events, summaries, histories, 
RTU-SOE points, DNP status points, and for time synchronizing the devices.  The pre-canned 
drivers are called via the “TXCOMMAND”.  Refer to the following on how to call the pre-canned 
drivers. 
 
"TXCOMMAND=RTU-SOE"  

The RTU-SOE command executes the precoded SES-92 binary protocol for reading SOE points 
from the RTU.  The command executes upon a "TXPERIOD" or "ATMESSAGE". 
REQUIREMENTS:  
TYPE=BINARY 
RXSTAY=2 
Use the "D0" data type with the "RXSTRIP" commands. 

 
"TXCOMMAND=RTU-ANALOG"  

The RTU-ANALOG command executes the precoded SES-92 binary protocol for reading analog 
dumps from the RTU.  The command executes upon a "TXPERIOD" or "ATMESSAGE". 
REQUIREMENTS: 
TYPE=BINARY 
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RXSTAY=2  
Use the "D0" data type with the "RXSTRIP" commands. 

 
"TXCOMMAND=RTU-STATUS"  

The RTU-STATUS command executes the precoded SES-92 binary protocol for reading status 
dumps from the RTU.  The command executes upon a "TXPERIOD" or "ATMESSAGE". 
REQUIREMENTS: 
TYPE=BINARY 
RXSTAY=2 
Use the "D0" data type with the "RXSTRIP" commands. 

 
"TXCOMMAND=SEL-351FM"  

The SEL-351FM (fast meter) command executes the precoded SEL-351 binary protocol for fast 
meter operations.  The command executes upon a "TXPERIOD" or "ATMESSAGE". 
REQUIREMENTS: 
TYPE=BINARY 
RXSTAY=2 
Use the "D0" data type with the "RXSTRIP" commands. 

 
"TXCOMMAND=SEL-EVENTS"  

The SEL-EVENTS command executes the precoded SEL EVE ASCII protocol for automatic 
event capture. The latest raw events files are downloaded and saved in separate files using the 
IEEE long file naming convention with the extension “.SEL”.  Summary files for each event is 
also saved in separate files using the IEEE long file naming convention with the extension 
“.SLS” and a history file is created if there are new events to download.  The history file is also 
saved using IEEE long file naming convention with the extension “.SLH”. The command 
executes upon a "TXPERIOD" or "ATMESSAGE". 
REQUIREMENTS: 
TYPE=ASCII 
RXSTAY=30 
RXEND==> 
RXWAIT=4 
 
Example Summary File: 

     SEL FAULT REPORT 
 --------------------------- 
     
     Date =  06/25/02 
     Time =  17:25:59.18 
  Station =  SEAVILLE SW 
   Device =  A-521 
    Event =  AG 
 Location =  +1.76 
  LineLen =  4.70 
  Targets =  COMM ZONE2 EN G 50 

 
Example History File: 

=>HIST 12 
 
SEAVILLE SW  A-521              Date: 12/05/02    Time: 12:29:47.012 
 
#    DATE      TIME      EVENT  LOCAT  GRP TARGETS 
 
1  12/04/02 14:50:42.202 CG    +22.90   1   EN 
2  11/25/02 17:10:03.189 CG 64   1   EN 
3  07/20/02 09:12:28.082 AG    +21.84   1   EN 
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4  07/20/02 09:12:27.874 AG    +40.53   1   EN 
5  07/02/02 17:01:51.200 BG    +22.09   1   EN 
6  07/02/02 16:57:56.713 BG    +34.93   1   EN 
7  06/25/02 17:25:59.180 AG     +1.76   1  INST ZONE1 EN A G 
8  04/01/02 04:43:19.558 ER    $$$$$$   1   EN 
9  03/14/01 00:28:36.139 BG     +4.85   1   EN 
10 00/00/01 00:03:11.753 BG     -0.02   1  INST ZONE1 EN B G 
11 00/00/01 00:03:07.501 BG    +16.05   1   EN 
12 00/00/01 00:03:03.062 BG    +16.00   1   EN 

 
"TXCOMMAND=SYNC-ARB"  

The STNC-ARB command executes the precoded ARBITRAR ASCII protocol for reading the 
GPS clock’s time and sets the PC'S system clock.  The command executes upon a 
"TXPERIOD" or "ATMESSAGE". 
REQUIREMENTS:  
TYPE=ASCII 
RXSTAY=4 
RXEND 
RXPLUS in this case are reserved for internal use.  

 
"TXCOMMAND=SYNC-TRUE"  

The SYNC-TRUE command executes the precoded TRUE TIME ASCII protocol for reading the 
GPS clock’s time and sets the PC'S system clock.  The command executes upon a 
"TXPERIOD" or "ATMESSAGE". 
REQUIREMENTS:  
TYPE=ASCII 
RXSTAY=4 
RXEND 
RXPLUS in this case are reserved for internal use. 

 
"TXCOMMAND=DNP-ANALOG"  

The DNP-ANALOG command executes the precoded DNP 3.0 protocol for reading analog 
values from the connected devices.  The analog values can be referenced by line number in the 
RXSTRIP commands.  For example, analog value 1 is located in line 1, analog value 2 is in line 
2 and so on.  The line values are stored as ASCII characters.  The command executes upon a 
"TXPERIOD" or "ATMESSAGE". 
REQUIREMENTS:  
TYPE=BINARY 
RXSTAY=4 
Use the "D0" data type with the "RXSTRIP" commands. 

 
"TXCOMMAND=HATH-DFR"  

The HATH-DFR command executes the precoded HATHAWAY DFR-II protocol for downloading 
the latest records and saving them to separate files using the IEEE long file naming convention 
with the extension “.DFR”.  The command executes upon a "TXPERIOD" or "ATMESSAGE". 
REQUIREMENTS: 
TYPE=BINARY 
RXSTAY=15 
RXEND=1B 03 FF 
RXPLUS=1   

 
"TXCOMMAND=REL-30X"  

The REL-30X command executes the precoded ABB REL30X protocol for downloading the 
latest event records, target files and history files for the events and targets.  All downloaded data 
is saved to separate files using the IEEE long file naming convention.  The event files have the 
extension “.30X”, the summary files have the extension “.30S” and the event history files have 
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the extension “.3EH” and targets history files have “.3TH”.  The command executes upon a 
"TXPERIOD" or "ATMESSAGE". 
REQUIREMENTS:  
TYPE=HEX 
RXSTAY=4 
RXPLUS in this case is reserved for internal use.  
 
Example Target File: 
REL 301/302 FAULT REPORT 
 --------------------------- 
      MODEL =  REL 301/302 
 STATION ID =  SEAVILLE SW 
    LINE ID =  B43 (REL-302) 
       DATE =  09/04/03 03:14:11.830 
 FAULT TYPE =  BG Fault 
     TARGET =  Z3 Pickup 
 
  BK1 =  NO     SEND =  NO  
  BK2 =  NO      RX1 =  NO  
  Z1G =  NO      RX2 =  NO  
  Z1P =  NO      WFT =  NO  
  Z2P =  NO      ITP =  NO  
  Z2G =  NO      ITG =  NO  
  Z3P =  NO      CIF =  NO  
  Z3G =  NO      LLT =  NO  
 PLTG =  NO       GB =  NO  
 PLTP =  NO  
 
    Z =  7.04 Ohms 
 FANG =  68° 
  DMI =  30.00 Miles 
  DKM =  48.20 kilometers 
 
 PFLC =  1.50 Amps 
 PFLV =  68.00 Volts 
   LP =  3° 
  VPA =  63.20 Volts     ANG = 0° 
  VPB =  55.20 Volts     ANG = -117° 
  VPC =  62.80 Volts     ANG = 128° 
   V1 =  60.30 Volts     ANG = 3.69° 
   V2 =  5.11 Volts      ANG = -51.15° 
  3V0 =  0.10 Volts      ANG = 0° 
  IPA =  5.90 Amps       ANG = -21° 
  IPB =  8.00 Amps       ANG = 176° 
  IPC =  3.10 Amps       ANG = 33° 
   I1 =  5.14 Amps       ANG = -53.50° 
   I2 =  3.11 Amps       ANG = 39.38° 
  3I0 =  0.18 Amps       ANG = 46.01° 
  IPN =  0.00 Amps       ANG = 0° 
 
Example Target History File: 
--  REL TARGET HISTORY  -- 
---------------------------- 
 
 STATION ID =  SEAVILLE SW 
    LINE ID =  115 (REL-302) 
       DATE =  05/13/2004 01:06:18 PM 
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#   TRIG DATE    TRIG TIME    F-TYPE      TRIGGER     DIST  EVENT# 
------------------------------------------------------------------ 
10  10/31/2003  19:48:06.100  BG Fault    Z3 Pickup   279   210 
09  06/24/2003  10:05:42.900  CA Fault    Z3 Pickup   340   1 
08  05/25/2003  09:04:34.990  AG Fault    Trip        128   15 
07  05/25/2003  09:04:34.970  AG Fault    Z2 Pickup   128   223 
06  05/25/2003  09:03:46.100  AG Fault    Trip        1     14 
05  05/25/2003  09:03:42.720  AG Fault    Trip        1     253 
04  05/25/2003  09:03:16.560  AG Fault    Trip        128   76 
03  05/25/2003  09:03:16.550  AG Fault    Z2 Pickup   128   172 
02  05/25/2003  09:02:51.670  AG Fault    Trip        174   219 
01  05/25/2003  09:00:02.730  AG Fault    Trip        174   10 
16  05/25/2003  08:59:46.990  AG Fault    Trip        175   169 
15  05/25/2003  08:53:55.620  AG Fault    Trip        175   216 
14  05/25/2003  08:53:43.840  AG Fault    Trip        174   7 
13  05/25/2003  08:51:44.750  AG Fault    Trip        174   246 
12  05/25/2003  08:51:34.800  AG Fault    Trip        172   5 
11  05/25/2003  08:51:21.200  AG Fault    Trip        174   20 
 
Example Event History File: 
--  REL EVENT HISTORY  -- 
---------------------------- 
 
 STATION ID =  SEAVILLE SW 
    LINE ID =  B43 (REL-302) 
       DATE =  05/13/2004 01:18:05 PM 
 
#   EVE-DATE    EVE-TIME      COUNTER      TRIGGER 
------------------------------------------------------- 
09  05/07/2004    10:23:19.100  0000       N / A 
08  04/23/2004    18:28:19.450  0008       Trip 
07  04/23/2004    18:28:18.970  0007       Z3 Pickup 
06  04/01/2004    19:17:02.240  0006       Z3 Pickup 
05  02/28/2004    15:25:57.580  0005       Z3 Pickup 
04  10/15/2003    16:53:15.370  0004       Z3 Pickup 
03  09/04/2003    03:14:12.100  0003       Z3 Pickup 
02  09/04/2003    03:14:11.840  0002       Z3 Pickup 
01  09/04/2003    03:14:11.710  0001       Z3 Pickup 
16  00/00/2000    00:00:00.000  0000       N / A 
15  00/00/2000    00:00:00.000  0000       N / A 
14  00/00/2000    00:00:00.000  0000       N / A 
13  00/00/2000    00:00:00.000  0000       N / A 
12  00/00/2000    00:00:00.000  0000       N / A 
11  00/00/2000    00:00:00.000  0000       N / A 
10  00/00/2000    00:00:00.000  0000       N / A 
 

"TXCOMMAND=REL-30X-M"  
The REL-30X-M command executes the precoded ABB REL30X-M protocol for downloading the 
latest meter values.  The command executes upon a "TXPERIOD" or "ATMESSAGE". 
REQUIREMENTS:  
TYPE=HEX 
RXSTAY=4 
RXPLUS in this case is reserved for internal use.  
 
Meter Values Extracted: 
Date and Time 
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LOP – Loss of Potential 
LOI – Loss of Current 
IA and Angle 
IB and Angle 
IC and Angle 
VA and Angle 
VB and Angle 
VC and Angle 
 

"TXCOMMAND=DLP-EVENTS"  
The DLP-EVENTS command executes the precoded GE DLP-EVENTS protocol for 
downloading the latest event records and summaries.  All downloaded data is saved to separate 
files using the IEEE long file naming convention.  The event files have the extension “.OSC” and 
the summary files have the extension “.DLS”.  The command executes upon a "TXPERIOD" or 
"ATMESSAGE". 
REQUIREMENTS:  
TYPE=HEX 
RXSTAY=10 
RXPLUS in this case is reserved for internal use.  
 
Example Summary File: 
DLP FAULT REPORT 
 ----------------- 
      MODEL: DLP1512GC        
 STATION ID: SEAVILLE SW 
    LINE ID: X2250 (DLP) 
 
 TRIP DATE: 6/27/04    TRIP TIME: 14:33:55.890 
 
 FAULT TYPE:  AG        DISTANCE: 003.2 
  TRIP TYPE:  Z1        OPERATING TIME: 00023 
 
 PREFAULT            FAULT 
 Ia: 548.00 A        Ia: 4380.0 A 
 Ib: 012.00 A        Ib: 008.00 A 
 Ic: 012.00 A        Ic: 012.00 A 
 In: 372.00 A        In: 4368.0 A 
 
                     Va: 000.4 KV 
                     Vb: 134.0 KV 
                     Vc: 134.0 KV 
 

"TXCOMMAND=DPU-MODBUS "  
The DPU-MODBUS command executes the precoded ABB DPU-MODBUS protocol for 
downloading the latest event records.  All downloaded data is saved to separate files using the 
IEEE long file naming convention.  The event files have the extension “.DPU”.  The command 
executes upon a "TXPERIOD" or "ATMESSAGE". 
REQUIREMENTS:  
TYPE=HEX 
RXSTAY=10 
RXEND=^[13;10] 
RXPLUS in this case is reserved for internal use. 

 
"TXCOMMAND=ROCH-DFR"  

The ROCH-DFR command executes the precoded Rochester DFR protocol for downloading the 
latest event records.  All downloaded data is saved to separate files using the Rochester naming 
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convention.  The event files have the extension “.0##”.  The command executes upon a 
"TXPERIOD" or "ATMESSAGE". 
REQUIREMENTS:  
TYPE=HEX 
RXSTAY=8 
RXPLUS in this case is reserved for internal use. 

 
"TXCOMMAND=GE-D60"  

The GE-D60 command executes the precoded GE-D60 protocol for downloading the latest 
event records.  All downloaded data is saved to separate files using the IEEE long file naming 
convention.  The event files are in the Comtrade format and have the extension “.CFG”, “.DAT”.  
The command executes upon a "TXPERIOD" or "ATMESSAGE". 
REQUIREMENTS:  
TYPE=HEX 
RXSTAY=8 
RXPLUS in this case is reserved for internal use. 

 
"TXCOMMAND=FTP-EVENTS"  

The FTP-EVENTS command executes the standard FTP protocol for downloading the latest 
event records from the connected FTP server.  All downloaded data is saved to separate files 
using either the IEEE long file naming convention or maintaining the original file name.  The 
event files are in the manufacturer allocated format.  The command executes upon a 
"TXPERIOD" or "ATMESSAGE". 
REQUIREMENTS:  
TYPE=ASCII 
RXSTAY=4 
RXPLUS in this case is reserved for internal use. 

 
"TXCOMMAND=FTP-SEND"  

The FTP-SEND command executes the standard FTP protocol for sending event files to the 
connected FTP server.  The command executes upon a "TXPERIOD" or "ATMESSAGE". 
REQUIREMENTS:  
TYPE=ASCII 
RXSTAY=4 
RXPLUS in this case is reserved for internal use. 

 
TXEND: 

A sequence of characters to transmit (ASCII OR BINARY) after the "TXCOMMAND" and 
"TXLOGON" commands ("TXEND" is inserted at the end of these commands).  The maximum 
length is 1024 characters and escape code commands are allowed. 

 
TXPERIOD: 

The transmit cycle in seconds (an integer number integer number up to 2 to 2 million).  For 
example, if "TXPERIOD=4" was specified then the "TXSTART", "TXCOMMAND", and "TXEND" 
strings are concatenated and transmitted once every 4 seconds.  If "TXPERIOD=0" was specified 
then these actions will not occur unless "TXDELAY>0" was specified in which case the driver will 
execute one time only.  If "TXPERIOD=T0800" was specified then the driver will execute at 08:00 
am.  All “T” periods are defined in military time.  

 
TXDELAY: 

The duration in seconds to wait before the transmit cycle begins.  For example, if "TXDELAY=3" 
was specified then only the first occurrence of "TXPERIOD" is delayed by 3 seconds.  In the 
previous example the first period occurs after 7 seconds (TXPERIOD+TXDELAY) and all others will 
occur 4 seconds apart.  If "TXPERIOD=0" was specified then specifying "TXDELAY" will cause the 
driver to execute only one time (useful for logon procedures).  
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TXBREAK: 
This command sends a number of break signals to the connected device. The sequence runs by 
first calling the WinAPI SetCommBreak function to suspend character transmission for the 
specified communications device and places the transmission line in a break state until the 
ClearCommBreak function is called. It then waits the specified break time then calls the WinAPI 
ClearCommBreak function to restore character transmission for the specified communications 
device and places the transmission line in a non-break state. It then pauses the specified pause 
time before repeating the sequence. This sequence is repeated the number of times specified in 
the command break parameters. The calling scheme is TXBREAK=# of times to repeat sequence, 
time interval in milliseconds between SetCommBreak and ClearCommBreak, time interval between 
sequence calls. 
 
Example: TXBREAK=2,500,250 

 
ONDAY: 

The driver commands will be processed on the specified day of each month for the duration of that 
day or once during that day.  The range of values is 1 to 31.  Use this command in combination 
with the military time "TXPERIOD" command to perform monthly functions.  

 
ONDOW: 

The driver commands will be processed on the specified day of each week for the duration of that 
day or once during that day.  The range of values is 1 to 7 (1=Monday to 7=Sunday). Use this 
command in combination with the military time "TXPERIOD" command to perform weekly functions.  

RECEIVE (RX) COMMANDS 

RXSTART: 
A sequence of characters received from the device that indicates the "Start of Response" (STX). 
The maximum length for "RXSTART" is 255 characters.  This string is used to synchronize with the 
start of a response.  For example, the numeric value 2 (02 Hex) is used by some devices to 
indicate the start byte of the response.  In this case use "RXSTART=^[02]" for "TYPE=ASCII", or 
"RXSTART=02" for "TYPE=HEX". 

 
RXEND: 

A sequence of characters received from the device indicating "End the Response" (ETX).  The 
maximum length for "RXEND" is 255 characters.  This string is used to indicate that the driver has 
received the full response.  Upon "RXEND" the system will process the "RXSTRIP" commands to 
parse and display the data and when complete the driver is unloaded so other drivers (that are 
defined at the same port) can execute.  Also upon "RXEND" the "RXSTAY" delay is aborted.  
 
For example: the numeric value 3 (03 Hex) is used by some devices to indicate the end of a 
response.  In this case use "RXEND=^[03]". for "TYPE=ASCII", or "RXEND=03" for "TYPE=HEX".   
 
Another example is connecting to a modem.  The connection is established when the modem 
sends a connect signal (CONNECT 14400/ARQ).  For modem connection drivers set 
“RXEND=Connect”. 

 
RXPLUS: 

Some devices transmit a check sum or CRC code after "RXEND".  In this case, the "RXEND" no 
longer indicates the physical end of the response.  Use "RXPLUS" to define the total number of 
bytes received beyond "RXEND".  For example, if "RXEND=1B 03 FF" is set and the actual 
response end in "1B 03 FF 83" then use "RXPLUS=1". 

 
RXSTAY: 
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There is a delay between the time that a command is transmitted and the time the response 
arrives.  Also, there are breaks during transmission where the responding device may pause and 
then continue to transmit.  Such delays and pauses should be timed using terminal mode to study 
the response time of a device.  Use the “RXSTAY” command to record the largest delay 
encountered.  If "RXSTAY=4" is defined the system will initiate an internal counter to count up to 4 
seconds from the time that last byte was received.  If new bytes arrive during the "RXSTAY" 
counter then the internal counter is initialized.  The default value is "RXSTAY=3".  Once the internal 
counter reaches "RXSTAY" then the system will unload the driver so other driver (on the same 
port) can execute.  When "RXEND" is encountered, "RXSTAY" aborts.  
 

RXWAIT: 
If “RXEND” is known and the number of bytes received after the defined “RXEND” is unknown use 
“RXWAIT” to wait a number of seconds before ending the driver.  For example, when a modem 
connects it sends a “Connect” signal.  The number of bytes it sends after the “Connect” signal 
varies.  Set “RXWAIT=” to delay the driver from being unloaded.  This ensures that all the data 
remaining to be received goes to the proper device file “DEV_###.DTB”.  Refer to the example 
modem driver below.  

 
RXQUIT: 

If "RXEND" is not detected set "RXQUIT" to send message commands.  For example, in the 
modem driver below if the “Connect” signal is not detected then the RXQUIT can be used to set a 
message “REDO” to execute the driver again.  

 
RXCLEAR: 

The receive buffer will not be cleared upon TXPERIOD and will be allowed to build up to the total 
number of fields (RXSTRIP Lines).  Use “RXCLEAR” to hold only the last polled values.  The range 
of values for RXCLEAR is 0 or 1 (default=0).  This is useful for creating scrollable information.  

 
RXSAVE: 

The receive data is buffered into link list with 256 characters per link.  To save the buffered data to 
a text or binary file (depends on the type setting) use RXSAVE=filename.  For example, the 
Optimho driver buffers the data then when complete it saves the buffered data to a file.  The 
maximum length is 255 characters and escape code commands are allowed.  The following 
example saves the received data to a text file called RX-Device#.BUF (RX-2.BUF) in the 
c:\SDCSave directory.  
 
RXSAVE=C:\SDCSAVE\RX-^[ID].BUF 
 

Examples: The following drivers use the RXSTAY, RXEND, RXWAIT, RXQUIT and RXPLUS commands.  
 
[HATHAWAY DFR PROTOCOL] 
DRIVER#=71 
TYPE=BINARY 
TXCOMMAND=HATH-DFR 
TXPERIOD=0 
TXDELAY=1 
RXSTAY=15 
RXEND=1B 03 FF 
RXPLUS=1 
RXSTRIP=N00,                      X1,Y1,H6,"     Scan Hathaway DFR" 
RXSTRIP=N00,%^ADDR,               X1,Y2,H1,"    DAU ID:" 
RXSTRIP=N00,%^[MON]/^[DAY]/^[YR], X1,Y3,H1,"      Date:" 
RXSTRIP=N00,%^[HR]:^[MIN]:^[SEC], X1,Y4,H1,"      Time:" 
RXSTRIP=N03,S1,T40,D0,C14,        X1,Y5,H1,"    LstRsp:" 
RXSTRIP=N04,S1,T40,D0,C02,        X1,Y6,H1,"   NxtCmnd:" 
RXSTRIP=N01,S1,T40,D0,C01,        X1,Y7,H0,"  LstFault:" 
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RXSTRIP=N02,S1,T40,D0,C01,        X1,Y8,H0,"      Time:"    
 
[DIAL MODEM] 
DRIVER#=2 
TYPE=ASCII 
ATMESSAGE=^[^STN],^[^SID],RUN 
TXCOMMAND=^[P2]ATDT ^[^CMND;13;10;P4] 
RXSTAY=90 
RXEND=CONNECT 
RXWAIT=4 
RXQUIT=SDCEND^[^SID],REDO^[^STN] 
RXSTRIP=N01, S01, T40, X01, Y01, D00, C08, H11, "", @D1 
RXSTRIP=N03, S01, T40, X01, Y02, D00, C14, H11, "", @D2 

 
 
RXSTRIP: 

Sequence of characters or bytes to strip from the received data and displayed on screen [up to 512 
RXSTRIP commands per driver].  The RXSTRIP commands are executed following the sequence 
in which they appear.  Also, the RXSTRIP commands are the last commands executed when the 
driver is complete.  

 
N# = Line number to strip or block number for binary [positive #] 

If "N0" is specified then the field is a header field only. 
Header fields can be used to display variables defined or calculated using the @, +, -, *, /, 
&, |, >, or < commands. 

S# = Starting character or byte number to strip [from 1 to 512]. 
T# = Total number of characters or bytes to strip [ASCII=1 to 75, Binary=1 to 4]. 
B# = The Nth non-blank sequence of characters to strip.   

For example, to strip “Viny” from “My name is Viny” use the “B4” command. 
BC# = The Nth comma sequence of characters to strip.   

For example to strip "Viny" from "My,,name,is,,,Viny" use the "BC7" command. 
D# = Type of data to display.  The available types are: 

0: ASCII (read each byte as an ASCII code), 
1: INTEGER (convert 1, 2 or 4 bytes to an integer string), 
2: HEX (convert 1 byte to a hexadecimal string), 
3: REAL (4 byte IEEE single float to a real string), 
4: ASCII-HEX (convert 1, 2 or 4 hex characters to decimal), 
5: ASCII-DECIMAL (read ASCII string as decimal). 
6: ASCII-CODED-DECIMAL (convert hex string to ASCII code). 

"" = Contains the header to display ahead of the stripped data [max 24 characters]. 
H# = Color to display the header [from 0 to 15]. 
X# = X column offset to display the header and the stripped data [from 1 to 75]. 
Y# = Y row offset to display the header and the stripped data [from 1 to 8]. 
C# = Color to display the stripped data [from 0 to 15]. 
V# = Compare the parsed data with a string/value and show the defined header if equal. 
V=# = Compare the parsed data with a string/value and show the defined header if equal. 
V># = Compare the parsed data with a string/value and show the defined header if greater. 
V<# = Compare the parsed data with a string/value and show the defined header if less). 
V~# = Compare the parsed data with a string/value and show the defined header if not equal. 
U# = Upper offset for the V trigger (V+U Hysteresis (default=0)). 
L# = Lower offset for the V trigger (V-L Hysteresis (default =0)) 
P# = Persistence (# of true readings before trigger (default=1, disable=0)). 
M"" = If the V command triggered then set a message in for all drivers "". 
MF"" = If the V command triggered then set the message to the forward drivers only. 
JC# = If V triggered bypass the next # of RXSTRIPS (jump conditional). 
J# = Bypass the next # of RXSTRIP COMMANDS (JC# over rides J#). 
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*# = Multiply the parsed data by a constant value (ASCII-DECIMAL). 
/# = Divide the parsed data by a constant value (ASCII-DECIMAL). 
+# = Add a constant value to the parsed data (ASCII-DECIMAL). 
-# = Subtract a constant value from the parsed data (ASCII-DECIMAL). 
&# = And the parsed data (1 byte) with a hex value (Hex = 00 to FF). 
|# = Or the parsed data (1 byte) with a hex value (Hex = 00 to FF). 
<# = Shift left (1 byte) a number of bits (ASCII-DECIMAL 1 to 8). 
># = Shift right (1 byte) a number of bits (ASCII-DECIMAL 1 to 8). 
= = Set a variable to a defined value. 
FE = Exponential of the parsed data. 
FL = Logarithm of the parsed data. 
FS = Sin in radians of the parsed data. 
FC = Cos in Radians of the parsed data. 
FA = Arc Tangent in radians of the parsed data. 
FQ = Square of the parsed data. 
FR = Square root of the parsed data. 
FT = Truncate the parsed data to an integer values. 
%# = Set data to a constant text string. 
@NAME = Put the parsed data in a variable named "NAME" (maximum length is 12 characters). 

The reserved system variable defined in the beginning of this Appendix names cannot 
be used.  System and user variables can be accessed using the "^NAME^DEVICE" 
commands. 

^NAME = Get the parsed data (maximum 80 characters) stored in the variable name. 
(@/^)NAME^# = Applies only to the variable "NAME" attached to the device# "#". 

If "@" was in place instead of the # then the number of the parent device will be 
used. 

E"" = Same as "", but for the DXF display only [maximum 24 characters]. 
ES# = Same as S#, but for the DXF display only [from 1 to 512]. 
ET# = Same as T#, but for the DXF display only [same range as T#]. 
EH# = Same as H#, but for the DXF display only [from 0 to 15]. 
EX# = Same as X#, but for the DXF display only [from -255 to 255]. 
EY# = Same as Y#, but for the DXF display only [from -255 to 255]. 
EC# = Same as C#, but for the DXF display only [from 0 to 15]. 

NOTES: 

The "," comma is reserved as the separator between the RXSTRIP commands. 
The maximum number of variables allowed per file is 10,000. 

 
* Available Colors: 

• 00: Black 
• 01: Blue 
• 02: Green 
• 03: Cyan 
• 04: Red 
• 05: Magenta 
• 06: Brown 
• 07: Lightgray 
• 08: Darkgray 
• 09: Lightblue 
• 10: Lightgreen 
• 11: Orange 
• 12: Lightred 
• 13: Lightmagenta 
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• 14: Yellow 
• 15: White 

EXAMPLES: 

[SEL-LOGON EXAMPLE] 
DRIVER#=1 
TYPE=ASCII 
TXSTART=^[13;10] 
TXCOMMAND=acc^[13;10]OTTER 
TXEND=^[13;10] 
TXPERIOD=0 
TXDELAY=1 
 
[ASCII RESPONSE EXAMPLE] 
DRIVER#=2 &1 
TYPE=ASCII 
TXSTART=^[13] 
TXCOMMAND=^[02;10;10;10;10;10] 
TXCOMMAND=METER 
TXEND=^[13;03] 
TXPERIOD=8 
TXDELAY=1 
RXSTART=2 
RXEND=3 
RXSTRIP=X1, Y1, "Any Label For The Window", H1 
RXSTRIP=N06,S1,T49,D0,C08,X1,Y3,H1,"N06: " 
RXSTRIP=N08,S1,T49,D0,C07,X1,Y4,H6,"N08: " 
RXSTRIP=N09,S1,T49,D0,C12,X1,Y5,H6,"N09: " 
RXSTRIP=N10,S1,T49,D0,C07,X1,Y6,H6,"N10: " 
RXSTRIP=N12,S1,T24,D0,C10,X1,Y7,H1,"N12: " 
RXSTRIP=N13,S1,T24,D0,C10,X1,Y8,H1,"N13: " 
RXSTRIP=ES12,ET3,EC12,EX-15,EY2,EH12,E" I(A):" 
RXSTRIP=ES12,ET3,EC10,EX-15,EY3,EH10,E"P(kV):" 
RXSTRIP=ES12,ET3,EC10,EX-15,EY4,EH10,E"Q(kV):" 
 
[TRANSMIT FILES EXAMPLE] 
DRIVER#=3 
TYPE=BINARY 
TXFILE=C:\EVENTS\TEMP\*.* J:\EVENT\MASTER1 /MOVE 
TXFILE=C:\SDCSAVE\*.OK C:\SDCHOLD /MOVE 
TXFILE=C:\PECO\DATABASE\*.* C:\TEMP 
TXFILE=C:\BP\BIN\DATAPORT\CREATE.HLP C:\TEMP 
TXFILE=C:\SDCSAVE\PORT_001.DTB C:\TEMP 
TXDIAL=^[13]ATDT 1,123-456-7899^[13] 
TXHANGUP=+++ATH0^[13] 
TXPERIOD=0 
TXDELAY=5 
 
[RTU-SOE POINTS DUMP] 
DRIVER#=4 
TYPE=HEX 
TXCOMMAND=RTU-SOE 
TXPERIOD=5 
TXDELAY=0 
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RXSTRIP="FIN ",       H1, X41, Y1, T1, D0, C8 
RXSTRIP="ALE ",       H1, X41, Y2, T1, D0, C8 
RXSTRIP="ATT ",       H1, X41, Y3, T1, D0, C8 
RXSTRIP="ERR ",       H1, X41, Y4, T1, D0, C8 
RXSTRIP="SOE ",       H4, X41, Y5, T1, D0, C8 
RXSTRIP="ACC ",       H1, X41, Y6, T1, D0, C8 
RXSTRIP="ALG ",       H1, X41, Y7, T1, D0, C8 
RXSTRIP="STS ",       H1, X41, Y8, T1, D0, C8 
RXSTRIP="SYNC-BYTE ", H1, X48, Y1, T2, D0, C8 
RXSTRIP="   RTU-ID ", H1, X48, Y2, T2, D0, C8 
RXSTRIP=" GROUP-ID ", H1, X48, Y3, T2, D0, C8 
RXSTRIP="FRAME-LEN ", H1, X48, Y4, T2, D0, C8 
RXSTRIP="  MESSAGE ", H1, X48, Y5, T2, D0, C8 
RXSTRIP=" FUNCTION ", H4, X48, Y6, T2, D0, C8 
RXSTRIP=" DATA-LEN ", H4, X48, Y7, T2, D0, C8 
RXSTRIP=" END-FLAG ", H1, X48, Y8, T2, D0, C8 
RXSTRIP="CRC-HI ",    H1, X63, Y7, T2, D0, C8 
RXSTRIP="CRC-LO ",    H1, X63, Y8, T2, D0, C8 
RXSTRIP=X1, Y1, T38, D0, C1, N1, S2 
RXSTRIP=X1, Y2, T38, D0, C7, N2, S2 
RXSTRIP=X1, Y3, T38, D0, C7, N3, S2 
RXSTRIP=X1, Y4, T38, D0, C7, N4, S2 
RXSTRIP=X1, Y5, T38, D0, C7, N5, S2 
RXSTRIP=X1, Y6, T38, D0, C7, N6, S2 
RXSTRIP=X1, Y7, T38, D0, C7, N7, S2 
RXSTRIP=X1, Y8, T38, D0, C7, N8, S2 

 
 
 



Appendix A - Device Drivers 
 

A-24   

 
 



Appendix B – System Keys 

B-1 

A P P E N D I X  B  

System Keys 
 
This section lists the function keys, cursor keys, and menu buttons available in the device manager, query 
fields and DXF display. 

Device Manager 

Function Keys Description 
F1 Display the device manger’s help file.  
F2 Edit the device record at the cursor position.  
F3 Test the device’s port at the cursor positon using the loop back plug detection test. 
F4 Create a new device. 
F5 Create or edit the terminal function keys for the device at the cursor position. 
F6 View the data stored in the device buffer. 
F7 Run the MID interrogration interface for all or marked devices assigned a device 

driver. 
F8 Run the DXF interrogration interface for all devices assigned a device driver. 
 
Cursor Keys Description 
Left Arrow Move the cursor bar to the left one position. 
Right Arrow Move the cursor bar to the right one position. 
Up Arrow Move the cursor bar up one position. 
Down Arrow Move the cursor bar down one position. 
Page Up Display the devices on the previous page. 
Page Down Display the devices on the next page. 
Home  Move the cursor to the first column in the port table. 
End Move the cursor to the last column in the port table. 
Ctrl+Home Move the cursor to the first device in the table. 
Ctrl+End Move the cursor to the last device in the table. 
Tab Move the cursor from the device table to the query fields. 
Delete Delete all the marked devices in the table. 
Enter Run the terminal display for the selected device. 
 
Menu Buttons Description 

 Configure Edit the device at the cursor position 

 New Create a new device. 

 TermKeys Create or edit the terminal function keys for the device at the cursor position. 

 Terminal Run the terminal display for the selected device. 

 EventFile View the data stored in the device buffer. 

 MID Run the MID interrogation display for all or marked devices assigned device drivers. 

 DXF Run the DXF interrogation display for all devices assigned device drivers. 
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Query Fields 

Function Keys Description 
F1 Display the query help file.  
F5 Query all the marked devices in the active configuration.  
F6 Query all the devices in the active configuration. 
F7 Query all the unmarked devices in the active configuration. 
F8 Clear the query criteria and set all the query operators to “=”. 
F9 Toggle through the available query operators for the active query field. 
 
Cursor Keys Description 
Up Arrow Return the cursor to the device table. 
Right Arrow Move the cursor one position to the right, wraps to next field at the end. 
Left Arrow Move the cursor one position to the left, wraps to next field at the beginning. 
Tab Move the editor to the next query field. 
Shift+Tab Move the editor to the previous query field. 
Enter Process the query criteria for all devices in the active configuration. 
 
Menu Button Description 

 Query 
Query all devices in the active configuration. 

DXF Display 

Function Keys Description 
F1 Display DXF mode's help window.  
F2 Display the “Drawing Properties” dialog.  
 
Cursor Keys Description 
Up Arrow Move the viewing area of the drawing up 40 pixels.  
Down Arrow Move the viewing area of the drawing down 40 pixels. 
Right Arrow Move the viewing area of the drawing to the right 40 pixels. 
Left Arrow Move the viewing area of the drawing to the left 40 pixels. 
Ctrl+Right Move the viewing area of the drawing to the right by one screen. 
Ctrl+Left Move the viewing area of the drawing to the left by one screen. 
Page Up Move the viewing area of the drawing up by one screen. 
Page Down Move the viewing area of the drawing down by one screen. 
Home Display the far left portion of the drawing. 
End Display the far right portion of the drawing. 
Ctrl+Home Display the top left portion of the drawing. 
Ctrl+End Display the bottom right portion of the drawing. 
Tab Move to the next DXF drawing tab 
Shift+Tab Move to the previous DXF drawing tab 
+ key Increase the drawing's resolution. 
- key Decrease the drawing's resolution. 



Appendix B – System Keys 

B-3 

 
Menu Buttons Description 

 Original  Display the drawing in the original coordinates.  

 Fit in Win Fit the full drawing to fit in the screen area. 

 Zoom-In Increase the drawing's resolution. 

 Zoom-Out Decrease the drawing's resolution. 

 Print Print the DXF drawing in the selected DXF tab. 

 Const Set the drawing properties for the active DXF drawing. 

 Refresh Refresh the polled values in the selected DXF drawing. 

 Control  Display the control dialog to send control commands to the connected devices. 

File Manager 

Function Keys Description 
F1 Display the file table’s help file.  
F2 Display the file, at the cursor position in text format:  ASCII Editor. 
F3 Display the file, at the cursor position in hexadecimal format:  Hex Editor. 
F4 Display a list of the DAU-DEF station titles found in the active directory. 
F5 Display the command line dialog to run an application. 
F7 Change the active path to the specified destination path. 
F8 Copy the marked files to the destination path. 
F9 Move the marked files to the destination path. 
F11 Display a sequence of events table for all the marked waveform files. 
F12 Refresh the folder tree and the current directory 
 
Cursor Keys Description 
Left Arrow Move the cursor bar to the left one position. 
Right Arrow Move the cursor bar to the right one position. 
Up Arrow Move the cursor bar up one position. 
Down Arrow Move the cursor bar down one position. 
Page Up Display the files on the previous page. 
Page Down Display the files on the next page. 
Home  Move the cursor to the first column in the file table. 
End Move the cursor to the last column in the file table. 
Ctrl+Home Move the cursor to the first file in the file table. 
Ctrl+End Move the cursor to the last file in the file table. 
Tab Move the cursor from the file table to the query fields. 
Delete Delete all the marked files and empty directories. 
Enter Run the driver at the cursor position. 
Backspace Change the active path to the previous directory. 
Character keys Move to the next row in the active column that starts with the entered character. 
 
Menu Buttons Description 

 Folder Tree Show / Hide the Folder Tree 
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 Email Email all marked files and their support files. 

 Refresh Refresh the current directory from disk. 

 ChDir Change the active path to the specified destination path. 

 Previous Dir Change to the previous directory. 

 Last Dir Change to the last navigated directory. 

 Copy Copy the marked files to the destination path. 

 Move Move the marked files to the destination path. 

 Mark Mark/Unmark all visible files. 

 Query 
Query all files in the active directory. 

 Plot Plot the data contents for the highlighted file. 

 Summary Display the waveform summary for the file at the cursor position. 

 Edit Edit the contents of the file at the cursor position:  ASCII Editor 

Load Analysis Perform load analysis on the marked files. 

Analysis 

Function Keys Description 
F1 Display the data help file.  
F2 Display the analog and digital channel information.  
F3 Generate a max/min peak chart and an EN/SR summary log. 
F4 Toggle between the available analog views. 
F5 Display the software analog channel dialog. 
F6 Turn channel amplitude auto scaling ON or OFF. 
F7 Turn super imposing ON/OFF for all or marked channels. 
F8 Mark or unmark all the visible analog/digital channels. 
F9 Toggle between the available digital views (All or Triggered). 
F11 Display the harmonics table. 
 
Cursor Keys Description 
Left Arrow Move the data bar to the left one sample. 
Right Arrow Move the data bar to the right on sample. 
Ctrl+Right Arrow Move the data bar to the next peak for the first display channel or the first 

marked channel. 
Ctrl+Left Arrow Move the data bar to the previous peak for the first display channel or the first 

marked channel. 
Shift+Ctrl+Right 
Arrow 

Move the data bar ahead one cycle for the first displayed channel or the first 
marked channel. 

Shift+Ctrl+Left Arrow Move the data bar back one cycle for the first displayed channel or the first 
marked channel. 

Shift+Left Arrow Shift the analog information table to the left by one column. 
Shift+Right Arrow Shift the analog information table to the right by one column. 
Page Up Page up through the data. 
Page Down Page down through the data. 
Home Move the data bar to the first data sample. 
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End Move the data bar to the last data sample. 
Ctrl+Up Arrow Increase the amplitude for all or marked channels. 
Ctrl+Down Arrow Decrease the amplitude for all or marked channels. 
Ctrl+Page Up Expand the time scale for all visible channels. 
Ctrl+Page Down Condense the time scale for all visible channels. 
Tab Toggle between the analog and digital channels. 
Up Arrow Move the cursor up one channel. 
Down Arrow Move the cursor down one channel. 
Shift+Page Up Display the analog/digital channels on the previous page. 
Shift+Page Down Display the analog/digital channels on the next page. 
Ctrl+Home Display the first page of the analog/digital channels. 
Ctrl+End Display the last page of the analog/digital channels. 
Spacebar Mark or Unmark the channel at the cursor position. 
Shift+Up Arrow Mark or Unmark a group of channels while moving the cursor up. 
Shift+Down Arrow Mark or Unmark a group of channels while moving the cursor down. 
Insert Display the hidden channels that were removed by the delete keys. 
Delete Hide the marked channels and respace the unmarked channels. 
Enter Hide the unmarked channels and respace the marked channels. 
Esc Display all the hidden channels or exit the data window. 
Backspace Display all the hidden channels. 
+ Shift all the marked channels up one position. 
- Shift all the marked channels down one position. 
Ctrl-A Move the reference bar to the sample at the cursor bar. 
Ctrl-Z Move the RMS bar to the sample at the reference bar. 
 
 
 
Menu Buttons Description 

 Reopen File Reopen a previous viewed waveform file. 

 Email Active File Email the active file and any support files needed. 

 View Raw Data View the waveform`s raw data file in an ASCII or binary editor. 

 Summary View the Analog/Digital Summary of the active displayed file. 

 Recorder Chans Display the waveform's analog/digital channel headers and scale factors. 

 Inc Magnify the amplitude of the marked channels. 
 Dec Attenuate the amplitude of the marked channels. 

 ASV Turn auto scaling ON/OFF for all visible channels. 

 In Condense the time scale of the visible channels. 

 Out Expand the time scale of the visible channels. 

 View Marked Hide the unmarked channels and respace the marked channels. 
 View All Replot all the hidden channels. 

  

 Set Ref Bar Move the reference bar to the sample at the cursor bar.  

 SetRMS Bar Move the RMS bar to the sample at the reference bar. 
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 Properties 
Display the Window Properties dialog. 

 Restore Original Restores the samples to the original raw samples stored in the file. 

 Change Freq. 
Change the frequency of the active display file. 

 Duplicate Cyc. 
Duplicate the cycle and number of times at the data bar. 

 Resize Sliding 
Window 

Resize the RMS sliding window. 

Select Views  
Select a specific line or view from the drop down list. 
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show all hidden channels ..................................... 261 
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super impose ............................................... 163, 265 
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waveform summary .............................................. 273 
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zoom channels ..................................................... 157 
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data type....................................................... 69, 72, 111 
database viewer 

comma delimited .......................................... 133, 207 
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dau-def 
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decrease amplitude .................................................. 212 
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delete channels ................................................ 156, 229 
delete devices .............................................. 76, 96, 212 
delete files ................................................................ 212 
delete text ................................................................ 213 
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delta x .............................................................. 153, 213 
delta y ...................................................................... 213 
descending sort ........................................................ 213 
device 

data type .............................................................. 111 
default display frequency ..................................... 111 
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address ............................................................ 69, 72 
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